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1 Legal Information

The information provided in this documentation contains general descriptions and/or technical
characteristics of the performance of the products contained herein. This documentation is not
intended as a substitute for and is not to be used for determining suitability or reliability of these
products for specific user applications. It is the duty of any such user or integrator to perform the
appropriate and complete risk analysis, evaluation and testing of the products with respect to the
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you
have any suggestions for improvements or amendments or have found errors in this publication,
please notify us.

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when installing and
using this product. For reasons of safety and to help ensure compliance with documented
system data, only the manufacturer should perform repairs to components.

This document contains standardized industry terms that some customers might find insensitive
or offensive. These terms do not reflect the official policy or position of Schneider Electric.

Trademarks

Schneider Electric, ClearSCADA, EcoStruxure, Modbus, RemoteConnect, SCADAPack,
Telepace, and Trio are trademarks and the property of Schneider Electric SE, its subsidiaries
and affiliated companies. All other trademarks are the property of their respective owners.

Address

Schneider Electric Systems USA

Process Automation, Remote Operations
38 Neponset Avenue, Foxboro, Massachusetts 02035 USA
Email: RemoteOperations@se.com
www.se.com

© 2016 - 2022 Schneider Electric Systems USA Inc.
All rights reserved.

mailto:RemoteOperations@se.com
http://www.se.com
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2 Technical Support

Questions and requests related to any part of this documentation can be directed to one of the
following support centers.

Technical support: Americas, Europe, Middle East, Asia

Available Monday to Friday 8:00 am – 6:30 pm Eastern Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq

Email us Save time by emailing us your inquiry and an expert will contact
you:

supportTRSS@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Toll free within North America: 1-888-226-6876

· Direct Worldwide: +1-613-591-1943

Technical support: Australia/New Zealand (Pacific)

Available Monday to Friday 8:00 am - 5:00 pm Australian Eastern Standard Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq   

Email us Save time by emailing us your inquiry and an expert will contact
you:

techsupport.pz@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Inside Australia: 13 73 28 (13 SEAU)

· Inside New Zealand: 0800 652 999

https://se.com/faq
mailto:supportTRSS@se.com
https://se.com/faq
mailto:techsupport.pz@se.com
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3 Safety Information

Important information

Read these instructions carefully, and look at the equipment to become familiar with
the device before trying to install, operate, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

Please note

Electrical equipment should be installed, operated, serviced, and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out
of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Before you begin

Do not use this product on machinery lacking effective point-of-operation guarding. Lack of
effective point-of-operation guarding on a machine can result in serious injury to the operator of
that machine.

 WARNING

EQUIPMENT OPERATION HAZARD

· Verify that all installation and set up procedures have been completed.

· Before operational tests are performed, remove all blocks or other temporary holding means
used for shipment from all component devices.

· Remove tools, meters, and debris from equipment.

Failure to follow these instructions can result in death or serious injury.

Follow all start-up tests recommended in the equipment documentation. Store all equipment
documentation for future reference.

Test all software in both simulated and real environments.

Verify that the completed system is free from all short circuits and grounds, except those
grounds installed according to local regulations (according to the National Electrical Code in the
U.S.A, for instance). If high-potential voltage testing is necessary, follow recommendations in
equipment documentation to help prevent accidental equipment damage.

Operation and adjustments

The following precautions prevail:

· Regardless of the care exercised in the design and manufacture of equipment or in the
selection and ratings of components, there are hazards that can be encountered if such
equipment is improperly operated.

· It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or
unsafe operation. Always use the manufacturer’s instructions as a guide for functional
adjustments. Personnel who have access to these adjustments should be familiar with the
equipment manufacturer’s instructions and the machinery used with the electrical equipment.

· Only those operational adjustments actually required by the operator should be accessible to
the operator. Access to other controls should be restricted to prevent unauthorized changes in
operating characteristics.
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Acceptable use

 WARNING

UNACCEPTABLE USE

Do not use SCADAPacks or I/O modules as an integral part of a safety system. These
devices are not safety products.

Failure to follow these instructions can result in death or serious injury.

 CAUTION

EQUIPMENT OPERATION HAZARD

When devices are used for applications with technical safety requirements, the relevant
instructions must be followed. 

Use only Schneider Electric software or approved software with Schneider Electric hardware
products.

Failure to follow these instructions can result in minor or moderate injury.
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4 About the Book

Audience

 WARNING

UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and programming of control
systems. Only persons with such expertise are allowed to program, install, alter, and apply
this product.

Follow all local and national safety codes and standards.

Failure to follow these instructions can result in death or serious injury.

This manual is written for people who need to configure SCADAPack x70 devices. These
individuals are typically: 

· Systems Engineers

· Commissioning Engineers

· Maintenance Technicians

Document scope

This manual assumes that:

· The SCADAPack RemoteConnect configuration software is installed and running.

· A new project has been created and SCADAPack RemoteConnect is communicating with the
SCADAPack x70 device, as described in the SCADAPack RemoteConnect Configuration
Software manual.

This manual describes:

· Configuring parameters for the device.

· Accessing the SCADAPack x70 Logic Editor.

· Working online with the device.

· Importing and exporting files to and from the device.

· Updating the firmware and bootloader on the device.

Validity note

This document is valid for:

· SCADAPack x70 firmware version 9.7.3 and older

· SCADAPack RemoteConnect configuration software version 3.10.3 and older
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Related documents

Use this manual with the other manuals included in your SCADAPack x70 documentation set.
The table below describes the manuals available in the documentation set.

Folder Manual Content

Getting Started Getting Started · The SCADAPack x70 family of products
available in this release

· The basic steps to get your SCADAPack
x70 device operational

· Where to get more information about
configuring, monitoring and managing
your SCADAPack x70 device

SCADAPack
Software
Installation

SCADAPack Software
Installation

· Hardware and software requirements

· Installation procedures 

· Accessing help

· Troubleshooting guidance

Hardware
Manuals

The hardware manual for
your SCADAPack x70
device

· Installation, wiring and addressing
information

· Diagnostics capabilities

· Maintenance recommendations

· Hardware specifications

Configuration
Manuals

SCADAPack
RemoteConnect
Configuration Software

· Setting up and managing projects for your
SCADAPack x70 device

PC Communication
Settings -SCADAPack
CommDTM

· Setting up communications between
SCADAPack RemoteConnect and your
SCADAPack x70 device

SCADAPack x70
Configuration

· Configuring SCADAPack x70 device
operation

Porting Guide for
SCADAPack E to
SCADAPack
RemoteConnect

· Moving from SCADAPack E to
SCADAPack RemoteConnect

· Locating SCADAPack E Configurator
features in SCADAPack RemoteConnect

· Locating SCADAPack Workbench
features in SCADAPack RemoteConnect

· Compatibility chart
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Porting Guide for Telepace
to SCADAPack
RemoteConnect

· Moving from Telepace to SCADAPack
RemoteConnect

· Tutorial for creating a project

· Compatibility chart

Technical
Reference
Manuals

SCADAPack
Communication Interfaces
Technical Reference

· USB, serial and IP communications

· Mobile communications

· Dialup modem communications

SCADAPack Operations
Technical Reference

· The SCADAPack x70 device file system

· Command line operations

· Diagnostics operations

· Telnet server operations

· FTP server operations

SCADAPack SCADA
Protocols Technical
Reference

· DNP3 protocol support

· Modbus protocol support

· IEC 60870-5-104 protocol support

Logic
Programming
Manuals

SCADAPack Logic
Programming Overview

· The differences between EcoStruxure
Control Expert (Unity Pro) and the
SCADAPack x70 Logic Editor
environment

· Key programming concepts

· Basic procedures needed to use the
SCADAPack x70 Logic Editor

SCADAPack Function
Blocks Technical
Reference

· The custom SCADAPack x70 function
blocks that are available for developing
IEC 61131-3 applications 

Using EFB Toolkit with
SCADAPack x70

· Using the Schneider Electric EFB Toolkit
with SCADAPack x70 devices and
SCADAPack RemoteConnect
configuration software

Security
Administrator
Manuals

SCADAPack Security
Administrator

· Configuring security on your SCADAPack
x70 device

SCADAPack Security
Technical Reference

· Security standards

· Security overview

· DNP3 Secure Authentication

· Diagnostics
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· Attack vectors and requirements
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5 Cybersecurity

Cybersecurity is a branch of network administration that addresses attacks on or by computer
systems and through computer networks that can result in accidental or intentional disruptions.
The objective of cybersecurity is to help provide increased levels of protection for information and
physical assets from theft, corruption, misuse, or accidents while maintaining access for
intended users.

No single cybersecurity approach is adequate. Schneider Electric recommends a defense-in-
depth approach. This approach layers the network with security features, appliances, and
processes. The basic components of this approach are:

· Risk assessment: A systematic security analysis of the environment and related systems.

· A security plan built on the results of the risk assessment

· A multi-phase training campaign

· Network separation and segmentation: Physical separation of the control network from other
networks, and the division of the control network itself into segments and security zones.

· System Access Control: Controlling access to the system with firewalls, authentication,
authorization, and other software means, and traditional physical security measures such as
video surveillance, fences, locked doors and gates, and locked equipment cabinets.

· Device hardening: The process of configuring a device against communication-based threats.
Device hardening measures include disabling unused network ports, password management,
access control, and the disabling of all unnecessary protocols and services.

· Network monitoring and maintenance: An effective defense-in-depth campaign requires
continual monitoring and system maintenance to meet the challenge of new threats as they
develop.

· See Security Considerations in the Security Technical Reference manual

Contact us

For more information, refer to the Schneider Electric Cybersecurity Support Portal at
http://www.se.com/b2b/en/support/cybersecurity/overview.jsp.

Additional Resources

Schneider Electric Recommended Cybersecurity Best Practices
https://www.se.com/ww/en/download/document/CS-Best-Practices-2019-340/ 

Industrial Control Systems Cyber Emergency Response Team (ICS-CERT)
https://ics-cert.us-cert.gov 

ICS-CERT Recommended Practices
https://ics-cert.us-cert.gov/Recommended-Practices

Center for Internet Security (CIS) Top 20 Critical Security Controls
https://www.cisecurity.org/cybersecurity-best-practices

http://www.se.com/b2b/en/support/cybersecurity/overview.jsp
https://www.se.com/ww/en/download/document/CS-Best-Practices-2019-340/
https://ics-cert.us-cert.gov
https://ics-cert.us-cert.gov/Recommended-Practices
https://www.cisecurity.org/cybersecurity-best-practices
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FBI Cyber Crime
https://www.fbi.gov/investigate/cyber

Guide to Industrial Control Systems (ICS) Security
https://www.nist.gov/publications/guide-industrial-control-systems-ics-security

WaterISAC Water Security Network
https://www.waterisac.org

https://www.fbi.gov/investigate/cyber
https://www.nist.gov/publications/guide-industrial-control-systems-ics-security
https://www.waterisac.org
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6 About the SCADAPack x70 Configuration Software

The SCADAPack x70 Controller Settings -DeviceDTM , also referred to as the SCADAPack x70
configuration software, provides a graphical user interface that lets you:

· Configure operating parameters for the SCADAPack x70 device 

· Configure communication with the other devices in your SCADA network

· Access the SCADAPack x70 Logic Editor 

· Update the firmware and bootloader on the device

· View status and diagnostic information from the device

The SCADAPack x70 Controller Settings -DeviceDTM  is one of two components included, by
default, in a SCADAPack RemoteConnect configuration software project when a new project is
created. This component is an FDT 2.1 communication DTM. It appears in the catalog as
SCADAPack x70.

The other component is the PC Communication Settings -SCADAPack CommDTM. Use the PC
Communication Settings -SCADAPack CommDTM to configure communications between the
SCADAPack x70 device and the SCADAPack RemoteConnect configuration software after you
initially create your SCADAPack x70 project. For details, see the PC Communication Settings -
SCADAPack CommDTM manual.

Working offline and online

Like the PC Communication Settings -SCADAPack CommDTM, the SCADAPack x70
configuration software operates in 2 modes:

· Offline: You can define and review configuration parameters and access the SCADAPack x70
Logic Editor without affecting device operation. The configuration parameters that are
displayed depend on the role the SCADAPack x70 device is performing in your SCADA
network. The device does not need to be communicating with the SCADAPack
RemoteConnect configuration software to operate in offline mode. The configuration
parameters take effect when you take the SCADAPack x70 configuration software online and
write the configuration to the SCADAPack x70 device.

· Online: You can communicate directly with the SCADAPack x70 device to view status and
diagnostic information and to apply parameter settings that were defined in offline mode. The
device needs to be communicating with the SCADAPack RemoteConnect configuration
software to operate in online mode. For details about setting up this connection, see the PC
Communication Settings -SCADAPack CommDTM manual.

SCADAPack RemoteConnect displays the software component names in bold when you are
operating in online mode.

For information about accessing offline and online functionality, see:

· Accessing Offline Functionality 25
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· Accessing Online Functionality

Language support

The user interface for the SCADAPack x70 configuration software can be displayed in English or
in French. For details, see the Changing the User Interface topic in the SCADAPack
RemoteConnect Configuration Software manual.

Using the SCADAPack x70 Controller Settings -DeviceDTM  in external FDT
frame applications

The SCADAPack x70 Controller Settings -DeviceDTM  is not designed to be used in external
third-party FDT 2.1 frame applications.

While the SCADAPack x70 Controller Settings -DeviceDTM  adheres to the requirements of the
FDT 2.1 standard for Device Type Managers (DTM), the SCADAPack x70 Controller Settings -
DeviceDTM  relies on the SCADAPack RemoteConnect framework to provide additional services
required for SCADAPack x70 device configuration. 

28
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7 Accessing SCADAPack x70 Functionality

Every task in this manual is accessed through the SCADAPack x70 configuration software that
was added when you created the SCADAPack x70 project for the SCADAPack x70 device. 

There are 4 ways to access functionality in the SCADAPack x70 configuration software:

· Using the configuration parameters

· Using the online parameters

· Using the context menu

· Using the Network View toolbar

The tasks you can perform depend on whether the SCADAPack x70 configuration software is
offline or online. When the SCADAPack x70 configuration software is online, you are
communicating directly with the SCADAPack x70 device. Each mode provides a set of
parameters and a context menu that give you access to the available functions. 

Some SCADAPack x70 functions can be accessed using either the context menu or the
Network View toolbar. In these cases, the procedures in this manual provide only the context
menu item. 

For additional information about accessing SCADAPack x70 functionality, see:

· Basic Configuration and Advanced Configuration

· Understanding Configuration Status

· Working in Tables  and Working in Pop-Up Dialogs

· Managing the Device Role in the Network

7.1 Accessing Offline Functionality

When the SCADAPack x70 configuration software is offline, you are not communicating with the
SCADAPack x70 device. In offline mode, you can:

· Open the configuration parameters  to define device operation and access the SCADAPack
x70 Logic Editor. The parameter settings and logic program take effect when you take the
SCADAPack x70 configuration software online  and write the configuration to the device .

· Use the context menu  to access additional offline functionality.
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To take the SCADAPack x70 configuration software offline

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Offline.

The SCADAPack x70 Controller Settings -DeviceDTM  name is displayed in plain text when it
is offline. The name is displayed in bold and the status bar at the bottom of SCADAPack
RemoteConnect displays the word Connected when it is online.

 

To open the offline configuration parameters

You can open the offline parameters when the SCADAPack x70 configuration software is offline
or online. 

· If the offline configuration parameters are not already open, under My Network, right-click on
SCADAPack x70 Controller Settings -DeviceDTM  and select Configure.

The configuration parameters are displayed. 
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Use the configuration parameters to perform the following tasks:

· Configuring SCADAPack x70 Settings and Identification Strings

· Configuring Physical I/O

· Configuring USB Communication

· Configuring Serial Communication

· Configuring IP Communication

· Configuring DNP3 Operation

· Configuring Modbus Operation

· Configuring IEC 60870-5-104 Operation

· Accessing SCADAPack x70 Logic

· Configuring Database Objects

For information about accessing basic and advanced configuration parameters, see Basic
Configuration and Advanced Configuration .

To access offline functionality in the context menu

· See Using the Context Menu

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select the required function:

· Managing the Device Role in the Network

· Exporting and Importing Object Parameters

· Importing Logic Projects
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7.2 Accessing Online Functionality

When the SCADAPack x70 configuration software is online, you are communicating directly with
the SCADAPack x70 device. In online mode, you can:

· Open the online parameters  to read status and diagnostic information from the
SCADAPack x70 device.

· Use the context menu  to access additional online functionality.

The device needs to be communicating with SCADAPack RemoteConnect to operate in online
mode. 

To take the SCADAPack x70 configuration software online

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

The SCADAPack x70 Controller Settings -DeviceDTM  name is displayed in italics when it is
going online with the SCADAPack x70 device. The name is displayed in bold and the status
bar at the bottom of SCADAPack RemoteConnect displays the word Connected when it is
online. When you take the SCADAPack x70 Controller Settings -DeviceDTM  online, the PC
Communication Settings -SCADAPack CommDTM automatically goes online as well. 

To open the online configuration parameters

· If the online configuration parameters are not already open, under My Network, right-click on
SCADAPack x70 Controller Settings -DeviceDTM  and select Online Diagnostics.

The online parameters are displayed. The figure below shows the online parameters when the
status has been read from the device. 

28

29
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Use the online parameters to perform the following tasks:

· Reading Status and Version Information from the Device

· Managing the Logic Application in the Device

· Monitoring Modem Status

· Reading Object Values from the Device

To access online functionality in the context menu

· See Using the Context Menu

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select the required function:

· Reading the Configuration and Logic Application from the Device

· Writing the Configuration and Logic Application to the Device

Additional functions:

· Updating the Firmware and Bootloader on the Device

· Applying the Security Configuration to the Device

· Restarting the Device

· Restarting the DNP3 Service

· Restarting the IEC 60870-5-104 Service

· Executing Command Line Operations on the Device
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· Applying the License File to the Device

· Setting the Time on the Device

· Comparing Project Configurations

· Reading a File from the Device  

· Writing a File to the Device  

· Testing the Connection to the SCADAPack x70 Device

· Getting Device Information File

7.3 Using the Context Menu

The tasks you can perform from the context menu depend on whether the SCADAPack x70 is
offline or online. Functions that do not apply to the current mode, or that are not supported, are
grayed out in the context menu.

For information about accessing offline and online functionality, see:

· Accessing Offline Functionality

· Accessing Online Functionality  

To access context menu functions

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select the required function. 

Context Menu Item  Available
In

Function

Add Not supported

Update Tag Name Offline mode

Online mode

Updates the tag at the end of the fixed
DTM name

Copy (Export) Not supported by the SCADAPack x70 configuration
software

Paste (Import) Not supported by the SCADAPack x70 configuration
software

Remove Offline mode

Online mode

Removes the SCADAPack x70
configuration software from the network

The configuration parameters and the
online parameters need to be closed
before you can remove the
SCADAPack x70 configuration
software from the network
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Go Online Offline mode Takes the SCADAPack x70
configuration software online so it is
communicating with the SCADAPack
x70 device

Go Offline Online mode Takes the SCADAPack x70
configuration software offline so it is no
longer communicating with the
SCADAPack x70 device

Configure Offline mode

Online mode

Opens the configuration parameters so
you can define device operation

Online Diagnostics Online mode Opens the SCADAPack x70 online
parameters so you can view status and
diagnostics information from the device

Compare Not supported by the SCADAPack x70 configuration
software

Configuration Not supported by the SCADAPack x70 configuration
software

Observe Not supported by the SCADAPack x70 configuration
software

Additional Functions > Project
Settings 

Offline mode Opens the Project Settings so you can
change the role that the device
performs in your network

If this menu item is not available, press
Apply to accept unsaved configuration
changes

Additional Functions > Export to
Excel File

Offline mode Export SCADAPack x70 device
configuration settings into an Excel file 

Additional Functions > Import from
Excel File

Offline mode Import configuration settings from an
Excel file to the SCADAPack x70
device

Additional Functions > Import
Logic Project

Offline mode Imports an existing logic project into
the SCADAPack x70 configuration
software so you can work with it in the
SCADAPack x70 Logic Editor

Additional Functions > Create
Recovery Media

Offline mode

Online mode

Only available for a SCADAPack 47x
project.
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See the Creating Recovery Media on a
SCADAPack 47x  for details.

Additional Functions > Update
Device Firmware or Bootloader

Online mode Installs the selected firmware or
bootloader file on the SCADAPack x70
device

Additional Functions > Apply
Security Configuration to Device

Online mode Applies the selected security file to the
SCADAPack x70 device when you are
using Security Administrator

Additional Functions > Restart
Device

Online mode Restarts the SCADAPack x70 device

Additional Functions > Restart
DNP3

Online mode Restarts the DNP3 driver in the
SCADAPack x70 device

Additional Functions > Restart IEC
60870-5-104

Online mode Restarts the IEC 60870-5-104 driver in
the SCADAPack x70 device

Additional Functions > Execute
command

Online mode Opens the command line window so
you can execute command line
operations on the device

See the Command Line Operations
topic in the Operations Technical
Reference manual for details about
command line commands

Additional Functions > Apply
License to Device

Online mode Applies the selected license file to the
SCADAPack x70 device

Additional Functions > Set Device
Time

Online mode Sets the time on the SCADAPack x70
device to either Coordinated Universal
Time (UTC) or to the local time on the
computer running SCADAPack
RemoteConnect 

Additional Functions > Compare
Project Configuration

Online mode Indicates whether the configuration and
logic application on the SCADAPack
x70 device match the versions in
SCADAPack RemoteConnect.

Additional Functions > Read File
from Device

Online mode Reads a file from the SCADAPack x70
device and saves it to your computer

Additional Functions > Write File
to Device

Online mode Writes a file from your computer to the
SCADAPack x70 device

437
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Additional Functions > Test
Connection

Online mode Tests the communication with the
SCADAPack x70 device. Possible
results are:

· Connection test successful

· Connection test unsuccessful

Additional Functions > Get Device
Information File

Online mode Creates a file which contains
information that identifies a device and
its operational status

Read from Device Online mode Reads the current configuration from
the SCADAPack x70 device and
displays the results in the SCADAPack
x70 configuration software 

Write to Device Online mode Writes the parameter settings defined
in the SCADAPack x70 configuration
software to the SCADAPack x70
device

Create PDF Report Offline mode

Online mode

Lists the parameter settings configured
in the SCADAPack x70 configuration
software in a PDF document

7.4 Using the Network View Toolbar

The Network View toolbar provides access to a subset of the functionality available in the
context menu. Toolbar items are greyed out when they do not apply to the current mode. For
example, the figure below shows the Network View toolbar items that are available in offline
mode. This toolbar is displayed after you create a project.

The icons are described in the table below.

Icon Name Function

DTM Context Menu When a component is selected, this icon opens a subset of
the menu that is displayed when you right-click the
component itself.

Go Online Takes the selected software component online.

Go Offline Takes the selected software component offline.
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Read from Device Reads the configuration and logic application from the device.

For details, see Reading the Configuration and Logic
Application from the Device in the SCADAPack x70
Configuration manual.

Write to Device Writes the configuration to the device.

For details, see Writing the Configuration and Logic
Application to the Device in the SCADAPack x70
Configuration manual.

7.5 Working in Tables

The SCADAPack x70 configuration software uses tables to organize lists of:

· Object Configuration and Object Browsers

· Physical I/O

· IP routes and IP Firewall addresses

· Modbus Servers and scanners

· Modbus Store and Forward routes

· DNP3 Outstations and remote points

· DNP3 routes

· Online Object Browsers and Forced Objects

 In each table, the column headings correspond to the main configurable parameters for the table
items. The figure below shows an example table for the database objects on a SCADAPack 474.
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Common functions

While the information provided varies depending on the table, the functions described below are
available in each table type.

Function Operation

Select a table row Click anywhere in the table row.

Select multiple table rows in
sequence

Hold down the Shift key while selecting the table
rows.

Select multiple table rows not in
sequence

Hold down the Ctrl key while selecting the table
rows.

Select all objects in the table

Click on the top left corner of the table: 

View or change parameter settings for
a table entry

Double-click anywhere in the table row.

Accept changes made to the table Click Apply.

Move a table column Click and hold on a column title and drag sideways.
Release when bold line indicates new desired
position.*

*Tables only retain new column positions while the Configuration tab remains open. Table returns
to default column positions after tab is re-opened, project is opened, etc.

7.6 Working in Pop-Up Dialogs

Pop-up dialogs are displayed when more information needs to be configured or you need to
make a choice. Reading from the SCADAPack x70 device is disabled while a pop-up dialog is
open. 

The following image is an example of a pop-up dialog. 



3.10.3

x70 ConfigurationAccessing SCADAPack x70 Functionality

36

To close a pop-up dialog, click the close icon: 

To view content that is hidden by the pop-up dialog, click and hold the opacity icon: 
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8 Configuring SCADAPack x70 Device Operation

Once you have created a new project for your SCADAPack x70 device (see Creating a New
Project in the SCADAPack RemoteConnect Configuration Software manual) and set up
communication between SCADAPack RemoteConnect and the device, you can use the
SCADAPack x70 configuration software to define how the device operates in your SCADA
network. 

Each SCADAPack x70 device needs to be configured according to its role(s) in the network. For
example, if the device is operating as a DNP3 Outstation, you need to define the parameters
that determine how the Server communicates with and sends events to the DNP3 Data
Concentrator Client(s). For simplicity, the SCADAPack x70 configuration software displays only
the parameters that are relevant to the configured role. 

Configuration parameters are defined offline and only take effect when you take the SCADAPack
x70 configuration software online  and write the configuration to the device . They are
stored in a configuration file.

See the following topics for information on working in SCADAPack RemoteConnect Configuration
Software manual:

· Understanding Objects and Associations

· Basic Configuration and Advanced Configuration

· Understanding Configuration Status

· Changing the Project Settings

· Managing the Device Role in the Network

· Navigating the SCADAPack Summary Page

The topics listed below provide the high-level steps required to configure the device for its role(s)
in the network:

· Configuring DNP3 Outstation Operation Overview

· Configuring DNP3 Router Operation Overview

· Configuring DNP3 Peer to Peer Client Operation Overview

· Configuring DNP3 Data Concentrator Client Operation Overview

· Configuring Modbus RTU Server Operation Overview

· Configuring Modbus RTU Client Operation Overview

· Configuring Modbus/TCP Server Operation Overview

· Configuring Modbus/TCP Client Operation Overview

· Configuring IEC 60870-5-104 Operation

8.1 Understanding Objects and Associations

The SCADAPack x70 configuration software uses an object database to store configuration and
status information for data items. When you configure the SCADAPack x70 parameters for data
items, you are populating the object database. That information is transferred to the
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SCADAPack x70 device when you take the SCADAPack x70 configuration software online and
write the configuration to the device.

· Use the Configuration tab  to define the parameter settings that will be applied to the
SCADAPack x70 device.

· Use the Objects tab  to view and configure any type of object in the SCADAPack x70
database.

Populating the SCADAPack x70 object database

The table below summarizes the main types of information that a database object can represent
and how that object is added to the SCADAPack x70 database.

Object Information Mandat
ory or
Optiona
l

Added to the Object Database

The operating characteristics for
the inputs and outputs on the
SCADAPack x70 device

Mandato
ry

Automatically with default parameter settings
when you first create the project for the
SCADAPack x70 device.

The operating characteristics for
the inputs and outputs on any
I/O modules that are attached
to the SCADAPack x70 device

Mandato
ry

Manually when you add I/O on the
Configuration tab > Physical I/O > Local
page.

For details, see Associating Status Information
with an I/O Module .

Status and control data for a
remote DNP3 Outstation device
when this device is operating as
a DNP3 Controlling Station

Mandato
ry when
operatin
g as a

Automatically with default parameters when you
add a remote device and points on the
Configuration tab > DNP3 > Controlling
Station page.

37
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DNP3
Controlli
ng
Station

Status and control data for a
remote Modbus RTU Server
device when this device is
operating as a Modbus RTU
Client

Mandato
ry when
operatin
g as a
Modbus
RTU
Client

Automatically with default parameters when you
add a remote device and point scanners on the
Configuration tab > Modbus > Client page.

Status and control data for a
remote Modbus/TCP Server
device when this device is
operating as a Modbus/TCP
Client

Mandato
ry when
operatin
g as a
Modbus/
TCP
Client

Automatically with default parameters when you
add a remote device and point scanners on the
Configuration tab > Modbus > Client page.

Status data for a SCADAPack
x70 device or I/O module

These are objects that you
create based on the status
information you want to collect

Optional Manually when you add an object on the
Objects > Object Configuration page.

System data

These objects are predefined
and are described in the 
System Data topic of the
Operations Technical Reference
manual.

Optional Automatically for system data references
available in a newly created SCADAPack
RemoteConnect project.

Manually by creating an object and configuring
its Association Source Type to System Data.
See Configuring an Association with a System
Data Reference . 

Logic programming data

These are objects that you
create based on your logic
programming requirements. For
example, you may want to
create an object that stores
calculations generated by logic
applications. 

Optional Manually when you add an object on the
Objects > Object Configuration page.

Data from other devices
connected to the SCADAPack
x70 device

Optional Manually when you add an object on the
Objects > Object Configuration page.

316
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These are objects that you
create based on the information
you want to collect from the
other devices in your network. 

8.2 Basic Configuration and Advanced Configuration

The configuration parameters in the SCADAPack x70 configuration software are grouped into 2
categories:

· Basic Configuration parameters are displayed on each page by default. These parameters are
the ones that you most likely want to change. 

· Advanced Configuration parameters are not displayed by default and are provided only where
required. These parameters typically only need to be changed to meet unique requirements,
such as networks with higher latency or frequent power interruptions, or remote devices with
particular communication requirements. 

Viewing and hiding configuration parameters

Click the Show  and Hide  buttons to display and hide configuration parameters.

The figure on the left shows the default view with Basic Configuration parameters displayed and
Advanced Configuration parameters hidden. The figure on the right shows the Basic
Configuration parameters and the Advanced Configuration parameters.

8.3 Understanding Configuration Status

The SCADAPack x70 configuration software uses the icons described below to indicate the
status of the configuration.
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Icon Description Meaning

  
Pen The configuration has been modified and is valid, but has not

been applied. 

Click Apply on the page displaying the Pen icon to accept
the updated configuration in the current project. 

Red exclamation
mark

The configuration is invalid. 

The Apply button is not available until you correct every
invalid configuration setting on the page or in the table. 

For parameter settings, hold the mouse over the icon for
guidance about valid settings.

In tables, hold the mouse over the yellow exclamation mark
for a description of the configuration conflict.

Red box The tab or page includes an item with an invalid
configuration. 

Navigate through the hierarchy until you see an item with a
red exclamation mark. 

Lightning bolt Used in tables to list the details of the first 3 configuration
conflicts.

Hold the mouse over the icon to display the conflicts. The
details for additional configuration conflicts are displayed as
you resolve the conflicts.

Question mark The online status for this parameter is not available. 

Verify that the SCADAPack x70 configuration software is
online then click Refresh to update the parameter
information.

Examples

In the figure below, there is a configuration conflict in rows 1, 2 and 3 of the Modbus Scanners
table and an unsaved configuration update in the Object Association table. The Apply button will
not be available until the conflicts are resolved.
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The figure below shows an example of the conflict detail that is displayed when you hold the
mouse over the configuration conflict details icon.

8.4 Changing the Project Settings

After you have created your project using the wizard, you can still make changes to the
configuration of your project. When you change the device type, there are a few details that you
need to keep in mind. See Changing the Project Device Type .

NOTICE

DATA LOSS

Configuration information can be lost if the project settings are changed after a project has
been created.  

Failure to follow these instructions can result in equipment damage.

44
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To change the project settings:

1. If the SCADAPack x70 Controller Settings -DeviceDTM  is currently online, under My
Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and select Go
Offline.

2. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Project Settings.

3. Select the required configuration options.

4. Click Ok.

5. In the Update Project Settings window, review the modifications that will be made to the
current project configuration. 

6. Click Ok.

7. To view the log file, click View Log File, and then click Close.
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By default, the log file is saved here: C:\Users\your user
directory\AppData\Roaming\Schneider Electric\RemoteConnect where your user directory is
specific to your environment. 

The log file lists the changes that were made to your specific project configuration. This file
can be saved for future reference. 

The associated parameters are now available for configuration in the SCADAPack x70
configuration software.

8.5 Changing the Project Device Type

You can change the project device type, however, there are a few details that you need to keep
in mind. Three areas that you will need review are:

· Physical I/O

· Communication ports

· Logic program

A log file is generated that lists the changes that were made to your specific project
configuration when you changed the device type.

NOTICE

UNINTENDED DEVICE OPERATIONS

After changing the device type, review the use of communication ports and communication
configuration settings that might have used that port. 

Failure to follow these instructions can result in equipment damage.

Physical I/O

The associations and objects for external 5000 and 6000 series I/O modules are preserved when
you change from an old device type to a new device type.

Existing SCADAPack x70 device I/O is disconnected, but preserved in the database with the
same name. This includes channel objects and status objects. 

The old device type in the I/O configuration table is replaced with the new device type. 

The disconnected I/O objects and status object can be manually reconnected to the new device
type or renamed. 

Communication Ports

Communication ports refers to serial, Ethernet, and modem ports. 

If the port on the old device type has the same functions as the corresponding port on the new
device type, then the configuration is preserved on the new device type. 
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If the port on the old device type is not supported on the new device type, then there is no
related configuration preserved on the new device type.

If the functionality of the port on the old device type is different than on the new device type, then
the port functionality on the new device type is set to default. The default settings are the same
as those used when creating a new project. 

Logic Program

If you change the device type to one that is in the same family as your current device type, for
example, change from a SCADAPack 570 to a SCADAPack 575 or from a SCADAPack 470 to
a SCADAPack 474, then the conversion process will not change the logic. The application
should remain built.

If you change the device type to one that is in a different family from your current device type, for
example, change from a SCADAPack 570 to a SCADAPack 470 then:

· The existing project will be imported into the SCADAPack x70 Logic Editor with the new
device type, and

· You will need to rebuild the application

The logic Libset will be updated to the latest available Libset.

You will need to review any references to communication ports in the logic and update them, if
necessary. It is possible that the application will build even if it refers to a port that no longer
exists. 

8.6 Managing the Device Role in the Network

The role(s) that the SCADAPack x70 device performs in the network is first defined when you
create a new project for the device. See Creating a New Project topic in the SCADAPack
RemoteConnect Configuration Software manual.

NOTICE

DATA LOSS

Configuration information can be lost if the project settings are changed after a project has
been created.  

Failure to follow these instructions can result in equipment damage.

You can add and remove roles for the device at any time. Before you change the device role,
review Understanding the Device Role .

The following are just a few of the situations where you will need to change the device role:

· The device is currently operating as a DNP3 Outstation and you want to increase the number
of DNP3 Controlling Stations that this device reports to. A SCADAPack x70 device that is
operating as a DNP3 Outstation can communicate with up to 3 DNP3 Controlling Stations.
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· The device is operating as a DNP3 Outstation and you want it to operate as a Modbus RTU
Server as well

· You've added a Modbus/TCP Server to your network and you want the device to operate as a
Modbus/TCP Client for that Server

· You want the device to operate as an IEC 60870-5-104 Controlled Station

· The device is currently operating as an IEC 60870-5-104 Controlled station and you want to
add another Controlling Station (client) for the device. SCADAPack x70 devices support
connection to up to four IEC 60870-5-104 Controlling Stations.

8.7 Understanding the Device Role

The role that the SCADAPack x70 device performs in the network determines which
configuration and communication parameters are displayed in the SCADAPack x70 configuration
software. The SCADAPack x70 configuration software displays only the parameters that are
relevant to the configured role.

For example, the configuration parameters for DNP3 Controlling Station operation are only
displayed if DNP3 Data Concentrator Client is selected in the Project Settings.

Device Role Description

DNP3 Outstation Default setting that allows the SCADAPack x70 device to respond
to requests from a DNP3 Controlling Station

The DNP3 Outstation can have up to 3 DNP3 Controlling
Stations, each with different connection, object, event, and
communication settings.

DNP3 Router Forwards DNP3 frames between any combination of serial and
Ethernet ports

DNP3 Peer to Peer Client Allows DNP3 controls and reads of object data with DNP3 remote
servers.

An efficient way to exchange data between remote SCADAPack
x70 devices, and other devices, over a DNP3 communication
channel.

Only reads or controls current values for specifically selected data
points

Recommended for exchanging data managed by logic function
blocks between remote sites instead of DNP3 Data Concentrator
Client.

DNP3 Data Concentrator
Client

Manages DNP3 communication including requesting events from
DNP3 remote Outstations

The SCADAPack x70 device operates as a SCADA Client,
setting time and retrieving device data, including buffered events,
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from a remote DNP3 device. A DNP3 Data Concentrator Client is
typically used in a hierarchical Client/Server network.

Not recommended for exchanging real-time data between remote
devices. DNP3 Peer to Peer Client is recommended where
possible.

The SCADAPack x70 device needs to be licensed to use this
role.

Modbus RTU Server Allows the SCADAPack x70 device to report information to a
Modbus RTU Client

Modbus RTU Client Writes or reads Modbus register data from Modbus RTU Server
devices

This option needs to be enabled to select the following
configuration parameters:

· SCADAPack Serial Port

· Modbus device type : 

o Modbus RTU Serial

Modbus IP Servers Allows the SCADAPack x70 device to report information to
Modbus IP Clients (for example, Modbus/TCP clients)

Modbus IP Clients Allows the SCADAPack x70 device to request information from
Modbus IP Servers

This option needs to be enabled to set or select the following
configuration parameters:

· IP Address

· Device Listen Port

· Modbus device type: 

o Modbus/TCP

o Modbus RTU over TCP

o Modbus RTU over UDP

IEC 60870-5-104
Controlled Station (server)

Allows the SCADAPack x70 device to report information to IEC
60870-5-104 Controlling Stations.

This option needs to be configured in Project Settings. 

As well, Controlling Station needs to be enabled and configured to
set or select the following configuration parameters:

· Controlling Station connection interface and IP address (for
2nd, 3rd, or 4th controlling station)

· Device ASDU Address
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· General setup parameters

· Enabling Controlling Station to receive events

8.8 Navigating the SCADAPack Summary Page

On the Configuration tab, the SCADAPack page provides a summary of the device for quick

reference. On the right-hand side, you can click the green arrows ( ) to navigate to the relevant
page. 

The summary page also:

· Highlights areas of interest when you hover the mouse over the SCADAPack x70 device
image 

· Provides tool tips, which provide configuration or informational details, for some areas of
interest 

· Changes the tab panel selection automatically to correspond to the highlighted area of interest

· Displays the hand icon when you hover the mouse over an area of interest that has a
corresponding configuration page. When you click the mouse, you are navigated to the
corresponding page.

· Displays the information icon when you hover the mouse over an area of interest that has a
corresponding help page. When you click the mouse, the corresponding help topic in the
documentation is opened.

Summary tabs

The images shown below use the SCADAPack 575 as an example. The tabs for other
SCADAPack x70 devices are similar.

· General: Displays the DNP3 Outstation Address, Modbus/TCP Server Unit Identifier (if
applicable to the configuration), IEC 60870-5-104 ASDU address, if configured, and any
Supported Applications
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· Physical I/O: Displays the configured I/O devices and the number of used and free I/O
channels by type



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

50

· USB Communication: Displays information about the USB communication port

· Serial Communication: Displays information about the Serial communication ports
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· IP Communication: Displays information about the IP communication ports including a link
to the IP Services tab

· IP Services: Displays information about the IP services including which IP services are active
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8.9 Configuring SCADAPack x70 Settings and Identification Strings

Use the SCADAPack > Settings page to configure device settings, such as the time offset from
Coordinated Universal Time (UTC) and to add identification information for the SCADAPack x70
device.

To configure device settings

1. On the Configuration Tab, select SCADAPack > Settings.

2. On the Basic Configuration tab, configure the SCADAPack Settings .53
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To configure identification information for the SCADAPack x70 device

1. On the Configuration Tab, select SCADAPack > Settings.

2. Expand the Advanced Configuration tab and configure the Identification Strings and Advanced
SCADAPack Settings .

3. Click Apply.

8.9.1 SCADAPack Settings Parameters

The following table describes the SCADAPack settings parameters on the Basic tab.

Paramete
r

Parameter Description Setting Description

Low
Voltage
Alert Level

The input power supply voltage at
which the Input Voltage Status
changes from Normal to Low.

The Input Voltage Status is
displayed on the Status tab in the
online parameters. 

Default: 11.5 Vdc

Valid range: 9...32 Vdc

Time
Offset from
UTC

The offset from Universal
Coordinated Time (UTC) for local
operations such as time of day
control by logic applications when
the SCADAPack x70 device is
operating on UTC rather than local
time. 

Default: 0 hours

Valid range: -12...13 hours
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8.9.2 Identification Strings and Advanced SCADAPack Settings Parameters

Identification Strings parameters

Parameter Parameter Description Setting Description

Location
Name

Where the SCADAPack x70 device is
installed.

Maximum length: 254 characters with
spaces

ID
Code/Numb
er

A numeric identifier for the
SCADAPack x70 device.

Maximum length: 31 characters with
spaces

Device
Name

A name for the SCADAPack x70
device.

Maximum length: 31 characters with
spaces

The name can include letters,
numbers, hyphens, and underscores. 

The following characters are not
permitted:  

< > # % \ " ; : ? @ & = + $ { } |  ̂[ ]

Advanced SCADAPack settings parameters

Paramete
r

Parameter Description Setting Description

At Limit
Alert
Processing

Indicates when the over-range limit
value and the under-range limit
value are considered to be
transgressed. 

Object values are displayed on the
Objects tab in the online
parameters. For details, see
Reading Object Values from the
Device .

When the box is checked:

· The current value needs to exceed the
over-range limit value to be considered
over-range. 

· The current value needs to be below the
under-range limit value to be considered
under-range.

When the box is not checked:

· The current value needs to be equal to,
or more than, the over-range limit to be
considered over-range.

· The current value needs to be equal to,
or below, the under-range limit value to
be considered under-range.

Default: Not checked
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8.10 Configuring Physical I/O

Each input and output on the SCADAPack x70 device and its attached I/O modules are
represented in the SCADAPack RemoteConnect database.

There is 1 type of physical I/O:

· Local

Local I/O

Local I/O identifies and defines the operating characteristics of the physical I/O on the
SCADAPack x70 device and on any attached I/O modules. The Physical I/O > Local page
displays local I/O in 2 tables: 

· The I/O Configuration table lists each local module or device that provides I/O

· The Channel Configuration table lists the individual channels for each I/O module or device in
the I/O Configuration table

For more information, see Defining Local Physical I/O .

8.10.1 Defining Local Physical I/O

Use the Physical I/O > Local page to identify and define the operating characteristics of the
physical I/O on the SCADAPack x70 device and on any attached I/O modules. 
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I/O Configuration table

The I/O Configuration table lists the physical I/O modules and device. Use this table to add,
configure, and remove I/O and to edit and clear object associations. For details, see:

· Changing the Default Parameter Settings for Physical I/O

· Adding an I/O Module

· Removing an I/O Module

· Associating Status Information with an I/O Module

Channel Configuration table

The Channel Configuration table lists the individual I/O channels on each I/O module and device.
Use this table to access the configuration parameters for individual I/O channels and to clear
object associations for I/O channels. For details, see:

· Configuring Analog and Digital I/O Channels

· Configuring Counter I/O Channels

· Configuring Pulse Rate (Frequency) I/O Channels

· Clearing Object Associations for I/O Channels

Outputs on Logic Stop

These parameters allow you to identify how outputs are processed when a logic application
transitions from RUN to a STOP or HALT state, including when a logic application is updated as
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the result of writing a configuration to the SCADAPack x70 device. The configuration applies to
the physical output points. 

When an Outputs on Logic Stop parameter is set to Hold, the local physical outputs of the type
specified are held at their current values while in STOP, HALT, and while a logic program is
updated. The outputs will change when the output object is next updated. 

When the Digital Outputs parameter is set to Off, the local physical digital outputs are set to the
Off state when the logic program goes into STOP or HALT or when the logic is updated.

When the Analog Outputs parameter is set to Minimum, the local physical analog outputs are
set to the minimum output value (e.g. 4 mA on 4...20 mA outputs, 0 Vdc on 0...5 Vdc outputs,
etc.) when the logic program goes into STOP or HALT or when the logic is updated.

The default parameter settings for Outputs on Logic Stop are:

· Digital Outputs

o Default: Off

· Analog Outputs

o Default: Minimum

Advanced Configuration: HART Pass Through

When you add a HART I/O module, the HART Pass Through parameters are displayed. See
Adding an I/O Module  and HART Pass Through Parameters .

8.10.1.1 Changing the Default Parameter Settings for Physical I/O

When you first create the project for the SCADAPack x70 device in SCADAPack
RemoteConnect:

· The SCADAPack x70 device is added to the I/O Configuration table with the default parameter
settings.

· The channels on the SCADAPack x70 device are added to the Channel Configuration table
and an object for each channel is added to the object database with the default parameter
settings.

To change the default parameter settings for physical I/O

· Double-click on the table row to access the configuration parameters:

· I/O Configuration parameters

· Channel Configuration parameters:

§ Object Configuration Parameters

§ Associations Tab

§ DNP3 Tab

§ Modbus Tab
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§ IEC 60870-5-104 Tab

§ Alert Notifications Tab: Analog Objects

§ Basic Tab: Analog Objects

§ Advanced Tab: Analog Objects

§ Basic Tab: Digital Objects

§ Basic Tab: Counter Objects

8.10.1.2 Adding an I/O Module

Each SCADAPack x70 device and I/O module needs to be listed in the tables on the Physical
I/O > Local page, along with its I/O channels. There can be only one SCADAPack x70 device
entry and it needs to correspond to the SCADAPack x70 device that you are creating a
configuration for. This entry is added by default and cannot be deleted. See I/O Configuration
for details about how many I/O modules can be connected. 

If there is an I/O module connected to the SCADAPack x70 device, or if you connect an I/O
module to the device at a later time, there are 2 ways to add it to the Local page:

· If the hardware is not yet available, add and configure the physical I/O as described below.
Once the hardware is available, you can write the configuration to the device .

· If the hardware is available, take the SCADAPack x70 configuration software online  and
read the configuration from the device .

Once the physical I/O is listed in the I/O Configuration table, you can associate status
information with it  to monitor the health of the device and you can configure its I/O.

To add an I/O module before the hardware is available

1. On the Configuration tab, select Physical I/O > Local.
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2. In the I/O Configuration table, click Add I/O.
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3. Configure the I/O Configuration  parameters, then click Ok.

4. In the Object Associations dialog, specify how objects are assigned to the I/O channels.

· The default is Manually connect existing objects to the I/O channels? When this
option is selected, the existing object associations are removed and no new associations
are created.

· If you select Automatically create and connect new objects to the I/O channels?, a
new database object is automatically created for each I/O channel.

o In the DNP3 Options section, if available, select one of the following:

§ Leave the DNP3 point numbers unassigned. When this option is selected, objects are
created, but no DNP3 point numbers are assigned.

§ Automatically assign DNP3 point numbers with the next available values

§ If you select Assign DNP3 point numbers sequentially, choose one of the following:

· For digital objects, enter the starting number in the Digital Input or Digital Output
field
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· For analog objects, enter the starting number in the Analog Input or Analog Output
field

· For counter objects, enter the starting number in the Counter Input or Counter
Output field

o In the Modbus Options section, if available, determine how to assign Modbus

registers:

§ Leave Modbus registers unassigned. When this option is selected, objects are
created, but no Modbus registers are assigned.

§ If you select Automatically assign Modbus registers with the next available values,
choose one of the following:

· For analog objects, choose one of the following: 

o read-only Input Registers

o read/write Holding Registers

· For digital objects, choose one of the following:

o read-only Discrete Inputs

o read/write Discrete Coils

· For counter objects, choose one of the following:

o read-only Input Registers

o read/write Holding Registers

§ If you select Assign Modbus registers sequentially, enter one of the following:

· For analog objects, enter the starting number in the Analog field

· For digital objects, enter the starting number in the Digital field

· For counter objects, enter the starting number in the Counter field

o In the IEC 60870-5-104 Options section, if available, determine how to assign

Information Object Addresses (IOAs):

§  Leave IOAs unassigned. When this option is selected, objects are created, but no
IEC 60870-5-104 IOAs are assigned.

§  If you select the Automatically assign IOAs with the next available values option,
Monitoring Direction IOAs are automatically assigned to each created object, starting
at the first available Monitor Direction IOA address not already allocated to an object.

§ If you select the Assign IOAs sequentially starting from option, you can specify the
IOA for Monitor Direction for the first object. Monitor Direction IOAs are automatically
assigned to objects, sequentially, from this number.

4. Click OK.
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5. SCADAPack 570, SCADAPack 574, and SCADAPack 575 models support configuring a
HART module so that data from HART instruments can be sent directly to an Asset
Management System by expanding the Advanced Configuration parameters and configuring
the HART Pass Through  parameters. This is presently not supported for SCADAPack 470
and SCADAPack 474 models.

6. Configure the I/O channels:

· Configuring Analog and Digital I/O Channels

· Configuring Counter I/O Channels

8.10.1.3 Removing an I/O Module

Typically, you need to remove I/O only when you are updating the offline configuration to match a
new hardware configuration. When you remove the I/O module, you are deleting the I/O
information for the module and its I/O channels from the device database. You can choose
whether you also want to delete objects associated with the I/O module. 

If you have not modified the default parameter settings for the I/O module, there is no benefit to
keeping the object. However, if you have customized the object configuration to meet specific
requirements, you may want to keep the object so you can associate it with a different I/O
module in the future. This will save you from having to re-customize the parameter settings.

To remove an I/O module

1. On the Configuration tab, select Physical I/O > Local.

2. In the I/O Configuration table, select the table row(s) for the I/O you want to delete.
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3. Click Remove I/O.

4. Confirm whether you want to delete the database object(s) associated with the table entry,
then click Yes.

8.10.1.4 Associating Status Information with an I/O Module

Each physical I/O module or device can be associated with an object that indicates the status,
or health, of the I/O module or device. In the SCADAPack x70 device, the digital object
associated with the I/O device status has a current value of:

· 1 (ON state) when the I/O device is online

· 0 (OFF state) when the I/O device is offline

The SCADAPack x70 device cannot read or control the I/O device channels when it is offline.

When you add a status object association, you can spontaneously create a new object for
status information, or you can choose an existing object. If you spontaneously create a new
status object, it is displayed immediately in the Status Object Association field for the physical
I/O, but you need to configure the object before it will provide status information. You can edit
the association for one I/O module or device at a time.

When you remove, or clear, the status object association for physical I/O, you can choose
whether to keep the status object in the database. Keep the status object if it is associated with
other physical I/O, or if you might associate it with other physical I/O in the future. You can clear
the association for multiple I/O modules or devices, or for multiple I/O channels at the same
time.

To associate status information with an I/O module or device

1. On the Configuration tab, select Physical I/O > Local.
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2. In the I/O Configuration table, select the row for the I/O for which you want to add an object
association.

3. Click Add Status Object.

4. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

5. Click Ok.

The object name can be 1...32 characters with no spaces. The name needs to begin with a
letter or an underscore, and can contain only letters, numbers and underscores.

If you created a new object, you now need to configure the object parameter settings. For
details, see Configuring Database Objects .

To remove the status association for physical I/O

1. On the Configuration tab, select Physical I/O > Local.
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2. In the I/O Configuration table, select the row with the Status Object Association you want to
remove.

3. Click Clear Status Object.

4. Specify whether you want to delete the status object from the object database, then click
Yes.

8.10.1.5 Configuring Analog and Digital I/O Channels

The I/O channels available for an I/O module or device are shown in the Channel Configuration
table when the I/O module or device is added to the I/O Configuration table .

The procedure below describes how to configure analog and digital I/O channels on a
SCADAPack x70 device. 

Some digital inputs on SCADAPack x70 devices provide counter capabilities. To use these
capabilities, you need to configure the digital channel, as described below, and the counter
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channel as described in Configuring Counter I/O Channels . To determine whether the digital
inputs on the device support counter capabilities, see the hardware manual for the device.

You can also add the object association for a channel .

To configure analog and digital I/O channels

1. On the Configuration tab, select Physical I/O > Local.

2. In the Channel Configuration table, double-click on a table row to view the object configuration
parameters.

The tabs that are displayed depend on whether the object represents digital or analog I/O and
the role the SCADAPack x70 device is performing in the network. For example, if the device
is operating only as a DNP3 Outstation, the Modbus tab is not displayed.
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3. Configure the object parameters as required, then click Ok.

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Modbus Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. If you are configuring an analog input channel, in the Channel Configuration table, select the
Type.

The settings that are available depend on the I/O module or device type.

5. On the Local page, click Apply. 
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To add the object association for a channel

1. In the Channel Configuration table, double-click the row of the object where you want to add
the association. 

2. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

3. Click Ok.

4. On the Basic Configuration page, click Apply. 

8.10.1.6 Configuring Counter I/O Channels

Some digital inputs on SCADAPack x70 devices can also provide counter capabilities. To use
these capabilities, you need to configure the digital channel, as described in Configuring Analog
and Digital I/O Channels  and the counter channel, as described below. 

To determine whether the digital inputs on the device support counter capabilities, see the
hardware manual for the device.

You can also add the object association for a channel .

To configure counter I/O channels

1. On the Configuration tab, select Physical I/O > Local.
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2. In the Channel Configuration table, scroll to the bottom of the table to view the counter
channels.

If you have a SCADAPack 470 or SCADAPack 474, the list looks similar to the following:

If you have a SCADAPack 570, SCADAPack 574, or a SCADAPack 575, the list looks
similar to the following:
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3. If you want to associate a counter with a new object, double-click on an empty channel row.

4. If you want to edit an object associated to a counter, double-click on the channel of the
object. 

5. Configure the object parameters as required, then click Ok.

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Modbus Tab
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· IEC 60870-5-104 Tab

· Basic Tab: Counter Objects

6. In the Channel Configuration table, select the Type.

Digital inputs 1 and 2 on a SCADAPack 470, SCADAPack 474, SCADAPack 570,
SCADAPack 574, or a SCADAPack 575 can have an associated Type. See Counter Type
Parameters .

7. On the Physical I/O > Local page, click Apply. 

To add the object association for a channel

1. In the Channel Configuration table, double-click the row of the object where you want to add
the association. 

2. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

3. Click Ok.

4. On the Basic Configuration page, click Apply. 
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8.10.1.7 Configuring Pulse Rate (Frequency) I/O Channels

Some digital input channels on SCADAPack x70 devices can also provide pulse rate (frequency)
capabilities. The value of the input’s pulse rate is represented as an Analog object. To use these
capabilities, you need to configure the digital channel, as described in Configuring Analog and
Digital I/O Channels  and the counter channel, as described below. 

To determine whether the digital inputs on the device support counter capabilities, see the
hardware manual for the device.

You can also add the object association for a channel .

To configure counter I/O channels

1. On the Configuration tab, select Physical I/O > Local.

2. In the Channel Configuration table, scroll to the pulse rate (frequency) channels. These
appear as an analog icon for the Digital Input Channel.

If you have a SCADAPack 570, SCADAPack 574, or a SCADAPack 575, the list looks
similar to the following:

65
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If you have a SCADAPack 470 or SCADAPack 474, the list will look slightly different.

3. If you want to associate the digital input channel’s pulse rate (frequency) with a new object,
double-click on the channel of the object association. An Analog object is associated with
the digital input channel to represent the value of the pulse rate (frequency).

4. If you want to edit an object associated to the Pulse Rate (Frequency), double-click on the
channel of the object. 
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5. Configure the object parameters as required, then click Ok.

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Modbus Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

6. On the Physical I/O > Local page, click Apply. 

To add the object association for a channel

1. In the Channel Configuration table, double-click the row of the object where you want to add
the association. 

2. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

249
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· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

3. Click Ok.

4. On the Basic Configuration page, click Apply. 

8.10.1.8 Clearing Object Associations for I/O Channels

Clearing the object association for an I/O channel removes the association, but it does not
delete the object from the database.

To clear the object association for an I/O channel

1. On the Configuration tab, select Physical I/O > Local.

2. In the Channel Configuration table, select the row(s) for the inputs and outputs for which you
want to clear the association.

3. Click Clear Associations.
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4. Specify whether you want to delete the database object associated with the table entry, then
click Yes.

5. On the Local page, click Apply. 

8.10.1.9 I/O Configuration Parameters

The following table describes the I/O Configuration parameters. The parameters that are
displayed depend on the I/O module or device type.

Parameter Parameter Description Setting Setting Description

Name The name used to identify
the SCADAPack x70
device or I/O module in
the I/O Configuration
table.

1...32
characters
with no
spaces

The name needs to begin with a
letter, a number, or an
underscore, and can contain
only letters, numbers, hyphens
and underscores.

Default: Module# 

Type A list of every
SCADAPack x70 device
and I/O module that can
be installed in a
SCADAPack x70 system.

Add each device and I/O
module that is present in
your system.

The parameters that follow
depend on the Type
selection.

5304 Analog
Out

Adds the inputs and outputs on
the selected I/O module or
SCADAPack x70 device to the
configuration software.

Only one  SCADAPack RTU can
be added. 

Keep in mind the following:

 SCADAPack 470, 
SCADAPack 570, and
SCADAPack 574

· Supports up to 15 I/O modules

· Maximum number of 6601
input output modules in the
system is 4
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· Maximum number of 6602
HART modules in the system
is 1

· Maximum number of 6607
input output modules in the
system is 4

SCADAPack 474

· Supports up to 15 I/O
modules 

· Maximum number of 6601
input output modules in the
system is 4

· Maximum number of 6602
HART modules in the system
is 1

· Maximum number of 6607
input output modules in the
system is 3

SCADAPack 575

· Supports up to 15 I/O
modules 

· Maximum number of 6601
input output modules in the
system is 3

· Maximum number of 6602
HART modules in the system
is 1

· Maximum number of 6607
input output modules in the
system is 4

5405 Digital
In

5410 Counter
I/O

5414 Digital
In

5415 Relay
Out

5505 RTD In

5506 Analog
In

5606
Composite
I/O

5607
Composite
I/O

6601
Composite
I/O

6602 HART
Analog I/O

6602 HART
Analog In

6607
Composite
I/O

Address The hardware address that is set on the SCADAPack x70 device or I/O
module. Each device and I/O module is shipped with a default address of 0.
See the hardware manual for details about setting the hardware address on
the device.

Input Filter Applies to 5506 analog
input module, 5606 input
output module, and 5607
input output module only

3 Hz Applies the selected frequency
filter to every analog input on the
I/O module or SCADAPack x70
device.
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The filter rate that is used
to dampen process
variations or noise in
analog input channels.

Filter
Frequenc
y 

Analog Input
Response Time

< 3 Hz
155 ms at 60 Hz

185 ms at 50 Hz 

6 Hz
85 ms at 60 Hz 

85 ms at 50 Hz 

11 Hz
45 ms at 60 Hz 

55 ms at 50Hz 

30 Hz
30 ms at 60 Hz

30 ms at 50 Hz 

6 Hz

11 Hz

30 Hz

Applies to 5414 digital
input module only

The type of filter used to
reduce noise on the 5414
digital input module
inputs.

Noise can distort signals
and affect digital input
values. 

AC input Filters noise from AC sources.

Default.

DC input Filters noise from DC sources.

AI Filtering The rate at which the
analog inputs are
sampled.

Use this parameter in
conjunction with the AI
Smoothing parameter to
reduce noise in analog
input channels.

None · 30 ms sampling

o 6601 input output module,

and 6602 HART module

· 100 ms sampling 

o 6607 input output module

50/60 Hz
Filter

Filters noise at 50/60 Hz and
samples at a rate that is slower
than the fastest possible
sampling rate. 

Filtering noise at 50/60 Hz can
be required when equipment
such as power supplies that
generate noise in this frequency
range is nearby. 

· 100 ms sampling
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o Default for SCADAPack 470

and SCADAPack 474

· 500 ms sampling

o 6607 input output module

· 620 ms sampling 

o SCADAPack 575

o 6601 input output module

· 640 ms sampling

o 6602 HART module

AI Smoothing Applies to SCADAPack
575 and 6601 input output
module only

The number of analog
input sample values that
are collected before the
averaging calculation is
applied. Averaging is
equivalent to low-pass
filtering. 

Use this parameter in
conjunction with the AI
Filtering parameter to
reduce noise in analog
input channels.

None See the table below  for
guidance on selecting the AI
Smoothing setting. 

Default: 3 samples

2 samples

3 samples

8 samples

AI1 to AI4
Filtering

Applies to SCADAPack
474 only

The rate at which the
analog inputs are
sampled.

None (30 ms
sampling)

Filters noise at 50/60 Hz and
samples at a rate that is slower
than the fastest possible
sampling rate. 

Filtering noise at 50/60 Hz can
be required when equipment
such as power supplies that
generate noise in this frequency
range is nearby. 

50/60 Hz
Filter (100
ms sampling)

AI5 to AI12
Filtering

Applies to SCADAPack
474 only

The rate at which the
analog inputs are
sampled.

None (100
ms sampling)

Filters noise at 50/60 Hz and
samples at a rate that is slower
than the fastest possible
sampling rate. 

Filtering noise at 50/60 Hz can
be required when equipment
such as power supplies that

80
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generate noise in this frequency
range is nearby. 

50/60 Hz
Filter (500
ms sampling)

Line
Frequency

The scanning rate for
analog inputs or digital
inputs. Selecting the
correct setting for your
environment improves
performance.

For analog inputs, this
parameter maximizes
noise rejection. 

For digital inputs, this
parameter maximizes
threshold voltages in AC
environments.

The setting applies to
every analog or digital
input on the I/O module
and is downloaded to the
I/O module by the
SCADAPack x70 device.

50 Hz If the I/O module is used in a DC
environment, the 60 Hz setting
yields a slightly faster response
time than the 50 Hz setting.

60 Hz

AO Output
Type

The signal range for
analog outputs.

0...20 mA Used when the device connected
to the analog output requires a
0...20 mA signal.

Default

4...20 mA Used when the device connected
to the analog output requires a
4...20 mA signal.

AI Smoothing

The table below indicates the configuration selection available and the corresponding operation of
the SCADAPack 575 or 6601 input output module analog inputs. AI Smoothing is available when
AI filtering is disabled. All analog inputs on the SCADAPack 575 or 6601 input output module
module are affected by the configuration.

Samples
Collected

Operation Tradeoffs Input Filter

Applied1 81
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2 samples Averages the value of the
current sample and the
previous sample.

Replaces the current sample
value with the average value.

Provides the fastest
averaging, but allows more
noise to pass through the
analog input channel than the
other options.

Noise
suppression
starts at 8 Hz

3 samples Averages the value of the
current sample with the
previous sample and the next
sample.

Replaces the current sample
value with the average value.

Provides the middle level of
averaging and noise
suppression compared to the
other options.

Noise
suppression
starts at 5 Hz

8 samples Averages the value of 8
samples starting from the
current sample.

Replaces the fourth sample
value with the average value.

Provides the highest level of
smoothing and noise
suppression, but calculating
the average value takes
longer than the other options.

Noise
suppression
starts at 3 Hz

None No sample values are
collected or averaged.

None

1These input filters can be selected for the SCADAPack 575 and 6601 input output module
analog input channels when AI Filtering is set to None (30 ms sampling).

8.10.1.10 Counter Type Parameters

The following table describes the counter type parameters.

Parameter Parameter Description

1.5 kHz Default for digital inputs 1 - 4 on SCADAPack 575

Default for digital inputs 5 - 8 on SCADAPack 474

150 Hz Default for digital inputs 5 - 8 on SCADAPack 575 

Default for digital inputs 9 - 12 on SCADAPack 474

10 kHz Counter Default for Din 1 and Din 2 on SCADAPack 570, SCADAPack 574,
and SCADAPack 575

Default for digital inputs 1 - 4 on SCADAPack 470 and SCADAPack
474

10 kHz Turbine
Counter

Available only for digital inputs 1 and 2 on SCADAPack 470,
SCADAPack 474, SCADAPack 570, SCADAPack 574, and
SCADAPack 575
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8.10.1.11 HART Pass Through Parameters

The following table describes the HART Pass Through parameters.

Parameter Parameter Description Setting Description

HART Pass
Through

Available on SCADAPack 570,
SCADAPack 574, and SCADAPack 575
models only. Not presently supported on
SCADAPack 470 and SCADAPack 474
models.

Determines whether the SCADAPack
x70 device and the 6602 HART module
send data from HART instruments
directly to an Asset Management
System (AMS). 

For the SCADAPack x70 device to
discover HART devices connected to a
6602, for device scanning, or for HART
Pass Through operation, you need to
enable the 6602 to discover active HART
devices. Add a HART_6602Control
function block in the SCADAPack x70
Logic Editor to enable device discovery
and provide control over the scanning
process.

A separate HART_6602Control function
block is required for each 6602 HART
module connected to the SCADAPack
x70 device.

The following settings are shown in the
example below for a 6602 HART module
to discover connected HART devices
when used for HART Pass Through:

· Set the 6602 HART Analog Module to
Address 0

· Set EnableHartModule0 (BOOL
variable) to TRUE

System status bit %S13 (see the
System Status Bits topic in the Logic
Programming Overview manual) is used
to trigger HART device discovery after
SCADAPack x70 device restart.

Other logic application content can
trigger new device discovery by toggling
EnableHartModule0 state from TRUE to
FALSE and back to TRUE.

When enabled, data from
HART instruments passes
through the SCADAPack x70
device and the 6602 HART
module to the AMS without
manipulation. 

Default: Not checked
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See the HART_6602Control: Enable
HART Module topic in the Function
Blocks Technical Reference manual.

HART Pass
Through Listen
Port

The TCP port on which the SCADAPack
x70 device listens for connection
requests from the AMS or HART
Communication DTM when HART Pass
Through is enabled.

Default: 5001

8.11 Configuring USB Communication

Use the USB Communication > USB Port page to activate and deactivate the USB Device port
on the SCADAPack x70 device for connection to a local computer. This is typically the
computer running the SCADAPack RemoteConnect configuration software. 

The USB Device port operates similarly to an Ethernet port. As a result, you can USB
communications to:

· Configure device parameters and write the configuration to the device

· Debug logic applications

· Transfer files to the device using FTP

· Establish a Telnet command line interface to the device

You can use USB to connect SCADAPack RemoteConnect to 1 SCADAPack x70 device.

 WARNING

COMMUNICATION LOSS

Applying invalid communication parameters can lead to loss of communication between
SCADAPack RemoteConnect and your SCADAPack x70 device or between devices. A site
visit may be required to re-establish communication.

Before changing communication parameters, verify that the new settings are valid for this
device and valid in your network.

Failure to follow these instructions can result in death or serious injury.
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To configure USB communication

1. On the Configuration tab, select USB Communication > USB Port.

2. Select the Port Function .

3. Click Apply.

8.11.1 General Setup Parameters

The following table describes the General Setup parameter for USB ports.

Paramet
er

Parameter Description Setti
ng

Setting Description

Port
Function

Determines whether the
USB port is active. 

Enab
led

The USB port provides communications with
a local computer.

Select this setting to communicate with the
computer running the configuration software.

Default

Disa
bled

The USB port does not provide
communications.

8.12 Configuring Serial Communication

Use the Serial Communication > Ports page to control the 5 Vdc power for the serial ports.
This power is provided by pin 1 of the RJ45 connector for serial ports 1 to 4 for a SCADAPack
57x and ports 3 and 4 for a SCADAPack 47x, and can be used to power a human-machine
interface (HMI) or other devices. For the SCADAPack 47x, serial port 5 is a modem.

You can also associate a Digital object with system data reference
SYS_INFO_SerialPortPowerOn, which allows you to configure it from a logic application or
through protocol control commands, or check the current state of the power pins. The system
data reference is set to true when the 5 Vdc power on the serial ports is on, and is false when
the 5 Vdc power on the ports is off.

Use the Serial Communication > Ports > Serial # page to define serial port operation. For an
overview of serial communication configuration requirements, see Serial Communication
Configuration Overview .

84
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 WARNING

COMMUNICATION LOSS

Applying invalid communication parameters can lead to loss of communication between
SCADAPack RemoteConnect and your SCADAPack x70 device or between devices. A site
visit may be required to re-establish communication.

Before changing communication parameters, verify that the new settings are valid for this
device and valid in your network.

Failure to follow these instructions can result in death or serious injury.

To configure serial communication

1. On the Configuration tab, select Serial Communication > Ports.

2. If you want to provide power to Pin 1 of the RJ45 connector, click the drop-down list for
Serial Port +5 Vdc Power, otherwise go to step 3.

3. Select Serial Communication > Ports > Serial #.

4. Configure the General Setup  parameters, as well as any additional parameters that are
displayed, then click Apply. 

The additional parameters that are displayed depend on your Port Function and Port Mode
selections.

· Modbus RTU Server Setup Parameters

· Terminal Server Setup Parameters

· Dialup Modem Setup Parameters

93

97

98

99
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· PPP Modem Setup Parameters

5. If required, expand the Advanced Configuration parameters and configure the parameters that
are displayed for your Port Function and Port Mode selections, then click Apply.

· General Setup Parameters

· DNP3 Setup Parameters

· PPP/TCPIP Setup Parameters

6. If you configured the serial port as described below, go to the following pages and configure
the Advanced Configuration parameters if required, then click Apply.

· If you selected PPP/TCPIP as the Port Function, select Serial Communication >
PPP/TCPIP Settings then configure the PPP/TCPIP Settings  parameters.

· If you selected Terminal Server as the Port Function, select Serial Communication >
Terminal Server Settings then configure the Terminal Server Settings  parameter.

· If you selected Dialup Modem as the Port Mode, select Serial Communication >
Modem Settings then configure the Modem Settings  parameters.

· If you selected RS232 (RTS) Keyed as the Port Mode, select Serial Communication >
Serial Multidrop then configure the Serial Multidrop  parameters.

8.12.1 Serial Communication Configuration Overview

The table below summarizes the parameters you need to configure for each type of serial port
connection you can make. The Port Function and Port Mode parameter settings determine
which additional parameters need to be configured. 

Additional parameters that apply to a single serial port are displayed on the same page as the
Port Function and Port Mode parameters. 

Additional parameters that apply to every serial port are displayed on their own page. See the
procedure below the table for details.

To Connect To... Port
Function
Setting

Port Mode
Setting

Additional
Basic
Parameters
to Configure

Optional Advanced
Parameters to
Configure

Another device using
DNP3 through the serial
port

DNP3 RS232 or
RS485
options

None General Setup
Parameters

DNP3 Setup
Parameters

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

100

102

102

104

104

106

105

106

102

102

106
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A dialup modem over a
DNP3 connection

DNP3 Dialup
Modem

Dialup Modem
Setup

General Setup
Parameters

DNP3 Setup
Parameters

Modem Settings
Parameters

An ASCII terminal
session to run command
line commands

Command
Line

RS232 or
RS485
options

None General Setup
Parameters

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

Another device that has
a PPP serial channel

This could be a serial
port on another
SCADAPack or RTU, or
on another type of
device, such as a router
that is using PPP

PPP/TCPIP RS232
(RTS On)

None General Setup
Parameters

PPP/TCPIP Setup
Parameters

PPP/TCPIP Settings
Parameters

A PPP modem, such as
a GPRS cellular modem,
3G modem or LTE
modem

PPP/TCPIP PPP
Modem

PPP Modem
Setup

General Setup
Parameters

PPP/TCPIP Setup
Parameters

PPP/TCPIP Settings
Parameters

A TCP port on a remote
TCP/IP node, such as a
terminal server, or
another SCADAPack
x70 device port that is
configured as a Server
port

An application on a host
computer, or another
SCADAPack x70 device
port that is configured as
a Client port

Terminal
Server

RS232 or
RS485
options

Terminal
Server
Setup

General Setup
Parameters

Terminal Server
Settings
Parameter

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

A Modbus RTU Server
device when you are
using SCADAPack x70

Modbus RS232 or
RS485
options

None General Setup
Parameters

99 102

102

105

102

106

102

104

104

100 102

104

104

98

102

106

106

102
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configuration software to
set up Modbus RTU
Client operation

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

The COM function blocks COM User
(Function
Block)

RS232 or
RS485
options

None General Setup
Parameters

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

A Modbus RTU Client
device

Modbus RS232 or
RS485
options

None General Setup
Parameters

Serial Multidrop
Parameters
(RS232 (RTS) Keyed
or RS485 2w only)

A multidrop hardware
device

Any of the
options that
offer RS232
(RTS)
Keyed or
RS485 2w
as the Port
Mode

RS232
(RTS)
Keyed or
RS485 2w

Depends on
the selected
Port Function

Serial Multidrop
Parameters

8.12.1.1 Basic Serial Configuration

Use the Basic Configuration parameters to define how the serial port is used.

The General Setup parameters are displayed by default. Additional parameters are displayed
based on the settings you select for the Port Function and Port Mode.

· General Setup Parameters

· Modbus RTU Server Setup Parameters

· Terminal Server Setup Parameters

· Dialup Modem Setup Parameters

· PPP Modem Setup Parameters

The following table lists the Serial Port Function and Port Mode for serial ports of each
SCADAPack x70 Device. For additional details about serial ports, see the hardware manual for
your SCADAPack x70 device. 

SCADAPack x70 Device Serial Port Port Function Port Mode

106

102

106

102

106

106

93

97

98

99

100
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SCADAPack 570

SCADAPack 574

SCADAPack 575

DNP3 is the default Port
Function 

RS232 (RTS Off) is the
default Port Mode

Serial1 None

DNP3 RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Dialup Modem

Command Line RS232 (RTS Off)

RS232 (RTS On)

COM User (Function
Block)

RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

PPP/TCPIP RS232 (RTS On)

PPP Modem

Terminal Server RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Modbus RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

SCADAPack 570

SCADAPack 574

SCADAPack 575

Modbus is the default Port
Function. If Modbus settings
are not enabled, DNP3 is the
default Port Function.

RS232 (RTS Off) is the
default Port Mode

Serial2 None

DNP3 RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Dialup Modem

Command Line RS232 (RTS Off)

RS232 (RTS On)

COM User (Function
Block)

RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed
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PPP/TCPIP RS232 (RTS On)

PPP Modem

Terminal Server RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Modbus RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

SCADAPack 570

SCADAPack 574

SCADAPack 575

Modbus is the default Port
Function, and RS485 2w is
the default Port Mode. 

If Modbus settings are not
enabled, DNP3 is the default
Port Function and RS232 is
the default Port Mode.

Serial3 None

DNP3 RS232

RS485 2w

Command Line RS232

COM User (Function
Block)

RS232

RS485 2w

Terminal Server RS232

RS485 2w

Modbus RS232

RS485 2w

SCADAPack 570

SCADAPack 574

SCADAPack 575

Command Line is the default
Port Function

RS232 is the default Port
Mode

Serial4 None

DNP3 RS232

RS485 2w

Command Line RS232

COM User (Function
Block)

RS232

RS485 2w

Terminal Server RS232

RS485 2w

Modbus RS232
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RS485 2w

SCADAPack 470

SCADAPack 474

Modbus is the default Port
Function. If Modbus settings
are not enabled, DNP3 is the
default Port Function.

RS485 2w is the default Port
Mode

Serial1 None

DNP3 RS485 2w

COM User (Function
Block)

RS485 2w

Terminal Server RS485 2w

Modbus RS485 2w

SCADAPack 470

SCADAPack 474

Modbus is the default Port
Function. If Modbus settings
are not enabled, DNP3 is the
default Port Function.

RS485 2w is the default Port
Mode. 

Serial2 None

DNP3 RS485 2w

COM User (Function
Block)

RS485 2w

Terminal Server RS485 2w

Modbus RS485 2w

SCADAPack 470

SCADAPack 474

Modbus is the default Port
Function. If Modbus settings
are not enabled, DNP3 is the
default Port Function.

RS232 (RTS On) is the
default Port Mode

Serial3 None

DNP3 RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

Dialup Modem

Command Line RS232 (RTS Off)

RS232 (RTS On)

COM User (Function
Block)

RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

Terminal Server RS232 (RTS Off)

RS232 (RTS On)
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RS232 (RTS) Keyed

RS485 2w

Modbus RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

PPP/TCPIP RS232 (RTS On)

PPP Modem

SCADAPack 470

SCADAPack 474

Command Line is the default
Port Function

RS232 (RTS On)

Serial4 None

DNP3 RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

Dialup Modem

Command Line RS232 (RTS Off)

RS232 (RTS On)

COM User (Function
Block)

RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

Terminal Server RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

Modbus RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

RS485 2w

PPP/TCPIP RS232 (RTS On)
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PPP Modem

SCADAPack 470

SCADAPack 474

None is the default Port
Function

Serial5 None

DNP3 RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Command Line RS232 (RTS Off)

RS232 (RTS On)

COM User (Function
Block)

RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

Modbus RS232 (RTS Off)

RS232 (RTS On)

RS232 (RTS) Keyed

PPP/TCPIP RS232 (RTS On)

PPP Modem

8.12.1.1.1 General Setup Parameters

The following table describes the General Setup parameters for serial ports.

Paramete
r 

Parameter
Description

Setting Setting Description

Port
Function

Specifies how the
serial port is
used. 

The Port Function
is typically tied to
the role the
SCADAPack x70
device performs in
your SCADA
network. 

The options
presented depend
on the device

DNP3 Enables DNP3 Data Concentrator Client,
DNP3 Outstation, or DNP3 Peer to Peer
Client operation on the serial port. Connect
a port with this setting to a remote
communication device or another device
that supports the DNP3 protocol.

Configuring multiple DNP3 ports allows any
combination of DNP3 devices to
simultaneously access the SCADAPack
x70 device. Messages can also be routed
between the DNP3 ports.
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type and serial
port number. 

Command Line Enables command line functions and
diagnostic output on the serial port.
Connect a port with this setting to a
terminal emulator application on a
computer.

Only one serial port can be used for
command line operation. 

COM User
(Function
Block)

This port function is required to make use
of the COM_Close, COM_Open,
COM_Read, COM_ReadBinary,
COM_ClearReadBuffer, COM_Write, and
COM_WriteBinary function blocks in the
SCADAPack x70 Logic Editor. See the
Communication Function Blocks in the
Function Blocks Technical Reference
manual.

If you will be using the COM function
blocks for communication with different
device types, configure a separate serial
port for each device type. 

PPP/TCPIP Enables PPP over TCP/IP communications
on the serial port. The serial port functions
as an IP interface on the device. 

Connect a port with this setting to another
device that has a PPP serial channel. This
is typically a PPP modem, but could also
be a serial port on another SCADAPack or
RTU, or on another type of device, such as
a router that is using PPP. If there is a
reliable Ethernet connection between the
devices, it is preferable to configure IP
communications over the Ethernet port
rather than over the serial port.

If you are connecting to a PPP modem,
select PPP Modem as the Port Mode then
configure the PPP Modem Setup
parameters.

If you are connecting to a SCADAPack,
RTU, or other device type, you need to
configure an IP Address and Subnet
Mask  for the port.

Configuring multiple PPP/TCPIP ports
allows multiple devices to simultaneously
access the SCADAPack x70 device. Each
IP port on the SCADAPack x70 device

100

104
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(Ethernet or PPP) needs to be configured
on a different subnet.

Terminal
Server

Enables terminal server functionality on the
serial port. A Terminal Server port can
operate in either client or server mode. 

Configuring multiple Terminal Server ports
allows a combination of clients and servers
to access the SCADAPack x70 device.

Modbus Enables Modbus operation on the serial
port. 

To add this port function to the selection
list, see  Changing the Project Settings
. Modbus RTU Client operation is
configured using the Modbus Scanner or
by using the function block 
MB_SERIAL_MASTER. See Modbus
Serial Master in the Function Blocks
Technical Reference manual. Connect a
port with this setting to one or more
Modbus RTU Servers.

Configuring multiple Modbus ports allows
the device to simultaneously, and more
efficiently, communicate with multiple
Modbus RTU Servers.

For Modbus RTU Server operation on the
serial port, connect a serial port with this
setting to a Modbus RTU Client. 

None 

Port Mode Sets the
hardware
communications

RS232 (RTS
Off)

Used for RS232 communications where the
Request to Send (RTS) signal needs to be
constantly deasserted. No hardware

42
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format for the
port. 

The options
presented depend
on the
SCADAPack x70
device type, the
serial port number
and the Port
Function. 

handshaking is required or supported when
this mode is selected.

RS232 (RTS
On)

Used for RS232 communications where the
Request to Send (RTS) signal needs to be
constantly asserted. No hardware hand
shaking is required or supported when this
mode is selected.

RS232 (RTS)
Keyed

Used for RS232 communications where
Request to Send (RTS) / Clear to Send
(CTS) flow control is required. 

RS232 Used for RS232 communications on serial
ports that do not provide hardware control
lines for Request to Send (RTS), Clear to
Send (CTS), Data Terminal Ready (DTR) or
Data Carrier Detect (DCD). 

RS485 (2w) Used for RS485 2-wire communications.
No hardware handshaking is required or
supported.

Dialup Modem Used for modem communications over a
telephone line or a GSM communications
link. 

If you choose this setting, you also need to
configure the Dialup Modem Setup
parameters.

PPP Modem Used for modem communications over a
Point-to-Point (PPP) protocol link. 

Only available when the PPP/TCPIP Port
Function is selected.

If you choose this setting, you also need to
configure the PPP Modem Setup
parameters.

Baud Rate Sets the data rate
for the port.

300 Select the baud rate that matches the rate
used by the device at the other end of the
link. 

Evaluate factors such as link quality and
link length when selecting the baud rate.
Generally, links with lower quality or longer
length require slower baud rates. 

Default: 9600

600

1200

2400

4800

99
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9600

19200

38400

57600

115200

8.12.1.1.2 Modbus RTU Server Setup Parameters

The following table describes the Modbus RTU Server Setup parameters for serial ports. These
parameters are only available when the Port Function is set to Modbus.

Parameter Parameter Description Setting Setting Description

Addressing Selects standard or
extended addressing mode

For addressing mode
information, see:
Configuring Standard and
Extended Addressing .

Standard
(default)

Modbus unit identifiers include
1...255

Extended Modbus unit identifiers include
1...65534

Station
Address

The Modbus RTU Server
address

· Standard
addressing
: 1...255

· Extended
addressing
: 1...65534

Default: 1

Enron
Modbus

When checked, the Enron
Station Address field is
enabled

Available only when the Realflo
Flow Computer option is
configured

Default: Unchecked

Enron
Station
Address

The Enron Modbus
address

· Standard
addressing
: 1...255

· Extended
addressing
: 1...65534

Default: 2

Available only when the Realflo
Flow Computer option is
configured

Enabled only when Enron
Modbus is checked

The Enron Station Address
needs to be different than the
Server Address for each port. 

183
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8.12.1.1.3 Terminal Server Setup Parameters

The following table describes the Terminal Server Setup parameters for serial ports. These
parameters are only available when the Port Function is set to Terminal Server.

Paramete
r 

Parameter Description Setting Setting Description

Port Mode Determines whether the
port operates as a client
or a server for terminal
server sessions.

Client A Client port initiates connection
requests to a TCP port on a remote
TCP/IP node, such as a terminal
server, or another SCADAPack x70
device port that is configured as a
Server port. 

Server A Server port listens on the specified
TCP port for connection requests from
a client, such as an application on a
host computer, or another
SCADAPack x70 device port that is
configured as a Client port.

Default setting

TCP Listen
Port
Number

Identifies the TCP port
that the SCADAPack x70
device listens on when
the Port Mode is set to
Server.

1...65535

Default: 

· Serial 1:
50001

· Serial 2:
50002

· Serial 3:
50003

· Serial 4:
50004

Data received from a remote device
that made a connection to the
SCADAPack x70 at this TCP port
number, is transmitted on the
SCADAPack x70 serial port. Data
received on the SCADAPack x70
serial port is sent to the remote
device. 

You can use any port number for the
SCADAPack x70 TCP port that does
not conflict with another port number
in use on the SCADAPack x70
device. For example, (assuming
default port configuration), do not use:

· Port 502 when the SCADAPack x70
device is operating as a
Modbus/TCP Server

· Port 504 when logic debugging is
enabled on the SCADAPack x70
device

· Port 5001 when HART pass through
is enabled on the SCADAPack x70
device
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TCP Port
Number

Identifies the remote TCP
port number that this
client connects to when
the Port Mode is set to
Client.

1...65535

Default: 

· Serial 1:
50001

· Serial 2:
50002

· Serial 3:
50003

· Serial 4:
50004

Set this field to the TCP port number
of the remote (server) device. The
SCADAPack x70 opens a TCP
connection with the remote device at
this port number. 

Data received on the SCADAPack x70
device serial port is sent to the remote
device. 

Data received from the remote device
is transmitted to the SCADAPack x70
serial port

IP Address Identifies the remote IP
address that this client
connects to when the
Port Mode is set to
Client.

Standard
IP address
format

Default: 1.0.0.0

Set this field to the IP address of the
remote (server) device. The
SCADAPack x70 opens a TCP
connection with the remote device at
this IP address. 

8.12.1.1.4 Dialup Modem Setup Parameters

The following table describes the Dialup Modem Setup parameters for serial ports. These
parameters are only available when the Port Function is set to DNP3 and the Port Mode is set
to Dialup Modem.

Paramet
er 

Parameter Description Setting Setting Description

Low
Power

Determines whether low
power support is enabled
on the modem.

Use this parameter in
conjunction with the DTR
Delay Time
parameter.

When the box is checked, the SCADAPack x70
device raises the Data Terminal Ready (DTR) line
when communicating with the modem and drops the
DTR line when communication is complete. 

The SCADAPack x70 device waits the DTR Delay
Time  between raising DTR and sending a
command string to the modem. This is to allow a low-
powered modem to wake from sleep mode. The
modem Initialization String may need to include
modem-specific commands to activate low power
mode based on the DTR signal. 

When the box is not checked, the DTR line remains
asserted. 

Default: Unchecked

Initializati
on String

The initialization string
that is sent to the modem

Default:
ATE0Q0V0&D2S

The default string sets up modem
parameters such as auto-answer

105 105
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every 30 seconds to
check modem status.

0=1 (S0=1) and hardware hand-
shaking requirements. Specific
modem settings can be tailored
by using this string. For example,
if a SCADAPack x70 device will
receive in-bound calls through the
modem, it needs to be set for
auto-answer.

Dial
Prefix

The prefix that is added
to the beginning of the
phone number that
causes the modem to
dial the desired number. 

Default: ATDT The default string is sufficient in
most situations. The phone
number is not entered here. It is
entered in the Connect Number
parameter for the DNP3 route .

Modem
Mode

Determines whether the
SCADAPack x70 device
maintains a permanent
connection with the
remote device, or if it will
disconnect the modem
after a period of time in
which no data is
transmitted or received.

Hangup Enabled The SCADAPack x70 device
disconnects the modem after a
timeout period if it has not
transmitted or received any data
during that time period. 

The timeout period is set using
the Inactivity Timeout
parameter . The Inactivity
Timeout is only configured when
Hangup Enabled is selected.

Default

Hangup Disabled The SCADAPack x70 device
does not disconnect the modem if
it has not transmitted or received
data during the Inactivity
Timeout .

8.12.1.1.5 PPP Modem Setup Parameters

The following table describes the Dialup Modem Setup parameters for serial ports. These
parameters are only available when the Port Function is set to PPP/TCPIP and the Port Mode
is set to PPP Modem.

Paramet
er 

Parameter Description Setting Setting Description

Initializati
on String

The initialization string
that is sent to the
modem every 30 seconds
to check modem status.

Default:
ATE0V0&D0&C1
&W

The default string sets up modem
parameters such as auto-answer
(S0=1) and hardware hand-
shaking requirements. Specific
modem settings can be tailored

154
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by using this string. For example,
if a SCADAPack x70 device will
receive in-bound calls through the
modem, it needs to be set for
auto-answer.

APN
String

The network specific
setup string that is sent
to the PPP modem when
a connection is being
established. 

Default:
AT+CGDCONT=1,
"IP","apnexample"

The "apnexample" part of the
default string is typically the
network name. Consult your
network operator for the specific
value.

Dial
Prefix

The dial string for the
PPP modem to go
online.

Default:
ATDT*99***1#

The string is specific to the
modem, but the default string is
sufficient in most situations.

PAP/CH
AP
Usernam
e

The Password
Authentication
Protocol/Challenge
Handshake
Authentication Protocol
(PAP/CHAP) username
that is used for
authentication during log
on to the PPP network.

Obtain the PAP/CHAP username from your network
operator. 

PAP/CH
AP
Passwor
d

The password that is
used for authentication
during log on to the PPP
network.

Obtain the PAP/CHAP password from your network
operator. 

8.12.2 Advanced Configuration

Use the Advanced Configuration parameters to customize the communication settings. The
parameters that are displayed are based on the settings you select for the Port Function and
Port Mode.

· General Setup Parameters

· DNP3 Setup Parameters

· PPP/TCPIP Setup Parameters

· PPP/TCPIP Settings Parameters

· Modem Settings Parameters

· Terminal Server Settings Parameter

· Serial Multidrop Parameters

102
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8.12.2.1 General Setup Parameters

The following table describes the General Setup parameter for serial ports.

Param
eter

Parameter Description Setting Setting Description

Serial
Format

The formatting for data that
is sent over the serial port.

8-bit No
Parity 

Select the Serial Format that matches
the format used by the device at the
other end of the connection. For most
devices, the default setting of 8-bit No
Parity is fine.

Settings with names that do not
specify stop bits send 1 stop bit.

Default: 8-bit No Parity

8-bit Even
Parity

8-bit Odd
Parity

7-bit Even
Parity

7-bit Odd
Parity

8-bit No
Parity, 2
Stop Bits

8.12.2.2 DNP3 Setup Parameters

The following table describes the DNP3 Setup parameters for serial ports. These parameters are
available only when the Port Function is set to DNP3.

Paramet
er

Parameter Description Setting Setting Description

Data
Link
Confirm
Mode

Determines whether the
SCADAPack x70 device requests
a confirmation message when it
sends DNP3 data link layer
frames.

If a confirmation message is
requested, the SCADAPack x70
device waits until the confirmation
is received before sending the
next DNP3 frame.

Sometim
es

The SCADAPack x70 device
requests a confirmation message
only when it sends multi-frame
DNP3 messages. This mode can
improve data delivery on low-
quality links because individual
frames can be resent rather than
entire multi-frame messages.

Select Sometimes if the
SCADAPack x70 device is
sending a range of message
sizes on potentially congested or
unreliable links.
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Always The SCADAPack x70 device
always requests a confirmation
message when it sends DNP3
frames. 

Select Always to improve
communications delivery on
unreliable links.

Never The SCADAPack x70 device
never requests a confirmation
message when it sends DNP3
frames.

Select Never when using a robust
communication medium, such as
a local serial connection between
two devices. This mode provides
the highest efficiency and the
highest throughput of the three
options.

Default

Data
Link
Retries

The number of times a data link
layer frame is resent if a
confirmation message was
requested but has not been
received. 

The SCADAPack x70 device
resends frames when the
Channel Receive Timeout
elapses, but it has not yet
received a confirmation message.
If the number of retries is
exceeded, the frame is
considered to be undeliverable
and transmission of the entire
DNP3 message is aborted.

This setting applies only when the
Data Link Confirm Mode
parameter is set to Sometimes
or Always.

0...100 Default: 2 

Channel
Receive
Timeout

The amount of time the
SCADAPack x70 device waits for
a data link layer confirmation
message when one has been
requested. 

0...65535
seconds
(s)

Default: 5 s
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If a confirmation message is not
received within this time, the
frame is either retransmitted, or
discarded. 

This setting applies only when the
Data Link Confirm Mode is set
to Sometimes or Always.

8.12.2.3 PPP/TCPIP Setup Parameters

The following table describes the PPP/TCPIP Setup parameters for serial ports. These
parameters are available only when the Port Function is set to PPP/TCPIP and only need to be
configured when you are creating a point-to-point RS232 link to another device. They do not need
to be configured when you are connecting to a PPP modem.

Paramet
er 

Parameter Description Setting Setting
Description

IP
Address

The IP address for the serial port when it
is configured for the PPP/TCPIP Port
Function and operating as an IP
interface. 

Standard IP
address format

Default: Negotiate

Subnet
Mask

The subnet mask for the serial port
when it is configured for the PPP/TCPIP
Port Function and operating as an IP
interface. 

Standard subnet
mask format

Default:
255.255.255.0

Disabled when the
IP Address is
Negotiate.

8.12.2.4 PPP/TCPIP Settings Parameters

The following table describes the PPP/TCPIP Settings parameters for serial ports. These
parameters are available only when the Port Function is set to PPP/TCPIP. To view these
parameters, select Ports > PPP/TCPIP Settings.

Parameter Parameter Description Setting Setting Description

PPP DCD
Drop Delay

The time that the data carrier
detect signal (DCD) needs to be off
before the PPP link is
disconnected. 

This parameter helps to improve
PPP connection reliability when
best-effort mobile data services,
such as GPRS, are used. 

0...60000
milliseconds
(ms)

Default: 500 ms
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8.12.2.5 Modem Settings Parameters

The following table describes the Modem Settings parameters for serial ports. These parameters
are available only when the Port Function is set to DNP3 and the Port Mode is set to Dialup
Modem. To view these parameters, select Ports > Modem Settings.

Parameter Parameter Description Setting Setting
Description

Inactivity
Timeout

The amount of time the SCADAPack x70
device waits to hangup the modem when
no further messages are being sent on
the modem channel. 

Use this timeout when the Modem
Mode parameter is set to Hangup
Enabled. 

0...65535
seconds (s)

Default: 30 s

Message Tx
Timeout

The amount of time the SCADAPack x70
device stores an outbound message in its
transmit queue before discarding it. 

This timeout accounts for delayed
transmission while waiting for modem
connection.

0...65535
seconds (s)

Set this timeout
to a value that is
slightly less
than the DNP3
Application
Layer Timeout
parameter.

Default: 120 s

Modem Test
Interval

The amount of time between Modem
health tests while the modem is not
connected. 

0...65535
seconds (s)

Default: 60 s

Send Delay The amount of time the SCADAPack x70
device waits for a new outbound request if
the modem channel is about to be
connected by an inbound call. 

The timer starts when a modem ring
response is received. This allows the
existing modem transaction to complete
before attempting to send the new
request. If a new request is sent during
this period, the modem hangs up
prematurely. 

0...65535
seconds (s)

Set this delay to
a value that is
higher than the
Modem
Inactivity
Timeout to allow
the modem to
hang-up
normally.

Default: 20 s

DTR Delay
Time

The amount of time the SCADAPack x70
device waits between asserting Data
Terminal Ready (DTR) and sending a
command string to the modem.

Use this timeout when the Low Power
parameter is enabled.

0...5000
milliseconds
(ms)

Default: 500 ms
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8.12.2.6 Terminal Server Settings Parameter

The following table describes the Terminal Server Settings parameter for serial ports. This
parameter is available only when the Port Function is set to Terminal Server. To view this
parameter, select Ports > Terminal Server Settings.

Parameter Parameter Description Setting Setting Description

Inactivity
Timeout

The amount of time the serial port
waits for activity before
disconnecting the TCP port. 

0...65535
seconds (s)

Default: 250 s

8.12.2.7 Serial Multidrop Parameters

The following table describes the Serial Multidrop parameters for serial ports. 

If the Port Mode is set to RS232 (RTS) Keyed, these parameters are available.

If the Port Mode is set to RS485 2w, Response Delay is the only parameter available.

Parameter Parameter Description Setting Setting
Description

Tx Warmup
Delay

The amount of time between the
transmission media being activated and
the actual transmission of data.

0....65535
millisecond
s (ms)

Default: 60 ms

Maximum
Random Delay

The amount of time the SCADAPack x70
device waits before it reattempts a data
transmission after a collision in the
communication media.

If this parameter and the Fixed Delay
parameter are both set to 0, then no
media access collision avoidance timing
is performed.

0...65535
millisecond
s (ms)

Default: 100 ms

Postamble
Delay

A fixed time to delay deactivation of the
transmission media after the completion
of a message. 

Use this parameter to overcome the case
where the transmission media
deactivates the communication channel
too early, resulting in incomplete transfer
of some of the data transmitted by the
SCADAPack x70 device. 

0...65535
millisecond
s (ms)

Default: 20 ms

Fixed Delay The amount of time the SCADAPack x70
device waits before transmitting data onto
the physical channel if the channel is

0...65535
millisecond
s (ms)

Default: 0 ms
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busy when the device first tries to
transmit data (after the Response Delay).

This time is valid for communications
drivers using collision avoidance, and is
applied after the SCADAPack x70 device
first detects the channel is available. 

Response
Delay

The amount of time data transmission is
delayed prior to any collision avoidance
mechanisms. This parameter is typically
used in situations where a radio repeater
may be slow to drop its carrier and the
SCADAPack x70 device tries to respond
to a request too quickly. 

0....65535
millisecond
s (ms)

Default: 0 ms

8.13 Configuring IP Communication

The procedure below describes how to configure IP communication between the SCADAPack
x70 device and another device. It does not describe how to activate TCP/IP services on the
SCADAPack x70 device. For information about activating TCP/IP services, see Using TCP/IP
Services .

As part of this procedure, you will configure a Default Gateway IP Address. This is the IP
address of the gateway node through which IP communications pass if no other path can be
determined for an IP address. A path is defined by Ethernet or PPP port interfaces, or by IP
Routing table entries.

 WARNING

COMMUNICATION LOSS

Applying invalid communication parameters can lead to loss of communication between
SCADAPack RemoteConnect and your SCADAPack x70 device or between devices. A site
visit may be required to re-establish communication.

Before changing communication parameters, verify that the new settings are valid for this
device and valid in your network.

Failure to follow these instructions can result in death or serious injury.

To configure IP communication between the SCADAPack x70 device and
another device

1. On the Configuration tab, select IP Communication > Ethernet Ports.

2. Configure the Default Gateway IP Address  parameter that will be used by every Ethernet
port.

3. Select IP Communication > Ethernet Ports > Ethernet #, configure the General Setup
parameters, then click Apply.

110
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4. Select IP Communication > Routing Table. 

5. Click Add IP Route.

6. Define the route to the device you want to connect to , then click Ok.

7. On the Routing Table page, click Apply.

8.13.1 Using Ethernet Ports

Use the IP Communication > Ethernet Ports page to define the IP address for the default
gateway that is used by every Ethernet port on the SCADAPack x70 device.

Use the IP Communication > Ethernet Ports > Ethernet # page to define the IP address and
subnet mask for each Ethernet port on the SCADAPack x70 device.

To configure the Default Gateway IP Address

1. On the Configuration tab, select IP Communication > Ethernet Ports.

114
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2. Configure the Default Gateway IP Address  parameter then click Apply. 

To configure the parameters for individual Ethernet ports

1. On the Configuration tab, select IP Communication > Ethernet Ports > Ethernet #.

When no Gateway IP Address is entered, the Basic Configuration is displayed as follows:

When a Gateway IP Address is entered, the address is displayed as follows:

2. Configure the General Setup  parameters, then click Apply. 

8.13.1.1 Default Gateway IP Address Parameter

The following table describes the IP address parameter that is used by every Ethernet port on
the SCADAPack x70 device if a gateway is not defined for the IP route.

Parameter Parameter Description Setting

Default
Gateway IP
Address

The IP address of the default gateway node
through which IP communications pass if no
other path can be determined for an IP address.

Standard IP address
format

109
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If the Ethernet port subnets, PPP port subnets or
IP Routing Table does specify a route for an IP
address, the communication is routed through
the default gateway node.

If this device and the device at the other end of
the connection are on the same subnet, you do
not need to define a Default Gateway IP Address
here or a route in the IP Routing Table. This
Default Gateway IP Address needs to be an IP
address on a subnet for an interface configured
on this SCADAPack x70 device.

If you define a gateway node and you want it to
be available for a specific subnet, add a route to
the IP Routing Table. 

The Default Gateway IP
Address is displayed for
every Ethernet port, but
can only be changed
here.

Default: Empty

8.13.1.2 General Setup Parameters

The following table describes the General Setup parameters for individual Ethernet ports.

Parameter Parameter Description Setting

IP Address The IP address for the Ethernet port on the
SCADAPack x70 device.

Each Ethernet port needs to be on a different
subnet. 

Standard IP address
format

Subnet Mask The subnet mask for the Ethernet port. Standard subnet mask
format

Default
Gateway IP
Address

Displays the Default Gateway IP Address for
information purposes.

The Default Gateway IP Address is set on the IP
Communication > Ethernet Ports page.

Standard IP address
format

8.13.2 Using TCP/IP Services

NOTICE

INSECURE COMMUNICATIONS

The Telnet server and the FTP server on the SCADAPack x70 device can be insecure if they
are not externally secured. This is because TCP/IP application protocols transmit data,
including user names and passwords, in clear text.
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It is strongly recommended that the Telnet server and the FTP server on the device be disabled
when not in use. Leaving these servers enabled can create a security vulnerability if the remote
IP connection to the device is not secured. 

Failure to follow these instructions can result in equipment damage.

Use the IP Communication > Services page to activate and deactivate TCP/IP services on the
SCADAPack x70 device. By default, DNP3/IP communications are activated on the device. You
can also activate:

· Telnet server functionality to enable remote access to the device command line

· FTP server functionality to enable remote access to the device file system

· DNP3/UDP Broadcast Server to receive DNP3 broadcast messages sent over UDP/IP

Every TCP/IP interface – Ethernet, PPP, USB – has access to enabled services except where
not allowed by IP Firewall configuration.

To activate DNP3/UDP Broadcast Server, Telnet Server, or FTP Server
functionality on the SCADAPack x70 device

1. On the Configuration tab, select IP Communication > Services.

2. Select the checkbox for each TCP/IP service that you want to activate on the
SCADAPack x70 device .

3. Click Apply.

8.13.2.1 TCP/IP Services Parameters

The following table describes the TCP/IP Services parameters.

Paramete
r

Parameter Description Setting

DNP3/IP DNP3/IP communications are enabled on the SCADAPack x70 device and
cannot be disabled.
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Telnet
Server

Determines whether the
Telnet server in the
SCADAPack x70 device is
activated.

When the box is checked, the Telnet server in the
device is enabled and multiple users can remotely
connect to the device command line. 

For details about Telnet Server operations, see the
Telnet Server Operations topic in the Operations
Technical Reference manual.

Default: Unchecked

FTP Server Determines whether the
FTP server in the
SCADAPack x70 device is
activated.

When the box is checked, the FTP server in the
device is enabled and multiple users can remotely
access the file system on the device using FTP
client software.

For details about FTP Server operations, see the
FTP Server Operations topic in the Operations
Technical Reference manual.

Default: Unchecked

DNP3/UDP
Broadcast
Server

Determines whether the
DNP3/UDP Broadcast
server in the SCADAPack
x70 device is activated.

When the box is checked, the DNP3/UDP
Broadcast server in the device is enabled and the
SCADAPack x70 device will listen for DNP3
Broadcast messages sent over UDP/IP.

For details about DNP3/UDP Broadcast Server
operations, see the DNP3/UDP Broadcast Server
Operations topic in the Operations Technical
Reference manual.

Default: Unchecked

8.13.3 Using IP Routes

Use the IP Communication > Routing Table page to define routes to the devices not directly
connected to the SCADAPack x70 device. For details about IP route types, routing priorities and
automatic IP route entries, see the Communication Interfaces Technical Reference manual. A
maximum of 20 IP routes can be added. 

For examples on how to use IP routes, see IP Routing Examples .

To add an IP route

1. On the Configuration tab, select IP Communication > Routing Table. 
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2. Click Add IP Route.

3. Configure the IP Routing  parameters, then click Ok.

4. If required, enable IP forwarding . 

5. On the Routing Table page, click Apply. 

To remove an IP route

1. On the Configuration tab, select IP Communication > Routing Table. 
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2. In the IP Routing Table, select the route you want to remove.

3. Click Remove IP Routes.

4. Click Yes to confirm that you want to remove the IP route.

5. On the Routing Table page, click Apply. 

8.13.3.1 Add/Edit IP Routing Table Parameters

The following table describes the add/edit IP Routing Table entry parameters.

Parameter
Parameter
Description

Setting Setting Description

Destination IP
Address

The IP address of the
device or sub-network
in a remote network. 

This parameter is used
for Host, Network and

Gateway routes.

A valid IP
address

Standard IP address format

Destination
Subnet Mask

The network subnet
address for the remote
sub-network. 

A valid
subnet
mask

Standard subnet mask format

Destination
Port

The physical serial or
Ethernet port on the
SCADAPack x70
device that will be used
for the route.

Serial #

Select the serial port number from
the list provided. Only serial ports
with the Port Function set to
PPP/TCPIP can be used for IP
routing.

The following table indicates the
serial ports that can be used for IP
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communications on each
SCADAPack.

SP57x SP47x

Serial1 ü X

Serial2 ü X

Serial3 X ü

Serial4 X ü

Serial5 n/a ü

Ethernet #
Select the Ethernet port number
from the list provided.

Gateway IP
Address

The IP address of the
gateway node for the
route. 

If this device and the
destination device are
on the same interface
(destination), you do
not need to define a
Gateway IP Address. 

A valid IP
address

Standard IP address format

Metric

The priority, or cost, of
an interface when
multiple paths exist for
interconnecting IP
hosts. 

Generally, PPP
interfaces have a higher
metric, and therefore a
lower priority, than
Ethernet interfaces. 

0...65535 Default: 0

8.13.3.2 IP Forwarding Parameter

The following table describes the IP Forwarding parameter.

Parameter Parameter Description Setting Description
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Disable IP
Forwarding

Determines whether IP packets received
by the SCADAPack x70 device, with a
destination address that is on the same
subnet as one of the IP interfaces on the
SCADAPack x70 device, are
automatically forwarded to that IP
interface. 

Routes between the IP interfaces on the
SCADAPack x70 device do not need a
static route entry in the IP Routing
Table. 

When selected, the SCADAPack
x70 device does not automatically
forward IP packets to other local IP
interfaces on the same subnet.

IP forwarding is typically disabled
for security reasons.

Default: Checked, indicating that
IP forwarding is disabled.

8.13.3.3 IP Routing Examples

This section describes various IP routing scenarios and how to configure them for a SCADAPack
x70 device. 

IP routes instruct a device how to pass on messages to other devices in a network. Each
message for a destination IP address can be routed as the result of one the following IP routing
rules and IP interface configurations being applied:

· Destination IP Address in a Local Subnet

· Default Gateway

· Host Route

· Gateway Route

· Messages, to which none of the above routing applies, are discarded

Destination IP Address in a Local Subnet

Communication with a device whose IP address is in the subnet of a SCADAPack interface does
not require a routing table configuration. The SCADAPack can communicate with the device
directly.

Example:

* Indicates any address in the subnet

/16 refers to a subnet mask of 255.255.0.0
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117

117

118



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

117

Default Gateway

A default gateway is configured to a device that can route messages when no other routing rules
are applicable to a destination IP address.

The SCADAPack x70 configuration field Default Gateway IP Address  specifies the address of
the default gateway device.

The Default Gateway IP Address needs to be in the subnet address range of one of the local
interfaces on the SCADAPack x70 device.

Example:

* Indicates any address in the subnet

/16 refers to a subnet mask of 255.255.0.0

Special Default Gateway Route for PPP (Point-to-Point Protocol) Connections

Where a PPP connection is configured in the SCADAPack x70 device, a DEFAULT GATEWAY
route is automatically added based on the PPP interface’s IP address. This allows the
SCADAPack x70 device to direct messages for unknown addresses via the PPP link (to devices
accessible via a serial cellular IP modem, for example).

Host Route

A HOST route defines a specific IP address for a device that is in a subnet separate from the
SCADAPack x70 device’s interface subnets. The subnet mask is 255.255.255.255 for this type
of route. The IP address of a gateway that can access the device is also provided.
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The gateway IP address needs to be in the subnet address range of one of the local interfaces
on the SCADAPack x70 device.

Example:

* Indicates any address in the subnet

/16 refers to a subnet mask of 255.255.0.0

Gateway Route

A GATEWAY route defines a sub-network separate from the SCADAPack x70 device interface
subnets and the IP address of the device which is the gateway to that specific sub-network. The
subnet mask of the sub-network is also provided.

The gateway IP address needs to be in the subnet address range of one of the local interfaces
on the SCADAPack x70 device.

Example:
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* Indicates any address in the subnet

/16 refers to a subnet mask of 255.255.0.0

/24 refers to a subnet mask of 255.255.255.0

8.13.4 Using IP Firewall to Control Communication

Use the IP Communication > IP Firewall Table page to help control the flow of network traffic
into the SCADAPack. The maximum number of user-created entries is 100.

The IP Firewall operation is a means for restricting access from and to other devices, monitors,
or other addresses. 

By default, the IP Firewall is disabled meaning that all network traffic can flow through the
SCADAPack. 

When the IP Firewall operation is enabled, no inbound or outbound network traffic is permitted
except for those addresses and services that are identified on the IP Firewall table. By default,
an entry is added that permits all inbound and outbound services for USB. This entry cannot be
removed and does not count as one of the user-created entries. 

When changes are made to the IP Firewall settings, the device may temporarily lose
connectivity as the firewall is reconfigured. Some TCP/IP connections may need to be re-
established.
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To add an IP Firewall entry

1. On the Configuration tab, select IP Communication > IP Firewall Table. 

2. Click the Enable IP Firewall  checkbox. 

3. Click Add IP Address.

4. Configure the IP Firewall  parameters, then click Ok.

5. On the IP Firewall Table page, click Apply. 
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To remove an IP Firewall entry

1. On the Configuration tab, select IP Communication > IP Firewall Table. 

2. In the IP Firewall Table, select the IP address that you want to remove.

3. Click Remove IP Address.

4. Click Yes to confirm that you want to remove the IP address. 

5. On the IP Firewall Table page, click Apply. 

8.13.4.1 IP Firewall Parameter

The following table describes the Enable IP Firewall parameter.

Parameter Parameter Description Setting Description

Enable IP
Firewall

Determines whether traffic from and to
the SCADAPack x70 device is permitted
or blocked. 

When not selected, all traffic is
permitted and the IP Firewall Table
is unavailable.

When selected, all inbound and
outbound traffic is blocked unless
explicitly permitted in the firewall
table. See IP Firewall Table .

Default: Not checked, indicating
that the IP firewall is disabled.

8.13.4.2 Add/Edit IP Firewall Table Parameters

The following table describes the add/edit IP Firewall Table entry parameters.

Parameter Parameter Description Setting
Setting
Description
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IP Address
The IP Address of the source of
the traffic. This could be a device,
a monitor PC, or other addresses.

A valid IP address
Standard IP
address format

Subnet Mask

The network subnet address

The subnet mask that is applied
to the IP address that defines the
range of accepted IP addresses. 

A valid subnet mask
Standard subnet
mask format

IP Address
Range

The range of IP addresses allowed Read only

Network
Address

The lowest number in the IP
Address range

Read only

Broadcast
Address

The highest number in the IP
Address range

Read only

Description
Allows you to enter short
descriptive text for each entry

Max length: 64
characters

Traffic
Direction

Indicates in which direction(s)
traffic is to be permitted

Inbound: Traffic is initiated from
another device and comes in to
the SCADAPack x70 device.

Outbound: Traffic is initiated and
sent out by the SCADAPack x70
device to another device.

Inbound and Outbound: Traffic
can be initiated in both directions.

Consider the following when
determining directionality: 

· DNP3 over UDP, Modbus RTU
over UDP

o These services uses the UDP

protocol, which requires both
Inbound and Outbound traffic
since there is no concept of a
direct response in this
protocol.

· Telnet, HART Pass Through,
Logic Debug Server

o These services will not work

with an Outbound direction,

· Inbound

· Outbound

· Inbound and
Outbound

Default: Inbound
and Outbound
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since the connection is
always initiated by an
external device, such as a
PC.

· FTP

o This service requires both

Inbound and Outbound traffic
because it uses two separate
connections for different
purposes to complete the
connection - an Inbound FTP
control connection for
receiving commands, and an
Outbound FTP data
connection for transferring
data back and forth.

· ICMP Ping Traffic, All ICMP
Traffic

o These services are typically

initiated in one direction, but
require a response in the
other direction. It is the initial
connection that determines
the relevant Traffic Direction
setting.

Port Number

If Custom Service is selected in
Permitted Services, you can enter
a Port Number and Protocol for
the rule

0...65535 Default: 0

Protocol

If Custom Service is selected in
Permitted Services, you can enter
a Port Number and Protocol for
the rule

· TCP

· UDP

· TCP and UDP

Default: TCP

Permitted
Services

The services whose ports that
traffic is permitted on.

At least one needs to be enabled.

DNP3 over TCP

DNP3 over UDP

Modbus/TCP

Modbus RTU over
TCP

Modbus RTU over
UDP
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Logic Debug
Service 

See Modifying a
Logic Application
Online  and
Disabling Logic
Debugging

Telnet

FTP

Active FTP
supported

Passive FTP not
supported

HART Pass Through

IEC 60870-5-104

Terminal Server for
Serial Port 1

Terminal Server for
Serial Port 2

Terminal Server for
Serial Port 3

Terminal Server for
Serial Port 4

ICMP Ping Traffic

Permits ICMP
ping traffic for the
specified rule and
only ping traffic

All ICMP Traffic

Permits all ICMP
traffic for the
specified rule,
including ICMP
ping

Custom Service

Allows you to
specify a custom
port number and
protocol to allow
traffic over

375
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8.14 Configuring DNP3 Operation

SCADAPack x70 devices can operate as a DNP3 Controlling Station or as a DNP3 Outstation
with up to 3 DNP3 Controlling Stations. For details, see:

· Configuring Outstation Operation

· Configuring DNP3 Layer Settings

· Configuring DNP3 Routes

· Configuring Data Concentrator Client Operation

Default operation

By default, each SCADAPack x70 project is configured for DNP3 Outstation operation and the
relevant configuration parameters are displayed in the SCADAPack x70 configuration software.

The configuration parameters for DNP3 Controlling Station operation are only displayed if DNP3
Data Concentrator Client is selected in the Project Settings . These options are initially
configured when you first create the project, but can be changed at any time if you need the
SCADAPack x70 device to perform different functions in your network. For details, see Managing
the Device Role in the Network .

For an overview of DNP3 communication configuration requirements, see:

· Configuring DNP3 Outstation Operation Overview

· Configuring DNP3 Router Operation Overview

· Configuring DNP3 Peer to Peer Client Operation Overview

· Configuring DNP3 Data Concentrator Client Operation Overview

8.14.1 Configuring DNP3 Outstation Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a DNP3 Outstation. Each step in the procedure below is described later in this
manual. Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 
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To configure the SCADAPack x70 device to operate as a DNP3 Outstation

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connection to each DNP3 Controlling Station(s). A DNP3 Outstation can have up to 3 DNP3
Controlling Stations.

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  

5. On the Configuration tab, select DNP3, then select:

· Outstation > Connection to Controlling Station  to configure the connection to each
DNP3 Controlling Station.

· Events  if you need to customize how the DNP3 Outstation generates events. 

· Layer Settings  if you need to customize the default DNP3 layer settings.

· DNP3 Routing Table  if you want the DNP3 Outstation to send events to a DNP3
Controlling Station before the DNP3 Controlling Station has tried to communicate with it.

6. On the Objects tab, select Object Configuration, then add database objects as
required .

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.
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8.14.2 Configuring DNP3 Router Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a DNP3 Router. Each step in the procedure below is described later in this manual.
Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a DNP3 Router

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connection to the other DNP3 Peer devices.

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  

5. On the Configuration tab, select DNP3, then select:

· Layer Settings  if you need to customize the default DNP3 layer settings . 
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· DNP3 Routing Table  to configure the routes to the other devices the SCADAPack x70
device needs to communicate with. 

6. On the Objects tab, select Object Configuration, then add database objects as
required .

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.14.3 Configuring DNP3 Peer to Peer Client Operation Overview

DNP3 Peer to Peer Client operation is an efficient way to exchange data between remote
SCADAPack x70 devices, and other devices, over a DNP3 communication channel. It differs
from DNP3 Data Concentrator Client and DNP3 Outstation operation in that a DNP3 Peer only
reads or controls current values for specifically selected data points. This is the recommended
way of exchanging data between remote sites. DNP3 Data Concentrator Client operation is not
recommended for exchanging specific real-time data between remote devices.

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a DNP3 Peer. Each step in the procedure below is described later in this manual.
Follow the links for details. 

Follow these same steps to set up DNP3 local data and DNP3 communications where you want
to generate requests for this SCADAPack x70 device to read or control DNP3 data in other
DNP3 Peer devices. In addition, use the SCADAPack x70 Logic Editor to build a logic
application using DNP3Peer_xxx function blocks to setup and execute communications to
DNP3 Peer devices. For more information, see DNP3 Peer Communication Function Blocks
topic in the Function Blocks Technical Reference manual.

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a DNP3 Peer

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 
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2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connection to the other DNP3 Peer devices.

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  

5. On the Configuration tab, select DNP3, then select:

· Layer Settings  if you need to customize the default DNP3 layer settings . 

· DNP3 Routing Table  to configure the routes to the other devices the SCADAPack x70
device needs to communicate with. 

6. On the Objects tab, select Object Configuration, then add database objects as
required .

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

The SCADAPack x70 device objects that you have configured with DNP3 addresses are now
available to be read or controlled as remote data in a DNP3 Peer device.

8.14.4 Configuring DNP3 Data Concentrator Client Operation Overview

When DNP3 Data Concentrator Client operation is configured, the SCADAPack x70 device
operates as a SCADA Client, retrieving device data, including buffered events, from a remote
DNP3 device. A DNP3 Data Concentrator Client is typically used in a hierarchical Client/Server
network. DNP3 Data Concentrator Client operation is not recommended for exchanging specific
real-time data between remote devices. For this purpose, use DNP3 Peer to Peer Client
Operation .
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The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a DNP3 Data Concentrator Client. Each step in the procedure below is described
later in this manual. Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a DNP3 Controlling
Station

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connections to the DNP3 Outstations:

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  

5. On the Configuration tab, select DNP3, then select:
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· Data Concentrator  to add the Remote Devices and Remote Points.

· Layer Settings  if you need to customize the default DNP3 Link Layer or Application
Layer settings. 

· DNP3 Routing Table  to add the routes to the DNP3 Outstations. 

6. On the Objects tab, select Object Configuration, then add database objects as
required .

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.14.5 Configuring Outstation Operation

Use the DNP3 > Outstation page to:

· Set the active time deadband

· Configure a connection to Controlling Station

Including time deadband data in Class 0

This checkbox applies to all objects that have deadbands configured. To set deadbands, see
Alert Notifications and Event Attributes .

When this option is selected, an active time deadband on a DNP3 point will delay creation of
DNP3 events and will include the current state or value in Class 0 poll responses.  

When this option is not selected, an active time deadband will delay creation of DNP3 events
and withhold the relevant data from Class 0 poll responses.

To include time deadband data in Class 0

1. Expand the Advanced Configuration parameters.

2. Select the Include Time Deadband data in Class 0 checkbox.

3. Click Apply.

8.14.5.1 Configuring Connection to Controlling Station

Use the DNP3 > Outstation > Connection to Controlling station page to define how the
DNP3 Outstation communicates with the DNP3 Controlling Station. A DNP3 Outstation can
have up to 3 DNP3 Controlling Station, each with different connection, event and communication
settings.

When you have defined the basic connection to the DNP3 Controlling Station, you can configure
Events, Layer Settings and the DNP3 Routing Table if required.

The procedure below takes you through each step in configuring DNP3 Outstation operation. The
parameter settings take effect when you write the configuration to the SCADAPack x70 device.
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To configure the DNP3 Outstation connection to the DNP3 Controlling Station

1. On the Configuration tab, select DNP3 > Outstation > Connection to Controlling Station
#.

2. Configure the Connection Setup  parameters, then click Apply.

3. If required, display the Advanced Configuration parameters on the same page and change the
Event Transmission Setup  parameters. 

4. If required, select DNP3 > Outstation > Events and display the Advanced Configuration
parameters to customize how the DNP3 Outstation generates events.

· Event Configuration Parameters

· Unsolicited Message Generation (Triggered Events) Parameters

· Unsolicited Message Generation (Buffered Events) Parameters

· Unsolicited Configuration Parameters

5. If required, select DNP3 > Layer Settings and display the Advanced Configuration
parameters to customize the DNP3 layer settings. 

· General Link Layer Setup Parameter

· Ethernet Link Layer Setup Parameters

· Application Layer Setup Parameters

6. If you want the DNP3 Outstation to send unsolicited information to a DNP3 Controlling
Station before the DNP3 Controlling Station has tried to communicate with it, click Add
DNP3 Route, and, if you selected Ethernet Port for the Communication Port, fill in the IP
Address or Phone Number as required, and click OK.

See Configuring DNP3 Routes  for more information.

7. Repeat the steps above for each DNP3 Controlling Station that this DNP3 Outstation will
report to.
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8.14.5.2 Connection Setup Parameters

This following table describes the Connection Setup parameters for DNP3 Outstation operation.

Parameter Parameter Description Settin
g

Setting Description

DNP3
Outstation
Address for
Connection to
Controlling
Station 1

The DNP3 Address that was
configured for this SCADAPack x70
device. 

This DNP3 Outstation uses this
address to communicate with DNP3
Controlling Station 1. If it is configured
as a Controlling Station for other
devices, it will reuse this address to
communicate with those other
devices. 

The SCADAPack x70 device uses this
address to communicate with other
devices in the network. 

This is not the DNP3 address that the
configuration software uses to
communicate with the SCADAPack
x70 device. The configuration software
uses the Target DNP3 Address
specified in the PC Communication
Settings -SCADAPack CommDTM to
communicate with the device.

0...655
19

While 0 is a valid DNP3
address for the
SCADAPack x70 device,
it is not a good choice
because:

· 0 is the default address
when the device is
shipped and after it is
started in Cold Boot or
Factory Boot mode.

· 0 is the assumed DNP3
address when the
device is started in
Service Boot mode.

· The device uses the
value 0 to terminate
some internal searches.

DNP3
Outstation
Address for
Connection to
Controlling
Station 2 and
Controlling
Station 3

The DNP3 Address this DNP3
Outstation uses to communicate with
DNP3 Controlling Station 2 or
Controlling Station 3.

0...655
19

0 means the DNP3
Outstation connection to
Controlling Station 2 or
Controlling Station 3 is
disabled.

Default: 0

DNP3
Controlling
Station
Address for
DNP3
Controlling
Station 1

The DNP3 Address of the DNP3
Controlling Station for this DNP3
Outstation.

0...655
19

Default: 30000

DNP3
Controlling
Station

The DNP3 Address of the DNP3
Controlling Station for this DNP3
Outstation.

0...655
19

Default: 0
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Address for
DNP3
Controlling
Station 2 and
Controlling
Station 3

Communicatio
n Port

Identifies the SCADAPack x70 device
port that will be used for spontaneous
communication with the DNP3
Controlling Station. 

The list includes every configured
Ethernet port and every serial port
with the Port Function parameter
set to DNP3.

Add DNP3
Route

Adds a connection to the Controlling
Station when unsolicited reporting is
required. See Configuring DNP3
Routes .

A route row is added as follows:

Source Port = Any Port

Source Start = 0

Source End = 65535

Destination Start = DNP3 Controlling
Station Address

Destination End = DNP3 Controlling
Station Address

Destination Port = Communication
Port

Connect Number = User-entered
connection value

Routing Status = On Static

Entries in the DNP3 Routing table
are flagged as duplicates if all of the
following criteria applies:

· The Destination address ranges
overlaps, AND

· The Source Port of one or both
entries is "Any Port" or the
Source Port of both entries is the
same, AND

· The Routing Status of both ports
is either "On Static" or "On
Fixed"

Unsolicited
Allowed

Determines whether the DNP3
Outstation sends spontaneous
information to the DNP3 Controlling
Station.

When the box is checked, the
DNP3 Outstation can
spontaneously send information for
objects where unsolicited
responses to the DNP3 Controlling
Station are enabled. 

For example, unsolicited responses
can be enabled for Event Deviation
parameters and for Out of Range
Limits parameters for analog
objects.

The DNP3 Routing table needs to
have a corresponding route that
includes the DNP3 Outstation

152
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Address in the Source Address
range and the DNP3 Controlling
Station Address in the Destination
Address range. See Configuring
DNP3 Routes .

When you enable unsolicited
communications, you can configure
the unsolicited message
parameters on the DNP3 >
Outstation > Events  page.

Default: Unchecked

8.14.5.3 Event Transmission Setup Parameters

The following table describes the Event Transmission Setup parameters for DNP3 Outstation
operation. 

Parameter Parameter Description Setting Setting
Descripti
on

Minimum
Unsolicited
Event Tx Delay

The minimum amount of time between
consecutive unsolicited responses sent
from the DNP3 Outstation to the DNP3
Controlling Station. 

After the DNP3 Outstation has sent an
unsolicited response, no unsolicited
responses are generated until this time
period elapses.

This parameter is displayed only when the
Unsolicited Allowed setting is enabled for
this DNP3 Controlling Station.

The value of the Minimum Unsolicited
Event Tx Delay parameter needs to be no
less than the value of the Triggered Event
Notification Delay  parameter. If the
Triggered Event Notification Delay
parameter is bigger, the firmware will use
the value of the Triggered Event
Notification Delay for the Minimum
Unsolicited Event Tx Delay.

0...65535
seconds (s)

Default:
30 s

Quiet Time
Delay

The delay that is applied when the number
of timed-out unsolicited responses
reaches the Unsolicited Attempts per
Burst count. 

0...65535
seconds (s)

Default:
120 s
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This delay allows the DNP3 Outstation to
wait an extended time period before it tries
to send another burst of unsolicited
responses to the DNP3 Controlling
Station.

This parameter is displayed only when the
Unsolicited Allowed setting is enabled for
this DNP3 Controlling Station.

Application
Layer Confirm
Timeout

The amount of time the DNP3 Outstation
waits for a DNP3 application layer
confirmation message from the DNP3
Controlling Station after it has transmitted
event data in a poll response or in an
unsolicited response. 

If data link confirmations are used to
acknowledge successful transmission of
frames to the DNP3 Controlling Station,
then the minimum application layer
confirm timeout is calculated by the DNP3
Outstation so that data link retries can be
completed. 

The application layer event timer is
restarted when a data link confirmation
message is received from the DNP3
Controlling Station. This allows the
transmission of a complete fragment
without the application layer timing out.

Minimum timeout
= ((Data Link
Retries + 1) *
Channel Receive
Timeout) + 1

The Data Link
Retries and
Channel Receive
Timeout are
those specified
for the port that is
used to
communicate
with the DNP3
Controlling
Station.

Maximum
timeout = 65535
seconds (s)

Default:
16 s

Unsolicited
Attempts per
Burst

A read-only view of the setting configured on the DNP3 > Server >
Events  page.

This parameter is displayed only when the Unsolicited Allowed setting is
enabled for this DNP3 Controlling Station.

8.14.5.4 Configuring DNP3 Outstation Events

Use the DNP3 > Outstation > Events page to specify how the DNP3 Outstation sends events
and unsolicited responses to the DNP3 Controlling Station. These are Advanced Configuration
parameters that only need to be changed from their default values when you have specific
requirements for event generation, event storage and unsolicited response timing.

145
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The following parameters are available only if the Unsolicited Allowed parameter was checked
on at least one of the Connection to Controlling Station pages. 
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· Event Configuration Parameters

· Unsolicited Message Generation (Triggered Events) Parameters

· Unsolicited Message Generation (Buffered Events) Parameters

· Unsolicited Configuration Parameters

8.14.5.4.1 Event Configuration Parameters

The following table describes the Event Configuration parameters for DNP3 Outstation operation. 

Parameter Parameter Description Setting Setting Description

Maximum
Event
Storage

The maximum number of
events that can be stored
by the DNP3 Outstation.

Changes to this parameter
require that you restart the
device. After writing the
changes to the device, use
Additional Functions >
Restart Device. 

10...40,000
events

If IEC 60870-5-104 is enabled in
the project, the default DNP3
Event Buffer size is 1000.

If IEC 60870-5-104 is not enabled
in the project, the default DNP3
Event Buffer size is 5000.

The combined maximum number
of events between DNP3 and IEC
60870-5-104 is 40000.

See IEC 60870-5-104
Parameters .

138
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Analog
Input/Float
Input Event
Buffer Mode

Specifies whether multiple
analog and float events for
the same point are buffered,
or whether the DNP3
Outstation overwrites
existing events with a more
recent event for the same
point. 

Multiple The DNP3 Outstation buffers
multiple event objects for each
analog and float point that
generates buffered events. 

Because buffered events need to
be timestamped for the DNP3
Controlling Station to process
them, you need to select one of
the With Time settings for analog
input events and float events.

Default setting

Single The DNP3 Outstation overwrites
any existing event that already
exists in the event buffer for an
integer or float point analog input
that generates a new event.
Events may exist for multiple
points in the event buffer, but only
one event per point is buffered.

Generate
Digital Input
Events

The DNP3 object that the
DNP3 Outstation uses to
report digital input events in
an unsolicited response or
an event class poll
response.

Digital input events are also
known as DNP3 binary
input events.

No Time Use this setting to generate DNP3
group 2, variation 1 digital input
event objects when timestamps
are not required, or when the
DNP3 Controlling Station does not
support timestamped digital
events.

With
Absolute
Time

Use this setting to generate DNP3
group 2, variation 2 digital input
event objects when the DNP3
Controlling Station supports
timestamped digital events, but
does not support relative time
objects.

Default setting

With
Relative
Time

Use this setting to generate DNP3
group 2, variation 3 digital input
events when the DNP3 Controlling
Station supports relative time
timestamps and DNP3 group 51,
variation 1 and variation 2 CTO
objects. 

If multiple digital events tend to
occur in close succession and
need to be transmitted together,



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

140

this is a more efficient object than
DNP3 group 2, variation 2.

Generate
Analog Input
Events

The DNP3 object that the
DNP3 Outstation uses to
report integer analog input
events in an unsolicited
response or event class poll
response.

With Time Use these settings for integer
analog input events when the
DNP3 Controlling Station supports
timestamped analog events. 

The DNP3 Outstation
automatically determines 16-bit or
32-bit event size for each point
based on its Static Group and
Variation .

· 32-bit events with time are sent
as DNP3 group 32, variation 3
objects. 

· 16-bit events with time are sent
as DNP3 group 32, variation 4
objects.

Default setting

No Time Use these settings for integer
analog input events when the
DNP3 Controlling Station does not
support, or does not require,
timestamped analog events. 

The DNP3 Outstation
automatically determines 16-bit or
32-bit event size for each point
based on its Static Group and
Variation .

· 32-bit events with no time are
sent as DNP3 group 32,
variation 1 objects.

· 16-bit events with no time are
sent as DNP3 group 32,
variation 2 objects.

Generate
Float Input
Events

The DNP3 object that the
DNP3 Outstation uses to
report floating point analog
input events in an
unsolicited response or
event class poll response.

With Time Use this setting for float events
when the DNP3 Controlling Station
supports timestamped float
events. 

The DNP3 Outstation reports
DNP3 group 32, variation 7 events
for floating point analog input point
types.

268
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Default setting

No Time Use this selection for float events
when the DNP3 Controlling Station
does not support timestamped
float events. 

The DNP3 Outstation reports
DNP3 group 32, variation 5 events
for floating point analog input point
types.

Generate
Counter
Input Events

The DNP3 object that the
DNP3 Outstation uses to
report counter input events
in an unsolicited response
or event class poll
response.

With Time Use these settings for counter
events when the DNP3 Controlling
Station supports timestamped
counter events. 

The DNP3 Outstation
automatically determines 16-bit or
32-bit event size for each point,
based on its Static Group and
Variation .

· 32-bit counter events with time
are sent as DNP3 group 32,
variation 5 objects.

· 16-bit counter events with time
are sent as DNP3 group 32,
variation 6 objects.

Default setting

No Time Use these settings for counter
events when the DNP3 Controlling
Station does not support, or does
not require, timestamped counter
events. 

The DNP3 Outstation
automatically determines 16-bit or
32-bit event size for each counter
point based on its Static Group
and Variation .

· 32-bit counter events with no
time are sent as DNP3 group
22, variation 1 objects.

· 16-bit counter events with no
time are sent as DNP3 group
22, variation 2 objects.

268
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Generate
Digital
Output
Events

The DNP3 object that the
DNP3 Outstation uses to
report digital output events
in an unsolicited response
or event class poll
response.

Digital output events are
also known as DNP3 binary
output events.

With Time Use this setting to generate DNP3
group 11, variation 2 digital output
event objects when the DNP3
Controlling Station supports digital
output events with timestamping.

Default setting

No Time Use this setting to generate DNP3
group 11, variation 1 digital output
event objects when timestamps
are not required or when the DNP3
Controlling Station does not
support timestamped digital
events. 

If the DNP3 Controlling Station
does not support digital output
event objects, set the Point Data
Class  for each point to Local or
Class 0.

Generate
Analog
Output/Float
Output
Events

The DNP3 object that the
DNP3 Outstation uses to
report integer analog output
and float analog output
events in an unsolicited
response or event class poll
response.

With Time Use this setting when the DNP3
Controlling Station supports
analog output and float analog
output event objects with
timestamping. 

The DNP3 Outstation generates
events based on the analog output
point's Static Group and
Variation .

· 32-bit integer analog output
events are sent as DNP3 group
42, variation 3 events. 

· 16-bit integer analog output
events are sent as DNP3 group
42, variation 4 events.

· 32-bit short floating point analog
output events are sent as DNP3
group 42, variation 7 events.

Default setting

No Time Use this setting when the DNP3
Controlling Station supports
analog output and float analog
output event objects, but does not
support or require timestamped
analog output events. 

271
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The DNP3 Outstation generates
events compatible with the analog
output point's Static Group and
Variation .

· 32-bit integer analog output
events are sent as DNP3 group
42, variation 1 events. 

· 16-bit integer analog output
events are sent as DNP3 group
42, variation 2 events.

· 32-bit short floating point analog
output events are sent as DNP3
group 42, variation 5 events.

File Event
Class

This configures the event
class in which a DNP3 file
event status is generated. 

When the RTU has
previously opened a file
from a DNP3 File Open
request, but automatically
closed it due to inactivity
(not read or written
recently, according to the
DNP3 > Layer Settings >
File Inactivity Timeout), the
DNP3 standard requires
that the RTU generate a file
status event to report that it
closed the file. 

None

Class 1

Class 2

Class 3

Default: Class 3 (recommended
setting)

Discard New
Events if
Buffer Full

The SCADAPack x70
device stops adding events
to the local buffer and
discards any new events.
The events that are already
in the buffer are saved. 

Not Checked: When the event
buffer is filled, the SCADAPack
x70 device will discard the oldest
events already in the buffer to
make room to add new events.

Checked: When the event buffer
is filled, the SCADAPack x70
device stops adding events to the
event buffer and discards any new
events. The events that are already
in the buffer are saved.

Default: Not checked (disabled)

268
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8.14.5.4.2 Unsolicited Message Generation (Triggered Events) Parameter

This following table describes the Unsolicited Message Generation (Triggered Events) parameter
for DNP3 Outstation operation. This parameter is available only if the Unsolicited Allowed
parameter was checked on at least one of the Connection to Controlling Station pages.

Parameter Parameter Description Setting Setting
Description

Event
Notification
Delay

The amount of time the SCADAPack x70
device waits after an event occurs before
the event object is sent to the DNP3
Controlling Station. 

This delay can reduce network bandwidth
usage because it allows the first event,
and any events that occur during this
period, to be sent to the DNP3 Controlling
Station in a single unsolicited response.

0...65535
seconds (s)

Default: 10 s

8.14.5.4.3 Unsolicited Message Generation (Buffered Events) Parameters

This following table describes the Unsolicited Message Generation (Buffered Events) parameters
for DNP3 Outstation operation. This parameter is available only if the Unsolicited Allowed
parameter was checked on at least one of the Connection to Controlling Station pages.

Parameter Parameter Description Setting Setting
Description

Class 1
Minimum Events

The minimum number of buffered events that
will lead to generation of an unsolicited
response. 

An unsolicited response may also be
generated before the number of buffered
events reaches this configured value if
unsolicited events were enabled for alert
notifications, over-range and under-range
parameters.

When an unsolicited response is generated
by the SCADAPack x70 device, every
buffered event for the matching configured
and enabled event classes is sent. Use the
Point Data Class  parameter in the Object
Editor to configure the event class for each
DNP3 Controlling Station.

0...65535 Default: 250

Class 2
Minimum Events

Class 3
Minimum Events

271
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8.14.5.4.4 Unsolicited Configuration Parameters

This following table describes the Unsolicited Configuration parameters for DNP3 Outstation
operation. These parameters are available only if the Unsolicited Allowed parameter was
checked on at least one of the Connection to Controlling Station pages.

Parameter Parameter Description Setting Setting
Description

Unsolicited
Attempts per Burst

The number of unsolicited transmissions in
a single burst. Receiving confirmation of an
unsolicited event transmission stops further
transmissions of the same events.

Each transmission in a burst is separated
by the Minimum Unsolicited Event Tx
Delay  parameter setting.

The time between bursts is determined by
the Quiet Time Delay  parameter setting.

0...6553
5

Default: 3

Default Enabled
Event Classes

The event classes that generate unsolicited
responses by default after the device is
restarted. 

Use this setting only when the DNP3
Controlling Station does not have the
functionality required to enable and disabled
unsolicited event classes using DNP3. 

The DNP3 Controlling Station typically
overrides this default setting at a later time. 

Select the combination
of event classes for
which unsolicited
responses are generated
by default.

Default: No Classes
(recommended setting)

8.14.6 Configuring DNP3 Layer Settings

Use the DNP3 > Layer Settings page if you need to customize DNP3 communication
parameters to accommodate networks with latency or frequent communication interruptions, or
to accommodate remote device requirements. In most cases, the default parameters are
adequate. 

To configure DNP3 layer settings

1. Select Configuration tab > DNP3 > Layer Settings, then expand the Advanced
Configuration parameters.

135

135



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

146

2. Configure the following parameters as required:

· General Link Layer Setup Parameter

· Ethernet Link Layer Setup Parameters

· Application Layer Setup Parameters

147

147
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3. Click Apply. 

8.14.6.1 General Link Layer Setup Parameter

The following table describes the General Link Layer Setup parameter for DNP3
communications.

Parameter Parameter Description Setting Setting Description

Maximum
Frame Size

The highest allowed transmit frame
size for data that can be included in a
single DNP3 frame. 

14 to
292

Some radios and other
communication devices
may require this value to
be set lower than the
default.

Default: 292

8.14.6.2 Ethernet Link Layer Setup Parameters

The following table describes the Ethernet Link Layer Setup parameters for DNP3
communications. 

Parameter Parameter Description Setting Setting
Description

DNP3/TCP
Keep-Alive

The rate at which a DNP3 link status test
message is sent across active TCP
sockets to verify an active TCP link.

Use this setting when the SCADAPack x70
device connects to remote intelligent
electronic devices (IEDs) or Remote
Terminal Units (RTUs) through DNP3
TCP/IP. 

The SCADAPack x70 device sends DNP3
link status requests to devices using TCP
transport, not UDP. The keep-alive timer
can help to recover from communication
stoppages, and to help keep remote TCP
sockets connected. 

When setting this timer, keep in mind that
the shorter the timer, the higher the number
of DNP3 link status messages. Higher
numbers of messages can potentially affect
communications costs.

The timer restarts each time DNP3 traffic
passes through the TCP socket. As a
result, this timer is typically set to be
longer than the standard poll rate.

0...65535
seconds (s)

0 = Deactivate
the timer

Default: 1150 s
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Channel
Receive
Timeout

The amount of time the SCADAPack x70
device waits to receive a data link layer
confirmation message from the remote
device when it has requested a confirmation
message for transmitted frames.

If a confirmation message is not received
within this time, the frame is either
retransmitted or discarded.

When the SCADAPack x70 device sends
DNP3 Controlling Station requests, such as
polls, this parameter is also used as the
time to wait for the next expected receive
frame on the port. 

0...65535
seconds (s)

Default: 5 s

Data Link
Confirm Mode

Specifies when the SCADAPack x70 device
requests a confirmation message for data
link layer frames that it transmits. 

If a confirmation message is requested, the
SCADAPack x70 device waits until the
confirmation is received before sending the
next DNP3 frame. 

Sometimes The
SCADAPack
x70 device
requests
confirmation that
data link layer
frames were
received when
multi-frame
DNP3 fragments
are transmitted. 

Select this
mode when the
device is
transmitting a
range of
message sizes,
from single to
multi-frame, on
potentially
unreliable links. 

This mode
improves data
delivery because
it re-transmits
individual frames
rather than
entire multi-
frame
messages.

Always The
SCADAPack
x70 device
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requests
confirmation that
data link layer
frames were
received. 

Select this
mode to improve
communication
delivery on
potentially
unreliable links.

Never The
SCADAPack
x70 device does
not request
confirmation that
data link layer
frames were
received

This setting is
the most
efficient and
enables the
highest
throughput of
the three
options.

It is the setting
that the DNP3
standard
recommends for
DNP3
communications
over Ethernet.

Default setting

Data Link
Retries

The number of times the SCADAPack x70
device attempts to resend a data link frame
if a data link confirmation message is
requested, but not received within the
Channel Receive Timeout period. This
parameter is only available when the Data
Link Confirm Mode parameter is set to
Sometimes or Always.

If the number of retries is exceeded, the
frame is considered undeliverable and the
application layer generating the message is

0...100 Default: 2
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notified. When this occurs, the application
layer transmission is considered
unsuccessful. 

Knowing that the Ethernet Link Layer has
exhausted its Data Link Retries can help
with troubleshooting DNP3 communications
and may mean that you need to adjust your
application layer settings  to better align
with the Ethernet Link Layer Setup. 

8.14.6.3 Application Layer Setup Parameters

The following table describes the Application Layer Setup parameters for DNP3
communications.

Parameter Parameter Description Setting Setting Description

Application
Layer
Attempts

The number of times the SCADAPack
x70 device attempts to send any
single application layer request before
discarding the fragment and stopping
the request.

Requests are only retransmitted if a
response to the request is not
received within the Application Layer
Timeout. 

The DNP3 standard does not permit
sending multiple attempts on control
messages. This is enforced by the
SCADAPack x70 device regardless of
how this parameter is set.

1...10 Default: 2 attempts

Application
Layer Timeout

The amount of time the SCADAPack
x70 device waits for an application
layer response before attempting to
send the same application layer
request again, or before discarding
and stopping an application layer
request.

0....65535
seconds (s)

Default: 24 s

File Inactivity
Timeout

The amount of time after which a file is
automatically closed by the
SCADAPack x70 device when a DNP3
file transfer does not successfully
complete. 

The timer restarts after each
successful file transfer.

5...3600
seconds (s)

Default: 60 s

150
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Select Arm
Timeout

The amount of time within which an
Operate command needs to be
received after the Select command is
received for a two-phase
Select/Operate DNP3 control. 

If an Operate command that matches
a recently received Select command
is not received within this period, then
the Control operation is aborted. In
this case, a Select Arm Timeout
status is returned in a DNP3 Control
Relay Output Block (Operate)
response to the sender. 

If an Operate command that matches
a recently received Select command
is received within this period, then the
Control operation is performed.

0...65
seconds (s)

Default: 10 s

Default Pulse
Time

The duration of the activation time of a
pulse of a Digital object state, when
the initiator of a pulse operation does
not provide a pulse time. 

E.g. receiving a DNP3 CROB (NULL
Pulse, Trip or Close command) with
On-time = 0

E.g. receiving a DNP3 CROB Unlatch
or Latch command to a
complementary (single-index) control,
emulating a Trip or Close command

E.g. Device_CROB logic function
block with On-time input = 0

0...65535
ms

Default: 250 ms

Time Update
Request Rate

The rate at which the SCADAPack
x70 device requests a time update
from the DNP3 Controlling Station. 

The device requests a time update by
setting an Internal Indication (IIN) bit in
each DNP3 communications
response. 

The next outgoing DNP3 response —
either a response to a DNP3
Controlling Station request sent to the
SCADAPack x70 device, or an
unsolicited event response sent from
the DNP3 Outstation to the DNP3

0...65535
minutes

0 = Periodic time
update requests are
not sent

Default: 1440
minutes
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Controlling Station — contains this IIN
bit. 

The SCADAPack x70 device also
requests a time update when DNP3 is
restarted. DNP3 is restarted when the
device is restarted and when you
select the Restart DNP3 context
menu item. 

Maximum
Transmit
Fragment Size

The size of the application layer
packet. 

Reduce the value of this parameter to
improve communication performance
over unreliable links.

Serial,
Ethernet,
and USB
ports:
100...2048
bytes

Default: 2048 bytes

Security
Response
Timeout

The time after which the device stops
waiting for a reply to a security
challenge.

1000...3600
000
millisecond
s (ms)

Default: 2000 ms

Default DNP3
Transport

The transport protocol used to
transmit initiating DNP3 frames if no
specific transport is indicated in the
Connect Number parameter. 

Response frames use the same
protocol as their initiating frames.

UDP If the SCADAPack
x70 device is an end
node in a TCP/IP
network and DNP3
communications is
used, set to the
same as the DNP3
Controlling Station
transport unless the
DNP3 Routing Table
Connect Number
parameter overrides
this.

Default: UDP

TCP

Default DNP3
Port

The TCP/UDP port that DNP3 frames
will be sent to and received from. The
setting for the DNP3 Routing Table
Connect Number parameter can
override this parameter for DNP3
messages sent to remote IP device
UDP ports.

0...65535 Default: 20000, the
port number
assigned to the
DNP3 protocol

8.14.7 Configuring DNP3 Routes

Use the DNP3 > Routing Table page to configure the routes to the DNP3 Controlling Station,
DNP3 Peer, and DNP3 Outstation devices that this SCADAPack x70 device communicates
with. A maximum of 100 DNP3 route entries can be added. 
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A SCADAPack x70 device that is operating as a DNP3 Peer device or DNP3 Data Concentrator,
needs routes to be configured for each DNP3 device that reports to it.

For a SCADAPack x70 device that is operating as a DNP3 Outstation only, it is recommended
that a Static route is configured for communication with the DNP3 Controlling Station. 

A SCADAPack x70 device that is operating as a DNP3 Outstation that is also configured for
unsolicited event reporting, requires at least one static route to be configured for communication
with the DNP3 Controlling Station.

· For additional information about Static, Fixed, and Dynamic Routes, see:

o Configuring DNP3 Routing in the SCADA Protocols Technical Reference manual

· For additional information about DNP3 Routing Rules, see:

o DNP3 Routing Rules in the SCADA Protocols Technical Reference manual

· For additional information about Routing and Forwarding DNP3 protocol over TCP/IP, see:

o DNP3 Routing over TCP/IP in the SCADA Protocols Technical Reference manual

To add a static or a fixed route to the DNP3 Routing Table

1. Select Configuration tab > DNP3 > Routing Table. 

2. Click Add DNP3 Route.
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3. Define the route  parameters, then click Ok. 

4. On the Routing Table page, click Apply.

8.14.7.1 DNP3 Routing Table Entry Parameters

The following table describes the DNP3 Routing Table Entry Parameters.

Parameter Parameter Description Setting Setting Description

Source Port The port from which the DNP3
frame needs to arrive for this entry
to be valid.

The SCADAPack x70 device
matches the Source Port, the
Source Start and the Source End
range as part of the route filtering.

The USB, serial or Ethernet port on the
SCADAPack x70 device. If it does not
matter which port is used, select Any
Port.

Default: Any Port
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Source Start The range of source DNP3
addresses from which the frame
needs to have originated to be
considered valid. 

In some network architectures,
store and forward routing can use
Source Port, Source Start and
Source End parameters. You can
also use these parameters to
partition networks and to stop
SCADAPack x70 devices on
different networks from
communicating with each other.

To improve routing efficiency and
simplify network configurations,
enter Source Start and Source
End ranges that are as general as
possible.

0...65535 If you enter 0 as the
Source Start and
65535 as the Source
End, it means the
frame can originate
from any DNP3 node in
the network. 

Default: 65519

Source End

Destination
Start

The range of destination DNP3
addresses to which this routing
table entry refers. 

A packet received by this
SCADAPack x70 device and
going on to another device in this
destination range is routed to the
Destination Port, providing the
source filtering is satisfied.

0...65535 Avoid entering a
Destination Start of 0
and a Destination End
of 65535. 

Instead, subdivide
DNP3 addressing into
sub-networks of
consecutive DNP3
node groups.

Default: 65519

Destination
End

Destination
Port

The SCADAPack x70 device port
to which DNP3 frames are
forwarded for this route.

A USB, serial or Ethernet port on the
SCADAPack x70 device.

Default: USB

Connect
Number

The connection number to reach
the destination. 

A routing table entry needs to be
configured for each remote device
with which the SCADAPack x70
device needs to communicate
using a TCP/IP, UDP, PSTN or
GSM connection.

Destination
Port

State

Maximum characters: 51

Default: Empty

Ethernet and Serial port configured
for PPP/TCPIP

Format Indicates Exampl
e

nnn.nnn.n
nn.nnn

IP address
only

192.168.
0.249
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USB Disabled

Ethernet Enabled

Serial port
configured for
PPP/TCPIP

Enabled

Serial port
configured for
DNP3

Enabled

Serial port
configured for
dialup
modem

Enabled

Static routes: Updated when a
DNP3 message is received from
the target DNP3 device. The
updated Connect Number
includes the IP address, IP
transport (TCP or UDP) indicator,
and the IP port number. If a fixed
IP address and port number are
required, use a fixed route.

Dialup devices: Stores the
telephone numbers for the
SCADAPack x70 device or other
devices that will be directly dialed
using a dialup modem. 

nnn.nnn.n
nn.nnn:T

Use TCP
transport

192.168.
0.249:T

nnn.nnn.n
nn.nnn:U

Use UDP
transport

192.168.
0.249:U

nnn.nnn.n
nn.nnn:pp
pppU

Use UDP
port
number

192.168.
0.249:70
01U

Serial port configured for dialup
modem

· Enter the PSTN or GSM phone
number of the remote device

Routing
Status

The status of this routing table
entry. 

For more information about route
types, see Configuring DNP3
Routes .

On Static A user-entered route
that is active and will
be automatically
updated if the remote
device sends a request
on a different interface,
IP address or IP port
than the one identified
in the route. 

Default setting

Off Static A user-entered route
that is disabled.

On Fixed A user-entered route
that is active, but will
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not be updated if the
remote device sends a
request on a different
port than the one
identified in the route. 

If your system is using
a SCADAPack 32
controller, a
SCADAPack 300
series controller, or a
SCADAPack 4203
controller, use On
Fixed. 

Off Fixed A user-entered route
that is disabled. 

If the Route Status is
Off Fixed, a dynamic
route entry is not
added to the DNP3
Routing Table.

8.14.8 Configuring Data Concentrator Client Operation

Use the DNP3 > Data Concentrator Client page to:

· Add the remote DNP3 Outstation devices for this DNP3 Data Concentrator Client 

· View the Number of Remote Point Objects

When devices are added, you can:

· Add the remote points on each DNP3 Outstation device  

When you have completed these steps, configure the: 

· DNP3 Layer Settings  parameters if you need to customize the default DNP3 Link Layer or
Application Layer settings

· Configure DNP3 Routes  to add the routes to the DNP3 Outstations

The following table lists the maximums for DNP3 Controlling Station operation.

Item Maximum Number

Maximum DNP3 Outstation devices (polled by the SCADAPack
when it is operating as a DNP3 Controlling Station)

Approximately 90*

* The number of supported connections to DNP3 devices can vary depending on:

· The number of DNP3 routing table entries (maximum 100). See the DNP3 Routing topic in
the SCADA Protocols Technical Reference manual.

158
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· The number of DNP3 association entries (maximum 100). See the DNP3 Status
Associations topic in the SCADA Protocols Technical Reference manual.

The configuration parameters for DNP3 Controlling Station operation are only displayed if DNP3
Data Concentrator Client is selected in the Project Settings . These options are initially
configured when you first create the project, but can be changed at any time if you need the
SCADAPack x70 device to perform different functions in your network. For details, see Managing
the Device Role in the Network .

8.14.8.1 Working with Remote Devices

Use the Remote Devices table on the DNP3 > Data Concentrator Client page to add and
configure , edit , and remove  remote DNP3 Outstation devices for this DNP3 Data
Concentrator Client. 

When you add a remote device, a page with the same name as the Remote Device is created
under the Data Concentrator Client page. Use the Remote Device page to manage the remote
points and their object associations after the points are added. For details, see Managing
Remote Points .

The Number of Remote Point Objects field shows you how many objects are currently mapped.  

The figure below shows the Remote Devices table. To change the parameter settings for a
remote device entry, do one of the following:

· Double-click on the table row to access the configuration parameters

· Navigate to DNP3 > Data Concentrator Client > DNP3 Device Name and click Edit Device

To add and configure a remote device

1. In the Remote Devices table, click Add Device.

42
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2. Configure the Remote Device , Poll Rate(s) , and Configuration  parameters, then
click Ok. 

3. To assign or change the DNP3 point number assigned to an object, use the Object Editor as
described in Changing the Object Configuration .

4. If required, expand the Advanced Configuration parameters and configure the General
Setup  parameters.

5. On the Data Concentrator Client page, click Apply.

To remove a remote device

1. In the Remote Devices table, select the device(s) that you want to remove, then click
Remove Devices. 

2. Specify whether you want to delete the object(s) associated with the device, then click Yes
to remove the device entry.

When you remove a remote device, the corresponding status and control objects are also
removed. 

8.14.8.1.1 Remote Device Parameters

The following table describes the Remote Device parameters for DNP3 Outstations. 

Parame
ter

Parameter
Description

Setting Setting Description

Device
Name

The name that
identifies the DNP3
Outstation.

Maximum length: 14 characters

The name can include letters, numbers, hyphens, and
underscores. 

159 161 163

301

165



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

160

Default: RemoteDevice#

Device
Address

The DNP3 address for
the DNP3 Outstation.
See Connection
Setup  parameters.

Default: 0

Device
Type

The type of outstation
device.

DNP3
Device

The server device is a DNP3 Outstation.

Polling
Type

The type of polling that
the DNP3 Controlling
Station uses with this
DNP3 Outstation. 

No Poll The DNP3 Controlling Station does not issue
poll requests to this DNP3 Outstation. The
DNP3 Controlling Station will process and
confirm unsolicited responses from the DNP3
Outstation.

Backgrou
nd Poll

The DNP3 Controlling Station sends integrity
polls to, and expects to receive unsolicited
responses from, the DNP3 Outstation.

The DNP3 Controlling Station sends an
integrity poll at the Must Poll Interval,
irrespective of the communications activity
between the DNP3 Controlling Station and
the DNP3 Outstation. 

The DNP3 Controlling Station also sends an
integrity poll if it does not receive an
unsolicited response from the DNP3
Outstation within the Background Poll time.

If the DNP3 Outstation sends an unsolicited
response to the DNP3 Controlling Station,
the background poll is rescheduled at the
Background Poll time.

Ratio Poll The DNP3 Controlling Station polls the DNP3
Outstation using an event poll to integrity poll
ratio.

For example, if you leave the default value of
65, there will be one integrity poll for every 65
event polls.

The DNP3 Controlling Station also processes
unsolicited responses from the DNP3
Outstation.

Class
Poll /
Time &
IIN

The DNP3 Controlling Station uses a
configured poll interval for each class poll,
including an integrity poll.
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If the DNP3 Outstation reports events for its
event classes in responses containing
Internal Indication (IIN) flags, additional polls
to those classes are automatically
generated.

The DNP3 Controlling Station also processes
unsolicited responses from the DNP3
Outstation.

Static
Only Poll

The DNP3 Controlling Station sends Class 0
polls only and does not respond to the class
data that is indicated as available in Internal
Indication (IIN) flags from the DNP3
Outstation. 

This provides a simplistic multi-client
interface for DNP3 Outstations that do not
support multi-client operation. 

With this setting, events are not collected
from the DNP3 Outstation.

Default setting.

Class
Poll /
Time

The DNP3 Controlling Station uses a
configured poll interval for each event class
poll, including an integrity poll. However, it
ignores the event Class Data Available
Internal Indication (IIN) flag in responses from
the DNP3 Outstation.

The DNP3 Controlling Station also processes
unsolicited responses form the DNP3
Outstation.

8.14.8.1.2 Poll Rate(s) Parameters

The following table describes the Poll Rates (seconds) parameters for Remote Devices. The Poll
Rate parameters provided depend on the setting for the Polling Type parameter.

Polling
Type

Poll Rate
Paramete
r

Setting
 

Parameter Description

Background
Poll

Backgroun
d Poll

0...6553
5
second
s

The interval, in seconds, at which the DNP3 Controlling
Station sends an integrity poll to the DNP3 Outstation.
This poll is delayed when the DNP3 Controlling Station
receives an unsolicited response from the DNP3
Outstation.
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The Background Poll time is typically set to a smaller
value than the Must Poll Interval.

Default: 65 seconds

Must Poll
Interval

0...6553
5
second
s

The interval, in seconds, at which the DNP3 Controlling
Station sends an integrity poll to the DNP3 Outstation
regardless of received unsolicited responses.

Default: 65 seconds

Ratio Poll Event Poll
Interval

0...6553
5
second
s

The interval, in seconds, between event polls.

Default: 65 seconds

Integrity
Poll Ratio

0...6553
5 

Determines how many event polls are issued between
integrity polls. For example, if you leave the default
value of 65, there will be one integrity poll for every 65
event polls.

If you set the value of 0 or 1, there will be one integrity
poll for each event poll.

Default: 65

Static Only
Poll

Poll
Interval

0...6553
5
second
s

The interval, in seconds, between Class 0 polls.

Default: 65 seconds

Class Poll /
Time & IIN

Class Poll /
Time

Class 1 0...6553
5
second
s

The poll interval, in seconds, for the selected Event
Class.

Default: 65 seconds

Class 2 0...6553
5
second
s

Class 3 0...6553
5
second
s

Integrity 0...6553
5
second
s

The integrity poll interval in seconds.

Default: 65 seconds
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8.14.8.1.3 Configuration Parameters

The following table describes the Configuration parameters for Remote Devices. 

Parameter Parameter Description Setting Setting Description

Poll Limit The number of unsuccessful
polls before the remote
device is considered to be
offline.

0...65535 Default: 2 unsuccessful polls

Health Poll
Rate

The interval at which the
DNP3 Controlling Station
sends a health poll to DNP3
Outstations when there has
been a communications
interruption.

The DNP3 Controlling
Station sends the selected
Health Poll Type at this
rate until the DNP3
Outstation comes online
again. 

0...65535 
seconds
(s)

Default: 120 seconds

Multiple
Fragment
Response

Indicates whether the DNP3
Outstation supports multi-
fragment responses. 

Yes The DNP3 Outstation supports
multi-fragment responses.

Default

No The DNP3 Outstation does not
support multi-fragment
responses. 

If the DNP3 Outstation sends a
complete fragment poll response
with no “class data available IIN”
set, the SCADAPack x70 device
sends another integrity poll so
that static data is returned to the
DNP3 Controlling Station. 

Application
Timeout

The timeout that is applied
to application layer
messages, such as class
poll requests, that are sent
to this DNP3 Outstation.

1...300
seconds
(s)

Default: 60 s

Health Poll
Type

The type of health poll the
DNP3 Controlling Station
sends to the DNP3
Outstation to initialize

Delay
Measure
ment

The DNP3 Controlling Station
sends a delay measurement poll
to reestablish communications. 
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communications at startup,
and to reestablish
communications if there has
been a communications
interruption.

The DNP3 Controlling
Station sends the selected
poll type to the DNP3
Outstation at the Health Poll
Rate. 

This option sends the smallest
message of the three options.
The response from the DNP3
Outstation will be small and
predictable and should not affect
the state of the DNP3
Outstation. Unless the DNP3
Outstation does not support the
Delay Measurement request
type, this is the recommended
setting. 

Default setting

Class 0
Poll

The DNP3 Controlling Station
sends a Class 0 poll to
reestablish communications. 

Because a Class 0 poll returns
static data for every DNP3 point
on the DNP3 Outstation, this
option has the potential to return
a high volume of data. High
traffic volumes can disrupt
network communications. This
option is typically only
recommended for DNP3
Outstations with a small number
of DNP3 points and no events. 

Event Poll The DNP3 Controlling Station
sends an event poll to
reestablish communications. 

Because the DNP3 Controlling
Station has to read the events
the DNP3 Outstation sends and
acknowledge them, this option
also has the potential to
generate high volumes of
network traffic that can disrupt
network communications. The
size of the response is
unpredictable as the response is
based on the number of events
in the DNP3 Outstation.

Event poll responses can be
delayed if the DNP3 Outstation
also reports events using
unsolicited responses. Use this
setting only when necessary.
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Set Time Indicates whether the DNP3
Controlling Station sets the
time in the DNP3
Outstation. 

Yes If the DNP3 Controlling Station
receives a DNP3 Outstation
response with the Time
Synchronization Required IIN
(IIN1.4) set, it sends a Delay
Measurement message followed
by a DNP3 Write Time message
to the DNP3 Outstation (object
50, variation 1).

No The DNP3 Controlling Station
does not set the time in the
DNP3 Outstation.

Default setting.

8.14.8.1.4 General Setup Parameters

This topic describes the Advanced Configuration General Setup parameters for DNP3
Outstations. These settings apply to every DNP3 Outstation in the Remote Devices table.

Parameter Parameter Description Setting Setting
Description

Update Points on
Successful
Command

Determines whether the DNP3 point value
in the DNP3 Controlling Station is updated
when a successful control status is
received from the DNP3 Outstation.

Consider disabling this parameter:

· If the DNP3 Outstation is configured to
send unsolicited control point states
using DNP3 Output Event objects. 

· If you want to poll the controlled states
along with input states before updating
the database in the DNP3 Controlling
Station.

When the box is checked,
the DNP3 point value is
updated in the DNP3
Controlling Station database.

Default: Checked (enabled)

Enable Command
Events on IED
Control Fail

Determines whether a DNP3 Outstation
adds DNP3 Output Command Events to
the event list regardless of the command
status. 

Enable this parameter if upstream DNP3
Controlling Stations support DNP3 Output
Command Events. This DNP3 Controlling
Station can then:

· Pass on output command events to
upstream DNP3 Controlling Stations if it

When the box is checked,
the DNP3 Outstation adds
DNP3 Output Command
Events to the event list
regardless of the command
status.

Default: Not checked
(disabled)



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

166

receives them from an intelligent
electronic device (IED).

· Generate its own output command
events when it receives a response with
a Control Fail status from an IED. This
can provide upstream DNP3 Controlling
Stations with more timely information
that downstream controls were
unsuccessful.

Stop Event
Polling if Buffer
Full

When this parameter is not checked and
the event buffers are filled, any new DNP3
events generated by the data concentrator
will over-write the oldest events in the
buffer. The data concentrator will maintain
communications with configured remote
devices. 

When this parameter is checked, and the
data concentrator DNP3 event buffers are
filled, any new DPN3 events generated by
the data concentrator will be discarded.
The data concentrator will suspend
communications with configured remote
devices except I/O expansion modules. 

Default: Not Checked
(disabled)

DNP3/TCP Keep-
Alive

The rate at which a DNP3 link status test
message is sent across active TCP
sockets to verify that the TCP link is
active.

Use this setting when the SCADAPack
x70 device connects to remote intelligent
electronic devices (IEDs) through DNP3
TCP/IP. 

The SCADAPack x70 device sends DNP3
Link Status requests to devices using
TCP transport, not UDP. The keep-alive
timer can help to recover from
communication stoppages, and to help
keep remote TCP sockets connected. 

When setting this timer, keep in mind that
the shorter the timer, the higher the
number of DNP3 Link Status messages.
Higher numbers of messages can
potentially affect communications costs.

The timer restarts each time DNP3 traffic
passes through the TCP socket. As a

0...6553
5
second
s (s)

0 = Deactivate the
timer.

Default: 1150
seconds.
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result, this timer is typically set to be
longer than the standard poll rate.

Security
Response
Timeout

The duration within which the DNP3
Controlling Station expects a response to
security authentication messages it sends
to DNP3 Outstations

1000...3
600000
millisec
onds
(ms)

DNP3 secure
authentication
message
exchange times
are typically
short. As a result,
the timeout
should only be as
long as the
latency of the
network and the
response times of
the devices. 

Setting a longer
timeout than is
necessary can
delay poll
requests and
disrupt network
operations.

Default: 2000 ms.

8.14.8.2 Managing Remote Points and Objects

When you add a remote device, a page with the same name as the Remote Device is created
under the Data Concentrator Client page. Use the Remote Device page to:

· Edit the device configuration

· Add remote points

· Remove remote points
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· Change remote point parameters

· Change DNP3 object parameters

· Clear the object association for a remote point

· Link a status and control object with an object association  

· Clear the object association for a status and control object

· Add the object association for a remote point

To access the Remote Device page, on the Configuration tab, select DNP3 > Data
Concentrator Client > Remote Device. The figure below shows an example Remote Device
page. To change the parameter settings for a remote points entry, double-click on the table row
to access the configuration parameters. 

170
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To edit the device configuration

1. In the Device Configuration section, click Edit Device.

2. Configure the Remote Device , Poll Rates  and Configuration  parameters, then click
Ok.

3. On the Data Concentrator page, click Apply.

To add remote points

1. In the Remote Points table, click Add Points.

2. Define the Remote Point Configuration  parameters, then click Ok.

3. In the Object Associations dialog, specify how to connect objects to the DNP3 remote
points.

· The default is Manually connect existing objects to the DNP3 remote points? When
this option is selected, the existing object associations are removed and no new
associations are created.

· If you select Automatically create and connect new objects to the DNP3 remote
points?, database objects are created corresponding to the Local Point Quantity specified.

o In the DNP3 Options section, if available, select one of the following:

§ Leave the DNP3 point numbers unassigned. When this option is selected, objects are
created, but no DNP3 point numbers are assigned.

§ Automatically assign DNP3 point numbers with the next available values

§ If you select Assign DNP3 point numbers sequentially, choose one of the following:

· For digital objects, enter the starting number in the Digital Input or Digital Output
field

· For analog objects, enter the starting number in the Analog Input or Analog Output
field

· For counter objects, enter the starting number in the Counter Input or Counter
Output field

o In the Modbus Options section, if available, determine how to assign Modbus

registers:

§ Leave Modbus registers unassigned. When this option is selected, objects are
created, but no Modbus registers are assigned. 

§ If you select Automatically assign Modbus registers with the next available values,
choose one of the following:

· For analog objects, choose one of the following: 

o read-only Input Registers

159 161 163
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o read/write Holding Registers

· For digital objects, choose one of the following:

o read-only Discrete Inputs

o read/write Discrete Coils

· For counter objects, choose one of the following:

o read-only Input Registers

o read/write Holding Registers

§ If you select Assign Modbus registers sequentially, enter one of the following:

· For analog objects, enter the starting number in the Analog field

· For digital objects, enter the starting number in the Digital field

· For counter objects, enter the starting number in the Counter field

o In the IEC 60870-5-104 Options section, if available, determine how to assign

Information Object Addresses (IOAs):

§  Leave IOAs unassigned. When this option is selected, objects are created, but no
IEC 60870-5-104 IOAs are assigned.

§  If you select the Automatically assign IOAs with the next available values option,
Monitoring Direction IOAs are automatically assigned to each created object, starting
at the first available Monitor Direction IOA address not already allocated to an object.

§ If you select the Assign IOAs sequentially starting from option, you can specify the
IOA for Monitor Direction for the first object. Monitor Direction IOAs are automatically
assigned to objects, sequentially, from this number.

4. Click OK.

5. On the Remote Device page, click Apply. 

By default, when an object is created or added, it is not automatically made available to the
SCADAPack x70 Logic Editor. You need to configure the Logic Variable Type. For more
information, see Changing the Object Configuration  and Assigning a Logic Variable and Task
to an Object .

To remove remote points

1. In the Remote Points table, select the table row(s) for the points, then click Remove Points.

2. Specify whether you want to delete the objects associated with the points, then click Yes to
remove the points entry.

To change remote point parameters

1. Double-click on the row in the Remote Points table to access the remote point parameters. 
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2. Edit the parameters.

3. Click OK.

4. In the Object Associations dialog, follow the steps for adding remote points . 

5. Determine if objects previously associated with DNP3 points will be deleted from the object
database by clicking the checkbox for Delete objects connected to DNP3 remote points. 

6. Click Ok.

When you change remote point ranges:

· DNP3 points for entries that are no longer in the remote point range are automatically
removed. You can specify whether the objects associated with the DNP3 points are also
deleted from the object database. If you are going to reassign the DNP3 point numbers, it may
make sense to keep the objects and reconfigure them if necessary rather than create new
objects to associate with the points.

· A database object is automatically created for each new entry in the remote point range. As
was the case when you initially added the remote point range, you can specify how the DNP3
point numbers are assigned to the database objects.

· The changes are automatically reflected in the Remote Points table on the Data Concentrator
page. 

To change DNP3 object parameters

· Double-click on the table row in the Object Associations table to access the object
configuration parameters. 

To clear the object association for a remote point

1. In the Object Associations table, select the point for which you want to remove the
association, then click Clear Association.

2. Specify whether you want to delete the object as well as the association, then click Yes.

3. On the Remote Device page, click Apply. 

To add the object association for a remote point

1. In the Object Associations table, double-click the row of the object where you want to add
the association. 

2. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list
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· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

3. Click Ok.

4. On the Remote Device page, click Apply. 

8.14.8.2.1 Configuring Status and Control for DNP3

Use the Status and Control Configuration table on the DNP3 > Data Concentrator Client >
Remote Device Name page to link a status and control object  with an object association
and to clear associations  for a status and control object. You can only clear object
associations if they have already been associated.

To change the parameter settings for a status and control object, double-click on the table row in
the Object Associations table to access the object configuration parameters. 

To link a status and control object with an object association

1. On the Configuration tab, select DNP3 > Data Concentrator Client > Remote Device
Name.

2. In the Remote Points table, select the entry for which you want to link status and control
objects.

3. In the Status and Control configuration section, double-click the row with the object.

4. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

5. Click Ok.

6. On the Remote Device page, click Apply. 

For details about the Status and Control objects, see Status and Control Object Details .

To clear the object association for a status and control object

1. On the Configuration tab, select DNP3 > Data Concentrator Client > Remote Device
Name.
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2. In the Remote Points table, select the entry for which you want to view status and control
objects. 

3. In the Status and Control Configuration section, select the object for which you want to clear
the association, then click Clear Associations. 

4. Click Yes.

5. On the Remote Device page, click Apply. 

8.14.8.2.2 Status and Control Object Details

Digital control objects for each device

Name Data
Type

Description
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Put Device In Service Digital This is a control object that can be used to either bring
the device online (into service by enabling the device) or
to manually put the device offline (out of service by
disabling the device). 

When this digital object is in the ON state (logic 1), the
appropriate device is put online.

When this digital object is in the OFF state (logic 0),
the appropriate device is put offline.

When remote devices are put offline, the DNP3
Controlling Station does not initiate communications
with the relevant device, and the value of the Device
Status object is Device is disabled. 

The Object Name is in the format
DNP3_DeviceName_PutInSrvc.

Force Event Poll Digital Pulsing this object with a “positive edge” transition will
invoke an event poll (class 1, 2, and 3) to the relevant
outstation.

The Object Name is in the format
DNP3_DeviceName_FrcEvtPoll.

Force Integrity Poll Digital Pulsing this object with a “positive edge” transition will
invoke an integrity poll (class 1, 2, 3, and 0) to the
relevant outstation.

The Object Name is in the format
DNP3_DeviceName_FrcIntPoll.

Force Warm Restart Digital Pulsing this object with a “positive edge” transition will
invoke a DNP3 Warm Restart request to the relevant
outstation.

The Object Name is in the format
DNP3_DeviceName_FrcWarmRst.

Force Cold Restart Digital Pulsing this object with a “positive edge” transition will
invoke a DNP3 Cold Restart request to the relevant
outstation.

The Object Name is in the format
DNP3_DeviceName_FrcColdRst.

Analog status objects for each device

Name Data
Type

Description
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Poll Count Analo
g

Indicates the number of ONLINE polls previously issued
to the device. That is, polls of the type determined by
the remote device “poll type” configuration, as well as
any other forced polls. This poll count does not include
health check polls that are issued after a device is
determined to be OFFLINE. The poll count value can be
reset by sending an analog output control to this object
(for example, from a DNP3 Controlling Station).

Use DINT (32-bit signed integer) data types to represent
the count value.

The Object Name is in the format
DNP3_DeviceName_PollCount.

Poll Response Error Count Analo
g

Indicates the number of unsuccessful polls to a
particular device, that is, the number of polls issued
with no response. Unlike the Poll Count status object,
the Poll Response Error Count does include
unsuccessful health check polls. This value can be
reset by sending an analog output control to this object
(for example, from a DNP3 Controlling Station).

Use DINT (32-bit signed integer) data types to represent
the count value.

The Object Name is in the format
DNP3_DeviceName_RespErrCnt.

Communication Status Analo
g

This read-only object represents the current status of
the outstation as seen by the DNP3 Controlling Station.

Valid status codes:

0 - Device not found

1 - Trying to contact device

2 - Initializing device

3 - Communications with device were unsuccessful

4 - Device is online

5 - Device is disabled

The Object Name is in the format
DNP3_DeviceName_CommStatus.

Unsolicited Response
Count

Analo
g

This Unsolicited Response Count object indicates the
number of unsolicited responses received by the DNP3
Controlling Station from a given device. NUL Unsolicited
Responses are included in this count. This object can
be reset by sending an analog output control to this
object (for example, from a DNP3 Controlling Station).
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The Object Name is in the format
DNP3_DeviceName_UnsolCount.

Last Reported Internal
Indication Flag

Analo
g

Stores the recently received Internal Indication (IIN) from
a particular outstation. The IIN is included in every
application layer response received from the device and
is used to indicate to the DNP Controlling Station-
specific device information, not necessarily related to
the preceding request. The IIN is a 16-bit field, where
each of the bits are assigned and well defined. 

See the DNP3 Internal Indication (IIN) Flags topic in the
SCADA Protocols Technical Reference manual

The Object Name is in the format
DNP3_DeviceName_IINFlags.

Poll 1 Countdown Timer

Poll 2 Countdown Timer

Poll 3 Countdown Timer

Poll 4 Countdown Timer

Analo
g

These read-only countdown timers report the time left in
seconds before the poll associated with the poll
countdown timer is sent. Once the relevant poll is sent,
the countdown timer object is restored with the poll
interval value.

Not all poll countdown timers are used for every poll
type. See Poll Rate(s)  parameters for more
information.

Background Poll - Poll 1, Poll 2

Ratio Poll - Poll 1, Poll 2

Static Only Poll - Poll 1

Class Poll / Time & IIN Class Poll / Time - Poll 1, Poll
2, Poll 3, Poll 4

The Object Name is in the format
DNP3_DeviceName_Poll<n>Timer.

8.14.8.2.3 Remote Point Configuration Parameters

The following table describes the Remote Point Configuration parameters for DNP3 Outstations.
You can only add Remote Points for Remote Devices that are listed in the Remote Devices
table . 

Parameter Parameter
Description

Setting Setting Description

Remote Point
Type

The type of
points on the
DNP3
Outstation. You

Digital Input Adds points with the selected type to the
Remote Points table.

Default: Digital Input
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need to create a
separate table
entry for each
point type.

Digital
Output

Analog Input

Analog
Output

Counter
Input

Remote Point
Number

The first DNP3 Outstation point number in the range that you want to add to
the Remote Points table. 

Local Point
Quantity

The number of points in the DNP3 Controlling Station that need to be mapped
to points on the DNP3 Outstation.

If these points do not already exist in the DNP3 Controlling Station, they are
created. 

8.15 Configuring Modbus Operation

SCADAPack x70 devices can operate as a:

· Modbus RTU Client

· Modbus RTU Server

· Modbus/TCP Client

· Modbus/TCP Server

· Modbus Store and Forward

· Realflo Flow Computer

Server operation

When the SCADAPack x70 device is operating as a Modbus RTU Server or Modbus/TCP Server,
it responds to requests from a Modbus RTU Client or Modbus/TCP Client. A Client can be
another SCADAPack or RTU, or it can be a different type of device, such as a SCADA host or
local human machine interface (HMI). For configuration details, see:

· Configuring Server Operation

Client operation

When the SCADAPack x70 device is operating as a Modbus RTU Client or a Modbus/TCP
Client, it requests information from a Modbus RTU Server or Modbus/TCP Server. A Server can
be another SCADAPack or RTU, or it can be a different type of device, such as a programmable
logic controller (PLC), or a smart device with Modbus protocol capability. For configuration
details, see:
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· Configuring Client Operation Using the Modbus Scanner

Store and Forward operation

A SCADAPack configured for Store and Forward operation, receives messages destined for an
Outstation on the Forward Interface. The SCADAPack forwards the message on the Forward
Interface to the Forward Station.

· Configuring Store and Forward Operation

Realflo Flow Computer

A SCADAPack configured as a Realflo Flow Computer measures natural gas or petroleum liquid
flow. For configuration details, see:

· Configuring Server Operation

Default operation

By default, each SCADAPack RemoteConnect project is configured for Modbus Server operation
and the relevant configuration parameters are displayed in the SCADAPack x70 configuration
software.

The configuration parameters for Modbus RTU Client, Modbus/TCP Client and Modbus/TCP
Server operation are only displayed if those settings are selected in the Project Settings .
These options are initially configured when you first create the project, but can be changed at
any time if you need the SCADAPack x70 device to perform different functions in your network.
For details, see Managing the Device Role in the Network .

8.15.1 Configuring Modbus RTU Server Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a Modbus RTU Server. Each step in the procedure below is described later in this
manual. Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 
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To configure the SCADAPack x70 device to operate as a Modbus RTU Server

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· Modbus Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select Serial Communication > Ports > Serial #  to configure
the physical connection to the Modbus RTU Clients(s).

5. On the Configuration tab, select Modbus > Server , then configure the:

· Modbus Server Address Mode , if you are using 6-digit Modbus addressing rather than
5-digit addressing.

6. On the Objects tab, select Object Configuration, then add database objects as
required .

For each SCADAPack x70 object that you want to access through the Modbus RTU Server,
configure the object's Modbus Register and Modbus Data Type. 

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.15.2 Configuring Modbus RTU Client Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a Modbus RTU Client. Each step in the procedure below is described later in this
manual. Follow the links for details. 

Before following the procedure below:

76

58

249

265

272

280

283

289

293

297

84

184

187

235



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

180

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a Modbus RTU Client

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select Serial Communication > Ports > Serial #  to configure
the physical connection to the Modbus RTU Server(s).

5. On the Configuration tab, select Modbus > Client  to add the Modbus RTU Servers and
Point Scanners.

6. On the Objects tab, select Object Configuration, then add database objects as
required .

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.
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8.15.3 Configuring Modbus/TCP Server Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a Modbus/TCP Server. Each step in the procedure below is described later in this
manual. Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a Modbus/TCP Server

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab

· Modbus Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connection to the Modbus/TCP Client. Select the Serial Communication option if you want to
make a TCP connection to the Modbus/TCP Client using a serial port.

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  
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5. On the Configuration tab, select Modbus > Server , then configure the:

· Unit Identifier

· Modbus Server Address Mode  if you are using 6-digit Modbus addressing rather than 5-
digit addressing.

6. On the Objects tab, select Object Configuration, then add database objects as
required .

For each SCADAPack x70 object that you want to access through the Modbus/TCP Server,
configure the object's Modbus Register and Modbus Data Type. 

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.15.4 Configuring Modbus/TCP Client Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as a Modbus/TCP Client. Each step in the procedure below is described later in this
manual. Follow the links for details. 

Before following the procedure below:

· Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the Configuring
Communication Parameters topic in the PC Communication Settings -SCADAPack
CommDTM manual before following the steps below.

· Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

· Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as a Modbus/TCP Client

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
device . 

2. If required, add any I/O modules that are connected to the SCADAPack x70 device .

3. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration Parameters

· Associations Tab
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· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. On the Configuration tab, select one or more of the following to configure the physical
connection to each Modbus/TCP Server. Select Serial Communication if you want to make a
TCP connection to the Modbus/TCP Server using a serial port.

· Serial Communication > Ports > Serial #

· IP Communication > Ethernet Ports > Ethernet #  

5. On the Configuration tab, select Modbus > Client  to add the Modbus/TCP Servers and
Point Scanners.

6. On the Objects tab, select Object Configuration, then add additional database objects as
required . 

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

8. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.15.5 Configuring Standard and Extended Addressing

Modbus serial communication and Modbus IP communication interfaces in SCADAPack x70
devices are configured with a Standard or Extended addressing mode and an address number
which is referred to as a Station Address or a Unit Identifier. The ranges of the address numbers
are as follows:

· Standard addresses: 1...254

· Standard or extended address: 255

· Extended addresses: 256...65534

Address 255 can be configured with either standard or extended mode. Standard address 255 is
different from extended address 255.

When configuring the station/unit addresses in Modbus Scanner and Store and Forward
parameters, the following configuration rules apply:

· If an address of a server/forward device is between 1 and 254, the addressing mode of the
client and server/forward communication interfaces can be either Standard or Extended.

· If the address of a server/forward device is 255, the addressing mode of the client
communications interface needs to be the same as the server/forward communications
interface.
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· If an address of a server/forward device is between 256 and 65534, the addressing mode of the
client communications interface and the server/forward communications interface needs to be
Extended.

8.15.6 Configuring Server Operation

Use the Modbus > Server page to define how the Modbus RTU Server or Modbus/TCP Server
communicates with the Modbus RTU Client or Modbus/TCP Client. 

To configure the Modbus RTU Server or Modbus/TCP Server connection to
the Client

1. On the Configuration tab, select Modbus > Server.

If you are not using Realflo Flow Computer, the following is displayed:

If you are using Realflo Flow Computer, the following is displayed:
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2. Configure the Modbus/TCP Server  parameters.

3. If required, display the Advanced Configuration parameters to view the Modbus/TCP
Server  parameter or change the Modbus Broadcast  and  Modbus/TCP Server and
Modbus/RTU Server  parameters.

4. On the Server page, click Apply. 

8.15.6.1 Modbus Server Basic Parameters

The following table describes Modbus/TCP Server parameters.

Parameter Parameter Description Setting Setting Description

Addressing Selects standard or
extended addressing mode

For addressing mode
information, see:
Configuring Standard and
Extended Addressing .

Standard
(default)

Modbus unit identifiers include
1...255

Extended Modbus unit identifiers include
1...65534

Unit Identifier The Modbus/TCP Server
address.

· Standard
addressing:

Default: 1
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1...255

· Extended
addressing:
1...65534

Inactivity
Timeout

The Modbus/TCP Server
will close incoming
connections after there has
been no activity for the time
set. 

60...86400
seconds (s)

Default: 60 s

Enron
Modbus

When checked, the Enron
Unit Identifier field is
enabled

Available only when the Realflo
Flow Computer option is
configured

Default: Unchecked

Enron Unit
Identifier

The Enron Modbus address · Standard
addressing:
1...255

· Extended
addressing:
1...65534

Default: 2

Available only when the Realflo
Flow Computer option is
configured

Enabled only when Enron
Modbus is checked

The Enron Unit Identifier needs
to be different than the Unit
Identifier for each port. 

8.15.6.2 Modbus Server Advanced Parameters

The following table describes the Modbus/TCP Server parameter.

Parameter Parameter Description Setting Setting Description

TCP Server
Port

The TCP port on which the
Modbus/TCP Server listens
for incoming connections
from the Modbus/TCP
Client. 

502 Default: 502

Valid values: 1...65535 

The following table describes the Modbus Broadcast parameter.

Parameter Parameter Description Setting Setting Description

Modbus
Broadcast

Enables handling of Modbus
broadcast station address

No Default: No



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

187

Enabled 0. Yes No

· Modbus broadcast station
address 0 is not handled by
Modbus RTU server nor Store
and Forward or logic

Yes

· Modbus broadcast station
address 0 is handled by
Modbus RTU server

· Modbus broadcast station
address 0 is allowed on serial
interfaces in Store and
Forward entries.

· Modbus broadcast station
address 0 is allowed to be
used by logic using Modbus
function blocks.

See the  in the SCADA
Protocols Technical Reference
manualModbus Broadcast topic
in the SCADA Protocols
Technical Reference manual for
details.

The following table describes the Modbus/TCP Server and Modbus RTU Server parameters.

Parameter Parameter Description Setting Setting Description

Modbus
Server
Address
Mode

The Modbus addressing
mode used by the
Modbus/TCP Server or
Modbus RTU Server.

Select the addressing mode
that matches the mode
used by the Modbus/TCP
Client or Modbus RTU
Client. 

5 Digits The Modbus/TCP Server or
Modbus RTU Server uses 5-
digit addressing.

In 5-digit Modbus addressing,
the leading digit generally
represents the register data
type. For example, if a
SCADAPack x70 device reads
Modbus register 40010, it is
represented by Modbus
protocol function code 3 and
protocol register address
0x0009.

Default
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6 Digits The Modbus/TCP Server or
Modbus RTU Server uses 6-
digit addressing.

In 6-digit Modbus addressing,
the address is composed of a
single-digit numeric prefix and a
5-digit Modbus register number
to enable access to additional
registers in each register
range. 

Byte
Ordering for
32-bit
Values

Determines how UDINT,
DINT, and REAL data from
objects is converted into
Modbus register data.

The setting configures the
order of the bytes for
register values received or
sent by a Modbus RTU
Server or Modbus/TCP
Server. 

Select the byte order and
word order combination that
matches the order expected
by the Modbus RTU Client
or Modbus/TCP Client that
is polling the RTU. 

The order you select is used
for 32-bit register values.

· 2 bytes (1 word) are
contained in the first
register, and 2 bytes (1
word) are contained in the
second 

High byte/Low
word first
(3412)

High byte/High
word first
(1234)

Low byte/High
word first
(2143)

Low byte/Low
word first
(4321)

The numbers 1, 2, 3, and 4
represent the 4 bytes in a 32-bit
register value.

· High byte/Low word first

o Sends 32-bit values in byte

order 3412

o Default setting

o Select this setting to

emulate SCADAPack
300E RTUs

· High byte/High word first

o Sends 32-bit values in byte

order 1234

o Default setting if Realflo is

enabled

o Select this setting to

emulate SCADAPack 32
and SCADAPack 300
RTUs

· Low byte/High word first

o Sends 32-bit values in byte

order 2143

· Low byte/Low word first

o Sends 32-bit values in byte

order 4321

Swap Word
Order for
32-bit
Integers

Telepace firmware has a
different word order for floats
and long integers. 

A SCADAPack x70 device
replacing a SCADAPack

No

Yes

· No

o Long integers have the

same byte order as floats

o Default setting for newly

created projects with
Realflo disabled
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3xx or 32 needs to behave
in the same way. 

This setting defines if the 4
byte long integer data needs
to be word swapped.This
only happens for 32 bit long
integer values, not for floats.
For example, a configured
byte order 1234 becomes
3412 for long integers only.

o Select this setting to

emulate SCADAPack 32
and SCADAPack 300
RTUs with ISaGRAF
firmware

o Select this setting to

emulate SCADAPack
300E RTUs

· Yes

o Words for long integers are

swapped

o Default setting for newly

created projects with
Realflo enabled

o Select this setting to

emulate SCADAPack 32
and SCADAPack 300
RTUs with Telepace
firmware

8.15.7 Configuring Client Operation Using the Modbus Scanner

Use the Modbus scanner for configurable polling.

Alternatively, you can use the Modbus function blocks in the SCADAPack x70 Logic Editor. See
the Modbus function blocks topics in the Function Blocks Technical Reference manual.

Use the Modbus > Client page to:

· Add Modbus RTU Server or Modbus/TCP Server devices for this Modbus RTU Client 

· Remove a Modbus Server

· View the Number of Modbus Scanner Objects

o The Number of Modbus Scanner Objects field shows you how many objects are currently

mapped. The maximum number of Modbus scanner objects mapped from Modbus devices
is 3000. 

When the devices are added:

· Add the scanners for each Modbus RTU Server or Modbus/TCP Server

· Configure Status and Control
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TCP connections are state based. The SCADAPack x70 device supports a finite number of
these state based connections. These connections are also shared with open files on the file
system. A total of 200 simultaneous TCP connections and open files across all IP capable ports
and all file systems are permitted. Once the limit is reached, new requests will be denied until
older TCP connections time out or are closed due to SCADA protocol retry failures.

Options to reduce the number of state based connections include UDP communications or TCP
network layouts that locate multiple Modbus or DNP3 devices at the same IP address from the
perspective of the SCADAPack x70 device.

The following table lists the maximums for Client operation.

Item Maximum Number

Maximum Modbus Server devices (polled by the SCADAPack
when it is operating as a Client)

If a logic application needs more than 150 Modbus Server
devices, use the Modbus function blocks (see the Function
Blocks Technical Reference manual) instead of the Modbus
Scanner. 

150

Maximum number of scanner objects mapped from Modbus
devices (using any Modbus RTU Client, Modbus/TCP Client,
Modbus RTU in UDP Client, or Modbus RTU in TCP Client
connections) 

3000

The configuration parameters for Client operation are only displayed if Modbus RTU Client or
Modbus/TCP Client is selected in the Project Settings . These options are initially configured
when you first create the project, but can be changed at any time if you need the SCADAPack
x70 device to perform different functions in your network. For details, see Managing the Device
Role in the Network .

8.15.7.1 Working with Remote Devices

Use the Modbus Server Devices table on the Modbus > Client page to add, configure ,
edit ,and remove  Modbus Server devices for this Modbus Client. 

When you add a Modbus Server device, a page with the same name as the Modbus Server is
created under the Client page. Use the Modbus Server device page to manage the remote points
and their object associations after the points are added. For details, see:

· Managing Modbus Scanners
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· Configuring Status and Control for Modbus

To change the parameter settings for a Modbus Server device, do one of the following:

· Double-click on the table row to access the configuration parameters

· Navigate to Modbus > Client > Device Name and click Edit Device 

The procedure below describes how to add a Modbus Server device. To change the parameter
settings for a Modbus Server device that is already in the Modbus Server Devices table, double-
click on the table row to access the configuration parameters. 

If you are configuring Modbus RTU Client operation, verify that at least one serial port Port
Function parameter is set to Modbus before beginning this procedure.

To add and configure a Modbus Server 

1. In the Modbus Server Devices table, click Add Device.

2. Configure the Device Name , Communication  and Configuration  parameters, then
click Ok. 

3. To assign or change the DNP3 point number or IEC 60870-5-104 IOA assigned to an object,
use the Object Editor as described in Changing the Object Configuration .

4. On the Client page, click Apply.

192

192 194 196

301



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

192

To remove a Modbus Server

1. In the Modbus Server Devices table, select the device(s) that you want to remove, then click
Remove Devices. 

2. Specify whether you want to delete the object(s) associated with the device, then click Yes
to remove the device entry.

When you remove a remote device, the corresponding status and control objects are also
removed. 

8.15.7.1.1 Device Name Parameter

The following table describes the Device Name parameter.

Parameter Parameter Description Setting Description

Device Name A name for the device that will
act as a Modbus RTU Server
or Modbus/TCP Server. 

The name is used to identify
the device in the Modbus
Server Devices table.

The name is mandatory.

1...14 characters with no spaces.

The name can include letters, numbers,
hyphens, and underscores. 

Default: ServerDevice#

8.15.7.1.2 Configuring Status and Control for Modbus

Use the Status and Control Configuration table on the Modbus > Client > Modbus Server
Device Name page to link a status and control object  with an object association and to clear
associations  for a status and control object. You can only clear object associations if they
have already been associated.

To change the parameter settings for a status and control object, double-click on the table row in
the Object Associations table to access the object configuration parameters. 

To link a status and control object with an object association

1. On the Configuration tab, select Modbus > Client > Modbus Server Device Name.

2. In the Modbus Scanners table, select the entry for which you want to link status and control
objects.

3. In the Status and Control configuration section, double-click the row with the object.

4. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

192
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· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

5. Click Ok.

6. On the Remote Device page, click Apply. 

For details about the Status and Control objects, Status and Control Object Details .

To clear the object association for a status and control object

1. On the Configuration tab, select Modbus > Client > Modbus Server Device Name.

2. In the Modbus Scanners table, select the entry for which you want to view status and control
objects. 

199



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

194

3. Select the object for which you want to clear the association, then click Clear Associations.
 

4. Click Yes.

5. On the Modbus Server Device page, click Apply. 

8.15.7.1.3 Communication Parameters

The following table describes the Communication parameters.

Parameter Parameter Description Setting Setting Description



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

195

Device
Type

The protocol used on the
communication link between
the SCADAPack x70 device
and the Modbus RTU Server
device or the Modbus IP Server
service.

The option you select here
needs to correspond to the
Ethernet device configuration.

To change the Modbus Device
Type after it has been added,
you need to delete the device
then recreate it with the new
Modbus Device Type.

The remaining Communication
parameters depend on the
protocol you select.

The standard addressing or
extended addressing below is
the addressing mode
configured for the selected
device type.

For addressing mode
information, see: Configuring
Standard and Extended
Addressing .

Modbus/TCP Requires Modbus IP
Clients to be set in
Project Settings

Default

Modbus RTU Serial Requires Modbus RTU
Client to be set in
Project Settings

Modbus RTU over
TCP

Requires Modbus IP
Clients to be set in
Project Settings

Modbus RTU over
UDP

Requires Modbus IP
Clients to be set in
Project Settings

Unit
Identifier 

The Modbus/TCP Server device
address.

· Standard
addressing:
1...255

· Extended
addressing:
1...65534

Default: 1

Device
Address

The device address of the
Modbus RTU Server. Available
only when the Device Type is
one of:

· Modbus RTU Serial

· Modbus RTU over TCP

· Modbus RTU over UDP

· Standard
addressing:
1...255

· Extended
addressing:
1...65534

Default: 0

IP Address The IP address of the Modbus
IP Servers.

Standard IP address
format

Default: Empty

183
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Available only when the Device
Type is set to:

· Modbus/TCP

· Modbus RTU over TCP

· Modbus RTU over UDP

Device
Listen Port 

The port on which the Modbus
IP Server device listens, and to
which communications from
the SCADAPack x70 device
are sent. 

Available only when the Device
Type is set to:

· Modbus/TCP

· Modbus RTU over TCP

· Modbus RTU over UDP

0...65535 Defaults:

Device
Type

Device
Listen
Port

Modbus/
TCP

502

Modbus
RTU over
TCP

49152

Modbus
RTU over
UDP

49152

SCADAPac
k Serial
Port 

A list of the SCADAPack x70
serial ports. 

Available only when Modbus
RTU Client is enabled in
Project Settings  and Device
Type is set to Modbus RTU
Serial.

Serial # Select the serial port
that you want to use
for communications
with the Modbus RTU
Server device.

A red exclamation
mark next to the
parameter indicates
that the SCADAPack
x70 device Port
function for the
selected serial port is
not set to Modbus.  

8.15.7.1.4 Configuration Parameters

The following table describes the Configuration parameters.

Parameter Parameter Description Setting Setting Description

Timeout The amount of time the Modbus
RTU Client or Modbus/TCP Client
waits before considering

0...65530
milliseco
nds (ms)

Default values:

· Modbus/TCP: 1000 ms

42
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communications with the device
to be interrupted.

· Modbus Serial RTU: 1000
ms

· Modbus RTU over TCP:
1000 ms

· Modbus RTU over UDP:
1000 ms

Maximum
Consecutive
Timeouts

The number of consecutive
communications interruptions that
can occur between the Modbus
RTU Client and Modbus RTU
Server or the Modbus/TCP Client
and the Modbus/TCP Server
before communications is
considered to be down.

If the Maximum Consecutive
Timeouts is exceeded, and the
Default Scan Rate is set faster
than 15000 ms (15 seconds), the
scan rate is automatically slowed
to 15 seconds to accommodate
the ongoing communications
interruptions. 

0...65535 Default: 3

Default Scan
Rate

The time interval at which the
Modbus RTU Client or
Modbus/TCP Client checks for
changes on this device.

If the Maximum Consecutive
Timeouts is exceeded, and the
Default Scan Rate is set faster
than 15000 ms (15 seconds), the
scan rate is automatically slowed
to 15 seconds to accommodate
the ongoing communications
interruptions. The Scan Rate
column in the Modbus Server
Devices table continues to
display the configured Default
Scan Rate.

The scan rate returns to the
configured Default Scan Rate
after the first successful scan and
response.

10...9999
99999
milliseco
nds (ms)

Default values:

· Modbus/TCP: 500 ms

· Modbus Serial RTU: 500 ms

· Modbus RTU over TCP: 500
ms

· Modbus RTU over UDP: 500
ms

Register
Addressing

The Modbus addressing mode the
Modbus/TCP Client or Modbus
RTU Client uses to communicate

5 digit The Modbus/TCP Client or
Modbus RTU Client uses 5-
digit addressing to
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with the Modbus RTU Server or
Modbus/TCP Server.

Select the addressing mode that
matches the mode used by the
Modbus RTU Server or
Modbus/TCP Server.

Modbus register addressing is
configurable only when adding a
new Modbus Server device.

communicate with the Modbus
RTU Server or Modbus/TCP
Server.

In 5-digit Modbus addressing,
the leading digit generally
represents the register data
type. For example, Modbus
register 40010 is represented
by Modbus protocol function
code 3 and protocol register
address 0x0009.

Default setting

6 digit The Modbus/TCP Client or
Modbus RTU Client uses 6-
digit addressing to
communicate with the Modbus
RTU Server or Modbus/TCP
Server.

In 6-digit Modbus addressing,
the address is composed of a
single-digit numeric prefix and
a 5-digit Modbus register
number to enable access to
additional registers in each
register range. 

Write Coils The Modbus request function
code (FC) sent to the Modbus
RTU Server or Modbus/TCP
Server to be scanned. The Server
needs to support this FC.

Multiple
(FC 15) 

Sends requests to write
multiple coils to the Modbus
RTU Server or Modbus/TCP
Server

Default setting

Single
(FC 5)

Sends requests to write a
single coil to the Modbus RTU
Server or Modbus/TCP Server

Write
Holding
Registers

The Modbus request function
code (FC) supported by the
Modbus RTU Server or
Modbus/TCP Server to be
scanned.

Multiple
(FC 16) 

Sends requests to write
multiple holding registers to
the Modbus RTU Server or
Modbus/TCP Server

Default setting

Single
(FC 6)

Sends requests to write a
single holding register to the
Modbus RTU ServerV or
Modbus/TCP Server
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Modbus
Byte Order

The order of the bytes exchanged
with a Modbus RTU Server or
Modbus/TCP Server.

Select the byte order and word
order combination that matches
the order used on the Modbus
RTU Server or Modbus/TCP
Server.

The order you select is used for
32-bit and 16-bit register values,
but the second part of the
selection — the word order — is
not used for 16-bit values
because these values consist of
just 2 bytes, or 1 word.

· For 32-bit register values, 2
bytes (1 word) are contained in
the first register, and 2 bytes (1
word) are contained in the
second register. 

· For 16-bit register values, the 2
bytes (1 word) are contained in
the only register. A second
register is not required.

In the setting description, the
numbers 1, 2, 3 and 4 represent
the 4 bytes in a 32-bit register
value

High
byte/Low
word first

Exchanges 32-bit values in
byte order 3412

Exchanges 16-bit values in
byte order 12

Default setting

High
byte/Hig
h word
first

Exchanges 32-bit values in
byte order 1234

Exchanges 16-bit values in
byte order 12

Low
byte/Hig
h word
first

Exchanges 32-bit values in
byte order 2143

Exchanges 16-bit values in
byte order 21

Low
byte/Low
word first

Exchanges 32-bit values in
byte order 4321

Exchanges 16-bit values in
byte order 21

Modbus Bit
Order

The order of the bits in each byte
exchanged with a Modbus RTU
Server or Modbus/TCP Server.
The bit order selection is applied
to every byte that is sent
regardless of the byte order.

Select the bit order that matches
the order used on the Modbus
RTU Server or Modbus/TCP
Server.

Most
significan
t bit first

Exchanges bits in the order
1...8

Default setting

Least
significan
t bit first

Exchanges bits in the order
8...1

8.15.7.1.5 Status and Control Object Details

The table below describes the status and control details for each object.

Name Data
Type

Description
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Message Count Analo
g

The number of messages that have been exchanged
with the selected Modbus device, including forced reads
and writes.

Use DINT (32-bit signed integer) data types to represent
the count value.

Reset this counter by changing the value of the object
to zero using the Object Value column of the Object
Browser.

The Object Name is in the format
MBUS_DeviceName_MsgCount.

Message Error Count Analo
g

The number of unsuccessful messages sent to the
selected Modbus device. A message is considered
unsuccessful when the Modbus device does not
respond within the configured timeout a number of
times consecutively, as configured by the Maximum
Consecutive Timeouts  parameter.

Use DINT (32-bit signed integer) data types to represent
the count value.

Reset this counter by changing the value of the object
to zero using the Object Value column of the Object
Browser.

The Object Name is in the format
MBUS_DeviceName_MsgErrCnt.

Communication Status Analo
g

The read-only current state of communications with the
Modbus RTU Server or Modbus/TCP Server.

Valid status codes:

0 - Device not found

1 - Trying to contact device

2 - Initializing device

3 - Communications with device were unsuccessful

4 - Device is online

5 - Device is disabled

The Object Name is in the format
MBUS_DeviceName_CommStatus. 

Default Read Scan
Countdown Time

Analo
g

The number of seconds remaining until read operations
are executed on the selected Modbus device. 

Typically, the configured Scan Rate determines the
Next Default Scan Time. However, in certain cases
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where there are ongoing communications interruptions,
the Scan Rate is automatically set to 15 seconds. For
details, see Default Scan Rate .

To define the Default Scan Rate for a device, use the
Modbus Server Devices table. 

To define the Scan Rate for specific registers on the
device, use the Modbus Scanners table.

To update this value, change the value using the Object
Value column of the Object Browser.

The Object Name is in the format
MBUS_DeviceName_RdScanTimr.

Default Write Scan
Countdown Time

Analo
g

The number of seconds remaining until write operations
are executed on the selected Modbus device. 

Typically, the configured Scan Rate determines the
Next Default Scan Time. However, in certain cases
where there are ongoing communications interruptions,
the Scan Rate is automatically set to 15 seconds. For
details, see Default Scan Rate .

To define the Default Scan Rate for a device, use the
Modbus Server Devices table. 

To define the Scan Rate for specific registers on the
device, use the Modbus Scanners table.

To update this value, change the value using the Object
Value column of the Object Browser.

The Object Name is in the format
MBUS_DeviceName_WrScanTimr.

Put Device in Service Digital Set this digital object to a value of 1 to bring the
selected Modbus RTU Server or Modbus/TCP Server
online for communications. When the Modbus device is
online, the Modbus RTU Client or Modbus/TCP Client
scans the defined registers and updates status
information at the Scan Rate.

Set this digital object to a value of 0 to take the
selected Modbus device offline. When the Modbus
device is offline, the Modbus RTU Client or
Modbus/TCP Client does not scan its registers or
update its status information.

The Modbus device needs to be online to enable read or
write communications.

The Object Name is in the format
MBUS_DeviceName_PutInSrvc.
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Force All Reads Digital To request a spontaneous scan of Modbus registers
with the Operation parameter set to Read, write a value
of 1 to the appropriate digital object.

The Object Name is in the format
MBUS_DeviceName_FrcAllRds.

Force All Writes Digital To request a spontaneous scan of Modbus registers
with the Operation parameter set to Write, write a value
of 1 to the appropriate digital object.

The Object Name is in the format
MBUS_DeviceName_FrcAllWrs.

Enable All Reads Digital Set this digital object to a value of 1 if you want the
Modbus RTU Client or Modbus/TCP Client to read
Modbus registers that are configured for Read
operations.

Set this digital object to a value of 0 if you want to
disable read operations on the selected Modbus
device. 

The Object Name is in the format
MBUS_DeviceName_EnblAllRds.

Enable All Writes Digital Set this digital object to a value of 1 if you want the
Modbus RTU Client or Modbus/TCP Client to write to
Modbus registers that are configured for write
operations.

Set this digital object to a value of 0 if you want to
disable write operations on the selected Modbus
device. 

The Object Name is in the format
MBUS_DeviceName_EnblAllWrs.

8.15.7.2 Managing Modbus Scanners

When you add a Modbus Server Device, a page with the same name as the Server Device is
created under the Client page. Use the Server Device page to:

· Edit the device configuration

· Add scanners

· Remove scanners

· Change scanner parameters

· Change Modbus object parameters

· Clear the object association for a scanner

· Add the object association for a scanner
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To access the Server Device page, on the Configuration tab, select Modbus > Client > Server
Device. The figure below shows an example Server Device page. Every procedure in this topic
starts on this page. To change the parameter settings for a scanner entry, double-click on the
table row to access the configuration parameters. 

To edit the device configuration

1. In the Device Configuration section, click Edit Device.

2. Configure the Device Name , Communication  and Configuration  parameters, then
click Ok. 

3. On the Client page, click Apply.
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To add scanners

1. In the Modbus Scanners table, click Add Scanners.

2. Configure the Modbus Scanners  and Configuration  parameters, then click Ok.

3. In the Object Associations dialog, specify how to connect objects to the Modbus Scanners.

· The first time this window opens, the default is Manually connect existing objects to
the Modbus Scanners? When this option is selected, the existing object associations
are removed and no new associations are created. The next time this window opens, the
previously selected options are displayed. 

· If you select Automatically create and connect new objects to the Modbus
Scanners?, a new database object is automatically created for each entry in the scanner
range.

o In the DNP3 Options section, if available, select one of the following:

§ Leave the DNP3 point numbers unassigned. When this option is selected, objects are
created, but no DNP3 point numbers are assigned.

§ Automatically assign DNP3 point numbers with the next available values

§ If you select Assign DNP3 point numbers sequentially, choose one of the following:

· For digital objects, enter the starting number in the Digital Input or Digital Output
field

· For analog objects, enter the starting number in the Analog Input or Analog Output
field

· For counter objects, enter the starting number in the Counter Input or Counter
Output field

o In the Modbus Options section, if available, determine how to assign Modbus

registers:

§ Leave Modbus registers unassigned. When this option is selected, objects are
created, but no local Modbus register attributes are assigned to the object. 

§ If you select Automatically assign Modbus registers with the next available values,
choose one of the following:

· For analog objects, choose one of the following: 

o read-only Input Registers

o read/write Holding Registers

· For digital objects, choose one of the following:

o read-only Discrete Inputs

o read/write Discrete Coils

· For counter objects, choose one of the following:
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o read-only Input Registers

o read/write Holding Registers

§ If you select Assign Modbus registers sequentially, enter one of the following:

· For analog objects, enter the starting number in the Analog field

· For digital objects, enter the starting number in the Digital field

· For counter objects, enter the starting number in the Counter field

o In the IEC 60870-5-104 Options section, if available, determine how to assign

Information Object Addresses (IOAs):

§  Leave IOAs unassigned. When this option is selected, objects are created, but no
IEC 60870-5-104 IOAs are assigned.

§  If you select the Automatically assign IOAs with the next available values option,
Monitoring Direction IOAs are automatically assigned to each created object, starting
at the first available Monitor Direction IOA address not already allocated to an object.

§ If you select the Assign IOAs sequentially starting from option, you can specify the
IOA for Monitor Direction for the first object. Monitor Direction IOAs are automatically
assigned to objects, sequentially, from this number.

4. Click Ok.

5. On the Modbus Server Device page, click Apply. 

By default, when an object is created or added, it is not automatically made available to the
SCADAPack x70 Logic Editor. You need to configure the Logic Variable Type. For more
information, see Changing the Object Configuration  and Assigning a Logic Variable and Task
to an Object .

To remove scanners

1. In the Modbus Scanners table, select the table row(s) for the scanner(s), then click Remove
Scanners.

2. In the Remove Entry window, specify whether you want to delete the objects connected to
Modbus Scanners.

3. Click Yes to remove the scanner entry.

To change scanner parameters

1. Double-click on the row in the Modbus Scanners table to access the scanner parameters. 

2. Edit the parameters.

3. Click OK.

4. In the Object Associations dialog, follow the steps for adding scanners . 
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5. Determine if objects previously associated with Modbus scanners will be deleted from the
object database by clicking the checkbox for Delete objects connected to Modbus
Scanners. 

6. Click Ok.

When you change scanner ranges:

· Objects previously associated with the scanners are removed. You can specify whether the
objects are also deleted from the object database. If you want to reassign the objects, you
may want to keep the objects and reconfigure them, if necessary, rather than create new
objects. 

· The changes are automatically reflected in the Modbus Scanners table on the Client page. 

To change Modbus object parameters

· Double-click on the table row in the Object Associations table to access the object
configuration parameters. 

To clear the object association for a scanner

1. In the Object Associations table, select the object(s) for which you want to remove the
association, then click Clear Associations.

2. In the Remove Entry window, specify whether you want to delete the objects connected to
Modbus Scanners.

3. Click Yes.

4. On the Modbus Server Device page, click Apply. 

To add the object association for a scanner

1. In the Object Associations table, double-click the row of the object where you want to add
the association. 

2. In the Object Associations window, select one of the following 

· Associate with new object

o Edit the default name, if needed

· Associate with existing object

o Select the Object Name from the drop-down list

· Associate with object in group

o Select the Group and the Object Name from the drop-down lists

3. Click Ok.

4. On the Modbus Server Device page, click Apply. 
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8.15.7.2.1 Modbus Scanners Parameters

The following table describes the Modbus Scanners parameters. You can only add Modbus
Scanners for devices that are listed in the Modbus Server Devices table .

Parameter Parameter Description Setting Setting Description

Operation The type of operation performed
on the selected Modbus RTU
Server or Modbus/TCP Server.

Read Reads the specified
registers. Default setting.

Write Writes to the specified
registers.

Read/Write Reads from and writes to
the specified registers. The
only Write Output
available is On change.

If objects are not forced:

· at start up, reads from
the remote device and
updates the associated
objects before writing to
the remote device

· writes to the remote
device when the object
values change

If objects are forced:

· at start up, writes the
forced value to the
remote device

· writes to the remote
device when the object
values change

Operation for
Offline
Devices

When Operation is set to
Read/Write, you can specify
which requests the Modbus
RTU Client or Modbus/TCP
Client sends when the Modbus
RTU Server or Modbus/TCP
Server is offline.

Requests are sent to offline
devices at the defined scan
rate. 

Send read
requests

Sends read requests to the
Server at the scan rate
specified for the device, or
at the scan rate specified
for the point scanner if that
scan rate is different than
the device scan rate.

Default setting.
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When Operation is set to
Read or Write, Operation for
Offline Devices is disabled. 

Send write
requests

Sends write requests to
the Server after a change in
value or after a write
command from another
source.

If a write request is sent
while a read request is still
in progress, the value of
database objects that are
part of both requests is not
updated. 

If a write request is sent
while there are buffered
read requests for that point
scanner, the buffered read
requests are canceled. If a
read request is in progress,
it continues.

Write Outputs When Operation is set to
Write, you can specify how
often the Modbus RTU Client or
Modbus/TCP Client writes
changes to the Modbus RTU
Server or Modbus/TCP Server.

When Operation is set to
Read, Write Outputs is
disabled. 

When Operation is set to
Read/Write, you can specify
the On Change setting.

At scan rate Changes are written at the
time of the next scan.

Default setting.

On change Changes are written only
after a change in value, or
after a write command for
the mapped points is
received from another
source.

Default setting when
Operation is Read/Write

On change
and at scan
rate

Changes are written after a
change in value or a write
command from another
source, as well as at every
scan.

Unsuccessful
Write
Operations

When Operation is set to
Read/Write, you can specify
how database object values are
treated when a write operation
is unsuccessful.

When Operation is set to
Read or Write, Unsuccessful
Write Operations is disabled. 

Revert point
values 

Returns database objects
to their previous value when
the write operation is
unsuccessful.

Default setting.

Retain point
values

Keeps the current values
for database objects when



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

209

the write operation is
unsuccessful.

8.15.7.2.2 Modbus Configuration Parameters

The following table describes the Modbus Configuration parameters. You can only add Modbus
Scanners for devices that are listed in the Modbus Server Devices table .

Parameter Parameter Description Setting Setting Description

Modbus Data
Type

The type of data contained in
the Modbus registers.

Discrete
(Digital)

Discrete

Applies to Object Type:
Digital

UINT (Digital) Unsigned integer

Applies to Object Type:
Digital

Valid only for versions 2.6.1
and newer

UINT
(Analog)

Unsigned integer

Default setting

Applies to Object Type:
Analog

INT Integer

Applies to Object Type:
Analog

DINT Double integer

Applies to Object Type:
Analog

REAL
(Floating
Point)

Real

Applies to Object Type:
Analog

UINT
(Counter)

Unsigned integer

Applies to Object Type:
Counter

UDINT Unsigned double integer
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Applies to Object Type:
Counter

Modbus
Register Start
Address

The first address in the Modbus
register range that you want
scanned.

5 digit

· 1...9999

· 10001...19
999

· 30001...39
999

· 40000...49
999

6 digit

· 1...65536

· 100001...1
65536

· 300001...3
65536

· 400001...4
55536

Valid registers for Modbus
data type:

Discrete

· 1...9999

· 10001...19999

· 1...65536

· 100001...165536

INT, UINT, DINT, REAL

· 30001...39999

· 40000...49999

· 300001...365536

· 400001...455536

Modbus
Register
Quantity

The total number of Modbus
registers that you want to be
scanned and mapped. 

This parameter is only
configurable after a valid
Modbus Register Start Address
is entered. It is automatically
updated based on the Modbus
Data Type. For example, DINT
and REAL data types require
twice as many Modbus
Registers as UINT or INT data
types.

1...3000 Each Modbus Scanner
entry can have up to 1000
registers at one time, to a
maximum of 3000 registers
across all entries.

The maximum quantity of
registers for each UINT
(Digital) is 64. 

Object Type This read-only field shows the
type of database object that
you want the specified Modbus
registers mapped to. The
setting is determined by the
Modbus Data Type selection. 

Analog 

Default
setting

When the Modbus Data
Type is set to one of the
following:

· UINT (Analog)

· INT

· DINT

· REAL (Floating Point)



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

211

Digital When the Modbus Data
Type is set to:

· Discrete (Digital)

· UINT (Digital)

Counter When the Modbus Data
Type is set to one of the
following:

· UINT (Counter)

· UDINT

Scan Rate Set this scan rate only if you
want the Modbus registers
specified in this dialog box to
have a different scan rate than
the Modbus RTU Server or
Modbus/TCP Server on which
they reside. 

0...99999999
9
milliseconds
(ms)

Sets the rate at which this
point scanner will send
requests. To use the
default scan rate of the
Modbus device, leave this
value as the default setting
of 0. See Default Scan
Rate .

Timeout Set this timeout only if you
want the Modbus registers
specified in this dialog box to
have a different timeout than
the Modbus RTU Server or
Modbus/TCP Server on which
they reside. 

0...65535
milliseconds
(ms)

Sets the timeout for point
scanner requests. To use
the default timeout of the
Modbus device, leave this
value as the default setting
of 0. See Timeout .

8.15.8 Configuring Store and Forward Operation

Use the Store and Forward operation to add a new route entry or edit an existing route entry in
the Store and Forward table.  A maximum of 128 Modbus Store and Forward operations can be
added. 

Modbus Store and Forward operation is required on systems where there is no direct Modbus
link between a host computer and the remote sites. This can occur in radio networks where the
host computer transmission is not in range of every remote site. It can also occur on systems
where one controller is used as a data concentrator for several remote Modbus devices. With
Store and Forward operation, a request to a Modbus device that cannot be directly accessed by
a host is routed through an intermediate SCADAPack, which can communicate with both the
host and the remote Modbus device. 

The Modbus protocol provides Store and Forward operation through address translation. A
SCADAPack configured for Store and Forward operation receives messages destined for a
remote station, re-addresses them according to the translation table, and then forwards the
message to the remote station. Responses from the remote station are processed in the same
manner. 
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The Modbus protocol allows messages to be re-transmitted on the same port with address
translation. With a radio system, the radio at the intermediate site is used as a type of repeater.
The protocol allows messages to be re-transmitted on a different port, with or without address
translation. This is used where the intermediate controller is a bridge between two networks. 

The Modbus protocol driver maintains diagnostics counters at the Store and Forward site on the
number of messages received and transmitted to aid in diagnosing unexpected communication
events. 

To add and configure a Store and Forward route entry

1. On the Configuration tab, select Modbus > Store and Forward.

2. Click the Enable Modbus Store and Forward checkbox.

3. Click Add Route.
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4. In the Modbus Store and Forward dialog, configure the Store and Forward  parameters.

5. Click OK.

6. Click Apply.
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To edit a Store and Forward route entry

1. On the Configuration tab, select Modbus > Store and Forward.

2. Double-click the route that you want to edit. 

3. In the Modbus Store and Forward dialog, configure the Store and Forward  parameters.

4. Click OK.

5. Click Apply.

To remove a Store and Forward route entry

1. On the Configuration tab, select Modbus > Store and Forward.

2. Click the route that you want to remove.

3. Click Remove Route. 
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4. In the Remove Entry dialog, click Yes. 

5. Click Apply.

8.15.8.1 Store and Forward Parameters

The following table describes the Enable Modbus Store and Forward parameter.

Parameter Parameter Description Setting Description

Enable
Modbus
Store and
Forward

Determines whether Modbus
Store and Forward is enabled. 

When not selected, Modbus Store and
Forward is disabled.

Default: Not checked, indicating that
Modbus Store and Forward is disabled.

The following table describes the Store and Forward parameters.

Parameter Parameter Description Setting Setting Description

Incoming
Interface

Contains the receiving server
interface the message is received
from for each translation

Serial 1 Only if configured for
Modbus

Serial 2 Only if configured for
Modbus

Serial 3 Only if configured for
Modbus

Serial 4 Only if configured for
Modbus

Serial 5
(Modem)

Only if configured for
Modbus and only for
SCADAPack 470 and
SCADAPack 474
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Modbus/TCP
Server

Default

Applies to all Ethernet
and PPP ports

Modbus/TCP Server
needs to be enabled in
the project settings. See
Changing the Project
Settings .

Server
Station

Contains the Modbus station
address of the server message.
This address needs to be different
from the Modbus address
assigned to the Incoming
Interface.

For addressing mode information,
see: Configuring Standard and
Extended Addressing .

· Valid range

o 1...255 when standard addressing is

configured for the serial interface and
Modbus broadcast disabled

o 0...255 when standard addressing is

configured for the serial interface and
Modbus broadcast enabled

o 1...65534 when extended addressing

is configured for the serial interface
and Modbus broadcast disabled

o 0...65534 when extended addressing

is configured for the serial interface
and Modbus broadcast enabled

o 1...255 when standard addressing is

configured for the Modbus/TCP
interface

o 1...65534 when extended addressing

is configured for the Modbus/TCP
interface

o Default: 1

Forward
Interface

Contains the interface the
message is forwarded from.

Serial 1 Only if configured for
Modbus

Serial 2 Only if configured for
Modbus

Serial 3 Default

Only if configured for
Modbus

Serial 4 Only if configured for
Modbus

Serial 5
(Modem)

Only if configured for
Modbus and only for

42

183



3.10.3

x70 Configuration Configuring SCADAPack x70 Device Operation

217

SCADAPack 470 and
SCADAPack 474

Modbus/TCP Requires a Forward IP
Address to be assigned

Forward
Station

Contains the Modbus station
address of the forwarded
message. This address needs to
be different from the Modbus
address assigned to the Forward
Interface.

For addressing mode information,
see: Configuring Standard and
Extended Addressing .

· Valid range

o 1...255 when standard addressing is

configured for the serial interface and
Modbus broadcast disabled

o 0...255 when standard addressing is

configured for the serial interface and
Modbus broadcast enabled

o 1...65534 when extended addressing

is configured for the serial interface
and Modbus broadcast disabled

o 0...65534 when extended addressing

is configured for the serial interface
and Modbus broadcast enabled

o 1...255 when standard addressing is

configured for the Modbus/TCP
interface

o 1...65534 when extended addressing

is configured for the Modbus/TCP
interface

o Default: 1

Forward IP
Address

Contains the IP address of the
Forward Station. This field is
blank unless a TCP network is
selected for the Forward
Interface. 

· Standard IP address format: 1...255 for
each byte in the IP address

Timeout The maximum time that the
forwarding task waits for a valid
response from the Forward
Station.

The timeout should be equal to or
less than the timeout set for the
client message received on the
Server Interface. 

· Valid entries: 50...120000

· Default: 2000

· Units: milliseconds (ms)

Enabled When checked, Modbus Store
and Forward is enabled for that
specific route. 

Read only

183



3.10.3

x70 ConfigurationConfiguring SCADAPack x70 Device Operation

218

8.16 Configuring IEC 60870-5-104 Operation

IEC 60870-5-104 is an international standard SCADA communications protocol. It describes
standards for remote SCADA protocol facilities over TCP/IP connections (known as balanced
communications), supporting data polling, events, cyclic reporting of values and spontaneous
transmission along with quality and time tag information (monitoring direction) as well as
controls to provide information to the remote device (controlling direction).

SCADAPack x70 devices provide IEC 60870-5-104 controlled station (server) protocol facilities
for communication with up to four IEC 60870-5-104 controlling stations (clients). Redundant IP
communication links are supported between controlling stations and the SCADAPack x70
device. 

For details, see:

· Configuring IEC 60870-5-104 Controlled Station Operation Overview

· IEC 60870-5-104 Controlled Station Operation

Default operation

By default, each SCADAPack x70 project is configured with the IEC 60870-5-104 Controlled
Station option disabled. The option can be enabled when you first create the project or by
changing the project settings . 

8.16.1 Configuring IEC 60870-5-104 Controlled Station Operation Overview

The following procedure provides the high-level steps to configure the SCADAPack x70 device to
operate as an IEC 60870-5-104 Controlled Station. Each step in the procedure below is
described later in this manual. Follow the links for details. 

Before following the procedure below:

1. Verify that the device can communicate with the SCADAPack RemoteConnect configuration
software. If you have not already set up this connection, follow the procedure in the
Configuring Communication Parameters topic in the PC Communication Settings -
SCADAPack CommDTM manual before following the steps below.

2. Create a new SCADAPack project, as described in the Creating a New Project topic in the
SCADAPack RemoteConnect Configuration Software manual. This adds the physical I/O on
the SCADAPack x70 device to the SCADAPack x70 configuration software.

3. Open the configuration parameters

The configuration takes effect in the SCADAPack x70 device when you take the SCADAPack
x70 configuration software online and write the configuration to the device as described at the
end of the procedure. 

To configure the SCADAPack x70 device to operate as an IEC 60870-5-104
Server

1. On the Configuration tab, select Physical I/O > Local, then double-click on the row in the
I/O Configuration table to define the operating characteristics for the SCADAPack x70
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device . If required, add any I/O modules that are connected to the SCADAPack x70
device .

2. In the Physical I/O > Local page Channel Configuration table, double-click on each
channel to define how it operates:

· Object Configuration

· Associations Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

3. On the Configuration tab, select IP Communication > Ethernet Ports > Ethernet #  to
configure the physical connection to the first IEC 60870-5-104 Controlling Station.

IP settings for the SCADAPack x70 device when communicating with the 2nd, 3rd, or 4th
controlling stations is configured on the Controlling Station x page.

4. On the Configuration tab, select IEC 60870-5-104, then select: 

· Server to select the IOA Format and Event Buffer Size, followed by, 

· Controlling Station x (where x is the number of the Controlling Station) to configure
communication with each IEC 60870-5-104 Controlling Station

5. On the Objects tab, select Object Configuration, then add database objects as
required .

6. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Go Online.

7. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

8.16.2 IEC 60870-5-104 Controlled Station Operation

The SCADAPack x70 device's IEC 60870-5-104 controlled station reports data to its controlling
station(s) through several mechanisms:

· General Interrogation (polling of SCADAPack x70 object data by the controlling station)

· Spontaneous transmissions (reporting of buffered event data from SCADAPack x70 objects
after connection from the controlling station). Events are reported with time tagged by the
SCADAPack x70 device. Where the clock validity period has expired, or the clock has not
been synchronized by the controlling station, events are stored and reported as not having
valid time tags until the clock is synchronized. 

· Counter Interrogation (polling of counter data by the controlling station)
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· Spontaneous transmission of counter events (as the result of a Freeze or Freeze+Reset
command by the controlling station)

The controlling station can also send command requests to the IEC 60870-5-104 controlled
station to update SCADAPack x70 device object data.

For more information, see IEC 60870-5-104 Protocol Reference Information in the SCADA
Protocols Technical Reference manual.

· Define the Event Buffer Size

· Configure communication with the IEC 60870-5-104 Controlling Station

Define the IOA Format

1. On the Configuration tab, select IEC 60870-5-104 > Server.

2. From the drop-down list, select the IOA Format . 

Define the Event Buffer Size for IEC 60870-5-104 events

1. On the Configuration tab, select IEC 60870-5-104 > Server.

2. Update the Event Buffer Size , as needed. 

3. On the IEC 60870-5-104 > Server page, click Apply.

Configure communication with the IEC 60870-5-104 Controlling Station

Use the IEC 60870-5-104 > Server > Controlling Station x (where x is the number of the
Controlling Station) page to configure communication with the Controlling Station. 

1. On the Configuration tab, select IEC 60870-5-104 > Server.

Before you enable the Controlling Station, none of the parameters are enabled. 
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2. To enable communication with the Controlling Station, click the checkbox, as shown below. 
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3. Configure the IEC 60870-5-104  parameters.

4. On the IEC 60870-5-104 > Server > Controlling Station x page, click Apply.

8.16.2.1 IEC 60870-5-104 Parameters

The following table describes the configuration parameters for IEC 60870-5-104 operation. 

Parameter Parameter Description Setting Setting Description

IEC 60870-5-104 Server

IOA Format A structured IOA is a trio of
numbers that represent an object
and cannot be duplicated. <high
byte>/<mid byte>/<low byte>

Structured IOA can be used to
create logical groupings for a
system. The numbers can be
purely abstract groupings or can
represent something recognizable
for users. For example one byte
could be an enumeration that
represents information about the
object (1 for physical IO, 2 for an
internal value produced by logic, 3
for RTU system data), another
byte could represent the relative
importance of the object (1 for
very important, 5 for unimportant),
and the third byte could be used
to distinguish between objects in
the same categories.

An unstructured IOA is a number
that represents an object and
cannot be duplicated. 

For every structured IOA value,
there is a corresponding
unstructured IOA. For example an
unstructured address of 459110,
is equivalent to a structured
address of 7/1/102. 7x256 2̂ +
1x256 + 102x1 = 459110. 

IEC 60870-5-104 protocol allows
for communication between
systems using both structured
and unstructured IOA.

Unstructured IOA (default)

· Valid values: 1...16777215

Structured IOA
(high/mid/low octet)
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Event Buffer
Size

The Event Buffer Size configures
the number of available events for
IEC 60870-5-104.

0...40000 Default: 4000 events

If IEC 60870-5-104 is
enabled in the project, the
default DNP3 Event Buffer
size is 1000.

The combined maximum
number of events between
DNP3 and IEC 60870-5-104
is 40000.

See Event Configuration
Parameters

Discard New
Events if
Buffer Full

When unchecked and the number
of IEC 60870-5-104 events
generated exceeds the event
buffer size, the oldest events are
discarded. 

When checked, the oldest IEC
60870-5-104 events are kept and
newest events are discarded when
the event buffer is filled.

Default: Unchecked

Controlling Station x (where x is the number of the Controlling Station)

Controlling
Station
Enabled

When checked, the Controlling
Station is enabled. 

Default: Unchecked

Connection Setup

Interface Configurable for Controlling
Stations 2...4

Controlling
Station 1:
Any

Controlling
Station
2...4:
Ethernet 1,
2, 3

Default for Controlling
Station 1: Any

Default for Controlling
Station 2...4: Ethernet 1

The Ethernet port
corresponding to the
selected Interface needs to
have an IP Address
configured to use the IEC
60870-5-104 SCADAPack
IP Address. See Using
Ethernet Ports .

IEC 60870-
5-104
SCADAPac

Configurable for Controlling
Stations 2...4

An empty IP Address is valid

The IP address for the
Controlled Station with
which the IEC 60870-5-104

138
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k IP
Address

controlling station
communicates: 

· Cannot belong to the
Network Range of Eth1,
Eth2, or Eth3 (for SP57x),
with the exception of the
selected interface

· Needs to be part of the
selected Interface's
Network Range

· Cannot be the same as
any of the SCADAPack
x70 device Ethernet
interface addresses

· Cannot be the same as
any other IEC 60870-5-
104 IP address for
Controlling Station
connections

Port Not configurable.

The TCP port on the IEC 60870-5-
104 Controlled Station that the
IEC 60870-5-104 Controlling
Station listens to.

To establish a connection, an IEC
60870-5-104 Controlling Station
makes a TCP connection to the
appropriate IP address using this
TCP port.

The
SCADAPa
ck x70
device
listens on
TCP port
2404 on all
SCADAPa
ck
interfaces,
for
connection
s from
Controlling
Station 1.

The
SCADAPa
ck x70
device
listens on
the TCP
port 2404
on the
configured
interface,
or on the
additionally
configured
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IP address
on the
configured
interface
for
connection
s from the
appropriate
Controlling
Station.

Application Setup

ASDU
Address

The ASDU address used by the
Controlled Station to
communicate with this IEC 60870-
5-104 Controlling Station.

1...65534 The valid range for a 2 Octet
ASDU Size.

General Setup

Clock Valid
Period

The period of time for which
timestamps are considered valid
after the IEC 60870-5-104
Controlled Station receives a
clock synchronization command. 

When the IEC 60870-5-104
Controlled Station starts,
timestamps are identified as
invalid until a clock
synchronization command is
received from the IEC 60870-5-104
Controlling Station.

1...744
hours

Default: 24 hours

Cyclic
Period

The rate at which the IEC 60870-
5-104 Controlled Station returns
cyclic data to the IEC 60870-5-
104 Controlling Station.

A value of 0 means no cyclic data
will be sent by the Controlled
Station.

Cyclic data is generated by
analog objects with an
Information Object Address
(IOA) and the Enable Cyclic
Scan parameter checked. These
parameters are configured in the
Object Editor on the IEC 60870-5-
104 tab.

0...86400
seconds
(s)

Default: 60 s
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Background
Period

The rate at which the IEC 60870-
5-104 Controlled Station returns
background data to the IEC
60870-5-104 Controlling Station. 

A value of 0 means no
background data will be sent by
the Controlled Station.

Background data is generated by
objects with an Information
Object Address (IOA) and a valid
Application Service Data Unit
(ASDU) type. These parameters
are configured in the Object Editor
on the IEC 60870-5-104 tab.

0...86400
seconds
(s)

Default: 3600 s

Maximum
Command
Age

The maximum time tag for time-
tagged commands. 

Received commands that are
older than this age are not
executed.

100...6553
5
millisecond
s (ms)

Default: 5000 ms

Short Pulse
Duration

The PULSE ON duration used
when a valid digital control is
received by the IEC 60870-5-104
Controlled Station, where the
qualifier of command for the
relevant control object specifies
Short Pulse Duration. 

100...6553
5
millisecond
s (ms)

Default: 100 ms

Long Pulse
Duration

The PULSE ON duration used
when a valid digital control is
received by the IEC 60870-5-104
Controlled Station, where the
qualifier of command for the
relevant control object specifies
Long Pulse Duration. 

100...6553
5
millisecond
s (ms)

Default: 1000 ms (1 second)

Select
Required

Determines whether a Select
message is required before an
Execute message to invoke the
specified control. 

When the box is checked, a Select
message needs to be issued first,
followed by an Execute message. The
Execute message needs to be received
within the Select Timeout period for the
control to be invoked.

When the box is not checked, only an
Execute message is required for the
control to be invoked.

Default: Unchecked
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Select
Timeout

The period within which an
Execute command needs to be
received. 

If an Execute command matching
a recently received Select
command is not received within
this period, then the control
operation is aborted. 

1...3600
seconds
(s)

Default: 5 s

Analog
Event Buffer
Mode

Specifies whether multiple analog
events for the same IOA are
buffered, or whether the IEC
60870-5-104 Controlled Station
overwrites an existing event with a
more recent event for the same
IOA. 

Single The IEC 60870-5-104
Controlled Station overwrites
an existing event in the
event buffer for an analog
IOA that generates a new
event. Events can exist for
multiple IOAs in the event
buffer, but only one event
per IOA is buffered.

Multiple The IEC 60870-5-104
Controlled Station buffers
multiple events for each
analog IOA that generates
events. Each event is
buffered with a timestamp,
allowing an IEC 60870-5-104
Controlling Station to
process the events.

Default

Controlling
Station
Uses Events

When checked, the IEC 60870-5-
104 controlled station sends
events to this controlling station.

Default: 

· Checked for Controlling
Station 1

· Unchecked for Controlling
Stations 2, 3, 4

8.17 Accessing System Data in a Remote Protocol

System data is internal information that represents the operating status of the SCADAPack x70
device. This topic describes how to access system data in a remote protocol such as DNP3,
IEC 60870-5-104, or Modbus.

1. In SCADAPack RemoteConnect, create a database object and configure an association with
a System Data Reference.
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2. The system data reference, and other information required to configure the object, is obtained
from the tables describing system data in the System Data topic in the Operations Technical
Reference manual

For example, if you want to provide the SCADAPack input supply voltage value to a remote
protocol, choose the following system data reference:

3. Set up the system data reference for the created object.
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4. Set the correct Data Type from the table. For this example, use Analog.

5. Set the name of the object to one of the following:

· The name of the system data reference (needs to be an exact match with the association's
System Data Reference configuration)

o To set the name of the object to the system data reference, click the Copy System Data

Reference to Name button, shown below.
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· An object name of your choosing (that does not begin with the prefix "SYS_")

For example:

6. Setup the object’s remote protocol settings. For this example, use Modbus Register and
Modbus Data Type.

You can get information about the type of data produced by the SCADAPack x70 device for
this system data (See the System Data topic in the Operations Technical Reference manual)
reference from the table column Select Object’s Logic Variable Type (optional). In this
case, even though you may not link the object to a logic variable, it indicates
T_SPx70_REAL meaning that the system data natively produces a REAL value. You can
choose to use a matching data type for the remote protocol, REAL (Floating Point) in this
example. No data conversion is necessary as the system data type and the configured
remote protocol data are compatible. In the case where you want to use a different data type
in the remote protocol, for example an Integer type in this example, you could choose the
Modbus UINT type and have the SCADAPack object automatically provide data conversion
using the Scaling parameters on the Basic tab. For more information see Scaling .283
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This default scaling would indicate, for example in the Modbus UINT register, a value of 2350
when the system data value indicates 23.5 (volts).

7. Another remote protocol configuration could be provided on the same object (DNP3 for
example).
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8. The remote protocol’s value will update at a rate determined by the SCADAPack x70
firmware. Typically, at 2, 5, or 10 second intervals depending upon the characteristics of the
system data.

The same SCADAPack object could also be configured to provide the system data value to a
logic variable. For more information, see the Accessing System Data in a Logic Program
topic in the Logic Programming Overview manual.
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9 Working with Objects

The core of the data model used in a SCADAPack x70 device is the RTU Object. The
SCADAPack x70 object database holds the configuration attributes and real-time data values for
the RTU objects (e.g. object value, data quality). 

When configuring the SCADAPack x70 device, you create objects to represent the data entities
in your system (for example pump running, tank level, out-flow, etc.) Then you make
connections from the data object to other RTU services. All connections are optional. 

When an RTU object is connected to an RTU service, the RTU object and the RTU service can
share data values, quality, and attributes, according to how the service uses the RTU object
data.

You can choose to configure one, none, or many connections to an RTU object depending on
how you want to use the data in your system. From the RTU object configuration dialog in
SCADAPack RemoteConnect you can: 

· Connect an object to a Logic variable, and/or

· Connect an object to one or more remote protocols (DNP3, Modbus, IEC 60870-5-104), and/or

· Connect an object to a data log, and/or

· Connect an object to Edge applications on a SCADAPack 47xi device

An association is a special type of connection to an RTU object from a configurable data source.
Data from a physical I/O point, an external device, or an internal RTU system data reference can
be connected to an RTU object using an association. Only one association can be configured
per object as follows:

· Configure an I/O association between an I/O channel and an RTU object by using the Physical
I/O page in SCADAPack RemoteConnect, or
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· Configure a Modbus client association between an external device and an RTU object by using
the Modbus Scanner page in SCADAPack RemoteConnect, or

· Configure a DNP3 client association between an external device and an RTU object by using
the DNP3 Data Concentrator page in SCADAPack RemoteConnect, or

· Configure an association between an RTU system data reference and an RTU object by using
the RTU object configuration dialog in SCADAPack RemoteConnect

Connections for the Realflo flow computer are managed by the Realflo application. Use Realflo to
configure connections with RTU objects and with Modbus server data.

The following information is provided in this section:

· Viewing Object Statistics

· Configuring Database Objects

· Configuring Parameter Settings Using the Object Editor

· Changing the Object Configuration

· Managing the Offline Browser List

· Configuring Data Logging

· Configuring an Association with a System Data Reference

9.1 Viewing Object Statistics

To view a summary of configured database objects

· Select Objects > Object Statistics

In the following image, Object Statistics by Data Type and Object Statistics by Logic Variable
Type are displayed.

Each pie chart shows the memory used by each data type or logic variable type, including the
unused memory when the Show Unused box is checked. This is checked by default. When the
box is not checked, the relative memory use of each type is displayed.

If a Total memory statistic exceeds 100%, a message is shown on the Object Statistics and
Object Configuration pages. 
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9.2 Configuring Database Objects

Use the Objects > Object Configuration page to manually add, copy, remove and reconfigure
database objects. The default display for Object Configuration is similar to the following:

SCADAPack x70 objects associated with the physical I/O for the selected SCADAPack are
automatically provided in the database when you create a new project. The objects for additional
I/O are provided when you add the I/O module or device on the Configuration > Physical I/O >
Local page.

You can also create objects to store information such as:

· Status information for physical I/O modules or devices. Objects that store status information
are configured using the same parameters as physical I/O objects. After you create a status
object, go to Configuration > Physical I/O > Local page and click Add Status Object to
associate the object with a physical I/O module or device. For details, see Associating Status
Information with I/O Modules .

· System information. Objects that store system information operate in the same way as other
objects. For details about the system data and control capabilities available, see Configuring
an Association with a System Data Reference .
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316



3.10.3

x70 ConfigurationWorking with Objects

236

· Logic programming data. For example, you may want to create an object that stores
calculations generated by logic applications. 

· Information from other devices connected to the SCADAPack x70 device.

The procedure to create a database object is the same for each object type. However, the
parameters that can be configured depend on the object type and the data type — analog, digital
or counter. For details, see:

· Adding Objects

· Copying Objects

· Removing Objects

· Refining the Objects Table 

· Grouping Objects

· Managing the Offline Browser List

· Changing the Object Configuration

· Configuring an Association with a System Data Reference

· Configuring Parameter Settings Using the Object Editor

For an overview of database objects and associations, see Understanding Objects and
Associations .

9.2.1 Adding Objects

The procedure below explains how to add an object to the database. It applies to any object, but
is typically used when you are adding objects that represent system information or status
information. For an overview of how objects are added to the database, see Understanding
Objects and Associations .

By default, when an object is created or added, it is not automatically made available to the
SCADAPack x70 Logic Editor. You need to configure the Logic Variable Type. For more
information, see Changing the Object Configuration  and Assigning a Logic Variable and Task
to an Object .

To add a database object

1. On the Objects tab, select Object Configuration.

2. In the Object Configuration table, click Add Object. 
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3. In the Object Editor, configure the object parameters, as required. 

The protocol tabs displayed depend on the role selected for the SCADAPack x70 device
when you created the project. The other tabs displayed depend on the object Data Type:
analog, digital or counter.

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Modbus Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. Click Ok.

5. On the Object Configuration page, click Apply.

9.2.2 Copying Objects

The procedure below explains how to copy database objects.

Copying database objects is an efficient way to create new objects that have the same, or
similar, parameter settings to objects that already exist. For example, you may want to copy
objects when you are:

· Adding physical I/O and want to replicate the configuration settings used for existing physical
I/O. 
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· Creating objects to store other types of data and want to base the parameter settings on
those used by existing objects. Other types of data may include reporting information that is
sent to a SCADA client, setpoint information from a SCADA client or local access by a
human-machine interface (HMI).

To copy database objects

1. On the Objects tab, select Object Configuration.

2. Select the object(s) that you want to copy. You may need to expand the Data Type to select
the object. 

3. In the Object Configuration table, click Copy Objects. 

4. Enter the Number of copies.

5. In the DNP3 Options section, if available, determine if you want to Assign unique DNP3
point number(s) to the copied object(s). 

· The default is Automatically assign DNP3 point numbers with the next available
values. When this option is selected, the next available point number for the object data
type is selected.

· If you selected Assign DNP3 point numbers sequentially, enter one of the following:

o For analog objects, enter the starting number in the Analog Input or Analog Output

field

o For digital objects, enter the starting number in the Digital Input or Digital Output field

o For counter objects, enter the starting number in the Counter Input or Counter Output

field

· If you deselect this option, the original objects and the new objects are marked with a
configuration conflict due to the duplicated DNP3 point number. You cannot apply the
changes to add the copied objects to the database until the conflicts are corrected.

6. In the Modbus Options section, if available, determine if you want to Assign unique
Modbus register(s).

· The default is Automatically assign Modbus registers with the next available values.
When this option is selected,  choose one of the following:

o For analog objects, choose one of the following: 
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§ read-only Input Registers

§ read/write Holding Registers

o For digital objects, choose one of the following:

§ read-only Discrete Inputs

§ read/write Discrete Coils

o For counter objects, choose one of the following: 

§ read-only Input Registers

§ read/write Holding Registers

· If you selected Assign Modbus registers sequentially, enter one of the following:

o For analog objects, enter the starting number in the Analog field

o For digital objects, enter the starting number in the Digital field

o For counter objects, enter the starting number in the Counter field

7. Click Yes.

8. On the Object Configuration page, click Apply.

9.2.3 Removing Objects

Follow the procedure below to remove one or more objects from the database.

To remove database objects

1. On the Objects tab, select Object Configuration.

2. In the Object Configuration table, select the object(s) that you want to remove. You may
need to expand the Data Type to select the object.

3. Click Remove Objects. 

4. Click Yes to confirm that you want to remove the object(s).

5. On the Object Configuration page, click Apply.
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9.2.4 Refining the Objects Table

The objects table can get very large, depending on your project. There are several ways that you
can sort, organize, or filter the results to focus on specific content. To facilitate refining the
objects table, carefully consider how objects are grouped . 

See:

· Sorting

· Using the Display Options

· Organize by Options

· Filter by Options

9.2.4.1 Sorting

You can sort the columns of the objects table. The row number is unrelated to the content in the
row.

To sort the objects table columns

1. On the Objects tab, select Object Configuration.

2. Click the column header of the column you want to sort.

The results are sorted in alphabetical or numerical order, depending on the column. 

The column that is being sorted is indicated by  or . 

3. Click again to reverse the order or click another column to sort on different content.

9.2.4.2 Using the Display Options

You can organize the contents of the objects table by using the Display Options. 

· Organizing the objects table

· Displaying the Default View

· Clearing Filters

Organizing the objects table

To organize the objects table

1. On the Objects tab, select Object Configuration.

2.  Click Display Options.
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3. Click the Organize by drop-down list and make a selection.

See Organize by Options  for details.

4. Click the Filter by drop-down list and make a selection.

243
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See Filter by Options  for details.

3. Select and enter further filtering options from the drop-down lists, as needed.

4. Click Apply.

The following image shows an example of organizing by Object Grouping.

In the objects table, you can expand the results by clicking on the . 

244
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Displaying the Default View

To revert to the Default View where the content is displayed with the Data Type option applied,
click Default View.

Clearing filters

To clear all display options and filtering, click Clear Filters.

9.2.4.3 Organize by Options

The table below describes the object groupings available for each Organize by option.

Organize by
option

Object Groupings

None No Organize by grouping

Object Grouping PIO_SP570, PIO_SP574, PIO_SP575, or whatever name you assigned to
the group in the Object Editor 

Data Type Analog, Digital, Counter

Source Type None, System Data

Logic Variable
Type

Analog objects:

· T_SPx70_INT 
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· T_SPx70_UINT

· T_SPx70_DINT 

· T_SPx70_REAL

· T_SPx70_ADV_ANALOG

Digital objects:

· T_SPx70_BOOL

· T_SPx70_ADV_DIGITAL

Counter objects:

· T_SPx70_UDINT

· T_SPx70_ADV_COUNTER

Logic Task MAST, FAST, AUX0, AUX1

DNP3 Static
Group and
Variation

See Static Group and Variation

DNP3
Controlling
Station 1/2/3
Point Data
Class

None, Class 0 (static), Class 1, Class 2, Class 3, Local

Modbus Data
Type

UINT, INT, DINT, REAL (Floating Point), Discrete, UDINT

IEC 104 ASDU-
Monitor

See IEC 60870-5-104 Objects General Parameters  for Monitor direction
ASDU types

IEC 104 ASDU-
Control

See IEC 60870-5-104 Objects General Parameters  for Control direction
ASDU types

9.2.4.4 Filter by Options

The table below describes the object filtering options available for each Filter by option.

Filter by: Filtering options Settings

None Not available

Name equals

contains

Enter a string value

Valid values: 1...64 characters in length
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Object Grouping equals

contains

Enter a string value

Comment equals

contains

Enter a string value

Valid values: 1...128 characters in length

DNP3 Point
Number

equals

is in range

is less than or equal
to

is greater than or
equal to

Enter an integer or integer range in the format x-
y using values between 0 and 65534 

Modbus Register equals Enter an integer or integer range in the format x-
y using:

5-digit addressing valid value:

· 1...9999

· 10001...19999

· 30001...39999

· 40001...49999  

6-digit addressing valid values:

· 1...65535

· 100001...165535

· 300001...365535

· 400001...465535

is in range The starting and ending range limit values needs
to be in the valid Modbus range:

5-digit addressing valid value:

· 1...49999

6-digit addressing valid values:

· 1...465535

is less than or equal
to

Same as 'equals' 

is greater than or
equal to

Sames as 'equals'
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IEC 104 IOA-
Monitor

equals

is in range

is less than or equal
to

is greater than or
equal to

Valid values: 1...16777215

IEC 104 IOA-
Control

equals

is in range

is less than or equal
to

is greater than or
equal to

Valid values: 1...16777215

9.2.5 Grouping Objects

Use object grouping to organize and categorize database objects in the way that is most
efficient for your operations. 

By default, the database object for a physical input or output is added to the group for the
hardware on which it resides. The object group is assigned using the Object Grouping parameter
in the Object Editor . 

You can reassign an object to a different group at any time. For example, you may want to
create a group that contains every object related to a particular application in your network. Or
you may want to create a separate group for each type of I/O on a SCADAPack x70 device and
its attached I/O modules. This would allow you to easily view and change the parameters for a
particular I/O type.

To view the group for an object

1. On the Objects tab, select Object Configuration. 

2. In the objects table, double-click on the row for the object.

The Object Grouping  parameter indicates which group the object is in.

250
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To reassign objects to a new group

1. On the Objects tab, select Object Configuration.

2. In the Object Configuration table, double-click on the row for the object you want to reassign.

3. In the Object Grouping parameter, enter a new group name, or select an existing group,
then click Ok.

The group name can contain up to 32 characters with spaces. It cannot contain the following
characters: < > # % \ " ; : ? @ & = + $ { } |  ̂[ ]

4. Repeat steps 2 and 3 for each object you want to reassign. 
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5. On the Object Configuration page, click Apply.

9.3 Configuring Parameter Settings Using the Object Editor

Use the Object Editor to configure and change parameter settings for the object. The tabs that
are displayed depend on the role(s) the SCADAPack x70 device is performing in your SCADA
network.

If you are using structure or array objects, some fields are non-configurable. These are marked
by a lock icon.

See the following topics for details about each parameter:

· Object Configuration Parameters 249
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o Analog Logic Variable Types

o Digital Logic Variable Types

o Counter Logic Variable Types

· Associations Tab

· DNP3 Tab

· Modbus Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

· Data Logging Tab

9.3.1 Object Configuration Parameters

The following table describes the Object Configuration parameters available in the Object Editor.

Paramete
r

Parameter
Description

Setting Setting Description

Name The name
assigned to the
object. 

This name is
used to identify
the object in
the object
tables.

1...321

characters with no
spaces.

The Name needs
to begin with a
letter or an
underscore, and
can contain only
letters, numbers
and underscores.

Each object needs to have a unique
name.

The name is not case sensitive. 

If the Name begins with SYS_, then the
object's Data Source needs to be set to
System Data and the object Name needs
to match the System Data Reference
name. See the System Data topic in the
Operations Technical Reference manual. 

If you do not want to match the System
Data reference's name, choose a name
that does not begin with SYS_.

When you add physical I/O, the
configuration software assigns a default
name that describes the physical object.
For example, the name PIO_SP575_DI1
is assigned to digital input 1 on a
SCADAPack 575. You can change the
default object name to any name that
follows the naming rules described in the
Setting column.
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If you are creating an object, you can
assign it any name that follows the
naming rules.

Object
Grouping

The grouping
assigned to the
object. 

Use the object
grouping to
categorize
objects of
similar types,
for example
physical I/O
objects or
status objects. 

0...32 characters
with spaces.

The Object
Grouping cannot
contain the
following
characters: < > #
% \ " ; : ? @ & =
+ $ { } |  ̂[ ]

The Object Grouping name is not case
sensitive. 

When you add physical I/O, the
configuration software assigns a default
object grouping based on the object type
and device. For example, the Object
Grouping PIO_SP575 is assigned to
physical I/O objects on the SCADAPack
575. You can change or delete the default
object grouping.

If you are creating an object, you can
assign a grouping if it helps you
categorize and organize your objects, but
it is not mandatory. For example, you
may want to have a grouping for analog
system objects that monitor SCADAPack
x70 device operation. 

Comment An optional
description for
the object. 

0...128 characters
with spaces.

The Comment
cannot contain
the following
characters: < > #
% \ " ; : ? @ & =
+ $ { } |  ̂[ ]

You can add any description that helps
you identify the object, but it is not
mandatory. 

Comments that are added to objects with
a configured Logic Variable Type are
shared with the SCADAPack x70 logic
variables comment.

Default: Empty

Data Type The data type
for the object.

Analog When you add physical I/O, the
configuration software assigns the data
type based on the I/O type. For example,
analog inputs and analog outputs are
assigned the Data Type Analog. You
cannot change the Data Type for a
physical I/O object.

If you clicked Add Object to create the
object, assign the data type that matches
the object you want to create. 

Digital

Counter

Logic
Variable
Type

Lists the pre-
defined logic
variables for the
SCADAPack
x70 device. 

None Default setting for objects that provide
counter information, system information or
status information. 
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You only need
to configure
this parameter
if you will be
using the
object in the
SCADAPack
x70 Logic
Editor to
develop an IEC
61131-3
application for
the
SCADAPack
x70 device.

Analog objects:

· T_SPx70_INT 

· T_SPx70_UINT

· T_SPx70_DINT 

· T_SPx70_REA
L

· T_SPx70_ADV
_ANALOG

Select the Logic Variable Type that
matches the format of the data and for
which you will be developing an IEC
61131-3 application. 

The ADV types are advanced variable
types that expose attributes that are not
included in the basic variable types. For
details about the object attributes
exposed in each logic variable type, see 

· Analog Logic Variable Types

· Digital Logic Variable Types

· Counter Logic Variable Types

When you set the Logic Variable Type
you can also set the Exclusive Logic
Control  parameter for the object.

Default settings:

· Objects that represent physical analog
I/O: T_SPx70_DINT

· Objects that represent physical digital
I/O: T_SPx70_BOOL

· Objects that represent physical counter
inputs: T_SPx70_UDINT

Digital objects:

· T_SPx70_BOO
L

· T_SPx70_ADV
_DIGITAL

Counter objects:

· T_SPx70_UDIN
T

· T_SPx70_ADV
_COUNTER

Logic Task The logic task
in which the
input
acquisition and
the output
update take
place.

You only need
to configure
this parameter
if you will be
using the
SCADAPack
x70 Logic
Editor to
develop an IEC
61131-3
application for
the
SCADAPack
x70 device.

MAST The MAST task typically executes the
majority of logic programmed in the
SCADAPack x70 Logic Editor. 

The MAST task is executed in 3 phases: 

· Input Management (IN): SCADAPack
x70 object data is copied to MAST
variables that are T_SPx70 types. The
input value of T_SPx70_INT and
T_SPx70_UINT variable types can be
modified by logic forcing.

· Program Processing: The program
sections are executed.

· Output Management (OUT): MAST
variables that are T_SPx70 types are
copied to writeable SCADAPack x70
object data. The output value of
T_SPx70_INT and T_SPx70_UINT
variable types can be modified by logic
forcing.

Default
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For details
about the task
types, see the
documentation
included with
the
SCADAPack
x70 Logic
Editor.

FAST An optional, time-triggered task that
executes short duration, time-sensitive
logic at a higher priority than the MAST
task. The FAST task can solve logic more
than once per MAST task scan.

The FAST task is executed in 3 phases: 

· Input Management (IN): SCADAPack
x70 object data is copied to FAST
variables that are T_SPx70 types. The
input value of T_SPx70_INT and
T_SPx70_UINT variable types can be
modified by forcing.

· Program Processing: The program

sections are executed.

· Output Management (OUT): FAST
variables that are T_SPx70 types are
copied to writeable SCADAPack x70
object data during the Output
Management (OUT) phase. The output
value of variables of T_SPx70_INT and
T_SPx70_UINT types can be modified
by forcing.

AUX0 An optional auxiliary task that executes
slower, less important background logic
at a lower priority than logic in the MAST
tasks. 

Using auxiliary tasks for low priority tasks
relieves some of the burden from MAST
tasks and helps to improve MAST task
scanning for essential functions. 

The AUX0 task operates in a similar way
to the MAST task regarding IN, Program
Processing and OUT phases, including
forcing support.

The AUX0 task executes its code
sections in the time remaining after the
FAST and MAST task sections are
executed, and other SCADAPack x70
system processing is complete. 

Configure the MAST task for Periodic
scanning when you are using the AUX0
task.

AUX1 An optional auxiliary task that executes
slower, less important background logic
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at a lower priority than MAST and AUX0
logic. 

The AUX1 task typically has a slower
Periodic scan rate than the AUX0 task.

The AUX1 task operates in a similar way
to the MAST task regarding IN, Program
Processing and OUT phases, including
forcing support.

The AUX1 task executes its code
sections in the time remaining after the
FAST, MAST and AUX0 task sections are
executed, and other SCADAPack x70
system processing is complete. 

Configure the MAST task for Periodic
scanning when you are using the AUX1
task.

Exclusive
Logic
Control

Determines
whether the
object can only
be updated by
the logic
application. 

When the box is checked, the object is under the exclusive
control of the logic application and can only be updated by the
logic application. 

When the box is unchecked, the object can be written from
multiple sources, for example through the SCADAPack x70
DNP3 Outstation from a Controlling Station, IEC 60870-5-104
Controlled Station, Modbus RTU Server, Modbus/TCP Server,
DNP3 Peer node, or a SCADAPack x70 logic application.

When the box is checked, requests from other sources, for
example DNP3 or Modbus protocol requests to update the
value of the object or to control the object, are blocked and a
status code is generated.

Default: Unchecked

1 Object names longer than 32 characters are permitted when objects are created from user DDT
logic variables. See the Creating a New SCADAPack x70 Variable in the Logic Programming
Overview manual. They are presented using dot notation where the portion of the object name
preceding the dot is the DDT instance variable name, and the portion of the name following the
dot is the DDT element name (of T_SPx70_ type). Only a single level of user DDT is permitted
(therefore only a single dot in the name is permitted). The total name length is 64 characters
including the dot. This means that the variable instance name length + the DDT element name
length can not exceed 63 characters.

9.3.1.1 Analog Logic Variable Types

The following table summarize the attributes that are exposed for analog logic variable types. 

All attributes are read-only, except where noted as "Writable".
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Logic Variable
Type

Attributes Exposed Data
Type

Comments

T_SPx70_INT OBJ_QUALITY BYTE Object quality value
comprising the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
UNDER_RANGE_QUAL

bit 2 = OVER_RANGE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

UNDER_RANGE_QUAL BOOL Engineering value is under-
range (see Out of Range
Limits Parameters )

OVER_RANGE_QUAL BOOL Engineering value is over-range
(see Out of Range Limits
Parameters )

FORCED_QUAL BOOL Object value is forced (by a
user)

VALUE INT Analog object current integer
value (Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID
input)

T_SPx70_UINT OBJ_QUALITY BYTE Object quality value
comprising the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
UNDER_RANGE_QUAL

bit 2 = OVER_RANGE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

287
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UNDER_RANGE_QUAL BOOL Engineering value is under-
range (see Out of Range
Limits Parameters )

OVER_RANGE_QUAL BOOL Engineering value is over-range
(see Out of Range Limits
Parameters )

FORCED_QUAL BOOL Object value is forced (by a
user)

VALUE UINT Analog object current integer
value (Writable)

OBJ_ID DWORD Object services identifier
(connect to logic function
blocks having an OBJ_ID
input)

T_SPx70_DINT OBJ_QUALITY BYTE Object quality value
comprising the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
UNDER_RANGE_QUAL

bit 2 = OVER_RANGE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

UNDER_RANGE_QUAL BOOL Engineering value is under-
range (see Out of Range
Limits Parameters )

OVER_RANGE_QUAL BOOL Engineering value is over-range
(see Out of Range Limits
Parameters )

FORCED_QUAL BOOL Object value is forced (by a
user)

VALUE DINT Analog object current integer
value (Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function

287
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blocks having an OBJ_ID
input)

T_SPx70_REAL OBJ_QUALITY BYTE Object quality value
comprising the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
UNDER_RANGE_QUAL

bit 2 = OVER_RANGE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

UNDER_RANGE_QUAL BOOL Engineering value is under-
range (see Out of Range
Limits Parameters )

OVER_RANGE_QUAL BOOL Engineering value is over-range
(see Out of Range Limits
Parameters )

FORCED_QUAL BOOL Object value is forced (by a
user)

VALUE REAL Analog object current scaled
Engineering value (Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID
input)

T_SPx70_ADV_AN
ALOG

COMMON_OBJ_QUALI
TY

WORD Object quality value
comprising the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
IO_NORESPONSE_QUAL

bit 2 =
USER_SET_OFFLINE_QUAL

bit 3 = LOGIC_QUAL

bit 5 = FORCED_QUAL
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ONLINE_QUAL BOOL Object is online and reports
good quality

IO_NORESPONSE_QU
AL

BOOL I/O not responding

USER_SET_OFFLINE_
QUAL

BOOL Object set Offline by user
ONLINE_QUAL = 0 (Writable)

LOGIC_QUAL BOOL Updated by logic

FORCED_QUAL BOOL Object value is forced (by a
user)

ANALOG_OBJ_QUALIT
Y

BYTE Counter object quality value
comprising the following bits:

bit 0 = OVER_RANGE_QUAL

bit 1 =
UNDER_RANGE_QUAL

bit 2 =
ROR_EXCEEDED_QUAL

bit 3 =
ROF_EXCEEDED_QUAL

bit 4 = NO_CHANGE_QUAL

bit 5 =
CHECK_REFERENCE_QUAL

OVER_RANGE_QUAL BOOL Engineering value is under-
range (see Out of Range
Limits Parameters )

UNDER_RANGE_QUAL BOOL Engineering value is over-range
(see Out of Range Limits
Parameters )

ROR_EXCEEDED_QUA
L

BOOL Engineering value change has
exceeded the Rate of Rise
limit (see Rate of Change
Parameters )

ROF_EXCEEDED_QUA
L

BOOL Engineering value change has
exceeded the Rate of Fall limit
(see Rate of Change
Parameters )
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NO_CHANGE_QUAL BOOL Engineering value has not
changed as expected (see
Rate of Change
Parameters )

CHECK_REFERENCE_
QUAL

BOOL Check analog input hardware
is reporting correctly

VALUE_ENG REAL Analog object current scaled
Engineering value (Writable)

VALUE_RAW DINT Analog object current integer
value (Writable)

ANALOG_OBJ_CONFIG BYTE Analog object configuration
fields value comprising the
following bits (Writable):

bit 0 = ALERT_INHIBIT

ALERT_INHIBIT BOOL Inhibits protocol events on this
object (Writable)

TREND_INHIBIT BOOL Not available for use

HNLN_STATES BYTE Analog object Engineering
High and Low alert limit
exceeded indications
comprising the following bits: 

bit 0 = H4_STATE

bit 1 = H3_STATE

bit 2 = H2_STATE

bit 3 = H1_STATE

bit 4 = L1_STATE

bit 5 = L2_STATE

bit 6 = L3_STATE

bit 7 = L4_STATE

H4_STATE BOOL Engineering High Limit 4
exceeded

H3_STATE BOOL Engineering High Limit 3
exceeded
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H2_STATE BOOL Engineering High Limit 2
exceeded

H1_STATE BOOL Engineering High Limit 1
exceeded

L1_STATE BOOL Engineering Low Limit 1
exceeded

L2_STATE BOOL Engineering Low Limit 2
exceeded

L3_STATE BOOL Engineering Low Limit 3
exceeded

L4_STATE BOOL Engineering Low Limit 4
exceeded

HNLN_ENABLES BYTE Analog object fields indicating
enabled Engineering Limits
alert checking, comprising the
following bits:

bit 0 = H4_ENABLE

bit 1 = H3_ENABLE

bit 2 = H2_ENABLE

bit 3 = H1_ENABLE

bit 4 = L1_ENABLE

bit 5 = L2_ENABLE

bit 6 = L3_ENABLE

bit 7 = L4_ENABLE

H4_ENABLE BOOL Engineering High Limit 4
enabled

H3_ENABLE BOOL Engineering High Limit 3
enabled

H2_ENABLE BOOL Engineering High Limit 2
enabled

H1_ENABLE BOOL Engineering High Limit 1
enabled

L1_ENABLE BOOL Engineering Low Limit 1
enabled
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L2_ENABLE BOOL Engineering Low Limit 2
enabled

L3_ENABLE BOOL Engineering Low Limit 3
enabled

L4_ENABLE BOOL Engineering Low Limit 4
enabled

H4_LIMIT REAL Engineering High Limit 4 value.
When the limit is disabled, the
value will be +3.4E+038
(Writable).

H3_LIMIT REAL Engineering High Limit 3 value.
When the limit is disabled, the
value will be +3.4E+038
(Writable).

H2_LIMIT REAL Engineering High Limit 2 value.
When the limit is disabled, the
value will be +3.4E+038
(Writable).

H1_LIMIT REAL Engineering High Limit 1 value.
When the limit is disabled, the
value will be +3.4E+038
(Writable).

L1_LIMIT REAL Engineering Low Limit 1 value.
When the limit is disabled, the
value will be -3.4E+038
(Writable).

L2_LIMIT REAL Engineering Low Limit 2 value.
When the limit is disabled, the
value will be -3.4E+038
(Writable).

L3_LIMIT REAL Engineering Low Limit 3 value.
When the limit is disabled, the
value will be -3.4E+038
(Writable).

L4_LIMIT REAL Engineering Low Limit 4 value.
When the limit is disabled, the
value will be -3.4E+038
(Writable).
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UNDER_RANGE_LIMIT REAL Engineering Under Range
Limit. When the limit is
disabled, the value will be -
3.4E+038 (Writable)

OVER_RANGE_LIMIT REAL Engineering Over Range Limit.
When the limit is disabled, the
value will be +3.4E+038
(Writable)

RAW_MINSCALE DINT Raw Minimum Scaling integer
value (Writable)

RAW_MAXSCALE DINT Raw Maximum Scaling integer
value (Writable)

ENG_MINSCALE REAL Engineering Minimum Scaling
value (Writable)

ENG_MAXSCALE REAL Engineering Maximum Scaling
value (Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID
input)

9.3.1.2 Digital Logic Variable Types

The following table summarize the attributes that are exposed for digital logic variable types. 

All attributes are read-only, except where noted as "Writable".

Logic Variable
Type

Attributes Exposed Data
Type

Comment

T_SPx70_BOOL

OBJ_QUALITY BYTE Object quality value comprising
the following bits:

bit 0 = ONLINE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

FORCED_QUAL BOOL Object value is forced (by a
user)
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VALUE BOOL Digital object current state
(Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID input)

T_SPx70_ADV_DIGI
TAL

COMMON_OBJ_QUALI
TY

WORD Object quality value comprising
the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
IO_NORESPONSE_QUAL

bit 2 =
USER_SET_OFFLINE_QUAL

bit 3 = LOGIC_QUAL

bit 5 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

IO_NORESPONSE_QU
AL

BOOL I/O not responding

USER_SET_OFFLINE_
QUAL

BOOL Object set Offline by user,
ONLINE_QUAL = 0 (Writable)

LOGIC_QUAL BOOL Updated by logic

FORCED_QUAL BOOL Object value is forced (by a
user)

DIGITAL_OBJ_QUALIT
Y

BYTE Digital object quality value
comprising the following bits:

bit 0 = CHATTER_QUAL

bit 1 = ALERT_STATE_QUAL

CHATTER_QUAL BOOL Physical digital input updates
are suppressed or restricted
due to rapidly state changes
(see I/O module hardware
manual for more information)

ALERT_STATE_QUAL BOOL Object is in an Alert State.
ALERT_STATE_QUAL = 1
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when VALUE =
ALERT_ACTIVE_STATE

VALUE BOOL Digital object current state
(Writable)

DIGITAL_OBJ_CONFIG BYTE Digital object configuration
fields value comprising the
following bits (Writable):

bit 0 = ALERT_INHIBIT

bit 1 = ALERT_ACTIVE_STATE

ALERT_INHIBIT BOOL Inhibits protocol events on this
object 

ALERT_STATE_QUAL = 0 
(Writable)

ALERT_ACTIVE_STAT
E

BOOL The active state of this object
that constitutes an Alert
(Writable).
ALERT_STATE_QUAL = 1
when VALUE =
ALERT_ACTIVE_STATE

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID input)

9.3.1.3 Counter Logic Variable Types

The following table summarize the attributes that are exposed for counter logic variable types. 

All attributes are read-only, except where noted as "Writable".

Logic Variable
Type

Attributes Exposed Data
Type

Comment

T_SPx70_UDINT

OBJ_QUALITY BYTE Object quality value comprising
the following bits:

bit 0 = ONLINE_QUAL

bit 3 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality
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FORCED_QUAL BOOL Object value is forced (by a
user)

VALUE UDINT Counter object current value
(Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID input)

T_SPx70_ADV_CO
UNTER

COMMON_OBJ_QUALI
TY

WORD Object quality value comprising
the following bits:

bit 0 = ONLINE_QUAL

bit 1 =
IO_NORESPONSE_QUAL

bit 2 =
USER_SET_OFFLINE_QUAL

bit 3 = LOGIC_QUAL

bit 5 = FORCED_QUAL

ONLINE_QUAL BOOL Object is online and reports
good quality

IO_NORESPONSE_Q
UAL

BOOL I/O not responding

USER_SET_OFFLINE_
QUAL

BOOL Object set offline by user
ONLINE_QUAL = 0 (Writable)

LOGIC_QUAL BOOL Updated by logic

FORCED_QUAL BOOL Object value is forced (by a
user)

COUNTER_OBJ_QUAL
ITY

BYTE Counter object quality value
comprising the following bits
(Writable):

bit 0 = HIGH_LIMIT_QUAL

HIGH_LIMIT_QUAL BOOL High Limit Alert state.
HIGH_LIMIT_QUAL = 1 when 

VALUE >= HIGH_LIMIT

VALUE UDINT Counter object current value
(Writable)
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HIGH_LIMIT UDINT High Limit Alert value (Writable)

COUNTER_OBJ_CONF
IG

BYTE Counter object configuration
fields value comprising the
following bits:

bit 0 = ALERT_INHIBIT

ALERT_INHIBIT BOOL Inhibits protocol events on this
object (Writable)

OBJ_ID DWORD Object services identifier (used
to connect to logic function
blocks having an OBJ_ID input)

9.3.2 Associations Tab

Use the Associations tab to view a description of the associations for the object. The following is
an example of a SCADAPack 575 configuration. 

The Data Source options change based on the object Source Type setting. 

If you add a new object, then Data Source is displayed similarly to the following, with default set
to None.

If the object is to be associated to a system data reference, from the Source Type drop-down
list, select System Data. The Data Source panel is displayed similarly to the following.

The Source Type for objects that are associated to physical I/O, DNP3 Controlling Stations, or
Modbus Clients cannot be modified. These associations are automatically created by the
system. Data Source is displayed similarly to the following:
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See: 

· Object Associations Parameters

9.3.2.1 Object Associations Parameters

The following table describes the Object Associations parameters that are displayed for each
object.

Paramet
er

Parameter Description Setting Setting
Description

Source
Type

The item with which the object is
associated. For example, an
object can be associated with a:

· Physical I/O channel

· Physical I/O status

· DNP3 Remote Point

· DNP3 Status and Control

· Modbus Scanner

· Modbus Status and Control

This field is configurable as
System Data only if the object is
not already associated with
another data source.

None Available only
if the object is
not associated
with another
data source.

System Data

Source
Details

Information about the data source
for the object

System
Data
Reference

Allows System Data Fields to be
associated with objects.

· Available when the Source Type
is System Data

· System field names are not
case sensitive

Needs to begin with a
known prefix, which is one
of:

SYS_CAPACITY

SYS_CLOCK

SYS_CODE

Max length: 32
characters
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· Not available when the object is
already associated with another
data source.

The Copy System Data

Reference to Name  button
allows you to set the name of the
object to the system data
reference. 

See: Configuring an Association
with a System Data Reference

SYS_CONFIG

SYS_DEVICE

SYS_DNP3Hosts

SYS_ETH

SYS_EVENTS

SYS_INFO

SYS_LICENSE

SYS_LOCATION

SYS_LOGIC

SYS_MODEM

SYS_PROTOCOL

SYS_ResetStats

SYS_RESTART

SYS_SERIAL1

SYS_SERIAL2

SYS_SERIAL3

SYS_SERIAL4

SYS_SET

SYS_StatsDNP3

SYS_StatsETH

SYS_StatsIO

SYS_StatsIOP

SYS_StatsIP

SYS_StatsMODEM

SYS_StatsSecLock

SYS_StatsSerial1

SYS_StatsSerial2

SYS_StatsSerial3

SYS_StatsSerial4

SYS_STATUS

See the System Data
topics in the Operations
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Technical Reference
manual

9.3.3 DNP3 Tab

Use the DNP3 tab to define how the object value and attributes are used by the SCADAPack
x70 DNP3 Outstation when it interacts with its DNP3 Controlling Station(s). 

The Static Group and Variation options change based on the object Data Type setting:
digital, analog or counter.

· DNP3 Objects General Parameters

· DNP3 Point Data Class Parameters

9.3.3.1 DNP3 Objects General Parameters

The following table describes the General parameters for DNP3 objects.

Paramete
r

Parameter
Description

Setting Setting Description

Point
Number

The identifier for
the DNP3 point.

0...65534 To find the next available DNP3 point number
for the currently selected Data Type, click

To start the search from a particular point
number, enter that point number, then click

.

 Static
Group and
Variation

The data object returned in response to a DNP3 Class 0 (static) data poll
request from a DNP3 Controlling Station. 

In the parameter settings below, the prefix indicates the Group and Variation.

For example, g30v1 is Group 30, Variation 1.

Analog data
types

g30v1 32-bit
Integer
Analog Input
with Flags

Use this object to return a 32-bit signed
integer analog value as a DNP3 analog input
point in the range -2147483648 to
+2147483647 where the DNP3 Controlling
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Station can process additional point status
flags, such as over-range or under-range.

g30v2 16-bit
Integer
Analog Input
with Flags

Use this object to return a 16-bit signed
integer analog value as a DNP3 analog input
point in the range -32768 to +32767 where the
DNP3 Controlling Station can process
additional point status flags, such as over-
range or under-range.

g30v3 32-bit
Integer
Analog Input
No Flags 

Use this object to return a 32-bit signed
integer analog value as a DNP3 analog input
point in the range -2147483648 to
+2147483647. This object does not include
DNP3 status flags. However, if the point does
not have good quality, a group 30, variation 1
object is automatically reported for the point.
This is a DNP3 protocol requirement.

g30v4 16-bit
Integer
Analog Input
No Flags

Use this object to return a signed 16-bit
signed integer analog value as a DNP3 analog
input point in the range -32768 to +32767.
This object does not include DNP3 status
flags. However, if the point does not have good
quality, a group 30, variation 2 object is
automatically reported for the point. This is a
DNP3 protocol requirement.

g30v5 32-bit
Floating
Point
Analog Input
with Flags

Use this object to return the value and status
of a floating point value as a DNP3 analog
input point in 32-bit IEEE floating point format.

g40v1 32-bit
Integer
Analog
Output with
Flags

Use this object to return the value and status
of a 32-bit signed integer value as a DNP3
analog output point. You can also use this
object to notify the DNP3 Controlling Station if
the point value is modified elsewhere, for
example due to internal state validation and
point quality. 

g40v2 16-bit
Integer
Analog
Output with
Flags

Use this object to return the value and status
of a 16-bit signed integer value as a DNP3
analog output point. You can also use this
object to notify the DNP3 Controlling Station if
the point value is modified elsewhere, for
example due to internal state validation and
point quality. 
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g40v3 32-bit
Floating
Point
Analog
Output with
Flags

Use this object to return the value and status
of a floating point value as a DNP3 analog
output point for control data. 

Use this object to notify the DNP3 Controlling
Station if the point value is modified
elsewhere, for example due to internal state
validation and point quality. 

Digital data types g1v1 Binary
Input No
Flags

Use this object to return the status of digital
data as a DNP3 input point. The minimum
transmitted data size for this object is 8 bits.
Eight consecutive binary input objects are the
same data length as a single binary input
object. To improve transmission efficiency,
group binary objects together in consecutive
addresses. 

If the point quality is not indicated as good
quality, a group 1, variation 2 object is
automatically reported for the point. This is a
DNP3 protocol requirement.

g1v2 Binary
Input With
Flags

Use this object to return the status of digital
data as a DNP3 input point when the DNP3
Controlling Station can process point status
flags, for example, online, offline or
downstream device communications lost.

g10v2
Binary
Output with
Flags

Use this object to return the status of digital
data as a DNP3 output point. You can also
use this object to notify the DNP3 Controlling
Station if the point value is modified
elsewhere, for example due to internal state
validation and point quality. 

g12v1,
g10v2
Complemen
tary

(single-
index) Trip

Use this selection to allow Trip/Close control
of a pair of digital objects using DNP3 single-
index complementary mode. The digital object
using this selection pulses when a CROB Trip
control is received. Control status flags
representing the quality of the digital object
pair can be returned to the DNP3 Controlling
Station. A separate digital object needs to be
configured with the complementary (single-
index) Close configuration.

g12v1,
g10v2
Complemen
tary 

Use this selection in conjunction with a
separate digital object using the
complementary (single-index) Trip
configuration to allow control of a pair of digital
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(single-
index) Close

objects using DNP3 single-index
complementary mode. The Digital object
using this selection pulses when a CROB
Close control is received. 

Counter data
types

g20v1 32-bit
Counter with
Flags

Use this object to return data for a counter or
unsigned integer data with 32-bit resolution in
the range 0...4294967295 where the DNP3
Controlling Station can process additional
point status flags, such as counter offline. 

g20v2 16-bit
Counter with
Flags

Use this object to return data for a counter or
unsigned integer data with 16-bit resolution in
the range 0...65535 where the DNP3
Controlling Station can process additional
point status flags, such as counter offline. 

g20v5 32-bit
Counter No
Flags

Use this object to return data for a counter or
unsigned integer data with 32-bit resolution in
the range 0...4294967295. This object does
not include DNP3 status flags. However, if the
point does not have good quality, a group 20,
variation 1 object type is automatically
reported for the point. This is a DNP3 protocol
requirement.

g20v6 16-bit
Counter No
Flags

Use this object to return data for a counter or
unsigned integer data with 16-bit resolution in
the range 0...65535. This object does not
include DNP3 status flags. However, it the
point does not have good quality, a group 20,
variation 2 object is automatically reported for
the point. This is a DNP3 protocol
requirement.

9.3.3.2 DNP3 Point Data Class Parameters

The following table describes the DNP3 Point Data Class parameters.

Paramet
er

Parameter Description Setting Setting Description

Point
Data
Class

The type of event data that the
SCADAPack x70 DNP3
Outstation returns to its DNP3
Controlling Station.

The DNP3 Outstation has three
event buffers, one for each of the
three event classes. If a point is

Local Point data is not returned to the
DNP3 Controlling Station in Class
0, 1, 2, or 3 polls, and DNP3
events are not generated for the
point. Point data is available to:
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assigned a Class 1, 2 or 3 data
class, then events generated by
the point are placed in the
appropriate buffer and sent to the
DNP3 Controlling Station in
response to a poll for that data
class. 

Events in the buffer can also be
sent to the DNP3 Controlling
Station in unsolicited responses
if unsolicited responses are
enabled for the SCADAPack x70
DNP3 Outstation and for that
event class. 

The most recently updated value
data for a point configured for
Class 1, 2, or 3 is also returned
in response to a Class 0 poll
request. 

· The DNP3 Controlling Station
using specific DNP3 point index
reads. 

· Peer DNP3 nodes through
DNP3 requests for specific point
index data.

· IEC 61131-3 applications. 

· The configuration software.

Default

Class 0
(static)

Returns the most recently updated
data value (static object data) for
the point to the DNP3 Controlling
Station. The setting for the Static
Group and Variation  parameter
determines the format of the point
data that is returned. 

Class 1 The DNP3 Outstation generates
events for the point in Class 1 and
returns them to the DNP3
Controlling Station in response to
a Class 1 poll, an integrity poll,
and optionally, in an unsolicited
response. 

Class 2 The DNP3 Outstation generates
events for the point in Class 2 and
returns them to the DNP3
Controlling Station in response to
a Class 2 poll, an integrity poll,
and optionally, in an unsolicited
response. 

Class 3 The DNP3 Outstation generates
events for the point in Class 3 and
returns them to the DNP3
Controlling Station in response to
a Class 3 poll, an integrity poll,
and optionally, in an unsolicited
response. 

9.3.4 Modbus Tab

Use the Modbus tab to define how an object value is used by the SCADAPack x70 Modbus RTU
Server or Modbus/TCP Server when it interacts with a Modbus RTU Client or Modbus/TCP
Client. 
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The Modbus Data Type options and Valid Modbus Register Range change based on the
object Data Type setting: digital, analog or counter, and the Modbus Server Address Mode .

· Modbus Objects General Parameters

9.3.4.1 Modbus Objects General Parameters

The following table describes the General parameters for Modbus objects. These parameters are
only displayed when the device is configured to operate as a Modbus RTU Server or a
Modbus/TCP Server.

Paramete
r

Parameter Description Setting Setting Description

Modbus
Register

The Modbus address for the
object. 

Use the Valid Modbus Register Range to confirm
that the Modbus Register entry falls within a valid
range.

If you are configuring an object with a DINT, Real,
or UDINT data type, 2 sequential registers are
used, starting with the first register you enter. 

Modbus
Data Type

The data type that is returned when a request is sent to this Modbus RTU
Server or Modbus/TCP Server.

Analog data type UINT Returns an unsigned integer value.

INT Returns a signed integer value.

DINT Returns a signed double integer
value.

Real Returns a floating point real value.

Digital data type Discrete Returns a discrete value.

Counter data type UINT Returns an unsigned integer value.

UDINT Returns an unsigned double integer
value.

187
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9.3.5 IEC 60870-5-104 Tab

Use the IEC 60870-5-104 tab to define how an object on an IEC 60870-5-104 Controlled Station
interacts with its Controlling Station. 

The Application Service Data Unit (ASDU) options change based on the object Data Type
setting: digital, analog or counter.

If Unstructured IOA  is selected, the following is displayed: 

If Structured IOA (high/mid/low octet)  is selected, the following displayed:

 

· IEC 60870-5-104 Objects General Parameters

9.3.5.1 IEC 60870-5-104 Objects General Parameters

The following table describes the General parameters for IEC 60870-5-104 object data. These
parameters are only displayed when the device is configured to operate as an IEC 60870-5-104
Controlled Station.

Paramet
er

Parameter
Description

Setting Setting Description

Monitor Direction

Informatio
n Object
Address
(IOA)

The IEC 60870-5
address for the
object. 

1...16777215 A unique identifier for the object.

Structured IOA is listed as “<high
byte>/<mid byte>/<low byte>”. Sorting
based on the unstructured value
groups common high byte and mid
byte values together, making it easy to
find common groupings of structured
IOA.

Applicatio
n Service

The type of Application Service Data Unit (ASDU) for the object. 

222
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Data Unit
(ASDU)

To generate events for the selected ASDU, use the ASDU type that includes the
(with event) suffix.

Analog data type 5 - Step Position
Information

Type ID 5: M_ST_NA_1 - Step position
information

Includes a 7-bit value in the Information
Object and applies to analog integer
values in the database. The current
integer value of the analog object
(when in the range -64 to 63) is
presented in this 7-bit value.

5 - Step Position
Information (with
Event)

As for 5 - Step Position Information,
but also generates events using:

· Type ID 32: M_ST_TB_1 - Step
position information with time tag
CP56Time2a 

9 - Measured Value,
Normalized Value

Type ID 9: M_ME_NA_1 – Measured
value, normalized value

Includes a 16-bit value in the
Information Object and applies to
analog object integer values in the
database. The current integer value of
the analog object is mapped to this 16-
bit value. 

9 - Measured Value,
Normalized Value
(with Event)

As for 9 - Measured Value, Normalized
value, but also generates events using:

· Type ID 34: M_ME_TD_1 -
Measured value, normalized value
with time tag CP56Time2a

11 - Measured
Value, Scaled
Value

Type ID 11: M_ME_NB_1 – Measured
value, scaled value

Includes a 16-bit value in the
Information Object and applies to
analog object integer values in the
database. The current integer value of
the analog object is mapped to this 16-
bit value. 

11 - Measured
Value, Scaled
Value (with Event) 

As for 11 - Measured Value, scaled
value, but also generates events using:

· Type ID 35: M_ME_TE_1 -
Measured value, scaled value with
time tag CP56Time2a
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13 - Measured
Value, Short
Floating Point Value

Type ID 13: M_ME_NC_1 – Measured
value, short floating point value

The short float value of the analog
object is mapped to the current value
of the protocol object.

Default 

13 - Measured
Value, Short
Floating Point Value
(with Event)

As for 13 - Measured Value, Short
floating point value, but also generates
events using:

· Type ID 36: M_ME_TF_1 -
Measured value, short floating point
value with time tag CP56Time2a

21 - Measured
Value, Normalized
Value without
Quality Descriptor

Type ID 21: M_ME_ND_1 – Measured
Value, normalized value without quality
descriptor

Includes a 16-bit value in the
Information Object and applies to
analog object integer values in the
database. The current integer value of
the analog object is mapped to this 16-
bit value. 

21 - Measured
Value, Normalized
Value without
Quality Descriptor
(with Event)

As for 21 - Measured Value,
normalized value, but also generates
events using:

· Type ID 34: M_ME_TD_1 -
Measured value, normalized value
with time tag CP56Time2a

Digital object type 1 - Single Point
Information

Type ID 1: M_SP_NA_1 – Single point
information

The value reported in the SPI of the
Information Object is derived from the
current state of the digital object. 

Default

1 - Single Point
Information (with
Event)

As for 1 - Single Point Information, but
also generates events using:

· Type ID 30: M_SP_TB_1 - Single-
point information with time tag
CP56Time2a

3 - Double Point
Information

Type ID 3: M_DP_NA_1 - Double-point
information
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The value reported in the DPI of the
information object is derived from the
current state of two digital objects.

The second point in a double point
information pair needs to be configured
as Secondary Double Point type, with
the same monitor direction IOA. 

3 - Double Point
Information (with
Event)

As for 3 - Double Point Information, but
also generates events using:

· Type ID 31: M_DP_TB_1 - Double-
point information with time tag
CP56Time2a 

Secondary Double
Point

Use this ASDU selection for the digital
object corresponding to the second
point of a Double Point Information
object pair. This object is paired with a
digital object with the same monitor
direction IOA. 

Counter object
type

15 - Integrated
totals

Type ID 15: M_IT_NA_1 – Integrated
totals

The counter values reported are frozen
values. Counter (integrated total)
values are retrieved from the
SCADAPack x70 device using Counter
Interrogation Commands. 

Default

15 - Integrated
totals (with Event)

As for 15 - Integrated totals, but also
generates events using:

· Type ID 37: M_IT_TB_1 - Integrated
totals with time tag CP56Time2a

Enable
Cyclic
Scan

Determines
whether the
analog object is
included in IEC
60870-5-104
cyclic responses.

When the box is
checked, the analog
object is included in
IEC 60870-5-104
cyclic responses.

Default: Not checked (disabled)

Control Direction

Informatio
n Object

The IEC 60870-5
address for the
object. 

1...16777215 A unique identifier for the object.

Structured IOA is listed as “<high
byte>/<mid byte>/<low byte>”. Sorting
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Address
(IOA)

based on the unstructured value
groups common high byte and mid
byte values together, making it easy to
find common groupings of structured
IOA.

Applicatio
n Service
Data Unit
(ASDU)

Analog data type

SCADAPack x70
Analog objects
can
simultaneously
be configured for
a Monitor
direction ASDU
type and a
Control direction
ASDU type,
where the types
are of a
corresponding
format.

Independent IOA
configurations are
provided for
Monitor and
Control direction.

48 - Set Point
Command,
Normalized Value

Type ID 48: C_SE_NA_1 - Set point
command, normalized value

Sets the current integer value of the
analog object to the 16-bit value in the
command

49 - Set Point
Command, Scaled
Value

Type ID 49: C_SE_NB_1 - Set point
command, scaled value

Sets the current integer value of the
analog object to the 16-bit value in the
command

50 - Set Point
Command, Short
Floating Point Value

Type ID 50: C_SE_NC_1 - Set point
command, short floating point value

Sets the current engineering value of
the analog object to the 32-bit short
floating point value in the command

Default 

61 - Set Point
Command,
Normalized Value
with Time Tag

Type ID 61: C_SE_TA_1 - Set point
command, normalized value with time
tag

Operates the same as ASDU Type ID
48, except the command is time
tagged and is only valid for the
Command Age time

62 - Set Point
Command, Scaled
Value with Time Tag

Type ID 62: C_SE_TB_1 - Set point
command, scaled value with time tag

Operates the same as ASDU Type ID
49, except the command is time
tagged and is only valid for the
Command Age time

63 - Set Point
Command, Short
Floating Point Value
with Time Tag

Type ID 63: C_SE_TC_1 - Set point
command, short floating point value
with time tag

Operates the same as ASDU Type ID
50, except the command is time



3.10.3

x70 Configuration Working with Objects

279

tagged and is only valid for the
Command Age time

Digital data type 45 - Single
Command

Type ID 45: C_SC_NA_1 – Single
command

SCADAPack x70 Digital objects
configured with this Control direction
ASDU type can also be configured
with a Monitor Direction ASDU type of
either:

· 1 - Single Point Information

· 1 - Single Point Information (with
Event)

Independent IOA configurations are
provided for Monitor and Control
direction.

Default

46 - Double
Command

Type ID 46: C_DC_DA_1 – Double
command

The second point in a double
command pair needs to be configured
as Secondary Double Point type, with
the same control direction IOA. 

47 - Regulating
Step Command

Type ID 47: C_RC_NA_1 – Regulating
step command

The second point in a regulating step
(double command) pair does not have
to be configured as a regulating step
command ASDU type. 

58 - Single
Command with
Time Tag 

Type ID 58: C_SC_TA_1 – Single
command with time tag

SCADAPack x70 Digital objects
configured with this Control direction
ASDU type can also be configured
with a Monitor Direction ASDU type of
either:

· 1 - Single Point Information

· 1 - Single Point Information (with
Event)
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Independent IOA configurations are
provided for Monitor and Control
direction.

Operates the same as ASDU Type ID
45, except the command is time
tagged and is only valid for the
Command Age time.

59 - Double
Command with
Time Tag

Type ID 59: C_DC_TA_1 – Double
command with time tag

Operates the same as ASDU Type ID
46, except the command is time
tagged and is only valid for the
Command Age time.

60 - Regulating
Step Command with
Time Tag

Type ID 60: C_RC_TA_1 – Regulating
step command with time tag

Operates the same as ASDU Type ID
47, except the command is time
tagged and is only valid for the
Command Age time.

Secondary Double
Point

Use this ASDU selection for the digital
object corresponding to the second
point of a Double Command object
pair. This object is paired with a digital
object with the same control direction
IOA. 

9.3.6 Alert Notifications Tab: Analog Objects

Use the Alert Notifications tab to enable and disable alerts and to specify when analog objects
generate alert events. 
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· Alert Notification Limits Parameters

9.3.6.1 Alert Notification Limits Parameters

· You can configure up to 8 limits for each analog object:

· 4 low limits: 1L, 2L, 3L, 4L

· 4 high limits: 1H, 2H, 3H, 4H

Limits can be used to generate events. They can also be used by SCADAPack x70 logic.
T_SPx70_ADV_ANALOG variables that are linked with analog objects indicate the alert
notification limit values and the Limit Exceeded alert state of each alert limit.

The value for each limit is a floating point value that is compared to the current engineering value
of the object to determine when the limit has been transgressed.

There are no restrictions on which alert limits can be used, however they need to be configured
such that the values of the limits are as follows: 

4L <= 3L <= 2L <= 1L <= 1H <= 2H <= 3H <= 4H

It is typically easiest to start with Limit 1H and Limit 1L and work outwards toward Limit 4H and
Limit 4L. This will help you follow the rules for limits. See the example  below for additional
guidance.

The following table describes the Alert Notification Limits parameters for analog objects.

Paramete
r

Parameter Description Setting Setting Description

281
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Enabled Determines whether
change-of-value events are
generated for the object
when the associated limit is
transgressed. 

The Exceeded states for
the limits are indicated in
the online parameters no
matter how you set this
parameter.

When the box is checked, change-of-value events
are generated for the object when the associated
limit is transgressed. 

Default: Not checked

Unsolicited
Events
(DNP3
only)

Determines whether the
DNP3 Outstation
spontaneously reports
DNP3 events to its DNP3
Controlling Station.

Valid for analog objects
where the Point Data Class
parameter is set to Class 1,
Class 2 or Class 3.

When the box is checked, the DNP3 Outstation
spontaneously reports DNP3 events to the DNP3
Controlling Station.

When the box is not checked, unsolicited
reporting of DNP3 events for the associated limit
is disabled. The SCADAPack x70 device
continues to buffer events as they are generated,
but does not send them to the DNP3 Controlling
Station until it receives a request for events.

Default: Not checked (disabled)

Value The value at which an event
is generated if Enabled is
selected for the limit. 

Any
floating
point
value

Compares the value entered with the
object’s current engineering value to
determine the state of the alert limit.

The At Limit Alert Processing
parameter setting determines when the
over-range limit value and the under-
range limit value are considered to be
transgressed. 

Example

In the example below, Limits 2H through 2L are set with specific values. Events are generated
based on the At Limit Alert Processing  parameter setting when these values are
transgressed. Events are not generated for Limits 4H, 3H, 3L or 4L.

54
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9.3.7 Basic Tab: Analog Objects

Use the Basic tab for analog objects to define analog object operation. These parameters need
to be configured for each analog object regardless of the role the SCADAPack x70 device is
performing in the network. 

· Scaling Parameters

· Value Deviation Parameters

· Out of Range Limits Parameters

· Period Event Generation Parameters

9.3.7.1 Scaling Parameters

SCADAPack x70 analog objects have a raw (integer) value and a scaled engineering (floating
point) value. Depending on how the analog object is used in the SCADAPack x70 configuration,

283
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289
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either the raw value or engineering value is used. Both values can be in use at the same time in
different parts of the SCADAPack x70 configuration.

Four analog object parameters define the scaling conversion between raw (integer) and
engineering (floating point) values. The same parameters are also used to convert from
engineering to integer values. These parameters are not optional. The following range checking is
performed on these parameters: 

RAW_MAXIMUM > RAW_MINIMUM, ENGINEERING_MAXIMUM > ENGINEERING_MINIMUM 

The following table describes the Scaling parameters for analog objects.

Parameter Parameter Description

Raw Minimum The minimum raw value for the analog object. 

When the analog object is associated with a physical analog input or
physical analog output, this value represents the user-defined integer
value at the minimum electrical signal. For example, for a 4...20 mA
channel:

· A value of 0 means an integer value of 0 represents 4 mA.

· A value of 400 means an integer value of 400 represents 4 mA.

When the analog object is not associated with a physical analog input
or output, set this value to the lowest expected operating integer value
for the object. This could be a negative value.

Default: 0

Limit: Greater than -1000000000 (negative 1 Billion)

Raw Maximum The maximum raw value for the analog object.

When the analog object is associated with a physical analog input or
physical analog output, this value represents the user-defined integer
value at the maximum electrical signal. For example, for a 4...20 mA
channel:

· A value of 10000 means an integer value of 10000 represents 20
mA. 

· A value of 20000 means an integer value of 20000 represents 20 mA.

When the analog object is not associated with a physical analog input
or output, set this value to the highest expected operating integer value
for the object.

Default: 10000

Limit: Less than 1000000000 (1 Billion)

Engineering
Minimum

The minimum engineering, or floating point, value for the analog object.

This is the floating point engineering units value when the object value
is at the Raw Minimum integer value.
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Default: 0

Engineering
Maximum

The maximum engineering, or floating point, value for the analog object.

This is the floating point engineering units value when the object value
is at the Raw Maximum integer value.

Default: 100

9.3.7.2 Value Deviation Parameters

The following table describes the Value Deviation parameters for analog objects.

Paramete
r

Parameter
Description

Setting Setting Description

Event
Deviation
Type

Used to detect
changes in an
analog object's
current value.

Percentage
of Span

An event is generated when a value change
exceeds the Event Deviation percentage.
This setting works only when:

· The Alert Inhibit parameter is set to No 

· The DNP3 Point Data Class parameter is
set to Class 1, Class 2, or Class 3

OR

· The IEC 60870-5-104 ASDU is configured
as a "with Event" type

With this setting, the Event Deviation
percentage is a percentage of the analog
object’s full-scale range as defined by the
Engineering Minimum and Engineering
Maximum parameters. 

Absolute An event is generated when a value change
exceeds the absolute value by the Event
Deviation Raw Units. This setting works only
when:

· The Alert Inhibit parameter is set to No

· The DNP3 Point Data Class parameter is
set to Class 1, Class 2, or Class 3

OR

· The IEC 60870-5-104 ASDU is configured
as a "with Event" type

If the DNP3 Static Group and Variation or
IEC 60870-5-104 ASDU type for the object is
set to a floating point type, then the absolute
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value deviation applies to the engineering
value of the object. 

If the DNP3 Static Group and Variation or
IEC 60870-5-104 ASDU type for the object is
not set to a floating point type, the absolute
value deviation applies to the raw value of the
object.

Integration An event is generated when a value change
exceeds the integrated value by the Event
Deviation Unit-Seconds. This setting works
only when:

· The Alert Inhibit parameter is set to No

· The DNP3 Point Data Class parameter is
set to Class 1, Class 2, or Class 3

OR

· The IEC 60870-5-104 ASDU is configured
as a "with Event" type

The analog object deviation is calculated as
the sum of the value change and time
products since the last value that was
reported as an event. 

A small value change over a long time period
can contribute to the deviation as well as a
large value change over a short time period. 

If the DNP3 Static Group and Variation or
IEC 60870-5-104 ASDU type for the object is
set to a floating point, then the value deviation
applies to the engineering value of the object
over time. 

If the DNP3 Static Group and Variation or
IEC 60870-5-104 ASDU type for the object is
not set to a floating point, the value deviation
applies to the raw value of the object over
time. The time constant part of the integration-
product is measured in seconds.

None An event is not generated when the analog
object value changes.

Default

Event
Deviation

The value change required to
generate an event for the object

Default: 100

See the Setting Description for each Event
Deviation Type.
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dependent on the chosen Event
Deviation Type.

The higher the value, the more
significant the value change
required to generate an event. 

Unsolicite
d Events
(DNP3
only)

Determines
whether the
DNP3 Outstation
spontaneously
reports events to
the DNP3
Controlling
Station when the
Event Deviation
is exceeded. 

This parameter is
only valid when
the DNP3 Point
Data Class
parameter is set
to Class 1, Class
2 or Class 3.

When the box is checked, the DNP3 Outstation
spontaneously reports events to the DNP3 Controlling
Station when a deviation event is generated.

Default: Not checked (disabled).

9.3.7.3 Out of Range Limits Parameters

The table below describes the Out of Range limits parameters for analog objects.

Use these parameters to specify analog object behavior when engineering values are out of
range. Analog objects with a DNP3 Static Group and Variation or IEC 60870-5-104 ASDU
type that is set to one of the engineering float options provide indication of the current
engineering value. To see the object value, check the Object Value for the object  in the online
parameters.

Paramet
er

Parameter Description Setti
ng

Setting Description

Under
Range
Limit

The value to compare with the
object’s current engineering
value in order to determine the
state of the under range
property.

Under range quality is indicated
in SCADAPack x70 logic
T_SPx70_xxx types for variables
linked with analog objects. It is
also available as
OUT_OF_RANGE through the

Any
floatin
g
point
value

Compares the value entered with the
object’s current engineering value. If
the current value is less than the
under-range limit, the analog object
reports that it is under-range. 

The At Limit Alert Processing
parameter setting determines when
the over-range limit value and the
under-range limit value are considered
to be transgressed. 

382
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DNP3 or IEC 60870-5-104
quality flags returned by the
SCADAPack x70 device. 

This parameter is active only
when the box is checked.

Default: Unchecked

Over
Range
Limit

The value to compare with the
object’s current engineering
value to determine the state of
the over range property. 

Over range quality is indicated in
SCADAPack x70 logic
T_SPx70_xxx types for variables
linked with analog objects. It is
also available as
OUT_OF_RANGE through the
DNP3 or IEC 60870-5-104
quality flags returned by the
SCADAPack x70 DNP3 device. 

This parameter is active only
when the box is checked.

Any
floatin
g
point
value

Compares the value entered with the
object’s current engineering value. If
the current value is greater than the
Over Range Limit, the analog object
reports that it is over range. 

The At Limit Alert Processing
parameter setting determines when
the over-range limit value and the
under-range limit value are considered
to be transgressed. 

Default: Unchecked

Zero
Threshold
Limit

Constrains the current
engineering value. If the
engineering value is below the
Zero Threshold Limit, the current
engineering value is set to 0.0. 

This parameter does not apply
to analog objects that are
connected to physical analog
output channels. 

This parameter is active only
when the box is checked

Any
floatin
g
point
value

Compares the value entered to the
current engineering value for the Zero
Threshold Limit.

Default: Unchecked

Unsolicite
d Events
(DNP3
only)

Determines whether the DNP3
Outstation spontaneously
reports events to the DNP3
Controlling Station when the
Range Limit is exceeded. 

This parameter is valid when the
DNP3 Point Data Class
parameter is set to Class 1,
Class 2 or Class 3.

When the box is checked, the DNP3
Outstation spontaneously reports events for
under range and over range to the DNP3
Controlling Station.

Default: Unchecked. Parameter is not active.
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9.3.7.4 Periodic Event Generation Parameters

The following table describes the Periodic Event Generation parameters for analog objects.
Events are generated based on the settings for the DNP3 Static Group and Variation and
Point Data Class parameters for the object or the IEC 60870-5-104 ASDU parameters.

Parameter Parameter Description Setting Setting Description

Periodic Event
Rate

The frequency at which
events are generated for the
analog object.

This parameter is active only
when the box is checked.

Range:
10...999999999
seconds (s)
expressed in hours,
minutes and
seconds

Default: Unchecked.
Parameter is not
active.

Periodic Event
Offset

The offset from Coordinated
Universal Time (UTC) for the
Periodic Event Rate.

Use this parameter to
specify when event
generation begins.

0...999999999
seconds (s)

The number of
seconds after Monday
at 00:00:00 that the
Period Event Rate
starts.

Default: 0

9.3.8 Advanced Tab: Analog Objects

Use the Advanced tab for analog objects if you need to customize how the analog object reports
actual values compared to configured thresholds.

· Analog Alert Notifications Parameters

· Rate of Change Parameters

· No Change Parameters

9.3.8.1 Analog Alert Notifications Parameters

The following table describes time and value deadband parameters that affect the Alert
Notifications behavior for analog objects.

When an alert limit has been crossed, and deadbands are configured, a timer starts in the
device. This is referred to as an Active Deadband Timer. 

289
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While the object has one or more active deadband timers, the SCADAPack x70 device withholds
object event data for the analog object from DNP3 and IEC 60870-5-104 responses.

Each alert limit for an analog object is processed individually, so a single object can have several
Active Deadband Timers.

See Active Deadband Setup > Filter Class 0 Data  to configure additional DNP3 effects on
objects with active deadband timers. 

If the deadband times are configured to 0, or when the timers expire, the SCADAPack x70
device reports the object's event and current values in DNP3 and IEC 608705-5-104 responses
as per its event configuration.

Parameter Parameter
Description

Setting Setting Description

Alert Set
Time
Deadband

The amount of
time that the value
of an analog
object needs to
have exceeded an
alert limit before it
is considered to
have transgressed
the limit.

0...65535 seconds
(s)

Default: 0, no time deadband

Alert Clear
Time
Deadband

The amount of
time that the value
of an analog
object needs to
have returned
within the alert
limit before it is
considered within
the limit.

0...65535 seconds
(s)

Default: 0, no time deadband

Alert Clear
Value
Deadband

Determines when a transgressed limit
alert is cleared. When an alert limit has
been transgressed, an object’s value
needs to return to within the alert limit
and the deadband before it is cleared.
This helps to avoid generating excessive
alerts when a value is fluctuating around
an alert limit. 

A single value deadband is specified as a
floating-point number that operates on
each of the eight limits. The Alert Clear
Value Deadband is subtracted from the
High limits and added to the Low limits. 

Maximum value: The absolute
value of (Engineering Maximum
- Engineering Minimum)

Minimum value: 0

Default: 0, no value deadband
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Event/Alert
Inhibit

Determines
whether events
are collected and
reported for the
object.

The setting for
this parameter
can be changed
by SCADAPack
x70 logic.

No Events for the object are collected
and reported.

Default setting

Yes Events for the object are not
collected or reported. Alerts for the
object are not generated.

9.3.8.2 Rate of Change Parameters

The table below describes the Rate of Change parameters for analog objects.

Use these parameters to determine if an analog object value is rising or falling too rapidly for
your requirements. The SCADAPack x70 device compares the current engineering value for the
object with its value over the specified time period and calculates the rate of change. The rate of
rise and rate of fall calculation is evaluated every time the current engineering value of the analog
object changes. 

To see the object value, see Reading Object Values from the Device  in the online
parameters.

Paramete
r

Parameter Description Setting Setting Description

Rate of
Rise

The percentage of the analog
object’s full scale engineering
range by which the analog
value is not expected to rise,
within the time Period

0...100
percent (%)

Default: 100% meaning
disabled

Other configured value: If the
object’s analog value’s rise
exceeds the Rate of Rise
percentage during the time
Period, the following occurs:

· The RoR Exceeded object
quality status is activated
and shown in
RemoteConnect online
Object Browser lists

· The
ROR_EXCEEDED_QUAL
BOOL field of a
T_SPx70_ADV_ANALOG
type logic variable changes
from 0 to 1

· The value of the BOOL
attribute
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ATTRIB_RateOfRiseAlert
for the object changes from
value 0 to 1 (when using
the OBJ_ReadField
function block - see
Function Blocks Technical
Reference manual)

Rate of Fall The percentage of the analog
object’s full scale engineering
range by which the analog
value is not expected to fall,
within the time Period

0...100
percent (%)

Default: 100% meaning
disabled

Other configured value: If the
object’s analog value’s fall
exceeds the Rate of Fall
percentage during the time
Period, the following occurs:

· The RoF Exceeded object
quality status is activated
and shown in
RemoteConnect online
Object Browser lists

· The
ROF_EXCEEDED_QUAL
BOOL field of a
T_SPx70_ADV_ANALOG
type logic variable changes
from 0 to 1

· The value of the BOOL
attribute
ATTRIB_RateOfFallAlert for
the object changes from
value 0 to 1 (when using
the OBJ_ReadField
function block - see
Function Blocks Technical
Reference manual)

Period The time period over which the
rate of rise and rate of fall
calculations are evaluated.

0...65535
seconds (s)

Default: 0 s

9.3.8.3 No Change Parameters

The table below describes the No Change parameters for analog objects.

Use these parameters to determine if an analog object value that is expected to change is
remaining static. The SCADAPack x70 device compares the current engineering value for the
object with its value over the specified time period and calculates the change percentage. The
calculation is performed every time the current engineering value of the analog object changes. 
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To see the object value, see Reading Object Values from the Device  in the online
parameters.

Paramete
r

Parameter Description Setting Setting Description

Expected
Change

The percentage of the analog
object’s full scale
engineering range by which
the analog value is expected
to change within the time
Period

0...100
percent (%)

Default: 0% meaning disabled

Other configured value: If the
object’s analog value does not
change by the Expected Change
percentage during the time
Period, the following occurs:

· The No Change object quality
status is activated and shown
in RemoteConnect online
Object Browser lists

· The NO_CHANGE_QUAL
BOOL field of a
T_SPx70_ADV_ANALOG type
logic variable changes from 0
to 1

· The value of the BOOL
attribute
ATTRIB_NoChangeAlert for the
object changes from value 0 to
1(when using the
OBJ_ReadField function block
- see Function Blocks
Technical Reference manual)

Period The time period over which
the analog object's value
change is evaluated.

0...65535
seconds (s)

Default: 0 s

9.3.9 Basic Tab: Digital Objects

Use the Basic tab for digital objects to define digital object operation. These parameters need to
be configured for each digital object regardless of the role the SCADAPack x70 device is
performing in the network. The figure below shows the parameters for digital objects that are not
associated with physical I/O.
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The figure below shows the parameters for digital objects that are associated with physical
digital inputs on SCADAPack x70 devices and on 6000 series I/O modules.

· Physical I/O Performance Parameters

· Event Attributes Parameters

· Alert Notifications Parameters

· Periodic Event Generation Parameters

9.3.9.1 Physical I/O Performance Parameters

The following table describes the Physical I/O Performance parameters for digital objects. These
parameters can only be configured for digital objects that are associated with physical digital
inputs on SCADAPack x70 devices and on 6000 series I/O modules.

Paramete
r

Parameter Description Setting Setting Description

Debounce
Time

The length of time that the physical
digital input must remain in a new
state before the state is reported as
changed. 

Use this parameter to avoid over-
reporting of state changes in an
environment where fast state
fluctuations can occur.

0...2500
milliseconds
(ms)

Default: 0 ms, no
debounce time

The debounce time is
validated in multiples of 10
for the following:

· SCADAPack 575: digital
input channels 1 to 16 

· SCADAPack 474: digital
input channels 5 to 20 

· 6601 input output
module and 6607 input
output module: digital
input associated objects

Invert State The state of the digital input or
output in the object database needs
to indicate the opposite state
compared to its physical state.

No The current state for the
object is the same as the
physical hardware state as
long as the physical
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hardware state remains
the same for the duration
of the Debounce Time.

Default.

Yes The current state for the
point is the inverse of the
physical hardware state.

9.3.9.2 Event Attributes Parameters

The following table describes the Event Attributes parameters for digital objects.

When an alert limit has been crossed, and deadbands are configured, a timer starts in the
device. This is referred to as an Active Deadband Timer. 

While the object has an active deadband timer, the SCADAPack x70 device withholds DNP3
and IEC 60870-5-104 object event data for the digital object.

See Active Deadband Setup > Filter Class 0 Data  to configure additional DNP3 effects on
objects with active deadband timers. 

If the deadband times are configured to 0, or when the timers expire, the SCADAPack x70
device reports the object's event and current state in DNP3 and IEC 60870-5-104 responses as
per its event configuration.

Paramete
r

Parameter Description Setting Setting Description

Alert Set
Time
Deadband

The amount of time that the value of
a digital object needs to have
exceeded an alert limit before it is
considered to have breached the
limit.

0...65535
seconds (s)

Default: 0 s, no time
deadband

Alert Clear
Time
Deadband

The amount of time that the value of
an digital object needs to have
returned within the alert limit before
it is considered within the limit.

0...65535
seconds (s)

Default: 0 s, no time
deadband

Unsolicited
(DNP3
only)

Determines whether the DNP3
Outstation spontaneously reports
events to the DNP3 Controlling
Station when there is a change in
state for the DNP3 point. The Point
Data Class for the point determines
the event class in which the event is
reported. The event is timestamped
with the time the change occurred. 

When the box is checked, the DNP3
Outstation spontaneously reports state
changes for the point to the DNP3
Controlling Station.

Default: Not checked (disabled).
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This parameter is only valid when
the DNP3 Point Data Class
parameter is set to Class 1, Class
2 or Class 3.

9.3.9.3 Alert Notifications Parameters

The following table describes the Alert Notifications parameters for digital objects.

Paramete
r

Parameter Description Setting Setting Description

Event/Alert
Inhibit

Determines whether event
collection and reporting for the
object are inhibited.

No Event collection and reporting
for the object are not inhibited.

This means that events for the
object are collected and
reported.

Default setting.

Yes Event collection and reporting
for the object are inhibited.

This means that events for the
object are neither collected nor
reported, and alerts for the
object are not generated.

SCADAPack x70 logic can
change the Event/Alert Inhibit
parameter of an object.

Alert Active
State

Configures the Value of the digital
object that is considered to be an
alert condition. 

The object Value is displayed in the
online parameters.

On When this configuration is set
to On, the object is considered
to have an alert condition when
the Value is On. 

Default

Off When this configuration is set
to Off, the object is considered
to have an alert condition when
the Value is Off.

9.3.9.4 Periodic Event Generation Parameters

The following table describes the Periodic Event Generation parameters for digital objects. These
parameters are displayed only when Enable Data Logging is configured in the Project
Settings .42
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Parameter Parameter Description Setting Setting Description

Periodic Event
Rate

The frequency at which
events are generated for the
analog object.

This parameter is active only
when the box is checked.

Range:
10...999999999
seconds (s)
expressed in hours,
minutes and
seconds

Default: Unchecked.
Parameter is not
active.

Periodic Event
Offset

The offset from Coordinated
Universal Time (UTC) for the
Periodic Event Rate.

Use this parameter to
specify when event
generation begins.

0...999999999
seconds (s)

The number of
seconds after Monday
at 00:00:00 that the
Period Event Rate
starts.

Default: 0

9.3.10 Basic Tab: Counter Objects

Use the Basic tab for counter objects to define counter object operation. These parameters need
to be configured for each counter object regardless of the role the SCADAPack x70 device is
performing in the network. 

· Counter Event Attributes Parameters

· Counter Alert Notifications Parameters

· Periodic Event Generation Parameters

9.3.10.1 Counter Event Attributes Parameters

The following table describes the Event Attributes parameters for counter objects.

Paramet
er

Parameter
Description

Settin
g

Setting Description

Counter
Change
Deviation

Used to detect changes
in a counter value. 

Any
positive
integer
value
up to

An event is generated when a value change
exceeds this setting. This parameter
requires the following:

· The Alert Inhibit parameter is set to No

297
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999999
999

· The DNP3 Point Data Class parameter is
set to Class 1, Class 2 or Class 3

OR

· The IEC 60870-5-104 ASDU is configured
as a "with Event" type

Default: 50

Counter
High Limit

The value at which the
counter limit is
considered to be
exceeded. 

Any
positive
integer
value
up to
999999
999

An event is generated when the counter
value exceeds this limit.

This parameter requires the following:

· The Alert Inhibit parameter is set to No

· The DNP3 Point Data Class parameter is
set to Class 1, Class 2 or Class 3

OR

· The IEC 60870-5-104 ASDU is configured
as a "with Event" type

Default: 0

Unsolicite
d (DNP3
only)

Determines whether the
DNP3 Outstation
spontaneously reports
events to the
DNP3Controlling
Station  when the
Counter High Limit is
exceeded or the
Counter Change
Deviation is exceeded.

The event is
timestamped with the
time the change
occurred. 

When the box is checked, the DNP3 Outstation
spontaneously reports events to the DNP3 Controlling
Station when the Counter High Limit is exceeded and
each time the Counter Change Deviation is exceeded.

Default: Not checked (disabled).

9.3.10.2 Counter Alert Notifications Parameters

The following table describes the Alert Notification parameters for counter objects.

Paramet
er

Parameter
Description

Settin
g

Setting Description

Event/Aler
t Inhibit

Determines whether
events are collected
and reported for the
object.

No Events for the object are collected and
reported.

Default.
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Yes Events for the object are not collected or
reported. Alerts for the object are not
generated.

9.3.10.3 Periodic Event Generation Parameters

The following table describes the Periodic Event Generation parameters for counter objects.
Events are generated based on the settings for the Static Group and Variation and Point
Data Class parameters for the object.

Parameter Parameter Description Setting Setting Description

Periodic Event
Rate

The frequency at which
events are generated for the
analog object.

This parameter is active only
when the box is checked.

Range:
10...999999999
seconds (s)
expressed in hours,
minutes and
seconds

Default: Unchecked.
Parameter is not
active.

Periodic Event
Offset

The offset from Coordinated
Universal Time (UTC) for the
Periodic Event Rate.

Use this parameter to
specify when event
generation begins.

0...999999999
seconds (s)

The number of
seconds after Monday
at 00:00:00 that the
Period Event Rate
starts.

Default: 0

Reset Period The frequency at which the
counter object value is reset
to 0 after an event has been
generated to record the
current counter value.

0...999999999
minutes (min)

Default: 0

9.3.11 Data Logging Tab

Use the Data Logging tab to enable data logging on a particular object. See Data Logging Object
Parameters .

Data logging stores events for SCADAPack x70 objects for changes in data and quality values in
the same way that events are generated for DNP3 and IEC 60870-5-104 protocols. As such, set
up basic protocol parameters for event generation for one of these protocols (even if the protocols
are not being used) for event logging to store event data.

For DNP3, set the following object configurations (see DNP3 Tab ):

· DNP3 Point Number

· Point Data Class to one of Class 1, Class 2 or Class 3

Or, for IEC 60870-5-104, set Controlling Station Enabled (see IEC 60870-5-104 Objects General
Parameters ) and the following object configurations (see IEC 60870-5-104 Tab ):
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· Monitor Direction IOA

· ASDU to a selection that includes “with Event”

For analog objects

For digital objects

For counter objects

9.3.11.1 Data Logging Object Parameters

The following table describes the Data Logging parameters that are displayed for each object.

Paramet
er

Parameter
Description

Setting Setting Description

Enable
data
Logging

When checked, data
logging is enabled. 

Default: unchecked

Data Log
Name

Select a previously
added  data log to
add the object to.

When data logging is enabled, if
the default log
SCADAPack_x70_log exists, it is

314
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selected by default. Otherwise, the
first data log in the collection is
selected by default. 

Selected
Events

Selects which events
are logged for each
object.

Analog

· Deviation 

· Alerts

· Out of range

· Periodic

· Object Quality
Change

· Logic

Deviation

· percentage, absolute value,
integration

Alerts

· 4H, 3H, 2H, 1H, 1L, 2L, 3L, 4L

Counter

· Deviation

· High Limit

· Periodic

· Object quality
change

· Logic

Deviation

· absolute value

Digital

· Change of
state

· Periodic

· Object quality
change

· Logic

9.4 Changing the Object Configuration

You may want to change the parameters of a database object to enable or modify options.

For example, before you can access a database object in the SCADAPack x70 Logic Editor,
you need to assign a Logic Variable Type and a Logic Task to it in the SCADAPack x70
configuration software. 

The procedure below describes how to change the parameter settings for one database object at
a time. If available, use the Next and Prev buttons in the Object Editor to move through the
object table entries. 

If you need to change the parameter settings for many objects at once, the most efficient
approach is to export the parameters to an Excel file, edit them, then import the parameters
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back into the SCADAPack x70 configuration software. For details, see Exporting and Importing
Object Parameters .

To change the configuration for a database object

1. On the Objects tab, select Object Configuration or Object Browsers > Browser List
Name.

2. In the Object Configuration table, double-click on the row for the object you want to
reconfigure.

The Object Editor is displayed, as shown below. The protocol tabs displayed depend on the
role selected for the SCADAPack x70 device when you created the project. The object tabs
displayed depend on the object Data Type: analog, digital or counter.

346
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3. In the Object Editor, change the object parameters, as required. 

· Object Configuration Parameters

· Associations Tab

· DNP3 Tab

· Modbus Tab

· IEC 60870-5-104 Tab

· Alert Notifications Tab: Analog Objects

· Basic Tab: Analog Objects

· Advanced Tab: Analog Objects

· Basic Tab: Digital Objects

· Basic Tab: Counter Objects

4. Click Ok.

5. On the Object Configuration page, click Apply.

9.5 Managing the Offline Browser List

Use the offline Browser List to create permanent browser lists that contain object and system
data references. These permanent browser lists, which are saved in the SCADAPack
RemoteConnect project and SCADAPack x70 device configuration, can also be used in Online
mode. See Managing the Online Object Browser List .

You can create browser lists to read and write object or system data values to a SCADAPack
x70 device when SCADAPack RemoteConnect is online.

When you create a new project, a default browser list called SCADAPack I/O is created. 

When you add objects to a browser list, the maximum number of objects is 2000. 
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Configuring an object’s Object Grouping  attribute should be considered in the context of a
collection of like objects. This can greatly assist in adding objects to a browser list. See
Grouping Objects  for more information.

The following table lists the fields that are present in the offline Browser List.

Field Name Description

Name The name of the object

Type Analog

Digital

Counter

System Group

Display Format Digital BOOL

Analog DINT

REAL (Eng)

INT

UINT

OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Counter UDINT

UINT

Binary

Hex

String Hex

ASCII

Preset Value Use this field to enter preset values for sets of objects that can
be written to the SCADAPack x70 device.

Double-click the row to enter a value in this field.

The value has the same format as the Display Format field for
the specified row.  

See Working with Preset Values .
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Source Type The item with which the object is associated. For example, an
object can be associated with a:

Physical I/O channel

Physical I/O status

DNP3 Remote Point

DNP3 Status and Control

Modbus Scanner

Modbus Status and Control

System Data Group

System Data Reference

Source Details Information about the data source for the object

DNP3 Point Number The identifier for the DNP3 point

Modbus Register The identifier for the Modbus address

See the following topics for more information:

· Adding a Browser List

· Copying or Removing a Browser List

· Adding an Entry to the Browser List

· Removing Entries from a Browser List

· Editing the Display Format and Preset Value

· Working with Preset Values

9.5.1 Adding a Browser List

The procedure below explains how to add a browser list. This browser list is saved in the
SCADAPack RemoteConnect project and SCADAPack x70 device configuration.

To add a browser list

1. On the Objects tab, select Object Browsers.
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2. Click Add Browser.

3. In the Browser Name field, enter a name that indicates the purpose of the list and the
content that you intend to define.

4. Click Ok.

5. Click Apply.

9.5.2 Copying or Removing a Browser List

· Copying a Browser List

· Removing a Browser List

To copy a browser list

1. On the Objects tab, select Object Browsers.

306
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2. Select one or more Browser Names.

3. Click Copy Browsers.

4. Click Yes.

5. Click Apply.

To remove a browser list

1. On the Objects tab, select Object Browsers.

2. Select one or more Browser Names.

3. Click Remove Browsers.
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4. Click Yes.

3. Click Apply.

9.5.3 Adding an Entry to the Browser List

You can add several kinds of objects to a browser list:

· Individual objects

· All objects in a group

o Creates an instantaneous snapshot of all of the objects in the same group. The objects

need to have the same Object Group identified. See Grouping Objects .

o This browser list is not dynamically updated if objects are reconfigured to modify their group

attribute

o The maximum number of objects in a browser list is 2000

· A System Data Group

o Automatically filled in when data is read from the SCADAPack x70 device

· A System Data Reference

o See the System Data topic in the Operations Technical Reference manual for more

information

To add an entry to the browser list

1. Navigate to Objects > Object Browsers > Browser List Name and click Add Entry.

246
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2. Choose one of the following:

· Add Object

o Click the drop-down list and select the Object Name to add

· Add all Objects currently in Group

o Click the drop-down list and select the Object Group to add

o The maximum number of objects in a browser list is 2000. If the list will have more than

2000 after you add the objects, an information icon is displayed. If you hover the mouse
over the icon, a message similar to the following is displayed:
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· Add System Data Group

o Click the drop-down list and select the System Data Group to add

· Add System Data Reference

o Click the drop-down list and select the Object Group and then the System Data

Reference Name to add

3. If available, click the drop-down list for the Display Format and select the appropriate format
for the object. 

If no display format is selected, the default display format is applied as follows:

Object Default Display Format

Analog DINT

Digital BOOL

Counter UDINT

4. Optionally, enter a Preset Value in the Offline Browser list to pre-define a Proposed Value
when the browser list is opened in Online mode. 

See Working with Preset Values .

5. Click Ok.

6. Click Apply.

9.5.4 Removing Entries from a Browser List

To remove entries from a browser list

1. Navigate to Objects > Object Browsers > Browser List Name.

2. Select one or more browser list entries.

3. Click Remove Entries.

312
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4. Click Yes.

5. Click Apply.

9.5.5 Editing the Display Format and Preset Value

You may want to edit the default format displayed online, depending on the purpose of the data
or the format you would like to see. For example, matching the logic variable type, to see the
protocol representation, debugging communications packets, to view the Engineering value
instead of raw value, etc.

 Or, you may want to add Preset Values for specific objects so that you can write those values
to the SCADAPack x70 device. 

To edit the Display Format and Preset Value of the browser entry

1. Navigate to Objects > Object Browsers > Browser List Name and click Edit Entry.

2. From the Object Browser Table drop-down list, select a format.

The following table lists the display formats available.

Type Display Formats Available

Digital BOOL

Analog DINT

REAL (Eng)

INT

UINT

OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Counter UDINT

UINT

Binary

Hex

String Hex

ASCII

System Data Reference and System Data Group BOOL
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Because the format is not known until the value
is read from the device, you can choose from the
formats available.

DINT

REAL (Eng)

Binary (Raw)

Hex (Raw)

Hex (Eng)

OS TIME

UDINT

ASCII

3. Optionally, enter a Preset Value in the Offline Browser list to pre-define a Proposed Value
when the browser list is opened in Online mode. 

See Working with Preset Values .

4. Click Ok.

5. Click Apply.

9.5.6 Working with Preset Values

You can create one or more pre-configured lists of values using the Preset Value field. These
lists can be used, for example, to configure a SCADAPack x70 device after a hardware
replacement, to provide a set of pre-defined values when commissioning a system, to compare
initial settings with current operating settings, etc. 

An outline of the basic steps are as follows:

1. In the Offline Browser, enter Preset Values for each object that will later be updated in the
SCADAPack x70 device.

2. Apply the updates.

3. Save the project file.

4. At the site, open the project file.

5. Go into Online mode and open the Object Browser.

The Preset Values are automatically populated into the Object Browser Proposed Value
fields.

6. To write all the Proposed Values to the device, click Write All . 

Alternatively, select one or more rows to be written to the device and click Write Selected.

See Transferring Current Values to the Offline Preset Values  for more information.
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9.6 Configuring Data Logging

This screen is displayed only when Enable Data Logging is configured in the Project Settings
. 

You can use data logging to log the values of database objects to files when events occur on the
object. 

A data log is a named collection of files containing the recorded values of one or more
SCADAPack x70 RTU objects. 

The following information is recorded for each event in a data logging file:

· Sequence number

· Time stamp

· Object name

· Object value

· Object type (e.g. Analog, Digital, Counter)

· Object quality

· Event type (e.g. periodic, deviation, out of range, etc.)

When logging is enabled, the current value of the object is logged when an event trigger occurs.

The data log files are stored in CSV and compressed ZIP format files. They can be saved to the
SCADAPack x70 device file system, or optionally to a USB media device.

You can use SCADAPack RemoteConnect to retrieve and display data log files. You can use
other methods to read and process data log files from the SCADAPack x70 RTU, such as FTP
file transfer and Microsoft Excel.

42
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9.6.1 Adding a Data Log

The procedure below explains how to add a data log.

The Add Data Log button is enabled as long as the maximum number of table entries has not
been exceeded. The maximum number of data logs is 10. The maximum number of objects that
can be assigned to each log is 300. 

To add a browser list

1. On the Objects tab, select Data Logging.

2. Click Add Data Log.

3. In the Name field, enter a name that indicates the purpose of the data log.

4. Click the drop-down list for Location to select where the data log is saved:

· Internal: Data log files are saved to the /user/data_logs directory on the SCADAPack x70
device

· USB: Saved to a USB media device plugged into the SCADAPack USB Host port  to the
data_logs directory
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5. Click Ok.

6. Click Apply.

To navigate to the Object Configuration table to configure objects for data logging or to set other

object parameters, you can click on the green  symbol on the Data Logging page.

9.6.2 Removing Data Logs

Follow the procedure below to remove one or more data log definitions.

To remove data logs

1. On the Objects tab, select Data Logging.

2. In the Data Logging table, select the data log(s) that you want to remove.

3. Click Remove Data Logs. 

4. Click Yes to confirm that you want to remove the data log(s).

The data log definition is removed from the table. 

9.6.3 Data Logging Parameters

The following table describes the data logging parameters.

Parameter Parameter Description Setting Setting Description

Internal Drive
Space
Reserved for
Logging

Used to configure the
maximum amount of
internal file system drive
space that the data logging
feature will use in the
SCADAPack x70 device
(when data logs are
configured to be saved as
Internal). See Adding a
Data Log .

When the size of stored
data log files on the internal
drive exceeds this length,
older data log files are
deleted as new data log
files are added.

Range:
512...51200
KB

Default: 1024 KB

Log Initial
Value
Events

Determines if an event
representing the value for
each object is logged each
time a new file is created in

Default: unchecked

314
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the data log. This is called
the initial value.

When enabled, this
selection provides an initial
value for each object for
each data log file so that
independent files can
represent object values
from the time that the file
was created.

Enable this selection if you
will primarily graph the
content of the data log
using SCADAPack
RemoteConnect.  

9.7 Configuring an Association with a System Data Reference

The Associations Tab  in the object editor provides a configuration for allocating a data source
to system data when the object has no other association. If you identify that you do need an
object to be associated with system data, the object must not have an association with another
data source, such as an I/O module, a Modbus Client scanner, a DNP3 Data Concentrator
Client. 

System data is internal information that represents the operating status of the SCADAPack x70
device.

Associate an object with system data only when you want to:

· Access a system data field from logic to influence control behavior, or to manipulate a
writeable system data field from a logic program

· Map a system data field into a remote protocol, such as DNP3, IEC 60870-5-104, or Modbus,
for permanent remote monitoring

System data can also be accessed in an ad-hoc way using SCADAPack RemoteConnect. This
type of access does not require that system data be associated with a SCADAPack object or
linked to a logic variable. All system data is available to SCADAPack RemoteConnect through a
Browser List. Access is by name only, identifying individual system data references, or
identifying a collection of system data fields belonging to a System Data Group. 

Enter a System Data Reference to associate this SCADAPack object with a piece of system
data. System Data References have fixed names. See the System Data topic in the Operations
Technical Reference manual.

Individual system data references belong to a System Data Group which is a collection of
system data references with similar SCADAPack functionality. The System Data Group name
prefixes each system reference. All valid system data references begin with one of the prefixes

which can be viewed by hovering over the  information symbol adjacent to the system data
reference configuration.

Some system data references are SCADAPack model specific, and not available on all models.

265
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When associating an object with a System Data Reference, other object configurations need to
be specifically set to use the object as a representation of the system data. The tables in the
System Data topic in the Operations Technical Reference manual. topic indicate configuration
requirements for object type, logic variable type and access methods which vary between
system data fields.

For additional information see the Accessing System Data in a Logic Program topic in the Logic
Programming Overview manual and Accessing System Data in a Remote Protocol .

To add a System Data Reference

1. On the Associations tab of the object editor, from the Source Type drop-down list, select
System Data.

2. From the System Data Reference drop-down list, select the System Data Reference
prefix that you want to associate the object with. 

3. Enter the extension of the System Data Reference. 

The extension is displayed beside the System Data Reference prefix. The extension needs to
be a valid extension for the given prefix or the SCADAPack x70 Logic Editor will not build
correctly. 

4. Set the name of the object to one of the following:

227
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· The name of the system data reference (needs to be an exact match with the association's
System Data Reference configuration). 

o To set the name of the object to the system data reference, click the Copy System

Data Reference to Name button, shown below. The Name field is overwritten. 

· An object name of your choosing (that does not begin with the prefix "SYS_")

5. Click Ok. 

6. Click Apply.

For a description of the Associations parameters, see Associations Tab .265
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10 Accessing SCADAPack x70 Logic

Use the Open Editor button on the SCADAPack x70 Logic page to access the SCADAPack
x70 Logic Editor, an IEC 61131-3 programming environment where you can write applications to
customize SCADAPack x70 device operation. 

The Logic Debug Service is enabled by default. When the Logic Debug Service box is
checked, you can connect to the SCADAPack x70 logic applications on the device for
debugging purposes. See Modifying a Logic Application Online .

To open the SCADAPack x70 Logic Editor

1. On the Configuration tab, select SCADAPack x70 Logic.

2. Click Open Editor.

The SCADAPack x70 Logic Editor opens in the background, so you may not see it
immediately. Check your taskbar for one of the following icons:

 

375
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10.1 Logic Programming Activities

The SCADAPack x70 Logic Editor and the SCADAPack x70 configuration software share
information about the physical I/O objects that are shared between SCADAPack x70 logic and
the SCADAPack x70 object database. The SCADAPack x70 configuration software is used to
transfer the logic application to the device and to monitor its operation. 

The table below summarizes the main logic programming activities and where they are
performed.

Activity Software Location

Configure the SCADAPack x70
object information to be shared with
logic variables by specifying the
variable type and logic task

Specify that the object is under
exclusive control of the logic
application

Associate physical I/O channels with
objects

SCADAPack x70
configuration
software 

· Configuration tab >
Physical I/O > Local page

· Objects tab > Object
Configuration page

Open and close the SCADAPack
x70 Logic Editor

SCADAPack x70
configuration software

Configuration tab >
SCADAPack x70 Logic page
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Update variables and build the logic
application

Unlock and resynchronize variables

Replace the logic variables in the
SCADAPack x70 Logic Editor with
those in SCADAPack
RemoteConnect

Disable logic debugging over
Ethernet or USB interfaces

SCADAPack x70
configuration software
 

Configuration tab >
SCADAPack x70 Logic page

Create or edit logic program content,
including program tasks, sections,
subroutines, user-defined data types,
function blocks and variables

SCADAPack x70
Logic Editor

Context menu items in the
Project Browser structural
view

Analyze or build logic program
content

SCADAPack x70
Logic Editor

Build menu items

Specify the TCP port number used
for communication with the
SCADAPack x70 Logic Editor

SCADAPack x70
configuration
software 

Configuration tab >
SCADAPack x70 Logic
page 

Simulate the application SCADAPack x70
Logic Editor 

Mode > Start simulation
menu item

Debug the application SCADAPack x70
Logic Editor 

· Mode > Connect menu
item

· Debug > Go menu item

Transfer the application to the
SCADAPack x70 device

SCADAPack x70
configuration software
 

Write to Device context
menu item when the
SCADAPack x70
configuration software is
online

Modify logic application online SCADAPack x70
Logic Editor

See Modifying a Logic
Application Online

Update logic application source in
the SCADAPack x70 device after an
online logic modification

SCADAPack x70
configuration
software 

· On the Logic tab in the
SCADAPack x70 online
parameters, Write Logic
Source button

· SCADAPack
RemoteConnect Online
Modification dialog
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Monitor application status

Restart the application

Reset scan times

SCADAPack x70
configuration
software 

Logic tab in the SCADAPack
x70 online parameters

Import an archived logic application SCADAPack x70
configuration
software 

Additional Functions >
Import Logic Project context
menu item when the
SCADAPack x70
configuration software is offline

Save object data values SCADAPack x70
configuration
software 

Use T_SPx70_ variable types
to link logic variable data to
SCADAPack x70 objects for
each data value that you want
to save.

1. Create a configuration for
the Object Browser lists.

2. Navigate to the online
Object Browser.

3. Select the browser and
click Refresh.

4. Click Transfer Current
Values to copy values to
the offline Object Browser
Preset Values.

5. Navigate to the offline
Object Browser and click
Apply.

6. Save the project.

Restore object data values SCADAPack x70
configuration
software 

Logic variable data values for
T_SPx70_ variable types have
their values restored when
their linked SCADAPack x70
object data values are written.

1. Open the project.

2. Navigate to the online
Object Browser.

3. Select the browser and
click Refresh.

4. Click Write All.
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10.2 Assigning Variables to Database Objects

Objects that represent analog or digital I/O

Each database object that represents analog or digital physical I/O is automatically assigned a
default logic variable when the object is created. The default types of logic variables are:

· Analog objects: T_SPx70_DINT

· Digital objects: T_SPx70_BOOL

To change the default variable assignment, configure the physical I/O channel as described in
Configuring Analog and Digital I/O Channels .

Objects that represent counter inputs or data

The default type of logic variable is:

· Counter objects: T_SPx70_UDINT

For database objects that represent counter inputs or data, such as status data or logic data,
there are 2 ways to assign variables:

· Assign a Logic Variable Type and Logic Task to the object in the SCADAPack x70
configuration software. Variables created this way are automatically available in the
SCADAPack x70 Logic Editor. For details, see Assigning a Logic Variable and Task to an
Object .

· Create a variable in the SCADAPack x70 Logic Editor. These variables are added to the
SCADAPack x70 configuration software when you click Update & Build Logic on the
SCADAPack x70 Logic page. For details about creating variables in the SCADAPack x70
Logic Editor, see the Creating a New SCADAPack x70 Variable topic in the Logic
Programming Overview manual.

SCADAPack x70 logic variables that are synchronized with SCADAPack x70 objects with
T_SPx70_xxxx types are shown as being in a Locked state in the SCADAPack x70 Logic
Editor. A small yellow lock icon identifies each locked variable. If you need to make changes to
a variable that is locked in the SCADAPack x70 Logic Editor, unlock it in the SCADAPack x70
configuration software, modify it, then resynchronize it with the SCADAPack x70 Logic Editor
and the SCADAPack x70 object database. For details, see Unlocking and Modifying a
SCADAPack x70 Variable .

10.3 Assigning a Logic Variable and Task to an Object

Before you can access a database object in the SCADAPack x70 Logic Editor, you need to
assign a Logic Variable Type and a Logic Task to it in the SCADAPack x70 configuration
software. 

The following table lists the default settings.

Object Represents Default Logic Variable
Type

Default Logic Task

65
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Physical analog input or
output

T_SPx70_DINT MAST

Physical digital input or
output

T_SPx70_BOOL MAST

Physical Counter Input T_SPx70_UDINT MAST

Status data None None

Follow the procedure below to assign or change a Logic Variable Type and a Logic Task so
you can work with the object in the SCADAPack x70 Logic Editor.

To assign a logic variable and task to an object

1. On the Objects tab, select Object Configuration.

2. Double-click on the object entry in the table.

3. Select a Logic Variable Type  and Logic Task  for the object.

4. Click Ok.

5. On the Configuration page, click Apply. 

10.4 Displaying Object Protocol Addresses in the Logic Editor

To help with end-to-end debugging, you can view the DNP3 point numbers and/or Modbus
register addresses of logic variables for SCADAPack objects in the SCADAPack x70 Logic
Editor.

250 251
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NOTICE

DATA LOSS

Content that is in the Logic Editor Custom field is overwritten when you use the Object
Protocol Address(es) in Logic Editor Custom Field feature and apply the changes.

Save the content to another location.

Failure to follow these instructions can result in equipment damage.

 To display object protocol address(es) in the SCADAPack x70 Logic Editor

1. If the SCADAPack x70 is currently online, under My Network, right-click on SCADAPack
x70 Controller Settings -DeviceDTM  and select Go Offline.

2. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Project Settings.

3. Select the Object Protocol Address(es) in Logic Editor Custom Field checkbox.
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4. Click Ok.

5. Do one of the following: 

· Add an object

· Change an object's configuration

· Add I/O

6. Apply the changes.

See Viewing Object Protocol Addresses in the Logic Tool .

If you added DNP3 point numbers and/or Modbus register addresses before you selected the
Object Protocol Address(es) in Logic Editor Custom field, you can display those addresses in
the SCADAPack x70 Logic Editor:

236

301
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327
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1. If the SCADAPack x70 is currently online, under My Network, right-click on SCADAPack
x70 Controller Settings -DeviceDTM  and select Go Offline.

2. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Project Settings.

3. Select the Object Protocol Address(es) in Logic Editor Custom Field checkbox.

4. Click Ok.

5. Replace SCADAPack x70 Logic Editor Variables with SCADAPack RemoteConnect
Variables .

10.4.1 Viewing Object Protocol Addresses in the Logic Tool

When the Object Protocol Address(es) in Logic Editor Custom Field option is selected in
the Project Settings, SCADAPack RemoteConnect presents data in the logic custom field. 

The following may be included:

· I/O information

· DNP3 Point Number

· Modbus Register address

All sections of the logic custom field are optional (I/O, DNP, MB). Where multiple sections are
present in the custom field string, they are separated by a period followed by a space. The
format of the custom field is as follows:

[IOsourceName IOChannelName][. ][DNP pointType,pointNumber][. ][MB
registerType,registerAddress]

Where:

pointType is one of the DNP3 types: DI, DO, AI, AO, CI

pointNumber (preceded by a comma) is a DNP3 point index in the range 0...65534

registerType is one of: Discrete, INT, UINT, DINT, REAL, UDINT

registerAddress (preceded by a comma) is a 5-digit or 6-digit Modbus address (e.g. 40001,
400001) depending on the RTU configuration for the Modbus Server.

Examples

A RemoteConnect object that represents physical I/O and has a configured DNP3 point number
and Modbus address might look as follows:

SP574 DI8. DNP DI,99. MB Discrete,109

Other examples:

o A RemoteConnect object that is not a physical I/O point and has only a configured DNP3

point number might look as follows:

DNP AO,516

o A RemoteConnect object that is not a physical I/O point and has only a configured Modbus

address might look as follows:

342
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MB INT,30008

Custom field values are also presented in the logic editor's variable export file when the XSY file
type is selected. Various applications may import or parse this content. The "CustomerString"
attribute presents the Custom attribute field value for each variable. 

Following is an example of part of the XSY export file showing a variable with custom addressing
content:

<variables name="PIO_SP574_DI8" typeName="T_SPx70_BOOL">

<attribute name="ManagedKey" value="0449eb77-dd9e-4e6d-a7ec-
57407989319a"></attribute>

<attribute name="CustomerString" value="SP574 DI8. DNP DI,99. MB
Discrete,109"></attribute>

<attribute name="Owner" value="TRSS_RSC"></attribute>

The ManagedKey and Owner attributes are private data used by RemoteConnect for tracking
and locking the variable content for SCADAPack objects and logic synchronization. Ignore them
when parsing the XSY file.

To view the object protocol addresses in the SCADAPack x70 Logic Editor

1. In the SCADAPack x70 Logic Editor, in the Project Browser, under Variables and FB
instances, double-click Derived Variables.

2. If the Custom column is not visible:

a. Right-click the column heading and select Customize Columns.

b. Select Custom.

c. Click OK.

3. Scroll to the variable. 

The DNP3 point numbers and/or Modbus register addresses that were configured in
SCADAPack RemoteConnect are displayed in the Custom column.

Addresses are displayed only for variables that are not of type struct or array. 

10.5 Updating Variables and Building Logic

When you have completed your logic application, use the Update & Build Logic button on the
SCADAPack x70 Logic page to build the application and update the logic variables in
SCADAPack RemoteConnect with any new variables created in the SCADAPack x70 Logic
Editor. 

This button is available only when the SCADAPack x70 Logic Editor is open. If you have pending
updates that have not been applied, or if there are any validation errors, the button is not
available. 

Alternatively, you can select Build > Rebuild All Project in the SCADAPack x70 Logic Editor.
However, using this command does not update the variables in the SCADAPack x70 object
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database. It can also result in a message indicating there are inconsistencies with variables. If
you see this message, click Update & Build Logic on the SCADAPack x70 Logic page.

To update variables and build logic

1. On the Configuration tab, select SCADAPack x70 Logic.

2. If you used the SCADAPack x70 Logic Editor to modify or create your own DDT structures
containing T_SPx70_xxxx variables, analyze the DDT structure definition using Build >
Analyze or CTRL+SHIFT+B in the SCADAPack x70 Logic Editor before proceeding.

3. Click Update & Build Logic.

In a new project, save the project to enable the Update & Build Logic button.

You are prompted to confirm that you accept that the SCADAPack RemoteConnect
configuration and logic will be modified, and that the project file will be saved.

4. To proceed with the operation, click Yes.

The SCADAPack x70 Logic Editor may prompt you to confirm modifications to the
application. If the build operation does not complete, check whether you need to
acknowledge this prompt in the SCADAPack x70 Logic Editor. 
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In the SCADAPack x70 Logic Editor, the following message is displayed:

5. To maintain synchronization of the variables in the SCADAPack x70 object database and the
SCADAPack x70 Logic Editor, click Yes.

If you click No, you will be unable to build your application. A message similar to the
following is displayed in SCADAPack RemoteConnect:

6. Click OK and then click Update & Build Logic.
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10.6 Saving and Closing the SCADAPack x70 Logic Editor

Saving your project

By default, projects are saved on the SCADAPack RemoteConnect computer in C:
\Users\Public\Public Documents\Schneider Electric\RemoteConnect. Saving to a network drive
may not be successful if the network drive performance is not optimal.

To save your project in the SCADAPack x70 Logic Editor

· In the SCADAPack x70 Logic Editor, select File > Save.

Saving your project in the SCADAPack x70 Logic Editor also saves your project in SCADAPack
RemoteConnect. 

Closing your project

Use the Close Editor button on the SCADAPack x70 Logic page to close the SCADAPack x70
Logic Editor.

Alternatively, you can select File > Exit in the SCADAPack x70 Logic Editor.

To close the SCADAPack x70 Logic Editor

1. On the Configuration tab, select SCADAPack x70 Logic.

2. Click Close Editor.

10.7 Disabling Logic Debugging

By default, you can access a connection for debugging the logic application on the SCADAPack
x70 device. 

Limiting users to local access can help you comply with safety, security, permission, or
administrative policy requirements. When the Logic Debug Service box is unchecked, you
cannot connect to the SCADAPack x70 logic applications on the device for debugging purposes.
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To disable local or remote access to the logic application using a USB, Ethernet or PPP TCP/IP
connection, deactivate the Logic Debug Service, as described below.

To disable logic debugging 

1. On the Configuration tab, select SCADAPack x70 Logic.

2. Uncheck the Logic Debug Service checkbox.

3. Click Apply.

4. Write the configuration .

10.8 Importing Logic Projects

SCADAPack RemoteConnect allows you to import 4 different import formats:

· STA: A compressed archive version of the logic project (.stu) file that is generated by the
SCADAPack x70 Logic Editor. If the project has password protection, you will need to enter
the password to complete the import of the project.

· XEF and ZEF: Logic project exports generated by the SCADAPack x70 Logic Editor that can
also be generated by external tools. They are used by SCADAPack RemoteConnect to import
a full logic application for the SCADAPack x70 device type selected in the RemoteConnect
Project Settings. The ZEF file is a compressed version of the XEF file. Importing an encrypted
.ZEF file is not supported.  

· XPG: Logic content that is developed in the SCADAPack x70 Logic Editor can be exported
from the MAST, FAST, AUX0, or AUX1 tasks in the Project Browser. The exported content is
contained in a .xpg file that can be imported into another SCADAPack x70 project by the
SCADAPack RemoteConnect configuration software.

Import an archived or exported logic file into the SCADAPack x70 Logic Editor when you want
to:

· Work with a logic project developed in another project using the SCADAPack x70 Logic Editor

· Revert to a back-up copy of a SCADAPack x70 logic project

For the import to be successful, the device type of the logic project needs to match the device
type of the SCADAPack RemoteConnect project. For example, a logic project developed on a

354
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SCADAPack 47x can be imported into a SCADAPack 47x SCADAPack RemoteConnect
project. The same is true for a SCADAPack 57x logic project that is imported into a
SCADAPack 57x SCADAPack RemoteConnect project.

 WARNING

DATA LOSS

Importing an archive or export file for a logic project overwrites the information in the
SCADAPack x70 object database with the information contained in the imported file. Objects
currently in the RemoteConnect database that are linked with logic variables will be removed
after the file is imported.

Before importing an archive file into the SCADAPack x70 configuration software backup the
current project and configuration files, as described in the SCADAPack RemoteConnect
Configuration Software manual, in case you need to access them in the future.

Failure to follow these instructions can result in death or serious injury.

To import a SCADAPack x70 Logic Editor project 

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Import Logic Project. 

2. In the Import Logic Project dialog, click Browse to navigate to the file.

An archived logic project file has one of the extensions .XEF, .ZEF, or .STA.

Exported task logic content has a .xpg extension.
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3. In the Open dialog, locate the file that you want to import, then click Open.

4. In the Import Logic Project dialog, click Ok.

A confirmation dialog is displayed when the operation successfully completes. 

5. Click Ok.

If the .STA project is password protected, the Password dialog opens.  

6. Enter the password for the project and click Ok. 

7. If you have forgotten the password, in the Password field, press Shift+F2. 

The Password Forgotten dialog is displayed with information for retrieving the forgotten
password. 

8. Follow the instructions in the dialog and click Close. 

10.9 Importing Logic and Configuration from Geo SCADA

You can import logic and configuration from a Geo SCADA / SCADAPack x70 configuration
export. 

· If logic is present in the RTZ file, array and structure objects are imported

· If logic is not present in the RTZ file, array and structure objects are not imported since no
corresponding logic variables exist. Array and structure variables will need to be recreated in
the SCADAPack x70 Logic Editor after the import is completed.
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To import logic and configuration from a Geo SCADA / SCADAPack x70
configuration export

1. On the SCADAPack x70 Configuration tab in SCADAPack RemoteConnect, select
SCADAPack x70 Logic, then expand the Advanced Configuration parameters.

2. In the Geo SCADA section, click Import.

3. Navigate to the RTZ file you want to import and click Open. 

If the RTZ project is password protected, the Password dialog is opens. 

4. Enter the password for the project and click Ok.

5. If you have forgotten the password, in the Password field, press Shift+F2.

The Password Forgotten dialog is displayed with information for retrieving the forgotten
password. 
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4. Follow the instructions in the dialog and click Close. 

5. If the project is not password protected or when the password is successfully entered, you
can use SCADAPack RemoteConnect and the SCADAPack x70 Logic Editor to create or
modify logic and objects. 

· Any objects added or modified in SCADAPack RemoteConnect for use in logic need to be
added or modified in Geo SCADA

· Any changes to the T_SPx70_ logic type attribute or the logic task attribute of
SCADAPack RemoteConnect objects needs to be updated in Geo SCADA

· Any other object attribute or configuration changes made in SCADAPack RemoteConnect
are not updated in Geo SCADA when they are imported. Make configuration changes in
Geo SCADA objects only. 

6. On the SCADAPack x70 Logic page, click Update & Build Logic.

7. Save the project in SCADAPack RemoteConnect.

8. In Geo SCADA, import the updated RTZ file.

9. Create or modify Geo SCADA configuration objects for logic, as needed. 

10.10 Unlocking and Modifying a SCADAPack x70 Variable

NOTICE

OBJECT CONFIGURATION LOSS

Editing a DDT definition may result in the loss of object configuration, specifically DNP3
Address and/or Modbus register assignments and Physical I/O channel associations. 

After editing of the DDT definition is complete, check the object configuration of any objects in
the edited DDT.

Failure to follow these instructions can result in equipment damage.
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Use the Unlock Variable button in the Advanced section of the SCADAPack x70 Logic page
to:

· Unlock a SCADAPack x70 logic variable in the Logic Editor

· Make changes to the variable 

· Analyze the variable to apply the modification across the project if it is a structured variable

· Resynchronize the variable in the Logic Editor with the SCADAPack x70 object database

If you unlock a structured variable (user DDT), every other variable with the same type is also
unlocked so you can modify the DDT structure.

If you increase the size of an array of T_SPx70_xxxx type, objects are added to the object
database entries with default attributes. If you decrease the size of an array, the corresponding
object database entries are removed.

If you delete a structured variable while it is unlocked in the SCADAPack x70 Logic Editor, every
object linked to that variable is also deleted.

To unlock, modify and resynchronize a SCADAPack x70 variable

1. In the SCADAPack x70 Logic Editor, select Tools > Data Editor and locate the name of the
variable that you want to unlock. 
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2. On the Configuration tab in the SCADAPack x70 configuration software, select SCADAPack
x70 Logic, then expand the Advanced Configuration parameters.
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3. Click Unlock Variable.

4. Enter the name of the logic variable that you want to unlock, then click Unlock.

The SCADAPack x70 Logic Editor may prompt you to confirm modifications to the
application. If the build operation does not complete, check whether you need to
acknowledge this prompt in the SCADAPack x70 Logic Editor.

If you click No, a message similar to the following is displayed:
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5. Click OK and click Unlock Variable. 

The lock icon is no longer shown beside the variable name in the Data Editor.

6. Modify the variable name and fields as required.

7. If the SCADAPack x70 Logic Editor indicates that the variable needs to be analyzed, select
it then select Build > Analyze from the main menu. 

The Analyze icon  indicates when the variable requires the Analyze function. It is
typically needed for structured variables (user DDTs).
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8. Return to the SCADAPack x70 Logic page and click Resynchronize.

The dialog shows the original name for the variable, even if you renamed it as part of your
modifications.

When the resynchronization is complete, the variable is updated and relocked in the
SCADAPack x70 Logic Editor and updated in the SCADAPack x70 object database. In the
examples below, the variable PIO_SP575_DI2 was renamed to
DigitalInput2_SwitchConnection and the VALUE was set to 3 while it was unlocked.
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10.11 Replacing SCADAPack x70 Logic Editor Variables with SCADAPack
RemoteConnect Variables

Use the Replace Variables button in the Advanced section of the SCADAPack x70 Logic page
to replace the SCADAPack x70 (T_SPx70_xxxx) logic variables in the Logic Editor with the
corresponding objects in SCADAPack RemoteConnect. This is only required if the Logic Editor
is missing variables that are available in SCADAPack RemoteConnect.

NOTICE

DATA LOSS

Clicking the Replace Variables button when changes to the object database have not been
applied can lead to further inconsistencies between the variables in the SCADAPack x70 Logic
Editor and in SCADAPack RemoteConnect.

Do not click the Replace Variables button when the Apply button on the Objects tab, or on
the SCADAPack x70 Logic page is active. 

Failure to follow these instructions can result in equipment damage.

To replace SCADAPack x70 Logic Editor variables with SCADAPack
RemoteConnect variables

1. On the SCADAPack x70 Configuration tab in SCADAPack RemoteConnect, select
SCADAPack x70 Logic, then expand the Advanced Configuration parameters.
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2. Click Replace Variables.

The SCADAPack x70 Logic Editor may prompt you to confirm modifications to the
application. If the build operation does not complete, check whether you need to
acknowledge this prompt in the SCADAPack x70 Logic Editor.

If you do not click Yes, a message similar to the following is displayed in SCADAPack
RemoteConnect:

3. Click Replace Variables and in the SCADAPack x70 Logic Editor, click Yes to confirm the
modification to the variables.

10.12 Upgrading the Logic Library

Use the Upgrade Logic Library button in the Advanced section of the SCADAPack x70 Logic
page to use the latest Logic Library version. You will need to rebuild and you may need to
modify some logic in the SCADAPack x70 Logic Editor. It is a good idea to verify that the project
functions as expected on the SCADAPack x70 device.

The Upgrade Logic Library button is disabled if:
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· There are pending changes in the configuration that have not been saved

· The logic library is already the most current version

To upgrade the logic library

1. On the SCADAPack x70 Configuration tab in SCADAPack RemoteConnect, select
SCADAPack x70 Logic, then expand the Advanced Configuration parameters.

2. Click Upgrade Logic Library.

You are prompted to confirm that you accept that you want to upgrade the logic library. The
logic will be modified and the project file will be saved.

3. To proceed with the operation, click Yes.

4. In the Information dialog, click Ok.

The Update Logic Library button is now disabled. 
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10.13 Logic Debugger Parameters

The table below describes the Advanced Configuration Logic Debugger parameters for the
SCADAPack x70 Logic Editor.

Parameter Parameter Description Setting Setting Description

Logic
Editor IP
Address

A read-only parameter that is displayed
when there is a valid IP address or
hostname specified in the PC
Communication Settings -SCADAPack
CommDTM and TCP, UDP or USB is
being used for communication between
SCADAPack RemoteConnect and the
SCADAPack x70 device.

Standard IP address format

Logic
Debug TCP
Port

The TCP port number used for
communication with the SCADAPack x70
Logic Editor.

Default:
504

The default setting is
typically adequate and
only needs to be
changed if requested
by your Network
Administrator. For
example, a firewall or
other network
infrastructure may
require a different port
number. 

Enabled only when
Logic Debug Service
is enabled. 
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11 Working Offline with the SCADAPack x70 Device

When the configuration software is offline, you are not communicating with the SCADAPack x70
device. For details about functionality while offline, see Accessing Offline Functionality .

If you need to change many parameter settings at the same time or manipulate object
parameters in another SCADA application you can Export and Importing Object Parameters .

11.1 Exporting and Importing Object Parameters

If you need to change many parameter settings at the same time or manipulate object
parameters in another SCADA application, the most efficient approach is to export the
parameters to an Excel file. You can then:

· Make bulk changes to parameter settings and then import the file back into SCADAPack
RemoteConnect. The updated parameter settings take effect the next time you write the
configuration to the device .

· Reformat or manipulate the data so it can be imported into a SCADA client or into an external
application that is being used to configure the SCADA client and the SCADAPack x70 device.

Only .XLS format is supported

The exported Excel file includes the following SCADAPack RemoteConnect current parameter
settings:

· Export Settings · Modbus Scanner - Object associations

· Project Settings · Modbus Store and Forward

· Database Objects · IP Firewall

· Local Physical I/O · Serial Ports

· Local Physical I/O Channels · Parameters

o SCADAPack Identification, time zone, and

miscellaneous settings

o Modbus/TCP Server protocol settings 

o DNP3 Outstation protocol and event

settings 

o DNP3 protocol layer settings

o IP services settings

o HART Pass Through protocol settings

o IEC 60870-5-104 settings

· DNP3 Controlling Station Devices

· DNP3 Controlling Station Points

· DNP3 Routing

· IP Routing

· Modbus Server Devices

· Modbus Scanners

· DNP3 Controlling Station Device - Object
associations

· Ethernet Ports

25
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· DNP3 Controlling Station Point - Object
associations

· Browser Lists

· Modbus Server Device - Object associations · Browser objects

· Data logs

See:

· Exporting to Excel File

· Manipulating Object Parameters

· Adding Objects Using the Excel File

· Importing from Excel File

11.1.1 Exporting to Excel File

You can give the exported Excel file any name and store it in any location. 

To export the object parameters to Excel

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Export to Excel File. 

2. In the Export to Excel File dialog, click Browse to navigate to a location.

3. In the Save As dialog, enter a name and select a location for the Excel file, then click Save.
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Only .XLS format is supported

4. In the Export to Excel File dialog, click Ok.

11.1.2 Manipulating Object Parameters

You can use the exported Excel file to create templates, merge configurations, disable object
rows, and edit data. For example, if you wanted to assign DNP3 point numbers to your objects,
you can edit the spreadsheet and then import the file. 

It is recommended that you do not change the object Name. A modified object Name is not
updated in the logic program sections.

To manipulate the object parameters

1. Export the file . 

2. Open the saved Excel file.

3. Choose the Import Method .

4. Enable or disable specific object rows .

5. Edit the parameter settings as required .

6. Save the file.

7. Import the file.

Choose the Import Method

· On the (0) Export Settings worksheet, in the Value Column, second row, use the drop-down
list to choose one of the following: 

o Replace all configuration <0> (default)

§ All SCADAPack RemoteConnect data set configuration from the various worksheets is
replaced. Objects in the SCADAPack RemoteConnect data set and SCADAPack x70
Logic Editor whose object names do not appear in the (2) Objects worksheet are
deleted.

o Merge objects only <1>

§ Only the (2) Objects worksheet is imported into SCADAPack RemoteConnect. No
changes are made to other configurations in the SCADAPack RemoteConnect data set
other than to the objects list.

§ Only rows in the (2) Objects worksheet configured as Enable Import On <1> are
merged.

§ Imported Object worksheet rows with new Object Name fields results in the creation of
new objects in the SCADAPack RemoteConnect data set. The configuration attributes
are set from the spreadsheet columns. 
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§ Imported Object worksheet rows with modified attributes update the attributes of the
SCADAPack RemoteConnect object. Do not modify the object Name.

§ Changes merged for existing objects or newly created objects may have configuration
mismatches after the import merge. You need to manually resolve the mismatches in
SCADAPack RemoteConnect to complete a valid configuration.

§ No configuration in SCADAPack RemoteConnect is deleted when using this import
method.

Enable or disable specific object rows

You can selectively disable object rows from being imported by setting a row selection to Off
using the drop-down list.

· On the (2) Objects worksheet, in the Enable Import column, for each row, choose one of

o On <1> (default)

o Off <0>

Edit parameter settings

You can selectively edit parameter settings using the drop-down list for the parameter.

1. On a worksheet, select a parameter that you want to change.

2. Click the arrow on the right side of the cell.

3. Select the option from the list. 

Only options that are available for that parameter are displayed.

11.1.3 Adding Objects Using the Excel File

You can use the Excel file to add objects. It is recommended that you use this feature only if
you are an advanced user and familiar with the interactions of the configuration parameters of the
SCADAPack x70 system. Updates may be required on more than one worksheet.

If you want to add a number of objects that have similar parameters, you can use the exported
Excel file to add them and then import the file. 

To create a new object, copy an existing row or block of rows for the type of new objects that
you require. For example, if you want to create more digital objects, copy a row or block or rows
of digital objects. 

When using the Merge objects only <1> setting, the Object Sequence ID is optional for new
objects.

Take care copying system objects that start with SYS_. The object name needs to match the
system data reference name exactly or not start with SYS_.



3.10.3

x70 ConfigurationWorking Offline with the SCADAPack x70 Device

350

To add an object using the Excel file

1. Export to an Excel File .

2. On the (2) Objects worksheet, do one of the following:

· Copy and paste an existing row or a block of rows

· Add a new row

3. Edit the Name of the object. 

Each object Name needs to be unique. 

4. Leave the Object Sequence ID blank. 

The import process assigns a new Object Sequence ID as long as the object Name is
unique. 

5. Edit the parameters, as needed.

Each DNP Point Number (if used) needs to be unique for the same DNP3 point group.

Each object Modbus Register Address (if used) needs to be unique.

Each object IEC 60870-5-104 Monitor and Control direction IOA address (if used) needs to
be unique.

6. Save and close the file.

7. In SCADAPack RemoteConnect, import from an Excel file . 

11.1.4 Importing from Excel File

To import object parameters from Excel

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Import from Excel File.
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2. In the Import from Excel File dialog, click Browse.

3. In the Open dialog, navigate to the updated Excel file, then click Open.

Only .XLS format is supported

4. In the Import from Excel File dialog, click Ok.

The parameter settings are updated in the offline configuration. They take effect in the
SCADAPack x70 device the next time you write the configuration to the device .354
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12 Working Online with the SCADAPack x70 Device

When the configuration software is online, you are communicating with the SCADAPack x70
device. For details about functionality while online, see Accessing Online Functionality .

To access online functionality, under My Network, right-click on SCADAPack x70 Controller
Settings -DeviceDTM  and select the required function:

· Reading the Configuration and Logic Application from the Device

· Writing the Configuration and Logic Application to the Device

To access more online functionality, under My Network, right-click on SCADAPack x70
Controller Settings -DeviceDTM  and select Additional Functions. From there you can
access the Device Operation  functions. 

While online you can:

· Transfer the Configuration and Logic Application to and from the Device

· Read Status and Version Information from the Device

· Manage Licensing

· Manage the Logic Application in the Device

· Add a RemoteConnect Object and Logic Variable Online

· Read Object Values from the Device

· Manage the Online Object Browser List

· Manage Object Forcing

· Managing Data Logging

· Managing Device Operation

· Update the Firmware and Bootloader on the Device

12.1 Transferring the Configuration and Logic Application to and from the Device

The settings for configuration parameters and the logic application are transferred to and from the
SCADAPack x70 device at the same time. 

· Comparing Project Configurations

· Writing the Configuration and Logic Application to the Device

· Reading the Configuration and Logic Application from the Device

12.1.1 Comparing Project Configurations

To help determine whether you need to write the latest configuration and logic application to the
SCADAPack x70 device, you can compare the versions on the device with those in SCADAPack
RemoteConnect.

· If the versions are equal, you do not need to take any action. 

· If the versions are different, read or write the configuration and logic application to realign them.
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Comparison details

When the project configurations are compared, the parameter settings in SCADAPack
RemoteConnect are compared to those in the device. As a result:

· If you change a parameter setting in SCADAPack RemoteConnect after reading or writing the
configuration to the device, the 2 configurations are considered to be different. 

· If you then revert the configuration change in SCADAPack RemoteConnect to its original
state, the 2 configurations are considered to once again be equal.

When SCADAPack x70 Logic Editor applications are compared, each new build of the
application in the SCADAPack x70 Logic Editor is considered to be a different application. As a
result, 2 applications that appear to be identical in terms of content — function blocks, variables
and connections — may not be considered identical because the build number for the
SCADAPack x70 Logic Editor version has been incremented. If the application was rebuilt in the
SCADAPack x70 Logic Editor, but no changes were made, the build number is not incremented
and the 2 applications are still considered to be equal.

To compare project configurations

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Compare Project Configuration.

If the versions are different, follow the rest of this procedure to realign them.

2. Do one of the following:

· To update the versions in the SCADAPack x70 device to match those in SCADAPack
RemoteConnect, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Write to Device.

· To update the versions in SCADAPack RemoteConnect to match those in the
SCADAPack x70 device, right-click on SCADAPack x70 Controller Settings -
DeviceDTM  and select Read from Device.
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3. When the operation is complete, right-click on SCADAPack x70 Controller Settings -
DeviceDTM  and select Additional Functions > Compare Project Configuration.

The versions should now be equal.

12.1.2 Writing the Configuration and Logic Application to the Device

Write the configuration to the device to transfer and activate the latest parameter settings and
the logic application in the SCADAPack x70 device. The SCADAPack x70 device needs to
match the device type configured for the project. You can use Additional Functions > Project
Settings to change the Device Type.

 WARNING

UNINTENDED EQUIPMENT OPERATION

When you write the configuration to the SCADAPack x70 device:

· Any parameter settings that have been updated in the SCADAPack x70 configuration
software since the last write operation take effect in the device.

· The logic application automatically begins to run in the device.

Before writing the configuration and the logic application to the SCADAPack x70 device,
evaluate the operational state of the equipment being monitored and controlled by the
SCADAPack x70 device.

Failure to follow these instructions can result in death or serious injury.

Schneider Electric believes cybersecurity is critical in today’s connected world. Improved
cybersecurity mechanisms are now included in SCADAPack products and updated tools are
required to apply the new device configurations. Before installing the new hardware, install the
latest version of the configuration software. Old versions of software will not be able to configure
products equipped with these enhanced cybersecurity features. See the Working With Security
Locking topic in the Getting Started manual.
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For assistance in obtaining these updated versions, contact Technical Support .

To write the configuration and logic application to the device

1. Under My Network, select SCADAPack x70 Controller Settings -DeviceDTM  and click
Online.

2. Do one of the following:

· On the Network View toolbar, click Write. 

· Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM 
and select Write to Device.

 

3. In the confirmation dialog, click Yes.

13
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If the project's configured controller type does not match the actual configured device, a
message similar to the following is displayed:

See Changing the Project Settings .

12.1.3 Reading the Configuration and Logic Application from the Device

When you read the configuration from the SCADAPack x70 device, the parameter settings
defined on the device overwrite the parameter settings defined in the SCADAPack x70
configuration software and the local configuration file is updated. 

If you have developed a logic application in the SCADAPack x70 Logic Editor, it is also
transferred from the SCADAPack x70 device with the configuration. 

To read the configuration and logic application from the device

1. Under My Network, select SCADAPack x70 Controller Settings -DeviceDTM  and click
Online.

2. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Read from Device.

42
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If the project is password protected, the Password dialog is opens. 

3. Enter the password for the project and click Ok.

4. If you have forgotten the password, in the Password field, press Shift+F2. 

The Password Forgotten dialog is displayed with information for retrieving the forgotten
password. 
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5. Follow the instructions in the dialog and click Close. 

When the password is entered correctly, or when there is no password required, and the read
operation is complete, the parameter settings and the logic application are updated in the
SCADAPack x70 configuration software. 

12.2 Reading Status and Version Information from the Device

Use the Status tab in the SCADAPack x70 online parameters to view and reset status
information from the SCADAPack x70 device. 

· Control Actions Functionality

· Status Tab Details

· Status Tab Details - Advanced

Status tab
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Status tab - Advanced Status
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To read the latest status and version information from the device

· On the Status tab, click Refresh. 

This is a good way to confirm that the SCADAPack x70 device is communicating with the
SCADAPack x70 configuration software. 

The information remains until the next time you click Refresh.

Online Status The current status of communication between SCADAPack
RemoteConnect and the SCADAPack x70 device. One of:

· Stand by

· Checking

· Connecting

· Connected

· Disconnecting

· Disconnected

· Disturbed

These connection states are the same as those displayed along the
bottom bar in SCADAPack RemoteConnect. For details, see the Status
Indicators topic in the SCADAPack RemoteConnect Configuration
Software manual.

Connection
Information

The currently configured communication type between SCADAPack
RemoteConnect and the SCADAPack x70 device. When connected with
USB, the device serial number is also indicated.

To clear the Task Watchdogs, Restart Reason and System Status Code fields

· On the Status tab, click Reset Diagnostic Status. 

Because new mask values are added to existing values, clearing these fields makes it easier
to detect new conditions.

To set the device system time

· On the Status tab, click Set Device Time.

See Setting the Time on the Device . 

To view the contents of config.log

· On the Status tab, click Open Configuration Log. 

You can use this button to view the date and time that the configuration was written, and
check the validity of the configuration. The following is a sample log file:

423
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12.2.1 Control Actions Functionality

The following table describes the functionality available in the Control Actions section on the
Status tab.

Button or Field Description

Refresh Updates the online Status Tab Details  with the latest values from the
SCADAPack x70 device.

Reset
Diagnostic
Status

Clears online mask values displayed in the Task Watchdogs, Restart
Count, Restart Reasons, and System Status Code fields.

Because new mask values are added to the existing mask values in these
fields each time the SCADAPack x70 device is restarted, clearing these
fields can help you troubleshoot new conditions that are causing the device
to restart. 

Last Updated The PC date and time that information was last read from the SCADAPack
x70 device. 

Format: 

· 24-hour clock

· dd/mm/yyyy hh:mm:ss

12.2.2 Status Tab Details

The following tables describe the information provided on the Status tab.

361
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NOTICE

CONFIGURATION DATA LOSS

If the onboard RAM back-up battery loses its charge, SCADAPack x70 device configuration
data can be lost.

If the RAM Battery parameter displays Low, see the hardware manual for information about
replacing the battery in the device.

Failure to follow these instructions can result in equipment damage.

Identification

Information Description

SCADAPack Type The type of device that is communicating with the SCADAPack
RemoteConnect configuration software.

Serial Number The unique numerical identifier for the device that is communicating with
the SCADAPack RemoteConnect configuration software.

Release The description and release number of the firmware running in the
device that is communicating with the SCADAPack RemoteConnect
configuration software.

Firmware Version The version number of the firmware running in the device that is
communicating with the SCADAPack RemoteConnect configuration
software. 

Operation Status

Information Description

Forcing Displays if forcing is active and the number of objects and EBOOL logic
variables that are forced. See Managing Object Forcing .

n forced objects: Indicates the number of SCADAPack x70 objects
that are currently forced. In Online mode, see Objects > Forced
Objects.

n forced EBOOL logic variables: Indicates the number of EBOOL
logic variables that are currently forced. In the SCADAPack x70 Logic
Editor, in Connected mode, double-click the red F in the lower status
bar. 

If forcing is not active:

· The Force LED on the SCADAPack x70 is not lit

394
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· None is displayed

If forcing is active:

· The Force LED on the SCADAPack x70 is lit

· Active is displayed

Input Voltage The voltage being applied to the device that is communicating with the
SCADAPack RemoteConnect configuration software. Measured in Vdc.

The status of the voltage being applied to the device compared with the
Low Voltage Alert Level setting in the configuration parameters . 

Normal: The input voltage is above the Input Voltage Low Threshold
setting. No action is required.

Low: The input voltage is below the Input Voltage Low Threshold
setting. Check the source of the input voltage to the device.

Used to determine the Input Voltage Status. Measured in Vdc.

Memory Battery The voltage and status of the onboard RAM back-up battery in the
device that is communicating with the SCADAPack RemoteConnect
configuration software. Voltage is measured in Vdc. 

Normal: The battery is in good condition.

Low: The battery condition has deteriorated. For information about
replacing the battery, see the hardware manual for the device.

Internal
Temperature

The internal operating temperature of the device that is communicating
with the SCADAPack RemoteConnect configuration software in degrees
Celsius and Fahrenheit.

Security

Information Description

Locked State The SCADAPack will be in one of the following states:

· Initial

o SCADAPack is new or has been cold booted, factory booted, or

service boot has been used to initialize the security lock 

· No password required

o SCADAPack does not require a password for configuration. This

state can be set only when the device Locked state is Initial.

· Locked

53
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o SCADAPack is password protected and configuration and other

actions are no allowed because the SCADAPack is in a locked
state

· Unlocked

o SCADAPack is password protected and configuration is allowed

because the SCADAPack is in an unlocked state. You should lock
the SCADAPack x70 device after you finish interacting with it.

For more details, see: Working with security locking in the Getting
Started manual.

Device Lock Use this button to:

· Read the current lock status of the controller

· Unlock the controller with the password so configuration changes can
be made

· Lock the controller with the password so configuration changes
cannot be made

· Change the controller password by entering the old password and
new password

For more details, see: Working with security locking in the Getting
Started manual.

Diagnostics

Information Description

Uptime The number of days, hours, minutes and seconds the device has been
running.

System Status
Code

A numerical code and description that indicates the operational status
of the device that is communicating with the SCADAPack
RemoteConnect configuration software.

To clear the system status code, click Reset Diagnostic Status.

For details about system status codes, see the System Status Codes
topic in the Operations Technical Reference manual.

Configuration
Status

Indicates if the device is configured. If Needs configuration is displayed,
see Writing the Configuration and Logic Application to the Device .

Values: 

· Needs configuration

· Configured
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Open Configuration
Log

Use this button to view the date and time that the configuration was
written, and check the validity of the configuration.

Clock

Information Description

Device System
Time

The device system time in the SCADAPack x70 device. 

The time at which DNP events get generated.

For access to the SCADAPack real-time clock, see the Real-Time
Clock Function Blocks topic in the Function Blocks Technical
Reference manual.

The system words supported by the SCADAPack x70 Logic Editor can
be found here: the System Status Words topic, %SW49 row in the
Logic Programming Overview manual.

Device Local Time The device system time offset by the time offset from UTC configuration
and daylight saving time state. 

If no time offset or daylight saving time are in effect, Device System
Time and Device Local Time are the same.

For access to the SCADAPack real-time clock, see the Real-Time
Clock Function Blocks topic in the Function Blocks Technical
Reference manual.

The system words supported by the SCADAPack x70 Logic Editor can
be found here: the System Status Words topic, %SW49 row in the
Logic Programming Overview manual.

Daylight Savings When the System Data Reference the SYS_CLOCK_DST_State topic
in the Operations Technical Reference manual. is set, the checkbox is
checked. Otherwise, it is unchecked. 

Set Device Time Use this button to set device system time to:

· PC UTC time

· PC local time

· Custom time

See Setting the Time on the Device .

12.2.3 Status Tab Details - Advanced Status

The following tables describe the information provided on the Status tab - Advanced Status. 

423



3.10.3

x70 ConfigurationWorking Online with the SCADAPack x70 Device

366

NOTICE

CONFIGURATION DATA LOSS

If the onboard RAM back-up battery loses its charge, SCADAPack x70 device configuration
data can be lost.

If the RAM Battery parameter displays Low, see the hardware manual for information about
replacing the battery in the device.

Failure to follow these instructions can result in equipment damage.

Status Code History Diagnostics

Information Description

System Status
Code and
Metadata

The System Status Code value and text is repeated from the Device Status
diagnostics System Status code. See Status Tab Details .

It indicates the operational status of the device that is communicating with
the SCADAPack RemoteConnect configuration software.

Some status code values provide additional information in the Metadata field.
 See the System Status Codes topic in the Operations Technical Reference
manual for the status code number. The Further Actions field describes the
meaning of the metadata information for the status code.

To clear the System Status Code, click Reset Diagnostic Status.

For details about system status codes, see the System Status Codes topic
in the Operations Technical Reference manual.

Status Code 1
- 5

A history of 5 previous System Status Codes, with Metadata and Timestamp
fields. This history is not cleared when Reset Diagnostic Status is used.

Metadat
a

Additional information associated with the status code value. See
the System Status Codes topic in the Operations Technical
Reference manual for the status code number. The Further
Actions field describes the meaning of the metadata information
for the status code.

Timesta
mp

The device time when the system status code was reported.

Device Information

Information Description
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Ethernet 1
MAC Address

The IEEE 802.3 media access control (MAC) address used in Ethernet
communications from this Ethernet port.

Ethernet 3 MAC address is not applicable for the SCADAPack 47x.
Ethernet 2
MAC Address

Ethernet 3
MAC Address

I/O Board 0
Firmware

For a SCADAPack 575: The firmware version number of the first 6601 input
output module in the device that is communicating with the SCADAPack
RemoteConnect configuration software. If there is no 6601 input output
module, then the firmware version number displays 0.0.00. See the
SYS_DEVICE: Device Information topic in the Operations Technical
Reference manual.

For a SCADAPack 474: The firmware version number of the 6607 input
output module in the device that is communicating with the SCADAPack
RemoteConnect configuration software. If there is no 6607 input output
module, then the firmware version number displays 0.0.00.

Bootloader
Version

The version number of the bootloader firmware running in the device that is
communicating with the SCADAPack RemoteConnect configuration
software. 

Restart History Diagnostics

Information Description

Task
Watchdogs

A hexadecimal mask value indicating which operating system tasks caused
the device to restart since the Task Watchdogs were last cleared. If
additional task watchdogs are generated before the mask value is cleared,
the new mask values are added to the existing value.

To clear the Task Watchdogs value, click Reset Diagnostic Status.

For details about the hexadecimal mask values for task watchdogs, see the
the Task Watchdogs topic in the Operations Technical Reference manual.

Restart Count The number of SCADAPack x70 device restarts.

To clear the Restart Count, click Reset Diagnostic Status.

Restart
Reasons

A hexadecimal mask value indicating why the device restarted. If additional
restart reasons are generated before the mask value is cleared, the new
mask values are added to the existing value.

To clear the Restart Reasons, click Reset Diagnostic Status.
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For details about the hexadecimal mask values for restart reasons, see the
the Restart Reasons topic in the Operations Technical Reference manual.

Restart
Reasons 1 - 5

A history of the last 5 Restart Reasons.

12.3 Managing Licensing

Use the Licensing tab in the SCADAPack x70 online parameters to view details about licensed
features on the SCADAPack x70 device. 

· Control Actions Functionality

· Licensing Tab Details

Licensing tab

12.3.1 Control Actions Functionality

The following table describes the functionality available in the Control Actions section on the
License tab.

Button or Field Description

Refresh Updates the online Licensing Tab details  with the latest values from the
SCADAPack x70 device.
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Last Updated Displays the date and time that the content on the Licensing page was last
refreshed.

12.3.2 Licensing Tab Details

The following tables describe the information provided on the License tab.

NOTICE

CONFIGURATION DATA LOSS

If the onboard RAM back-up battery loses its charge, SCADAPack x70 device configuration
data can be lost.

If the RAM Battery parameter displays Low, see the hardware manual for information about
replacing the battery in the device.

Failure to follow these instructions can result in equipment damage.

The License tab indicates which features are currently licensed on the SCADAPack x70 device.
When the box is checked, it means the feature is licensed. To add any of the functionality listed
here, contact your Schneider Electric representative to obtain a software license file that can be
applied locally or remotely.

Information Description

DNP3 Data
Concentrator
Client

Needs to be enabled if the device is operating as a DNP3 Controlling
Station.

Default: Checked

DNP3 Secure
Authentication

When checked, indicates that DNP3 Secure Authentication is licensed.

Licensed
Applications

Displays details of the licensed applications in the SCADAPack x70 device.

12.4 Managing the Logic Application in the Device

Use the Logic tab in the SCADAPack x70 online parameters to read the latest information about
the logic application from the device and to manage the logic application in the device. The logic
application is transferred to the SCADAPack x70 device when you write the configuration to the
device .

· Control Actions Functionality

· Logic Tab Details

· Modifying a Logic Application Online

· Writing Logic Source
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To read the latest status and version information from the device

· On the Logic tab, click Refresh. 

This is a good way to confirm that the SCADAPack x70 device is communicating with the
SCADAPack x70 configuration software. 

The information remains until the next time you click Refresh.

Online Status The current status of communication between SCADAPack
RemoteConnect and the SCADAPack x70 device. One of:

· Stand by

· Checking

· Connecting

· Connected

· Disconnecting

· Disconnected
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· Disturbed

These connection states are the same as those displayed along the
bottom bar in SCADAPack RemoteConnect. For details, see the Status
Indicators topic in the SCADAPack RemoteConnect Configuration
Software manual.

Connection
Information

The currently configured communication type between SCADAPack
RemoteConnect and the SCADAPack x70 device. When connected with
USB, the device serial number is also indicated.

To read the latest information for the logic application from the device

· On the Logic tab, click Refresh. 

For details about the information displayed, see Logic Tab Details .

To restart the logic application in the device

1. On the Logic tab, click Restart Application.

2. Select the type of restart required , then click Yes.

To clear the scan times for the logic application in the SCADAPack x70 device

· Click Reset Scan Times

To update the logic archive in the SCADAPack x70 device

· Click Write Logic Source

12.4.1 Control Actions Functionality

The following table describes the functionality available in the Control Actions section on the
Logic tab.

Button or Field Description
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Refresh Updates the Logic Tab Details  with the latest values from the
SCADAPack x70 device.

Restart Application Restarts the logic application in the SCADAPack x70 device.

If the logic editor is in debug mode while connected and the application
is restarted, the connection between the logic editor and SCADAPack
x70 device is disconnected.

Warm Restart Application: Restarts the application in the
SCADAPack x70 device without initializing variables to the default
values specified in the SCADAPack x70 Logic Editor Data Editor. This
option is equivalent to selecting Mode > Stop then Mode > Run in the
SCADAPack x70 Logic Editor.

Initialize and Restart Application: Initializes every variable to the
default value specified in the SCADAPack x70 Logic Editor Data Editor
then restarts the application. This option is equivalent to selecting Mode
> Stop then Mode > Init then Mode > Run in the SCADAPack x70
Logic Editor.

Reset Scan Times Resets every Scan Time to 0. To view the latest scan times for the logic
application in the SCADAPack x70 device, click Refresh.

Write Logic Source Updates the logic source in the controller, after an online modification, to
keep the logic source and the logic executing in the controller
synchronized. This is not required if you are not performing online
updates of the logic.

Last Updated The PC date and time that information was last read from the
SCADAPack x70 device.

Format: 

· 24-hour clock

· dd/mm/yyyy hh:mm:ss

12.4.2 Logic Tab Details

The following tables describe the information provided on the Logic tab.

Application Information

Information Description

Project Name The name given to the application when it was developed in the
SCADAPack x70 Logic Editor

Project Version The version number of the logic application in the SCADAPack x70
device

372
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Start Time The date and time on the SCADAPack x70 device clock that the logic
application started running

Format: 

· 24-hour clock

· dd/mm/yyyy hh:mm:ss

Stop Time The date and time on the SCADAPack x70 device clock that the logic
application last stopped running

Format: 

· 24-hour clock

· dd/mm/yyyy hh:mm:ss

Logic Saved Data
Usage

Percentage of logic memory used for saved data

Application
Signature

Used to identify if there is a change to the application

Logic Status The status of the logic application in the SCADAPack x70 device. For
more details, see SCADAPack x70 Logic States in the Operations
Technical Reference manual. 

HALT: A programmed condition or an exception has occurred while
executing the logic

IDLE: Logic project is loaded but has not yet been started

NOCONF: Logic project is not loaded, or the loaded project is invalid

RUN: Logic project with at least one task is running

STOP: Logic project is not running, but the loaded project was in a
RUN state at least once

UNAVAILABLE: The logic engine is unavailable to execute the logic
project

OBJMISSING: The SCADAPack x70 device configuration is corrupted
or totally blank, but valid logic files are on the file system. 

BREAKPOINT: The logic editor is running in debug and a break point
is encountered.

Logic Status Code The status code produced by the logic program. See the System
Status Words topic, %SW125 row, in the Logic Programming Overview
manual.

Number of Forced
EBOOL Variables

Total number of variables in logic with EBOOL data type that are
forced. See the EBOOL Variable Type topic in the Logic Programming
Overview manual.
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Arithmetic Overflow When checked, there is an arithmetic overflow, such as an assignment
overflow or a divide by 0, in MAST task logic

Array Index Overflow When checked, an index value exceeds the defined size of an array in
MAST task logic

String Overflow When checked, a destination string in MAST task logic is insufficient
in size

Scan Times

Information Description

MAST Period The configured scan period of the MAST task

Displays as Cyclic when the logic application MAST task is
configured as Cyclic

Displays the configured period in ms when the logic application
MAST task is configured as Periodic

MAST Current Time The most recent scan time for the MAST task in the logic application
that is running in the SCADAPack x70 device. Measured in ms.

MAST Maximum
Time

The longest scan time for the MAST task in the logic application that
is running in the SCADAPack x70 device since the scan times were
reset. Measured in ms.

MAST Minimum Time The fastest scan time for the MAST task in the logic application that
is running in the SCADAPack x70 device since the scan times were
reset. Measured in ms.

AUX0 Period The configured scan period of the AUX0 task

Displayed in ms

FAST Period The configured scan period of the FAST task

Displayed in ms

FAST Current Time The most recent scan time for the FAST task in the logic application
that is running in the SCADAPack x70 device. Measured in ms.

FAST Maximum Time The longest scan time for the FAST task in the logic application that
is running in the SCADAPack x70 device since the scan times were
reset. Measured in ms.

FAST Minimum Time The fastest scan time for the FAST task in the logic application that
is running in the SCADAPack x70 device since the scan times were
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reset. Measured in ms.

AUX1 Period The configured scan period of the AUX1 task

Displayed in ms

12.4.3 Modifying a Logic Application Online

The SCADAPack x70 Logic Editor supports modifying a running logic application on a
SCADAPack x70 device. 

· Conditions for making online modifications

· Activating logic application changes

· Applying online modifications automatically to the SCADAPack x70 device

· Allocating more memory online

NOTICE

APPLICATION LOSS

If you use the SCADAPack x70 Logic Editor to modify the logic application online, for example
when you are debugging, and you do not update the logic source in the controller, you will not
be able to read the logic application from the SCADAPack x70 device in the future. 

After modifying the logic application online, make sure to write a logic source update to the
SCADAPack x70 device.

Failure to follow these instructions can result in equipment damage.

Online logic application modifications are retained on the SCADAPack, however as they are
incremental in nature they can not be uploaded from the SCADAPack x70 device in the future.
To be able to upload a modified application in the future, write the logic source updates to the
SCADAPack x70 device using SCADAPack RemoteConnect following the online changes. A
logic source update is an online action that does not disturb the operation of the SCADAPack
x70 device. See Writing Logic Source .

A variety of logic changes can be performed online, but there are some restrictions. For more
information on online modification in the SCADAPack x70 Logic Editor help, see SCADAPack
x70 Logic Editor > Operating Modes > General > Global Project management > Project
management > Allowed Online Modifications.

For online modification of SCADAPack RemoteConnect objects, see Adding a RemoteConnect
Object and Logic Variable Online .

Conditions for making online modifications

You can make online modifications to the logic application when the following conditions are
met:
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· A USB, Ethernet, or PPP TCP/IP connection is available between SCADAPack
RemoteConnect and the SCADAPack x70 device

· The SCADAPack configuration has Logic Debug Service enabled

· The application loaded on the SCADAPack x70 device exactly matches the application build
present in the SCADAPack RemoteConnect project. See Comparing Project
Configurations .

Activating logic application changes

Logic application changes are activated after a successful build when the following conditions
are met:

· The SCADAPack x70 Logic Editor is connected online to the SCADAPack x70 device using
the Mode > Connect menu option in the SCADAPack x70 Logic Editor

· Modifications are made through the SCADAPack x70 Logic Editor

· The application is built while online using Build > Build Changes

In the SCADAPack x70 Logic Editor, when you are in Connected mode and select Build >
Build Changes, by default a confirmation dialog is displayed.

To modify the running application in the SCADAPack x70 device, click OK.

To you do not want the modification deployed on the SCADAPack x70 device, click Cancel.

Applying online modifications automatically to the SCADAPack x70 device 

You can avoid having to confirm online modifications every time you Build Changes when
connected to the SCADAPack x70 device by changing the Build Settings. 

1. In the SCADAPack x70 Logic Editor, navigate to Tools > Project Settings > Build Settings
> Apply online modification. 

2. Change the option from On user request to Automatic.
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Allocating more memory online

Depending on the SCADAPack x70 Logic Editor version when the project was created, the
SCADAPack x70 device can automatically allocate data memory for online modifications using
the Create New data block on line feature.

In the SCADAPack x70 Logic Editor, navigate to Tools > Project Settings > Build Settings >
Create New data block on line.
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Prior to SCADAPack RemoteConnect version 3.7.1, the SCADAPack x70 device may run out of
data memory while making online modifications. 

To help avoid this situation or to use the Program Unit feature in SCADAPack RemoteConnect
versions 3.7.1 and later, you need to enable this setting.

For projects created using SCADAPack RemoteConnect versions 3.7.1 and later, the Create
New data block on line feature is enabled by default.

For projects created using SCADAPack RemoteConnect prior to version 3.7.1, it is
recommended that you enable this feature. 

Following a change in this setting, you will be prompted to rebuild the project.

12.4.4 Writing Logic Source

When the logic application in a SCADAPack x70 device has been modified online, the logic
application source is removed from the SCADAPack x70 device. To be able to upload a modified
application in the future, write the logic source updates to the SCADAPack x70 device after
online modifications have been completed.

· Writing logic source when offline

· Writing logic source when online
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379



3.10.3

x70 Configuration Working Online with the SCADAPack x70 Device

379

· Writing logic source when no dialogs are open

Writing logic source when SCADAPack RemoteConnect is offline

If you have made online modifications from the SCADAPack x70 Logic Editor and SCADAPack
RemoteConnect is offline, a message is displayed to remind you to write the logic source to the
SCADAPack x70 device.

1. After the logic application modification has been applied to the SCADAPack x70 device,
make SCADAPack RemoteConnect your active window.

The SCADAPack RemoteConnect Online Modification dialog is displayed. 

2. Read the instructions, click OK, and then complete the following steps:

a. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM 
and select Go Online.

b. On the Logic tab, click Write Logic Source. 

Writing logic source when SCADAPack RemoteConnect is online

You can write the logic source immediately, or delay writing to a later time. You may want to
delay writing if you have more online modifications to make. 

1. After the logic application modification has been applied to the SCADAPack x70 device,
make SCADAPack RemoteConnect your active window.

The SCADAPack RemoteConnect Online Modification dialog is displayed. 
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2. Choose one of the following:

· Write Logic Source Now

· Write Later

o Follow the instructions in the dialog.

3. Click OK.

To write logic source later

1. Right-click on the SCADAPack x70 Controller Settings -DeviceDTM  and select Online
Diagnostics. 

2. On the Logic tab, click Write Logic Source.

Writing logic source when no SCADAPack RemoteConnect dialogs are open

1. After the logic application modification has been applied to the SCADAPack x70 device,
make SCADAPack RemoteConnect your active window.

The SCADAPack x70 dialog is displayed. 

2. Read the instructions, click OK, and then complete the following steps:

c. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM 
and select Online Diagnostics.

d. On the Logic tab, click Write Logic Source. 
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12.5 Adding a RemoteConnect Object and Logic Variable Online

An object configured with a T_SPx70_xxxx logic variable type can be added to SCADAPack
RemoteConnect and deployed to a SCADAPack x70 device online, without disturbing the
operation of the logic application.

Both the logic editor and RemoteConnect need to be connected online to the SCADAPack x70
device. The object is added using RemoteConnect. 

An existing object and it’s linked variable cannot be renamed online. An existing object’s logic
variable type cannot be changed online. Changes to user DDT variables from the logic editor,
subsequently changing RemoteConnect objects, cannot be changed online.

Requirements

· Local USB or Ethernet connection to the SCADAPack, or Remote IP connection to the
SCADAPack

· Configuration in the SCADAPack x70 device has Logic Debug service enabled

· Logic project in the device is EQUAL to the logic editor project

The following steps explain how to create an object in RemoteConnect while the logic editor is
connected, deploy the logic change online, then download the configuration to the SCADAPack
x70 device. This allows the SCADAPack to connect the new logic variable to the new
SCADAPack x70 object, on-the-fly.

1. Open the SCADAPack x70 Logic Editor and connect online to the SCADAPack x70 device.

2. Check that the logic editor indicates that the project is in the EQUAL state with the logic in
the device.

3. Return to the SCADAPack RemoteConnect window (while the logic editor is still open and
online), add an object and configure its attributes, including setting the logic variable attribute
to a T_SPx70_ type.

4. Accept the change in the RemoteConnect object editor by clicking OK and then the Apply
button.

5. Return to the logic editor window and accept the change made by RemoteConnect. 

The Logic Editor displays the NOT BUILT state.

6. Select Build > Build Changes.

7. To deploy the logic changes to the SCADAPack x70 device, click OK.

8. Return to the RemoteConnect Online Diags – SPx70 Controller tab. 

A dialog is displayed prompting you to write the logic source. 

9. In the dialog displayed, click Write Later and then click OK.

10. To transfer the modified configuration to the SCADAPack, under My Network, right-click on
SCADAPack x70 Controller Settings -DeviceDTM  and select Write to Device.
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11. Return to the Logic Editor and add the new variable to an animation table. 

12. Expand the variable and confirm that the ONLINE_QUAL element indicates a value of 1, or
the OBJ_ID element indicates a non-zero value.

If the RemoteConnect Configuration – SPx70 Controller tab is open and displaying a reminder
to write the logic source press Ok. There is no further action to take as the configuration was
written in step 9.

12.6 Reading Object Values from the Device

Use the Objects tab in the SCADAPack x70 online parameters to read the current value for
database objects from the SCADAPack x70 device.

· Control Actions Functionality

· Viewing Object Values

To read the latest status and version information from the device

· On the Objects tab, click Refresh. 

This is a good way to confirm that the SCADAPack x70 device is communicating with the
SCADAPack x70 configuration software. 

The information remains until the next time you click Refresh.

Online Status The current status of communication between SCADAPack
RemoteConnect and the SCADAPack x70 device. One of:

· Stand by

· Checking

· Connecting

· Connected

· Disconnecting
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· Disconnected

· Disturbed

These connection states are the same as those displayed along the
bottom bar in SCADAPack RemoteConnect. For details, see the Status
Indicators topic in the SCADAPack RemoteConnect Configuration
Software manual.

Connection
Information

The currently configured communication type between SCADAPack
RemoteConnect and the SCADAPack x70 device. When connected with
USB, the device serial number is also indicated.

To read the current object value for database objects

· On the Objects tab, click Refresh. 

For details, see Viewing Object Values .

12.6.1 Control Actions Functionality

The following table describes the functionality available in the Control Actions section on the
Objects tab.

Button or Field Description

Refresh Updates the Object Table  with the latest values from the
SCADAPack x70 device.

Write Selected Sends the values entered in the Proposed Value fields from the selected
rows to the device

Write All Sends all values entered in the Proposed Value fields to the device

Auto refresh every When selected, the Object Browser is refreshed every time unit
specified in the field following the checkbox. The time unit needs to be
specified first. 

If the time unit is set too short for the Object Browser to completely
refresh, additional refresh requests are ignored until the previous refresh
is completed. 

Valid values: 1...43200 seconds

Default value: 5 seconds

Last Updated The PC date and time that information was last read from the
SCADAPack x70 device.

Format: 

· 24-hour clock
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· dd/mm/yyyy hh:mm:ss

12.6.2 Viewing Object Values

Use the Object Table to view object value for each object. The groups listed under the Object
Browser match those created in the SCADAPack x70 configuration parameters.

To update the object value, click Refresh.

The Display Format selector changes the way that the value is displayed in the Current Value
field. It does not change the underlying object value. 

12.7 Managing the Online Object Browser List

Create browser lists in Offline  mode to read and write object or system data values to a
SCADAPack x70 device when SCADAPack RemoteConnect is online.

You can also add ad-hoc entries to the default browser or configured browser lists. These entries
are not permanent. You can create permanent entries only while in Offline mode. When you add
objects to a browser list, the maximum number of objects is 2000. 

The following table lists the fields that are present in the online Browser List.

Field Name Description

Name The name of the object

Type Analog

Digital

Counter

System Group

Source Type The item with which the object is associated. For example, an
object can be associated with a:

Physical I/O channel

Physical I/O status
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DNP3 Remote Point

DNP3 Status and Control

Modbus Scanner

Modbus Status and Control

System Data Group

System Data Reference

Source Details Information about the data source for the object

Display Format BOOL

DINT

REAL (Eng)

INT

UINT

OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Current Value The value read from the SCADAPack x70 device. 

If the Current Value is out of range for the selected Display
Format, an Out of Range label is added to the Quality column
and the Current Value is displayed as follows:

UINT

· Less than 0 is displayed as 0

· Greater than 65535 is displayed as 65535

INT

· Less than -32768 is displayed as -32768

· Greater than 32767 is displayed as 32767

Proposed Value Enter a value manually, or use the Offline Browser list Preset
Value field to pre-define a value in the Online Browser list. The
value has the same format as the Display Format field for the
specified row. 

See Working with Preset Values .

Quality Offline
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Online

Not Responding

User set offline

Remote Forced

Updated by Logic

Forced

Chatter filter

Under-range

Over-range

RoR exceeded

RoF exceeded

No change

Check reference

Alert state

High limit

H4 state

...

H1 state

L1 state

...

L4 state

Out of Range is displayed if the Display Format is changed and
the Current Value is now out of range for the new Display
Format. 

DNP3 Point Number The identifier for the DNP3 point

Modbus Register The identifier for the Modbus address

See:

· Reading From the Device

· Editing the Display Format Online

· Writing Data to the SCADAPack x70 Device
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· Adding Ad-Hoc Entries

· Removing Ad-Hoc Entries

· Transferring Current Values to the Offline Preset Values

12.7.1 Reading From the Device

The Current Value and Quality information for the object entries in the browser list are read
from the SCADAPack x70 device. Quality information is shown regarding the status of the object
in the device. Where there a number of simultaneous quality indicators, hover over the field to
display more information. See Managing the Online Object Browser List .

If there is a problem reading objects or system data from the device, an indicator is provided in
the first column of the row where the read was unsuccessful. You can hover the mouse over the
column to see the reason. Possible reasons are: 

· Object does not exist

· Bad object type

· Object locked

· Missing configuration

· Database locked

· Unknown error

· Unauthorized request

· Object offline

· File invalid

· Update failed

To read the current value and quality information

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. Click Refresh.

To refresh the current value and quality information at a set interval

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. Set the time in seconds that you want to refresh the Object Browser.

3. Select the Auto refresh every checkbox.

If the time unit is set too short for the Object Browser to completely refresh, additional refresh
requests are ignored until the previous refresh is completed.
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12.7.2 Editing the Display Format Online

Depending on the purpose of the data or the format you would like to see, you may want to edit
the default format displayed online. For example, matching the logic variable type, seeing the
protocol representation, debugging communications packets, viewing the Engineering value
instead of the raw value, etc.

To edit the display format of the browser entry

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. In the row of the entry that you want to edit, click Display Format.

3. From the Display Format drop-down list, select a format.

The Display Format selection also affects the data format entered in the Proposed Value
field when writing data to objects. See Writing Data to the SCADAPack x70 Device .

The following table lists the display formats available.

Type Display Formats
Available

Comment

Digital BOOL

Analog DINT

REAL (Eng)

INT

UINT

OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Real (Eng) or Hex (Eng)

· The value displayed is the representation of
the object's scaled Engineering value. All
other formats display representations of the
object's unscaled integer Raw value.

INT

· If the integer value of the analog object
exceeds a 16-bit signed value, the value is
fixed at either -32768 (if the value is negative)
or 32767 (if the value is positive). The
displayed INT value is the value that a DNP3
16-bit analog point, IEC 60870-5-104
Measured Value Scaled value or Normalized
value, or Modbus INT register would present
from the object.

UINT

· If the integer value of the analog object
exceeds a 16-bit unsigned value, the value is
fixed at 65535. The displayed UINT value is
the value that a Modbus UINT register would
present from the object.

OSTIME
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· Represents the value in operating system
time format (seconds since 00:00:00 January
1, 1970 UTC).

Counter UDINT

UINT

Binary

Hex

The current integer value of the counter is
displayed in the selected format. 

UINT

· If the value of the counter exceeds a 16-bit
unsigned value, the least significant 16-bits of
the counter value will be displayed. The
displayed UINT value is the value that a DNP3
16-bit counter point, IEC 60870-5-104
Counter, or Modbus UINT register would
present from the object.

String Hex

ASCII

System Data
Reference and
System Data
Group

Before the value is read from the device, the data type is unknown. You
can choose from the following formats (organized by typical object type):

Digital

o BOOL

Analog

o DINT

o REAL (Eng)

o OS TIME

o Binary (Raw)

o Hex (Raw)

o Hex (Eng)

Counter

o UDINT

String

o ASCII

After the value is read from the device, you can change the Display
Format to one of the following:

Digital BOOL

Analog DINT
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REAL (Eng)

INT

UINT

OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Counter UDINT

UINT

Binary

Hex

String Hex

ASCII

4. Click Ok.

5. Click Apply.

12.7.3 Writing Data to the SCADAPack x70 Device

Use the Proposed Value field to enter a value that you want to write to the device. A Proposed
Value field is unavailable to enter a value if the SCADAPack x70 device is reporting that the
object or system data reference is read-only. Values for multiple objects can be entered.

You can clear an individual Proposed Value field by removing the field content.

You can clear all Proposed Value fields by clicking Clear Proposed Values.

If there is a problem writing objects or system data to the device, an indicator is provided in the
first column of the row that the read was unsuccessful. See Reading From the Device .

When writing a Proposed Value to the SCADAPack x70 device, you will notice that the
Current Value and Proposed Value are different. Click Refresh from the SCADAPack x70
device to determine if the Current Value updated successfully. Other device operations may
prevent updating a value, if for example, logic is in control of an object.

The Display Format selection affects the data format entered in the Proposed Value field
when writing data to objects. For more information on the Display Format selection see Editing
the Display Format Online .

To write data to the SCADAPack x70 device

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.
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2. To update the current values and quality information, click Refresh.

3. Select the row(s) that you want to write to the SCADAPack x70 device. 

4. Choose one of the following:

· Write Selected

o Sends the values entered in the Proposed Value field from specific rows to the device

· Write All

o Sends all values entered in the Proposed Value fields to the device

5. Click Ok. 

12.7.4 Adding Ad-Hoc Entries

Entries can be added to the browser list while in Online mode. These entries are called ad-hoc
entries and are shown in italics. These are the only entries that can be removed from a
configured browser list. Ad-hoc entries are not permanent. If you want an entry to be permanent,
it needs to be added in Offline mode. See Adding an Entry to the Browser List .

This can be done while the online UI is either opened or closed. If the online UI is open, changes
to the offline browser list configuration are transferred and updated to the Online browser list.

You can add several kinds of objects to a browser list:

· Individual objects

· All objects in a group

o Creates an instantaneous snapshot of all of the objects in the same group. The objects

need to have the same Object Group identified. See Grouping Objects .

o This browser list is not dynamically updated if objects are reconfigured to modify their group

attribute

o The maximum number of objects in a browser list is 2000

· A System Data Group

o Automatically filled in when data is read from the SCADAPack x70 device

· A System Data Reference

o See the System Data topic in the Operations Technical Reference manual. for more

information

To add an entry to the browser list

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name and click
Add Entry.
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2. Choose one of the following:

· Add Object

o Click the drop-down list and select the Object Name to add

· Add all Objects currently in Group

o Click the drop-down list and select the Object Group to add

o The maximum number of objects in a browser list is 2000. If the list will have more than

2000 after you add the objects, an information icon is displayed. If you hover the mouse
over the icon, a message similar to the following is displayed:

· Add System Data Group

o Click the drop-down list and select the System Data Group to add

· Add System Data Reference
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o Click the drop-down list and select the Object Group and then the System Data

Reference Name to add

3. If available, click the drop-down list for the Display Format and select the appropriate format
for the object. 

If no display format is selected, the default display format is applied as follows:

Object Default Display Format

Analog DINT

Digital BOOL

Counter UDINT

4. Click Ok. 

5. Click Apply.

12.7.5 Removing Ad-Hoc Entries

The only entries that can be removed from the online browser list are entries that were added
while online, or ad-hoc entries.

To remove entries from a browser list

1. On the Objects tab, select Object Browsers > Browser List Name. 

2. Select the entry that you want to remove and click Remove Entries.

3. Click Remove Entries.

4. Click Yes.

12.7.6 Transferring Current Values to the Offline Preset Values

You can transfer Current Values from an online Object Browser to the offline Object Browser
Preset Values. 
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This allows the Online Browser to be used in the future with a set of pre-defined values, for
example to configure a SCADAPack x70 device after a hardware replacement, for
commissioning a system, to compare initial settings with current operating settings, etc. For
more information, see Working with Preset Values .

Ad-hoc entries that were added to the online browser list do not have their current values
transferred. 

To transfer the online Current Value to the offline Preset Value

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. To get the most recent values, click Refresh.

3. Do one of the following:

· If you want to transfer the Current Values for specific row(s) to the offline Object Browser
list Preset Values, select the row(s) that you want to transfer, click Transfer Current
Values and then click Transfer Selected Current Values

· If you want to transfer all Current Values to the offline Object Browser list Preset Values,
click Transfer Current Values and then click Transfer All Current Values

Modifications cannot be undone after you click Yes. 

3. Click Yes.

4. In the pop-up dialog, click OK.

12.8 Managing Object Forcing

It is often convenient and necessary to be able to change the value of an object while the
program is in operation. Toggling a digital output or changing the value contained in an analog
object, for example, enables you to simulate a particular condition and then test the operation of
the program. You may want to replace the measured value with a fixed forced value on a
temporary basis to allow the process to continue while the problem is corrected. If there is a
power outage, objects maintain their forced condition. 

You activate forcing by clicking the Forcing Mode button. The button turns green when it is
active. Forcing mode is deactivated when auto refresh is activated. See Auto refresh every .

The forcing button is available in two locations in Online mode:

· By navigating to Objects > Object Browsers > Browser List Name

· By navigating to Objects > Forced Objects

Each location is independent of the other. For example, disabling forcing mode in a browser list
does not disable forcing mode in the Forced Objects list. 

You can track forced objects in the Objects > Forced Objects list. 

See Forcing a Value to an Object From a Browser List , Forcing a Value to an Object From
Forced Objects , and Clearing a Forced Object .
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When an object is forced, a green arrow  appears beside the object name. 

If the object does not appear in the offline configuration table, a red arrow  appears beside
the object name.

Forcing is not supported for, and will have no impact on, Digital objects configured as DNP3
single point number complementary Trip/Close control.

Forcing is not supported for, and will have no impact on, Digital objects configured as IEC 60870-
5-104 Double Command or  Regulating Step Command controls.

The following table shows the fields in the Forced Objects list.

Field Name Description

Name The name of the object

Type Analog

Digital

Counter

Source Type The item with which the object is associated. For example, an
object can be associated with a:

Physical I/O channel

Physical I/O status

DNP3 Remote Point

DNP3 Status and Control

Modbus Point Scanner

Modbus Status and Control

System Data Group

System Data Reference

Source Details Information about the data source for the object

Display Format BOOL

DINT

REAL (Eng)

INT

UINT
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OS TIME

Binary (Raw)

Hex (Raw)

Hex (Eng)

Forced Value After a refresh of the page, shows the object's current Forced
Value in the format of the Display Format.

Source Value After a refresh of the page, shows the object's Source Value or
pre-forced value in the format of the Display Format. Clearing a
Forced Value will cause the Current Value to return to this
value.

Where an object is linked to a logic variable that is writable from
logic, the Source Value is updated with the Forced Value. This
provides consistency of the value present in the logic variable at
the start of a scan, with the value in the object. It overrides a
value written by logic such that the object retains a constant
value and provides a smooth transition of the logic variable value
when forcing is removed. Logic variables which are read-only,
owing to being associated with other data sources (e.g.
Physical Inputs, scanner data), indicate the original Source
Value.

Quality Offline

Online

Not Responding

User set offline

Remote Forced

Updated by Logic

Forced

Chatter filter

Under-range

Over-range

RoR exceeded

RoF exceeded

No change

Check reference

Alert state

High limit
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H4 state

...

H1 state

L1 state

...

L4 state

DNP3 Point Number The identifier for the DNP3 point

Modbus Register The identifier for the Modbus address

12.8.1 Forcing a Value to an Object From a Browser List

You can force an object to have the current or source value read from the SCADAPack x70
device or you can force an object to have a specific value. 

· Forcing a value to an object that is not in a forced state

· Forcing a value to an object that is already in a forced state

Forcing cannot be applied to a System Data Group or a System Data Reference. If an object is
associated with a system data reference, forcing can be applied to the object. The name of the
object can be the same as the system data reference, or it can have a different name. See the
System Data topic in the SCADAPack Operations Technical Reference.

If an Object Browser contains only System Data types of objects, the Forcing Mode button is
not available.

If an Object Browser contains a mix of System Data and other types of objects, the Forcing
Mode button is available. If you double-click on a System object, a pop-up dialog indicates that
the object cannot be forced.

Forcing is not supported for, and will have no impact on, Digital objects configured as DNP3
single point number complementary Trip/Close controls.

Forcing is not supported for, and will have no impact on, Digital objects configured as IEC 60870-
5-104 Double Command or  Regulating Step Command controls.

To force a value to an object that is not in a forced state

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. Click Refresh.

3. Click Forcing Mode.

The button turns green.

4. Double-click the object that you want to force.

397
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5. In the Forcing Mode dialog, choose one of the following:

· Force to Current Value

· Force to Specific Value

a. Using the drop-down list, change the Display Format, if needed.

b. Enter a Value that you want to force to the object.

6. Click Ok.
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7. Confirm that you want to force the value by clicking Yes. 

A green arrow  appears beside the object name. 

To force a value to an object that is already in a forced state

1. In Online mode, navigate to Objects >  Object Browsers > Browser List Name.

2. Click Refresh.

3. Click Forcing Mode.

The button turns green.

4. Double-click the object that you want to force.

4. In the Forcing Mode dialog, choose one of the following:

· Force to Source Value

· Force to Specific Value
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c. Using the drop-down list, change the Display Format, if needed.

d. Enter a Value that you want to force to the object.

5. Click Ok.

6. Confirm that you want to force the value by clicking Yes. 

A green arrow  appears beside the object name. 

12.8.2 Forcing a Value to an Object From Forced Objects

You can force an object to have the current or source value read from the SCADAPack x70
device or you can force an object to have a specific value. 

Forcing cannot be applied to a System Data Group or a System Data Reference. If an object is
associated with a system data reference, forcing can be applied to the object. The name of the
object can be the same as the system data reference, or it can have a different name. See the
System Data topic in the SCADAPack Operations Technical Reference.
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To force a value to an object from Forced Objects

1. In Online mode, navigate to Objects > Forced Objects.

2. Click Refresh.

3. Click Forcing Mode.

The button turns green.

4. Double-click the object that you want to force.

4. In the Forcing Mode dialog, choose one of the following:

· Force to Source Value

· Force to Specific Value
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a. Using the drop-down list, change the Display Format, if needed.

b. Enter a Value that you want to force to the object.

5. Click Ok.

6. Confirm that you want to force the value by clicking Yes. 

A green arrow  appears beside the object name. 

12.8.3 Clearing a Forced Object

There are two ways that you can clear a forced object:

· From the browser list

· From the Forced Objects list



3.10.3

x70 Configuration Working Online with the SCADAPack x70 Device

403

To clear a forced object from the browser list

1. In Online mode, navigate to Objects > Object Browsers > Browser List Name.

2. Make sure that Forcing Mode is active. The button should be green.

3. Double-click the Name of the object for which you want to clear forcing.

4. In the Forcing Mode dialog, select Clear Forcing. 

5. Click Ok.

6. Confirm that you want to clear forcing by clicking Yes.

To clear forced objects from the Forced Objects list

1. In Online mode, navigate to Objects > Forced Objects.

2. Make sure that Forcing Mode is active. The button should be green.

3. To make sure that the list is complete, click Refresh. 

4. Do one of the following:

· Double-click the Name of the object for which you want to clear forcing

a. In the Forcing Mode dialog, select Clear Forcing.

b. Click Ok. 

c. Confirm that you want to clear forcing for that object by clicking Yes.

· Select the objects for which you want to clear forcing

a. Click Clear Forcing.

b. Select Clear Selected Forced Values. 

c. Confirm that you want to clear forcing for the object(s) by clicking Yes.

· Click Clear Forcing

a. Select Clear All Forced Values. 

b. Confirm that you want to clear forcing for the object(s) by clicking Yes.

12.9 Managing Data Logging

When Data Logging is enabled, you can use the Objects tab in the SCADAPack x70 online
parameters to retrieve and view data logs.

To enable Data Logging, see Changing the Project Settings .42
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Data logs are stored on the SCADAPack x70 device according to data log configurations and
object configurations which select if and when object data is stored in data logs files, and the
arrangement of the data log files. 

The same types of events that are reported though DNP3 and IEC 60870-5-104 protocols can be
stored in data log files on the SCADAPack x70 device. 

Set up event reporting on objects using DNP3 or IEC 60870-5-104 configurations. See Data
Logging Tab .

When you are connected online with a SCADAPack x70 device, you can select from which data
logs and for which timeframe you want to retrieve logged data. 

Once logged data is retrieved from the SCADAPack x70 device you can:

· View a list of the objects for which data log events can be retrieved

· Graph a selection of the data log events that have been retrieved

· Display data log events for a single object

· Display a data log event chronology for multiple objects 

· Use the retrieved data log files in other applications (for example in a spreadsheet)

Also:

· Control Actions Functionality

· Selecting Data Logs and Timeframe

· Reading Object Data Logs

· Online Data Logging Object Pages

· Graphing Data Logging Objects

· Displaying Data Logging Objects

The Data Logging page looks similar to the following:

To read the data logging information

1. In Online mode, navigate to Objects > Object Browsers > Data Logging.
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2. Click Refresh.

The Data Logging dialog is displayed where you can select which Data Logs and what
Timeframe you want to retrieve.

See Selecting Data Logs and Timeframe .

3. Choose the options you want and then click Ok.

It may take several minutes to retrieve the data logs from the SCADAPack x70 device.

Objects which are present in the retrieved files are shown in the Data Log Objects table.

When the log files have been successfully downloaded for the selected Objects, the Object
statuses are cleared and no longer display ?, and Data Logging Object pages are created,
see Online Data Logging Object Pages .

12.9.1 Control Actions Functionality

The following table describes the functionality available in the Control Actions section on the
Objects tab.

Button or Field Description

Refresh Obtains a list of Objects from the SCADAPack x70 device for which logged
data is available within a given timeframe, and optionally, within a specific

406
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set of data logs. See Selecting Data Logs and Timeframe .

Last Updated Displays the date and time that the content on the Data Logging page was
last refreshed.

Read Selected
Objects

Enabled when one or more object entries in the Data Log Objects table is
selected. Reads data log files to the local PC, from the SCADAPack x70
device for the selected objects. See Reading Object Data Logs .

Select objects in the table by clicking on the table rows. 

To select all objects in the table, click on the top left corner of the table:

To select a range of objects, click on the first object then hold down the
<Shift> key and clicking on the last object.

To select multiple objects, hold down the <Ctrl> key while clicking
individual objects.

Graph Selected
Objects

Displays a graphing tool in a new dialog to view data for selected objects.
See Graphing Data Logging Objects . A maximum of 10 Objects may
be selected to graph at once.  

To compare/graph multiple objects, you can launch the graphing tool from
the main Online Data Logging page, with the objects of interest selected in
the table. 

Only analog, digital, and counter objects can be graphed. String objects
are not graphable.

Default: Enabled when logged data has been read from the device for at
least one of the selected objects in the table.

Display
Selected
Objects

Displays a list of data events in a new dialog for selected objects. See
Displaying Data Logging Objects . 

To view a chronological list of data events, you can launch the data display
from the main Online Data Logging page, with the objects of interest
selected in the table.

Default: Enabled when logged data has been read from the device for at
least one of the selected objects in the table.

12.9.2 Selecting Data Logs and Timeframe

When you click Refresh on the Objects > Object Browsers > Data Logging page, the Data
Logging dialog is displayed.

Choose the options for selecting object data to retrieve, display, or graph, and click Ok.
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Data Logs

Get Object data from all
logs

Allows data to be read from all Data Logs available in the
SCADAPack x70 device. The Data Log Objects table shows a
list of Objects for which logged data is present in the
SCADAPack x70 device.

Default

Get Object data from
specific logs

Allows you to select one or more of the configured Data Logs
from which data can be read. The Data Log Objects table
shows a list of Objects for which logged data is present in the
selected Data Logs and present in the SCADAPack x70
device. 

You can select one or more Data Logs.

Timeframe
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Get all Object data logs Allows data to be read from the selected Data Logs across
the full time range of lagged data available on the
SCADAPack x70 device.

Default

Get Object data logs for a
specific timeframe

Allows data to be read from the specified Data Logs within a
time range on the SCADAPack x70 device. Allows you to
select a start time and end time.

You can manually enter a valid date and time. The Start Time
needs to be less than the End Time.

Default values when selected: End time is current time; Start
time is 1 hour earlier than the current time.

12.9.3 Reading Object Data Logs

The Read Selected Objects button is enabled if data for one or more of the selected entries in
the table not yet been read from the SCADAPack x70 device to the PC.

A ? status next to an object name indicates that data for the object is available to be read from
the SCADAPack x70 device that is not already available on the PC.

To read object data logs

1. On the Objects > Object Browsers > Data Logging page, select one or more objects in
the table to be read. 

2. Click Read Selected Objects.

3. In the pop-up dialog, browse to select a destination folder for the log file.

4. Click Select Folder.

5. Choose one of the following:

· If files are already present in the folder but you want to replace that data by reading up-to-
date data from the SCADAPack x70 device, click Overwrite. 

· If you want to use the data already read from the SCADAPack x70 device and present on
the PC, click Skip.

When the log files have been successfully read for the selected Data Logs, Timeframes, and
Objects, the Object status fields are cleared and no longer display ?.

Data Logging Object pages are created for each object where logged data was retrieved. See
Online Data Logging Object Pages .

Also, see:

· Graphing Data Logging Objects

· Displaying Data Logging Objects

410
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12.9.4 Online Data Logging Object Pages

After one or more Objects’ log files have been successfully read from the SCADAPack x70
device, new Data Logging Object pages are appended as children to the main Online Data
Logging page. Each page represents one object. 

Button or Field Description

Location of Log file(s):     Shows the location of the log files on the PC for the object data
shown in the table.

Clicking on the information icon shows a list of the Log File(s)
names retrieved from the SCADAPack x70 device and present
on the PC for the object.

View Log File(s) in Windows
Explorer

Opens the folder containing the log files in Windows Explorer.
Log files are stored as csv and zip files. 

Default: Enabled
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Graph Object Displays a graphing tool, see Graphing Data Logging
Objects  in a new dialog. When launching the graphing tool
from the Data Logging Object page, only a single Object (the
current Object) is graphed to a maximum of the first 5000 data
events. Only analog, digital, and counter Objects can be
graphed. String Objects are not graphable.

Default: Enabled if at least one data entry exists in the table

Graph Selected Displays the graphing tool, see Graphing Data Logging
Objects  in a new dialog using only the selected data event
entries, up to a maximum of 5000 data events.  

Default: Enabled if 1...5000 entries are selected in the table

Parameter Values

Timestamp Valid timestamp in the format: DD/MM/YYYY HH:MM:SS

Object Value The value of the Object event in the log file. 

Analog, digital, and counter objects are represented as an
integer.

Analog objects with a SCADAPack x70 configuration using a
REAL (Engineering) component of the object are represented
as a float.

String objects are represented as a string.

Quality Online

Not Responding

User Set Offline

Logic Controlled

Interlock Active

Forced

Chatter Filter

Under Range

Over Range

RoR Exceeded

RoF Exceeded

No Change

Check Reference

412
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Alert State

High Limit

H4 State

H3 State

H2 State

H1 State

L1 State

L2 State

L3 State

L4 State

Remote Forced

Initial Value

12.9.5 Graphing Data Logging Objects

You can use the graphing tool to visualize Object Data Log data. 

When you click Graph Selected Objects in either the online Data Logging page or one of the
Data Logging Object children pages, the graphing tool opens in a new dialog.  

Each series is indicated in the legend and each object's value is represented as a separate
series in the graph, sorted by timestamp. 

Up to 10 objects can be graphed at one time. If more than 10 objects are selected, the Graph
Selected Objects button is disabled. 

You can select individual objects or a collection of objects. 

The following is an example of graphed objects.
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Graphing dialog

The graphing dialog shows a graphical representation of the data for the selected objects. 

· Analog and counter objects are displayed as line graphs

· Digital objects are displayed as step-line graphs because they are binary values

· String data is not graphable

The legend indicates the Object Name, visibility and color associated with each object. 

Change the color

1. Click the color beside the object name that you want to change. 

The standard color picker is displayed. 

2. Choose the color you want and click OK.

The color of the object series changes to the selected color.

Change the visibility

· Toggle the checkbox beside the object name to display or hide the object series in the graph

Graph Settings

When selected, you can configure the settings for analog, counter, and digital objects.

The display depends on which objects are selected.

1. Click Graph Settings.

2. In the pop-up dialog, 

· For analog and counter objects:
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o Auto Scale the Axis: By default, the y-axis is auto scaled. When unchecked, the

Minimum Axis Value and Maximum Axis Value fields are enabled. 

o Minimum Axis Value and Maximum Axis Value: The minimum value needs to be

less than the maximum value

· For digital objects:

o A maximum of 10 objects is displayed. You can change the order of position by clicking

the down arrow for each object and selecting the relative position.

3. Click Apply.
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Save As Image

When selected, you can save the current graph as a JPEG, BMP, GIF, or PNG image.

1. Click Save As Image.

2. In the pop-up dialog, enter a File name for the graph image.

3. Click Save.

The Save Image Complete dialog is display with the location of the image.

4. Click OK.

12.9.6 Displaying Data Logging Objects

The Display Selected Objects button is enabled if data for one or more of the selected entries
in the table has been read from the SCADAPack x70 device to the PC and the Objects no longer
display a ?.

A dialog opens to display a list of the data log entries in sequential order for the selected
Objects. 

To display data logging objects

1. On the Objects > Object Browsers > Data Logging page, select one or more objects in
the table to display. 

2. Click Display Selected Objects.

A dialog opens to display a list of the data log entries in sequential order for the selected
Objects. 

3. When you are finished viewing the data logs, click Close.

12.10 Managing Device Operation

The topics in this section describe how to perform the following tasks:

· Restarting the Device

· Restarting the DNP3 Service

· Restarting the IEC 60870-5-104 Service

· Executing Command Line Operations on the Device

· Monitoring Modem Status

· Applying the License File to the Device

· Applying the Security Configuration to the Device

· Setting the Time on the Device

· Reading a File from the Device

· Writing a File to the Device
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· Testing the Connection to the SCADAPack x70 Device 

· Getting Device Information File

12.10.1 Restarting the Device

If required for troubleshooting or maintenance activities, you can restart the SCADAPack x70
device. 

When you restart the device, there is a period of time when it is offline and is unable to monitor
or control the equipment to which it is connected. 

 WARNING

UNINTENDED EQUIPMENT OPERATION

Before restarting the SCADAPack x70 device, evaluate the operational state of the equipment
being monitored and controlled by the device.

Failure to follow these instructions can result in death or serious injury.

If there is a logic application running in the device, restarting the device is equivalent to stopping
then restarting the application. See the Resetting Variables to their Default Values topic in the
Logic Programming Overview manual.

To restart the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Restart Device.

2. Click Yes to confirm the action.

12.10.2 Restarting the DNP3 Service

If required for troubleshooting or maintenance activities, you can restart the DNP3 service on the
SCADAPack x70 device. 

425
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When you restart the DNP3 service, there is a period of time when communication functions are
not available. 

 WARNING

UNINTENDED EQUIPMENT OPERATION

Before restarting the DNP3 service on the SCADAPack x70 device, evaluate the operational
state of the equipment being monitored and controlled by the device.

Failure to follow these instructions can result in death or serious injury.

Restarting the DNP3 service is equivalent to remotely sending a DNP3 Warm Restart command.

To restart the DNP3 service on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Restart DNP3.

2. Click Yes to confirm the action.

12.10.3 Restarting the IEC 60870-5-104 Service

If required for troubleshooting or maintenance activities, you can restart the IEC 60870-5-104
service on the SCADAPack x70 device. 

When you restart the IEC 60870-5-104 service, there is a period of time when communication
functions are not available. 
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Before restarting the IEC 60870-5-104 service on the SCADAPack x70 device, evaluate the
operational state of the equipment being monitored and controlled by the device.

Failure to follow these instructions can result in death or serious injury.

To restart the IEC 60870-5-104 service on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Restart IEC 60870-5-104.

2. Click Yes to confirm the action.

12.10.4 Executing Commands on the Device

You can execute some commands on the SCADAPack x70 device. The following commands
are available:

· Device management commands

o CLEAR

o GETCONFIG

o RESTART

· Diagnostics commands

o FILEDIAG
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o SYSDIAG

· File commands

o APPEND

o COPY

o DEL

o RENAME

o UNPACK

See the Device Management Commands topic in the Operations Technical Reference manual.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Before executing any command that restarts the device or a service on the SCADAPack x70
device, evaluate the operational state of the equipment being monitored and controlled by the
device.

Failure to follow these instructions can result in death or serious injury.

To execute command line operations on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Execute Command.

2. Enter the command you want to execute and then click Ok.

12.10.5 Monitoring Modem Status

When you are using a dialup modem connection or a PPP modem connection, use the Modem
tab in the SCADAPack x70 online parameters to read the modem connection status from the
device .
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To read the modem status from the device

· On the Modem tab, click Refresh

The Connect Status is one of:

· Not Available

· Check Modem Hardware

· Modem OK

12.10.6 Applying the License File to the Device

The license file for the SCADAPack x70 device activates the purchased features on the device.
The file is provided by your Schneider Electric representative.

Follow the procedure below to transfer the license file to the SCADAPack x70 device and apply
its content.

To apply the license file to the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Apply License to Device.
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2. In the Apply License to Device dialog, click Browse to navigate to the location where the
license file is stored.

The license file has a .lic extension.

3. In the Open dialog, select the license file, then click Open.

4. In the Apply License to Device dialog, click Ok.

When the license is successfully applied to the device, the device needs to be restarted to
activate some license options. 

5. In the pop-up dialog, click Yes to confirm.

12.10.7 Applying the Security Configuration to the Device

Security configuration files are created by the Security Administrator application. These files
have a .rtk extension. They are described in the Security Administrator manual.
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For the Security Configuration File, you can apply the security configuration using serial, USB,
or Ethernet connection. 

For the System Key File, you can only apply the security configuration to the SCADAPack x70
device using a local USB connection. This helps to reduce the risk of unauthorized access the
file. If there is not currently a USB connection between the SCADAPack RemoteConnect
computer and the device, see the Configuring Communication Parameters topic in the PC
Communication Settings -SCADAPack CommDTM manual for details about setting up the
connection. 

To apply the security configuration to the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Apply Security Configuration to Device.

2. Select the security configuration file type.

3. Click Browse to navigate to the location where the security configuration file is stored. 

· The Security Configuration File is called system.rtk

· The System Key File is called system.key

4. In the Open dialog, locate the file, then click Open.

5. In the Configuration File dialog, click Ok.

A confirmation dialog is displayed when the operation successfully completes. 
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6. Click Ok to acknowledge the message.

12.10.8 Setting the Time on the Device

You can set the time on the SCADAPack x70 device to either:

· Coordinated Universal Time (UTC)

· The local time on the PC running SCADAPack RemoteConnect

To set the time on the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Set Device Time.

2. Select one of the following:

· To set the time on the SCADAPack x70 device to UTC time, select Set Device System
time to PC UTC time, then click Ok.

· To set the time on the SCADAPack x70 device to the local time on the PC running
SCADAPack RemoteConnect, select Set Device System time to PC local time, then
click Ok.

· To set the time on the SCADAPack x70 device to a custom time, select Set Device
System time to custom time, enter the custom time and date into the appropriate fields,
then click Ok.
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3. In the confirmation dialog, click OK.

12.10.9 Reading a File from the Device

Follow the procedure below to read a file from the SCADAPack x70 device and save it to your
computer. 

You need to know the name and location of the file on the SCADAPack x70 device before you
start this procedure. To see a list of the subdirectories and files on the SCADAPack x70 device,
see the DIR: List Directory Contents topic in the Operations Technical Reference manual.

To read a file from the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Read File from Device.

2. In the Source File field, enter the name and location of the file that you want to read from
the device.

3. In the Destination File field, click Browse to navigate to the location where the file will be
saved on your computer.

4. In the Read File from Device dialog, click Ok.
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12.10.10 Writing a File to the Device

Follow the procedure below to write a file from your computer to the SCADAPack x70 device. 

To see a list of the subdirectories and files on the SCADAPack x70 device, see the DIR: List
Directory Contents topic in the Operations Technical Reference manual.

To write a file to the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Write File to Device.

2. In the Source File field, click Browse to navigate to the location of the file on your
computer.

3. In the Destination File field, enter the name and location on the device where you want to
write the file.

4. In the Write File to Device dialog, click Ok.

12.10.11 Testing the Connection to the SCADAPack x70 Device

Follow the procedure below to test the connection to the SCADAPack x70.

To test the connection to the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Test Connection.
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Either of the following images is displayed when the connection test is complete.

2. Click Close.

If the connection test is unsuccessful, your computer is not communicating with the
SCADAPack x70 device. The following are some suggestions for resolving the
communication issue: 

· Check that the device has power

· Check that the cables are connected correctly

· If using TCP or UDP, check that the IP address is correct

· If using serial communications, check that the serial port settings are correct

· Check that the target DNP3 address is correct

12.10.12 Getting Device Information File

Follow the procedure below to get a device information file from the SCADAPack x70 device and
save it to your computer.
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To get a device information file from the SCADAPack x70 device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Get Device Information.

2. In the Get Device Information dialog, click Browse to navigate to the location where the file
will be saved on your computer.

3. In the Save As dialog, enter the name of the file on the SCADAPack x70 device, then click
Save.

4. In the Get Device Information dialog, click Ok.

5. When the file is successfully saved, navigate to the file on your computer and open it. 

The following information is displayed:

· Associations information

· Date and Time information: 

o System Date/Time

o Local Date/Time

· DNP3 routing table information
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· Events information

· I/O Processor information

· IP information

· MEMSHOW information

· NETINFO information

· REALFLOSTATUS information

· Status information

· Security

· Task information

· UNITY PERFORMANCE information

· VER information

· WATCHDOG information

· WHOAMI information

12.11 Updating the Firmware and Bootloader on the Device

When you receive a new version of the firmware or bootloader for your SCADAPack x70 device,
you need to download the file to the device to activate the new features.

· Updating Firmware on a SCADAPack 47x

· Updating Firmware on a SCADAPack 57x

· Updating the Bootloader

· Creating Recovery Media

12.11.1 Updating Firmware on a SCADAPack 47x

Schneider Electric believes cybersecurity is critical in today’s connected world. Improved
cybersecurity mechanisms are now included in SCADAPack products and updated tools are
required to apply the new device configurations. Before installing the new hardware, install the
latest version of the configuration software. Old versions of software will not be able to configure
products equipped with these enhanced cybersecurity features. See Working with Security
Locking in the Getting Started manual.

For assistance in obtaining these updated versions, contact Technical Support .

Use the context menu that is available when the SCADAPack x70 configuration software is
online to update the firmware on your SCADAPack x70 device. The following table lists important
details to be aware of.  

SCADAPack x70
Device or Module

Instructions Firmware Filename
for the Device

428

432

435

437

13
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SCADAPack 570 Follow the procedure below

xxxe57x.biz 

or 

xxxxe57x.biz

Where xxx or xxxx is
the firmware version
number, such as 904
or 1001

SCADAPack 574 Follow the procedure below. You cannot
update the firmware on the 5607 input
output module.

SCADAPack 575 Follow the procedure below, then follow
the procedure in the Updating Module
Firmware topic of the SCADAPack 6601
Input Output Module manual to update
the firmware for the I/O, if required.

SCADAPack 470 Follow the procedure below xxxe47x.fwz

or 

xxxxe47x.fwz

Where xxx or xxxx is
the firmware version
number, such as 904
or 1001

SCADAPack 474 Follow the procedure below, then follow
the procedure in the Updating Module
Firmware topic of the SCADAPack 6607
Input Output Module manual to update
the firmware for the I/O, if required.

An attached 6000 series
I/O module

See the hardware manual for the I/O
module

 WARNING

LOSS OF CONTROL

During a firmware update, the 6000 series I/O module does not monitor or control any of the
devices to which it is connected. Before updating firmware:

· Confirm that you are connected to the correct SCADAPack.

· Evaluate the operational state of the devices that are monitored and controlled by the I/O
module. 

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Do not remove power from the SCADAPack during the firmware update.

Do not disconnect the 6000 series I/O module from the SCADAPack during the firmware
update.

If power is interrupted for any reason during the firmware update, contact Technical Support.

Failure to follow these instructions can result in death or serious injury.
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Preserving data 

When you update the firmware on the device:

· The device configuration is preserved

· Routes are preserved, with the exception of dynamic DNP3 routes and IP routes that were
added using the ROUTE command

· The logic application and the state of logic variables are preserved

NOTICE

DATA LOSS

Updating the firmware sets the Realflo flow computer to defaults without any configuration. 

Save the configuration before starting the firmware update. 

Failure to follow these instructions can result in loss of flow computer history and
configuration.

· During firmware upgrade the Realflo flow computer is set to defaults without any configuration.
Follow these steps to preserve the device configuration of the flow computer: 

1. Open Realflo and open the project file for the target to be upgraded.

2. Stop the flow computer runs.

3. Read the Realflo configuration from the flow computer.

4. Read the event and alarm logs as well as the hourly, daily and batch history.

5. Save the Realflo file.

6. Update the firmware as described below.

7. Write the Realflo configuration to the target. 

8. Start the flow computer runs.

This procedure restores the Realflo configuration. Accumulators and history are not restored.
Event and Alarm indexes restart at index 1.

If there is insufficient space on the file system to store the items listed above during the firmware
update, a message is generated and the firmware update is aborted.

NOTICE

UNINTENDED EQUIPMENT OPERATION

The SCADAPack x70 device automatically restarts when the firmware is updated.

Evaluate the operational state of the equipment being monitored or controlled by the
SCADAPack x70 device before updating the firmware. 

Failure to follow these instructions can result in equipment damage.
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NOTICE

INCOMPATIBLE FIRMWARE VERSIONS

Before installing any firmware updates, check the Release Notes for the firmware update to
determine the most suitable firmware versions for the functionality you are using and to confirm
version compatibility. 

Failure to follow these instructions can result in equipment damage.

To update the firmware on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Update Device Firmware or Bootloader.

2. Follow the instructions in the wizard to download the firmware to the device and update it. 

The firmware file has a .fwz file extension. By default, the firmware file is stored in one of the
following directories:
64-bit systems: C:\Program Files (x86)\Schneider
Electric\RemoteConnect\Firmware\SCADAPack 47x
32-bit systems: C:\Program Files\Schneider Electric\RemoteConnect\Firmware\SCADAPack
47x

3. After the device has restarted, open the Online Diags – SPx70 Controller parameters and
click Refresh on the Status tab to verify that the Firmware Version field was correctly
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updated.

12.11.2 Updating Firmware on a SCADAPack 57x

Schneider Electric believes cybersecurity is critical in today’s connected world. Improved
cybersecurity mechanisms are now included in SCADAPack products and updated tools are
required to apply the new device configurations. Before installing the new hardware, install the
latest version of the configuration software. Old versions of software will not be able to configure
products equipped with these enhanced cybersecurity features. See Working with Security
Locking in the Getting Started manual.

For assistance in obtaining these updated versions, contact Technical Support .

Use the context menu that is available when the SCADAPack x70 configuration software is
online to update the firmware on your SCADAPack x70 device. The following table lists important
details to be aware of.  

SCADAPack x70
Device or Module

Instructions Firmware Filename
for the Device

SCADAPack 570 Follow the procedure below

xxxe57x.biz 

or 

xxxxe57x.biz

Where xxx or xxxx is
the firmware version
number, such as 904
or 1001

SCADAPack 574 Follow the procedure below. You cannot
update the firmware on the 5607 input
output module.

SCADAPack 575 Follow the procedure below, then follow
the procedure in the Updating Module
Firmware topic of the SCADAPack 6601
Input Output Module manual to update
the firmware for the I/O, if required.

SCADAPack 470 Follow the procedure below xxxe47x.fwz

or 

xxxxe47x.fwz

Where xxx or xxxx is
the firmware version
number, such as 904
or 1001

SCADAPack 474 Follow the procedure below, then follow
the procedure in the Updating Module
Firmware topic of the SCADAPack 6607
Input Output Module manual to update
the firmware for the I/O, if required.

An attached 6000 series
I/O module

See the hardware manual for the I/O
module

13
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 WARNING

LOSS OF CONTROL

During a firmware update, the 6000 series I/O module does not monitor or control any of the
devices to which it is connected. Before updating firmware:

· Confirm that you are connected to the correct SCADAPack.

· Evaluate the operational state of the devices that are monitored and controlled by the I/O
module. 

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Do not remove power from the SCADAPack during the firmware update.

Do not disconnect the 6000 series I/O module from the SCADAPack during the firmware
update.

If power is interrupted for any reason during the firmware update, contact Technical Support.

Failure to follow these instructions can result in death or serious injury.

Preserving data 

When you update the firmware on the device:

· The device configuration is preserved

· Routes are preserved, with the exception of dynamic DNP3 routes and IP routes that were
added using the ROUTE command

· The logic application and the state of logic variables are preserved

NOTICE

DATA LOSS

Updating the firmware sets the Realflo flow computer to defaults without any configuration. 

Save the configuration before starting the firmware update. 

Failure to follow these instructions can result in loss of flow computer history and
configuration.

· During firmware upgrade the Realflo flow computer is set to defaults without any configuration.
Follow these steps to preserve the device configuration of the flow computer: 

1. Open Realflo and open the project file for the target to be upgraded.

2. Stop the flow computer runs.
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3. Read the Realflo configuration from the flow computer.

4. Read the event and alarm logs as well as the hourly, daily and batch history.

5. Save the Realflo file.

6. Update the firmware as described below.

7. Write the Realflo configuration to the target. 

8. Start the flow computer runs.

This procedure restores the Realflo configuration. Accumulators and history are not restored.
Event and Alarm indexes restart at index 1.

If there is insufficient space on the file system to store the items listed above during the firmware
update, a message is generated and the firmware update is aborted.

NOTICE

UNINTENDED EQUIPMENT OPERATION

The SCADAPack x70 device automatically restarts when the firmware is updated.

Evaluate the operational state of the equipment being monitored or controlled by the
SCADAPack x70 device before updating the firmware. 

Failure to follow these instructions can result in equipment damage.

NOTICE

INCOMPATIBLE FIRMWARE VERSIONS

Before installing any firmware updates, check the Release Notes for the firmware update to
determine the most suitable firmware versions for the functionality you are using and to confirm
version compatibility. 

Failure to follow these instructions can result in equipment damage.

To update the firmware on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Update Device Firmware or Bootloader.
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2. Follow the instructions in the wizard to download the firmware to the device and update it. 

The firmware file has a .biz file extension. By default, the firmware file is stored in one of the
following directories:
64-bit systems: C:\Program Files (x86)\Schneider
Electric\RemoteConnect\Firmware\SCADAPack 57x
32-bit systems: C:\Program Files\Schneider Electric\RemoteConnect\Firmware\SCADAPack
57x

3. After the device has restarted, open the Online Diags – SPx70 Controller parameters and
click Refresh on the Status tab to verify that the Firmware Version field was correctly
updated.

12.11.3 Updating the Bootloader

Use the context menu that is available when the SCADAPack x70 configuration software is
online to update the bootloader on your SCADAPack x70 device. 
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 WARNING

LOSS OF CONTROL

During a bootloader update, the 6000 series I/O module does not monitor or control any of the
devices to which it is connected. Before updating the bootloader on the I/O module:

· Confirm that you are connected to the correct SCADAPack

· Evaluate the operational state of the devices that are monitored and controlled by the I/O
module. 

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Do not remove power from the SCADAPack during the bootloader update.

Do not disconnect the 6000 series I/O module from the SCADAPack during the bootloader
update.

If power is interrupted for any reason during the bootloader update, contact Technical
Support.

Failure to follow these instructions can result in death or serious injury.

NOTICE

UNINTENDED EQUIPMENT OPERATION

The SCADAPack x70 device automatically restarts when the bootloader is updated.

Evaluate the operational state of the equipment being monitored or controlled by the
SCADAPack x70 device before updating the bootloader. 

Failure to follow these instructions can result in equipment damage.

Preserving data

When you update the bootloader on the device:

· The device configuration is preserved

· Routes are preserved, with the exception of dynamic DNP3 routes and IP routes that were
added via logic or from the RTU command line

· The logic application and the state of logic variables are preserved

· The device restarts to apply the update
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To update the bootloader on the device

1. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Update Device Firmware or Bootloader. 

2. Follow the instructions in the wizard to download the bootloader to the device and update it.

3. Open the Online Diags - SPx70 Controller parameters if they are not already open and click
Refresh on the Status tab to verify that the Bootloader Version field was correctly updated.

12.11.4 Creating Recovery Media on a SCADAPack 47x

This feature applies to SCADAPack 470 and SCADAPack 474 devices only. It is available in
online and offline mode. 

If the SCADAPack will not boot and you are unable to communicate with the RTU, then the
firmware on the SCADAPack 47x may have become corrupted or invalid. Use Create Recovery
Media to recover the firmware. After you have completed this process, the RTU will be in a cold
booted state. You will have to rewrite the RemoteConnect configuration to the RTU.

To create recovery media

1. Insert a USB media device in your PC and format it as FAT32. 

2. Under My Network, right-click on SCADAPack x70 Controller Settings -DeviceDTM  and
select Additional Functions > Create Recovery Media.
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3. Browse to the location of the .fwz firmware file. 

The default location for this file is: 

o 32-bit systems: C:\Program Files\Schneider

Electric\RemoteConnect\Firmware\SCADAPack 47x

o 64-bit systems: C:\Program Files (x86)\Schneider

Electric\RemoteConnect\Firmware\SCADAPack 47x

4. Click Next.
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5. From the drop-down list, select the USB media device formatted as FAT32.

If the USB media device is not formatted as FAT32, it will not appear in the list. 

6. Click Next. 
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7. Confirm that the information in the dialog is correct and that it is ok to overwrite any existing
firmware.bin file on the USB media device and click Next.

A progress bar is displayed.
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8. Confirm that the progress has completed successfully and click Finish. 
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There is now a firmware.bin file on the USB media device. 

For details on how to use the recovery media on a SCADAPack 470, see the Recovering
Firmware topic in the SCADAPack 470 Hardware manual.

For details on how to use the recovery media on a SCADAPack 474, see the Recovering
Firmware topic in the SCADAPack 474 Hardware manual.
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13 Troubleshooting

The table below provides suggestions for handling diagnostic messages and symptoms.

· Missing or duplicate SCADAPack logic variables

· Library database is locked

· Logic Editor unavailable diagnostic message

· Cannot rename diagnostic message

· The device has reported conditions that require attention

· The Logic content of this project is not compatible with the current version of the Logic
Editor

· Unexpected behavior after adding or updating a DTM  

· Opened window is not visible and not accepting input

· Catalog Update dialog remains open at 100%

· Unity Pro XL Fatal error

· Logic Editor V14.0 doesn't start when Logic Editor V11.1 was previously installed

· Logic Editor V11.1 doesn't start when Logic Editor V14.0 was previously installed

· SCADAPack RemoteConnect communication is disturbed when device is restarted in Service,
Cold, or Factory boot modes

· # 768: Invalid field Id: 550608

· Loss of communication to I/O modules

· The SCADAPack x70 device has reset unexpectedly

· SCADAPack RemoteConnect has restarted 3 times consecutively

· System status code 1013 was reported, but there is no message in config.log

· Checkbox for Object Protocol Address(es) in Logic Editor Custom Field is not available under
SCADAPack x70 Controller Settings -DeviceDTM  > Additional Functions > Project
settings

· Logic Editor V14.0 doesn't start if UnitySoControl_V140_HF_RAT_PSBROKER.exe was
applied

· The Integrity Check window is displayed after installing SCADAPack RemoteConnect

· Unable to change the user interface language

· Logic Editor doesn't start after Control Expert V15.0 hotfixes are applied

· Message IS_PAR_CON is displayed

· Installation Message displayed when starting SCADAPack RemoteConnect

· Missing SCADAPack x70 Library Content

Condition What to Do
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Missing or duplicate SCADAPack
logic variables

The SCADAPack x70 Logic Editor or
SCADAPack RemoteConnect may have
terminated unexpectedly.

1. Restart SCADAPack RemoteConnect and open
the project. 

2. Check in the SCADAPack x70 Logic Editor for
missing or duplicate T_SPx70_xxxx type
variables. 

3. On the SCADAPack x70 Configuration tab in
SCADAPack RemoteConnect, click
SCADAPack x70 Logic, expand the Advanced
Configuration parameters, and click Replace
Variables.

4. In the SCADAPack x70 Logic Editor, click Yes
to confirm the modification to the variables.

The missing or duplicate logic editor variables
where RemoteConnect objects are configured with
linked logic variables are updated.

Library database is locked

When attempting to modify the logic
library, the SCADAPack x70 Logic
Editor or the Types Library Update tool
reports that the library is opened by
another application.

Try each of the following:

· Close all instances of Unity Pro, Control Expert,
SCADAPack RemoteConnect and the Types
Library Update tool

· If necessary, stop SCADAPack RemoteConnect
from the Windows Task Manager

If the problem persists it is likely because of
Windows folder permissions settings.

Check the following:

1. With administrator privileges, right-click on C:
\ProgramData\Schneider Electric

2. Select Properties.

3. Click the Security tab.

4. Click Edit.

5. In the Group or user names section, click on
the Users entry. 

6. In the Permissions for Users section, scroll
down until you see a row called Write.

7. For the Write row, click the checkbox in the
Allow column.

8. Click OK.

The security settings are updated on all the
sub-folders.

9. To exit the Properties dialog, click OK.
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Logic Editor unavailable diagnostic
message

If SCADAPack RemoteConnect cannot
connect to the logic editor, you may see
a message that the SCADAPack x70
Logic Editor is unavailable.

The SCADAPACK_x70 Type library
folder may be missing under:

C:\ProgramData\Schneider
Electric\UnitySoControl
14.0\CustomLibset\V11.1 

or 

C:\ProgramData\Schneider
Electric\UnitySoControl
14.0\CustomLibset\V14.0

Try the following:

1. Shutdown SCADAPack RemoteConnect.

2. If necessary, stop SCADAPack
RemoteConnect from the Windows Task
Manager.

3. Restart SCADAPack RemoteConnect.

If the message reappears, follow the repair
instructions in one of the following:

· the Post-Installation Steps for Unity Pro (V13.1
or later) and SCADAPack RemoteConnect in the
Software Installation manual

· the Post-Installation Steps for Control Expert
(V14.0 and V14.1) and SCADAPack
RemoteConnect in the Software Installation
manual

· the Post-Installation Steps for Control Expert
(V15.0) and SCADAPack RemoteConnect in the
Software Installation manual

You may need to reinstall the missing
SCADAPACK_x70 Type library.

Follow the steps in the Installing a Family topic in
the Logic Programming Overview manual.

Cannot rename diagnostic message

If the SCADAPack x70 Logic Editor
project has not been saved, you may
see the following diagnostic message. 

Save the project.

The device has reported conditions
that require attention.

You may see one of the following
messages if, for example:

· There is a hardware condition on the
SCADAPack x70 device.  For
example, the real time clock could

There are several things you can check.

If the online configuration parameters are not
already open, under My Network, right-click on
SCADAPack x70 Controller Settings -
DeviceDTM  and select Online Diagnostics. 

· On the Status tab, click Refresh and check the
Memory Battery status, System Status Code, or
any other error indications.
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not be initialized properly or there is
something wrong with the battery.

· The configuration is not correct. For
example, the configuration has
become corrupted or does not exist
on the device.

· If there is a System Status Code, check what
the cause is determine a course of action based
on the code

The Logic content of this project is
not compatible with the current
version of the Logic Editor.

If the .sta file does not exist, you may
see the following message:

Resolution 

1. Using an earlier version of SCADAPack
RemoteConnect, on the Configuration tab,
select SCADAPack x70 Logic.

2. Click Update & Build.

3. Close this version of SCADAPack
RemoteConnect and open the latest version.

4. Open the project.

Unexpected behavior after adding
or updating a DTM

The DTM catalog is automatically
updated when you add or update a
DTM. If you notice unexpected behavior
after adding or updating a DTM, you can
disable automatic DTM catalog
updates. 

To disable automatic updates of the DTM catalog:

1. From Windows, run regedit.exe with
administrator privileges. 

2. Add the registry key: 

HKEY_CURRENT_USER\Software\Schneider
Electric\RemoteConnect\UserOptions\Confir
mCatalogUpdate [DWORD32]

3. Set the value to 1.

Opened window is not visible and
not accepting input

When a laptop is switched from a
multiple screen display to a single
screen display, application windows
may become orphaned on the no longer
visible screen. If the logic editor is not
accepting input after attempting to open
a secondary window such as the Types
Library Manager or FFB Input
Assistance, it's possible that the
window is open on a previously opened
display. If you've moved from using a
multi-screen display to a laptop, for
example, the opened window may not
be visible.

Press Alt-F4 to close the hidden window and
resume using the logic editor main screen.

OR

Press Alt-Space then M and hold down the left-
arrow key to move the window onto the current
display.
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Catalog Update dialog remains open
at 100%

The automatic catalog update dialog
usually closes when it is complete. If
the dialog does not close automatically,
you will see the following.

 

To close the Catalog Update when it does not
close automatically:

1. Close SCADAPack RemoteConnect.

2. Delete the DTMCatalog folder under:

C:\ProgramData\Schneider
Electric\RemoteConnect

The location of the folder is the same under 64-
bit and 32-bit and doesn't depend on where the
applications was installed.

3. Start SCADAPack RemoteConnect again.

The automatic update catalog should complete
updating.

Unity Pro XL Fatal error

When attempting to create an M340
CANOpen project from Unity Pro V13.0
or Unity Pro V13.1 after removing the
SCADAPack x70 Logic Editor V14.0, an
exception dialog is displayed.

Resolution

1. Close all instances of Unity Pro.

2. Open a command prompt with administrator
privileges.

3. Run the following command:

· 32-bit PC:

Regsvr32 "C:\Program Files\Schneider
Electric\Unity Pro\Cdbsps2.dll"

· 64-bit PC:

Regsvr32 "C:\Program Files (x86)
\Schneider Electric\Unity
Pro\Cdbsps2.dll"

The following dialog is displayed if the registration
is successful.

Logic Editor V14.0 doesn't start when
Logic Editor V11.1 was previously
installed

If SCADAPack x70 Logic Editor V11.1
was previously installed, and then
upgraded to V14.0, when you open an
existing project or create a new project,

Resolution

1. Close all instances of SCADAPack
RemoteConnect.

2. Open a command prompt with administrator
privileges.

3. Run the following command:
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the SCADAPack x70 Logic Editor
doesn't start. The PSBroker.exe register
may be missing.

· 32-bit PC:

cd "C:\Program Files\Common
Files\Schneider Electric
Shared\CommonControlExpert\PSBROKE
R"

· 64-bit PC:

cd "C:\Program Files (x86)\Common
Files\Schneider Electric
Shared\CommonControlExpert\PSBROKE
R"

4. Type psbroker.exe /regserver 

5. Start SCADAPack RemoteConnect again.

The SCADAPack x70 Logic Editor should start
correctly.

Logic Editor V11.1 doesn't start when
Logic Editor V14.0 was previously
installed

If SCADAPack x70 Logic Editor V14.0
was previously installed, and then
downgraded to V11.1, when you open
an existing project or create a new
project the SCADAPack x70 Logic
Editor doesn't start. The RAT and
PSBroker may not be the correct
version for SCADAPack x70 Logic
Editor V11.1.

Resolution

1. Close all instances of SCADAPack
RemoteConnect.

2. To repair the SCADAPack x70 Logic Editor, run
the following RemoteConnect repair utility by
double-clicking the repair executable and
following the installation wizard. By default, the
path to the executable file is one of the
following:

· 32-bit Windows:

C:\Program Files\Schneider
Electric\RemoteConnect\Repair\UnityPro
_V111_HF_RAT_SRCSDK.exe

· 64-bit Windows:

C:\Program Files (x86)\Schneider
Electric\RemoteConnect\Repair\UnityPro
_V111_HF_RAT_SRCSDK.exe

3. Start SCADAPack RemoteConnect again.

The SCADAPack x70 Logic Editor should start
correctly.

SCADAPack RemoteConnect
communication is disturbed when
device is restarted in Service, Cold,
or Factory boot modes.

To restore communication:

For USB:

1. Go offline before restarting the device. 

2. Wait for the device to restart. 
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3. Go online after the device has restarted. 

It can take up to 90 seconds for the SCADAPack
x70 USB port to be ready.

For Serial or Ethernet:

1. Go offline before restarting the device. 

2. In SCADAPack RemoteConnect configuration
software, change the PC Communication
Settings to match the device. 

3. Go online after the device has restarted.

# 768: Invalid field Id: 550608

After clicking the Open Configuration
Log button on the Status tab, the
message # 768: Invalid field Id:
550608 may be displayed when a new
feature of SCADAPack RemoteConnect
is not compatible with an older version
of firmware. 

Resolution 

Upgrade the firmware on your SCADAPack x70
device. See the hardware manual for your device for
details. 

Loss of communication to I/O
modules

System status code 6601 or any other
I/O module related communication
status codes is displayed (see the
System Status Codes topic in the
Operations Technical Reference
manual) and the status code can not be
cleared.

I/O Module objects display the quality
Not Responding.

Resolution

1. Check the 6601 I/O firmware version used by
6601 I/O modules:

· Retrieve a Device Information file (see Getting
Device Information File ) and check the
VER information section. The latest released
6601 I/O firmware version should be listed.

· Alternatively, issue the command ver on a
command console

2. Update all 6601 I/O modules where the latest
I/O firmware is not installed:

· Follow the update procedure through
RemoteConnect described in the Updating
Module Firmware topic in the SCADAPack
6601 Input Output Module manual.

· Alternatively transfer the 6601 I/O firmware
file to the SCADAPack x70 device and issue
the follow command for each module
replacing module_address with the correct
number:

restart iofirm fw6601_Version.bin
module_address

where Version represents the current version.

426
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3. Verify that the correct I/O firmware version was
installed by repeating step 1.

4. Restart the SCADAPack x70 device.

5. Reset the Diagnostic Status after reboot.

See To clear the Task Watchdogs, Restart
Reason and System Status Code fields

The System Status Code should not show any I/O
module related codes.

The SCADAPack x70 device has
reset unexpectedly

If the SCADAPack x70 device resets
unexpectedly, look for a dump file in the
root folder of the file system (/user).

Resolution

Contact Technical Support  and look for a dump
file at /user.

SCADAPack RemoteConnect has
restarted 3 times consecutively

When creating a new project, opening
an existing project, or reading a project
from the device, you may see a
message that the SCADAPack x70
Logic Editor is unavailable. If the logic
editor does not appear to be running and
SCADAPack RemoteConnect has
restarted 3 times consecutively, you will
need to perform the suggested
resolution. 

Resolution

Launch SCADAPack RemoteConnect using the
provided DVD and follow the wizard to reinstall
SCADAPack RemoteConnect.

System status code 1013 was
reported, but there is no message in
config.log

Resolution

Upgrade the firmware on your SCADAPack x70
device. See the hardware manual for your device for
details. 

Checkbox for Object Protocol
Address(es) in Logic Editor Custom
Field is not available under
SCADAPack x70 Controller Settings -
DeviceDTM  > Additional Functions >
Project settings

Resolution

1. Close SCADAPack RemoteConnect.

2. From Windows, run regedit.exe with
administrator privileges.

3. Remove the registry key: 

HKEY_CURRENT_USER\
Software\Schneider
Electric\RemoteConnect\Dev\
CustomVariableFieldOptions

4.  Start SCADAPack RemoteConnect again.

360
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The Object Protocol Address(es) in Logic Editor
Custom Field option should now be available
under SCADAPack x70 Controller Settings -
DeviceDTM  > Additional Functions > Project
settings

Logic Editor V14.0 doesn't start if
UnitySoControl_V140_HF_RAT_PSBR
OKER.exe was applied

If
UnitySoControl_V140_HF_RAT_PSBRO
KER.exe was applied before or after the
Logic Editor V14.0 was installed, the
Logic Editor may not start properly
when you attempt to launch from
RemoteConnect.

Resolution

1. Under Control Panel > Programs and
Features:

a. Select UnitySoControl.

b. Click Uninstall.

c. Follow the wizard to select the Remove
option.

2. Launch the RemoteConnect DVD.

3. Select Install RemoteConnect.

4. When prompted to Remove or Repair, select
Repair to continue with the installation. 

The Integrity Check window is
displayed after installing
SCADAPack RemoteConnect

If you see the Integrity Check window
displayed after installing SCADAPack
RemoteConnect, you may need to
install a missing certificate. 

Resolution

See the Installing a Missing Certificate Manually
topic in the Software Installation manual.

Unable to change the user interface
language 

You are unable to change the user
interface language for the SCADAPack
x70 Logic Editor when performing side-
by-side operation with Control Expert
V14.0 or V14.1.

Resolution

1. Close all instances and end all processes
related to SCADAPack RemoteConnect,
UnitySoControl, Unity Pro, and Control Expert.

2. Run the SCADAPack RemoteConnect repair
utilities by double-clicking the repair executable
and following the installation wizard. By default,
the path to the executable file is one of the
following:

· 64-bit Windows: C:\Program Files (x86)
\Schneider
Electric\RemoteConnect\Repair\UnitySoC
ontrol_V140_HF_LanguageSelector.exe

· 32-bit Windows: C:\Program
Files\Schneider
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Electric\RemoteConnect\Repair\UnitySoC
ontrol_V140_HF_LanguageSelector.exe

3. To change the user interface language in the
SCADAPack x70 Logic Editor, follow the steps
in the Accessing SCADAPack RemoteConnect
Functionality topic in the SCADAPack
RemoteConnect Configuration Software manual.

Logic Editor doesn't start after
Control Expert V15.0 hotfixes are
applied

If the Logic Editor displays a diagnostic
message or the integrity check window
from Logic Editor is displayed after
Control Expert V15.0 hotfixes are
applied, then follow the steps in the
Resolution.

Resolution

1. Close all instances and end all processes
related to SCADAPack RemoteConnect,
UnitySoControl, Unity Pro, and Control Expert.

2. Run the SCADAPack RemoteConnect repair
utilities by double-clicking the repair executable
and following the installation wizard. By default,
the path to the executable file is one of the
following:

· 64-bit Windows: C:\Program Files (x86)
\Schneider
Electric\RemoteConnect\Repair\ControlE
xpert_V150_HF0380489E_B.exe

· 32-bit Windows: C:\Program
Files\Schneider
Electric\RemoteConnect\Repair\ControlE
xpert_V150_HF0380489E_B.exe

Message IS_PAR_CON is displayed

A logic project previously built using
SCADAPack x70 Logic Editor versions
11.1 or 14.0 and using LIBSET V11.1
does not build with the following
message:

The type IS_PAR_CON is not available
for the current target PLC configuration

Update the project to the latest LIBSET version:

1. On the SCADAPack x70 Configuration tab in
SCADAPack RemoteConnect, select
SCADAPack x70 Logic. 

2. Expand the Advanced Configuration
parameters.

3. Click Upgrade Logic Library.

Installation Message displayed when
starting SCADAPack RemoteConnect

Starting SCADAPack RemoteConnect
from a non-privileged user account
following a Control Expert upgrade
results in the following installation
message:

If the non-privileged user does not have access
credentials for the privileged account, follow the
instructions in the Post-Installation Steps for
Control Expert (V15.1 and later) and SCADAPack
RemoteConnect topic in the SCADAPack Software
Installation manual.
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Missing SCADAPack x70 Library
Content

SCADAPack x70 Library content is
partially or wholly missing when opening
a SCADAPack RemoteConnect project.
This may occur where the
RemoteConnect project was created on
a different PC with a different version of
Control Expert.

To install the SCADAPack x70 RTU System and/or
Extensions library content into the LIBSET version
used by the project, follow the instructions in the
Installing a Family topic in the Logic Programming
Overview manual.

You can check the project’s LIBSET version by
opening the SCADAPack x70 Logic Editor's Types
Library Manager tool.
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1 Legal Information

The information provided in this documentation contains general descriptions and/or technical
characteristics of the performance of the products contained herein. This documentation is not
intended as a substitute for and is not to be used for determining suitability or reliability of these
products for specific user applications. It is the duty of any such user or integrator to perform the
appropriate and complete risk analysis, evaluation and testing of the products with respect to the
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you
have any suggestions for improvements or amendments or have found errors in this publication,
please notify us.

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when installing and
using this product. For reasons of safety and to help ensure compliance with documented
system data, only the manufacturer should perform repairs to components.

This document contains standardized industry terms that some customers might find insensitive
or offensive. These terms do not reflect the official policy or position of Schneider Electric.

Trademarks

Schneider Electric, ClearSCADA, EcoStruxure, Modbus, RemoteConnect, SCADAPack,
Telepace, and Trio are trademarks and the property of Schneider Electric SE, its subsidiaries
and affiliated companies. All other trademarks are the property of their respective owners.

Address

Schneider Electric Systems USA

Process Automation, Remote Operations
38 Neponset Avenue, Foxboro, Massachusetts 02035 USA
Email: RemoteOperations@se.com
www.se.com

© 2022 Schneider Electric Systems USA Inc.
All rights reserved.

mailto:RemoteOperations@se.com
http://www.se.com
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2 Technical Support

Questions and requests related to any part of this documentation can be directed to one of the
following support centers.

Technical support: Americas, Europe, Middle East, Asia

Available Monday to Friday 8:00 am – 6:30 pm Eastern Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq

Email us Save time by emailing us your inquiry and an expert will contact
you:

supportTRSS@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Toll free within North America: 1-888-226-6876

· Direct Worldwide: +1-613-591-1943

Technical support: Australia/New Zealand (Pacific)

Available Monday to Friday 8:00 am - 5:00 pm Australian Eastern Standard Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq   

Email us Save time by emailing us your inquiry and an expert will contact
you:

techsupport.pz@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Inside Australia: 13 73 28 (13 SEAU)

· Inside New Zealand: 0800 652 999

https://se.com/faq
mailto:supportTRSS@se.com
https://se.com/faq
mailto:techsupport.pz@se.com
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3 Safety Information

Important information

Read these instructions carefully, and look at the equipment to become familiar with
the device before trying to install, operate, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

Please note

Electrical equipment should be installed, operated, serviced, and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out
of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Before you begin

Do not use this product on machinery lacking effective point-of-operation guarding. Lack of
effective point-of-operation guarding on a machine can result in serious injury to the operator of
that machine.

 WARNING

EQUIPMENT OPERATION HAZARD

· Verify that all installation and set up procedures have been completed.

· Before operational tests are performed, remove all blocks or other temporary holding means
used for shipment from all component devices.

· Remove tools, meters, and debris from equipment.

Failure to follow these instructions can result in death or serious injury.

Follow all start-up tests recommended in the equipment documentation. Store all equipment
documentation for future reference.

Test all software in both simulated and real environments.

Verify that the completed system is free from all short circuits and grounds, except those
grounds installed according to local regulations (according to the National Electrical Code in the
U.S.A, for instance). If high-potential voltage testing is necessary, follow recommendations in
equipment documentation to help prevent accidental equipment damage.

Operation and adjustments

The following precautions prevail:

· Regardless of the care exercised in the design and manufacture of equipment or in the
selection and ratings of components, there are hazards that can be encountered if such
equipment is improperly operated.

· It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or
unsafe operation. Always use the manufacturer’s instructions as a guide for functional
adjustments. Personnel who have access to these adjustments should be familiar with the
equipment manufacturer’s instructions and the machinery used with the electrical equipment.

· Only those operational adjustments actually required by the operator should be accessible to
the operator. Access to other controls should be restricted to prevent unauthorized changes in
operating characteristics.
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Acceptable use

 WARNING

UNACCEPTABLE USE

Do not use SCADAPacks or I/O modules as an integral part of a safety system. These
devices are not safety products.

Failure to follow these instructions can result in death or serious injury.

 CAUTION

EQUIPMENT OPERATION HAZARD

When devices are used for applications with technical safety requirements, the relevant
instructions must be followed. 

Use only Schneider Electric software or approved software with Schneider Electric hardware
products.

Failure to follow these instructions can result in minor or moderate injury.
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4 About the Book

Audience

 WARNING

UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and programming of control
systems. Only persons with such expertise are allowed to program, install, alter, and apply
this product.

Follow all local and national safety codes and standards.

Failure to follow these instructions can result in death or serious injury.

This manual is written for people who need to install or update the SCADAPack x70
configuration environment for SCADAPack x70 devices. These individuals are typically: 

· Systems Engineers

· Commissioning Engineers

· Maintenance Technicians

Document scope

This manual describes:

· The history of release notes for the SCADAPack x70  

Validity note

This document is valid for:

· SCADAPack x70 firmware version 9.7.3 and older

· SCADAPack RemoteConnect configuration software version 3.10.3 and older

· Security Administrator version 1.6.2

Related documents

Use this manual with the other manuals included in your SCADAPack x70 documentation set.
The table below describes the manuals available in the documentation set.

Folder Manual Content

Getting Started Getting Started · The SCADAPack x70 family of products
available in this release

· The basic steps to get your SCADAPack
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x70 device operational

· Where to get more information about
configuring, monitoring and managing
your SCADAPack x70 device

SCADAPack
Software
Installation

SCADAPack Software
Installation

· Hardware and software requirements

· Installation procedures 

· Accessing help

· Troubleshooting guidance

Hardware
Manuals

The hardware manual for
your SCADAPack x70
device

· Installation, wiring and addressing
information

· Diagnostics capabilities

· Maintenance recommendations

· Hardware specifications

Configuration
Manuals

SCADAPack
RemoteConnect
Configuration Software

· Setting up and managing projects for your
SCADAPack x70 device

PC Communication
Settings -SCADAPack
CommDTM

· Setting up communications between
SCADAPack RemoteConnect and your
SCADAPack x70 device

SCADAPack x70
Configuration

· Configuring SCADAPack x70 device
operation

Porting Guide for
SCADAPack E to
SCADAPack
RemoteConnect

· Moving from SCADAPack E to
SCADAPack RemoteConnect

· Locating SCADAPack E Configurator
features in SCADAPack RemoteConnect

· Locating SCADAPack Workbench
features in SCADAPack RemoteConnect

· Compatibility chart

Porting Guide for Telepace
to SCADAPack
RemoteConnect

· Moving from Telepace to SCADAPack
RemoteConnect

· Tutorial for creating a project

· Compatibility chart

Technical
Reference
Manuals

SCADAPack
Communication Interfaces
Technical Reference

· USB, serial and IP communications

· Mobile communications

· Dialup modem communications
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SCADAPack Operations
Technical Reference

· The SCADAPack x70 device file system

· Command line operations

· Diagnostics operations

· Telnet server operations

· FTP server operations

SCADAPack SCADA
Protocols Technical
Reference

· DNP3 protocol support

· Modbus protocol support

· IEC 60870-5-104 protocol support

Logic
Programming
Manuals

SCADAPack Logic
Programming Overview

· The differences between EcoStruxure
Control Expert (Unity Pro) and the
SCADAPack x70 Logic Editor
environment

· Key programming concepts

· Basic procedures needed to use the
SCADAPack x70 Logic Editor

SCADAPack Function
Blocks Technical
Reference

· The custom SCADAPack x70 function
blocks that are available for developing
IEC 61131-3 applications 

Using EFB Toolkit with
SCADAPack x70

· Using the Schneider Electric EFB Toolkit
with SCADAPack x70 devices and
SCADAPack RemoteConnect
configuration software

Security
Administrator
Manuals

SCADAPack Security
Administrator

· Configuring security on your SCADAPack
x70 device

SCADAPack Security
Technical Reference

· Security standards

· Security overview

· DNP3 Secure Authentication

· Diagnostics

· Attack vectors and requirements
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5 Cybersecurity

Cybersecurity is a branch of network administration that addresses attacks on or by computer
systems and through computer networks that can result in accidental or intentional disruptions.
The objective of cybersecurity is to help provide increased levels of protection for information and
physical assets from theft, corruption, misuse, or accidents while maintaining access for
intended users.

No single cybersecurity approach is adequate. Schneider Electric recommends a defense-in-
depth approach. This approach layers the network with security features, appliances, and
processes. The basic components of this approach are:

· Risk assessment: A systematic security analysis of the environment and related systems.

· A security plan built on the results of the risk assessment

· A multi-phase training campaign

· Network separation and segmentation: Physical separation of the control network from other
networks, and the division of the control network itself into segments and security zones.

· System Access Control: Controlling access to the system with firewalls, authentication,
authorization, and other software means, and traditional physical security measures such as
video surveillance, fences, locked doors and gates, and locked equipment cabinets.

· Device hardening: The process of configuring a device against communication-based threats.
Device hardening measures include disabling unused network ports, password management,
access control, and the disabling of all unnecessary protocols and services.

· Network monitoring and maintenance: An effective defense-in-depth campaign requires
continual monitoring and system maintenance to meet the challenge of new threats as they
develop.

· See Security Considerations in the Security Technical Reference manual

Contact us

For more information, refer to the Schneider Electric Cybersecurity Support Portal at
http://www.se.com/b2b/en/support/cybersecurity/overview.jsp.

Additional Resources

Schneider Electric Recommended Cybersecurity Best Practices
https://www.se.com/ww/en/download/document/CS-Best-Practices-2019-340/ 

Industrial Control Systems Cyber Emergency Response Team (ICS-CERT)
https://ics-cert.us-cert.gov 

ICS-CERT Recommended Practices
https://ics-cert.us-cert.gov/Recommended-Practices

Center for Internet Security (CIS) Top 20 Critical Security Controls
https://www.cisecurity.org/cybersecurity-best-practices

http://www.se.com/b2b/en/support/cybersecurity/overview.jsp
https://www.se.com/ww/en/download/document/CS-Best-Practices-2019-340/
https://ics-cert.us-cert.gov
https://ics-cert.us-cert.gov/Recommended-Practices
https://www.cisecurity.org/cybersecurity-best-practices
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FBI Cyber Crime
https://www.fbi.gov/investigate/cyber

Guide to Industrial Control Systems (ICS) Security
https://www.nist.gov/publications/guide-industrial-control-systems-ics-security

WaterISAC Water Security Network
https://www.waterisac.org

https://www.fbi.gov/investigate/cyber
https://www.nist.gov/publications/guide-industrial-control-systems-ics-security
https://www.waterisac.org
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6 SCADAPack x70 Release Notes

· SCADAPack x70 R2.7.3 Release Notes 05/2022

· SCADAPack x70 R2.7.2 Release Notes 03/2022

· SCADAPack x70 R2.7.1 Release Notes 12/2021

· SCADAPack x70 R2.6.1 Release Notes 07/2021

· SCADAPack x70 R2.5.2 Release Notes 04/2021

· SCADAPack x70 R2.5.1 Release Notes 01/2021

· SCADAPack x70 R2.4.2 Release Notes 08/2020

· SCADAPack x70 R2.4.1 Release Notes 05/2020

· SCADAPack x70 R2.4 Release Notes 03/2020

· SCADAPack x70 R2.3.2 Release Notes 01/06/2020

· SCADAPack x70 R2.3.1 Release Notes 06/9/2019

· SCADAPack x70 R2.2.2 Release Notes 10/7/2019

· SCADAPack x70 R2.2.1 Release Notes 01/05/2019

· SCADAPack x70 R2.2 Release Notes 01/03/2019

· SCADAPack x70 R2.1.1 Release Notes 25/10/2018

· SCADAPack x70 R2.1 Release Notes 5/09/2018

· SCADAPack x70 R2.0 Release Notes 20/07/2018

6.1 SCADAPack x70 R2.7.3 Release Notes 05/2022

SCADAPack x70 R2.7.3 was first available in May 2022.

· SCADAPack 47x Upgrade Requirements

· SCADAPack 57x Upgrade Requirements

SCADAPack 47x Upgrade Requirements

Some SCADAPack 47x RTUs with Cypress (Spansion) NOR flash components did not boot
after a power cycle. SCADAPack 47x bootloader 1.41 helps to protect against overwriting of one-
time-programmable configuration registers in Cypress (Spansion) NOR flash.

Identifying Affected Units

Upgrade the SCADAPack 47x firmware to version 9.6.1 or newer. 

Use the VER command to identify the type of NOR flash. Hardware with Cypress (Spansion)
NOR flash will display

    NOR Flash Chip ID: 0x4d190201

21
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41

51

72

80

93

105

116

134

143

153

161

170

185

193

213

21

22
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To determine the NOR Flash Chip ID do one of the following

· Using SCADAPack RemoteConnect

1. Open a project.

2. Click Online to connect to the SCADAPack 47x RTU.

3. Right-click SCADAPack x70 Controller Settings – Device DTM.

4. Select Additional Functions > Get Device Information.

5. Click Browse and specify a file name.

6. Click OK.

7. Open the Device Information file read from the RTU and search for NOR Flash Chip ID.

· Using the SCADAPack 47x command line 

1. Type VER and press Enter.

2. Check the NOR Flash Chip ID displayed.

SCADAPack 47x RTUs with other NOR flash components are not affected.

SCADAPack 57x RTUs are not affected.

Action

Upgrade the SCADAPack 47x bootloader to version 1.41 or newer on hardware with Cypress
(Spansion) NOR Flash.

SCADAPack 57x Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using

· SCADAPack 57x firmware version 9.1.2 and older, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
older. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

6.1.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.1.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.10.3

· SCADAPack DNP3 Communication DTM version is 3.10

· SCADAPack x70 Device DTM version is 3.10

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.10.3

· Realflo flow computer version is 7.10.2

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.7.3

SCADAPack 47x bootloader version is 1.41

SCADAPack 57x firmware version is 9.7.3

SCADAPack 57x bootloader version is 1.40
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6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.1.127

6602 I/O module bootloader version is 2.1.127

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.1.3 Software and Firmware Version Compatibility

SCADAPack RemoteConnect version 3.10.3 is intended for use with SCADAPack x70 firmware
version 9.7.3 and Control Expert Version V15.1.02227 or later.

6.1.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574, and 575 modules with hardware version V4.00 and newer require
minimum bootloader and operating system firmware versions as described in the table below.

If you attempt to install bootloader firmware 1.30 or older on a SCADAPack 57x device with
hardware version 4.00 or newer, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or older with SCADAPack
57x hardware versions 4.00 or newer.

If you attempt to install operating system firmware 9.4.3 or older on a SCADAPack 57x device
with hardware version 4.00 or newer, the firmware installation will be unsuccessful. System
status code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or older
with SCADAPack 57x hardware versions 4.00 or newer.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader
Firmware
Version

SP57x
Operating
System
Firmware
Version

Comment

 3.02 or older any any Use bootloader version
1.30 or newer. See
SCADAPack 57x Upgrade
Requirements older in this
document.
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 4.00 or newer 1.40 or newer 9.5.1 or
newer

 X 4.00 or newer 1.30 or older
are not
supported

9.4.3 or
older are
not
supported

Use bootloader firmware
version 1.40 or newer.

Use Operating system
firmware version 9.5.1 or
newer.

You can check the SCADAPack 57x hardware version, bootloader firmware version and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.1.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.1.6 Supported Operating Systems

Windows 10 Professional (64-bit) - version 20H2 and 21H1

Windows 10 Enterprise (64-bit) - version 2019 LTSC (version 1809)

Windows Server 2019, standard 1809 version

6.1.7 SCADAPack RemoteConnect and Control Expert Compatibility

SCADAPack RemoteConnect installations can coexist with specific Unity Pro or Control Expert
installations. If RemoteConnect is installed on a computer that had Unity Pro or Control Expert
installed previously, the RemoteConnect installation automatically confirms that components in
the SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If
Unity Pro or Control Expert is installed or upgraded on a computer that already had
RemoteConnect installed, then a repair process is likely required on RemoteConnect to confirm
that components are correctly referenced. Use Run as administrator to run the repair process.

SCADAPack RemoteConnect R2.7.3 has been tested and is compatible with:

· EcoStruxure Control Expert version 15.1
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6.1.8 New and Improved Features (R2.7.3)

WI: 65163 SCADAPack x70 RTUs support configurable Data Logging. Data logs

can be read as CSV files. RemoteConnect displays tables and graphs of

logged data.

WI: 65319 The SCADAPack x70 Logic Editor is updated to Control Expert 15.1.

The side-by-side logic editor installation is replaced with a shared

installation of Control Expert. This provides support for new Control

Expert features and resolves problems with the side-by-side installation.

Control Expert logic password features are supported by SCADAPack

RemoteConnect R2.7.3 and later, and by SCADAPack x70 firmware

9.7.3 or later. This provides additional security for logic applications.

WI: 65812 SCADAPack x70 RTUs support the Modbus broadcast address.

WI: 60906 SCADAPack 47x RTUs support Micro SD cards.

WI: 64348 The SCADAPack x70 Extensions Library is now included with

RemoteConnect.

WI: 65238 SCADAPack x70 RTUs support structured IOA addressing for IEC

60870-5-104 protocol.

WI: 65851 Firmware will detect and correct duplicate MAC addresses on

SCADAPack 47x RTUs.

WI: 64693 Improved hardware documentation on ribbon cables between modules

and from 6103 power supply.

WI: 66385 Improved documentation of SFC program warm start operation. This

operation is different on SCADAPack x70 RTUs and Modicon PLCs.

WI: 66451 RemoteConnect automatically saves the project when the Device Type is

changed.

WI: 61997 Improved descriptions of ports in the DNP3Route_SelectOnline example

documentation.

WI: 65364 Improved further actions documentation for system status code 5000,

5002 and 5003.

WI: 65427 Added conceptual information in the Working with Objects topic.
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6.1.9 Fixed Issues (R2.7.3)

WI: 59839 The F_DeviceReady function block indicated that a SD card or USB drive
was installed when it was not. This is corrected.

WI: 59920 Logic Editor Memory Usage dialog showed incorrect values and calculated
the % of memory used using incorrect values. This is corrected. See also
WI: 59921.

WI: 59921 A project showed an internal memory usage of 86.6 % of executable code
but did not load due to lack of memory. The actual size of the project was
greater than 100% of available memory. The memory usage calculation
was incorrect. This is corrected. See also WI: 59920.

WI: 61206 Arrays could not be added to animation tables in the logic editor. This is
corrected.

WI: 62072 Logic Editor crashed when building logic on some projects with jumps and
labels in function block diagram code. This is corrected.

WI: 62654 Some characters in Project comments prevented RemoteConnect export
to .RCZ file. This is corrected.

WI: 62885 Logic Editor did not allow copy and paste of function blocks between two
Logic Editor instances. This is corrected.

WI: 62904 SCADAPack 47x RTU continuously restarted with reason 0x0400 after
loading some logic projects converted from SCADAPack 57x to
SCADAPack 47x (see WI: 65012). A cold boot was required to recover.
This is corrected. 

WI: 62988 USB connection to non-zero DNP3 address was not possible without
Remote Routing configuration. This is corrected.

WI: 63298 The user manual incorrectly described the Acceptable Data Size for with
String output arguments on x70 function blocks. This is corrected. 

WI: 64134 SCADAPack 47x restarted with reasons internal BSP Reset (0x0010) and
processor interrupt exception (0x0800) when connected to VFDs with
significant electrical noise on the serial connection. This is corrected and
additional guidance for wiring VFDs was added to the documentation.

WI: 64220 Addressed Logic Editor security vulnerabilities CVE-2021-22778, CVE-
2021-22780, and CVE-2020-7560.

WI: 64221 Addressed Logic Editor security vulnerabilities CVE-2021-21825, CVE-
2021-21830, CVE-2021-21826, CVE-2021-21827, CVE-2021-21828 and
CVE-2021-21829.
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WI: 64431 Addressed Logic Editor security vulnerability CVE-2021-22797.

WI: 64669 A background task watchdog (0x0008) boot loop occurred on the
SCADAPack 470 or 474 RTUs after pushing large logic editor update. This
is corrected.

WI: 64710 Modbus Scanner associations were removed following an Excel import.
This is corrected.

WI: 64734 The logic editor crashed when rebuilding some logic programs. This is
corrected.

WI: 64766 Installation instructions did not state that ADMIN rights are required to
install or uninstall RemoteConnect. This is corrected.

WI: 64771 Objects did not synchronize in RemoteConnect when importing a Logic
editor program. This is corrected.

WI: 64795 Update and Build project succeeded but after writing the program, system
status code 5000 was reported. This is corrected.

WI: 64820 RemoteConnect was unable to export some projects after successful
Update and Build logic. This is corrected. 

WI: 64898 Extensions Library - TOTAL_Daily function block accumulated less than
24 hours in a 24-hour period. This is corrected.

WI: 64903 Extensions Library – Some status codes for the DLOG_F function block
were not documented. This is corrected.

WI: 65102 A SCADAPack 570 project converted to SCADAPack 470 was not
compressed correctly by the logic editor so the RTU firmware was not able
to load the project. This is corrected.

WI: 65130 Extensions Library - FLOW_Daily function block accumulated less than 1
day in a 1-day period. This is corrected.

WI: 65142 Extensions Library - TOTAL_Hourly function block accumulated less than
60 minutes in 60 minutes period. This is corrected.

WI: 65143 Extensions Library – TOTAL_Monthly and FLOW_Monthly function blocks
accumulated less than a month in a full month period. This is corrected.

WI: 65153 Extensions Library - TOTAL_* function blocks reported an unexpected
Status code. This is corrected.

WI: 65180 Memory manager overwrote non-volatile memory resulting in loss of RTU
configuration and unloaded logic on next reboot. This is corrected.
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WI: 65217 Extensions Library – CTD_Retained function block PV input CV output
were documented UDINT but the MAX value was incorrectly documented
as 2147483647. This is corrected.

WI: 65234 Extensions Library - Documentation stated DINT data type for multiple
DFBs that used UDINT data type. This is corrected.

WI: 65236 R2.7.1 release notes listed incorrect Supported Operating Systems. This
is corrected.

WI: 65309 Logic did not compile when a newline character was placed at the
beginning of string "DATA" input. This is corrected.

WI: 65310 Extensions Library – The DLOG_F function block did not report the same
status in SP57x and SP47x when the USB stick not available. This is
corrected.

WI: 65325 Object browser read and write was permitted in the locked state when
using Modbus protocols. This is corrected.

WI: 65633 Memory leak occurred on SCADAPack 47x RTU generating DIN and 6607
counter events. This is corrected.

WI: 65701 The user manual did not describe data that is preserved when updating the
bootloader. This is corrected.

WI: 66143 R2.7.2 release notes incorrectly mentioned 57x bootloader version as
1.41. This is corrected to 1.40.

WI: 66204 Enron float registers in the 30000 to 59999 range of the Realflo flow
computer could not be read or written. This is corrected.

WI: 66269 Documentation was missing information for user debugging of status code
5000. This is corrected.

WI: 66513 6602 I/O module Analog Input status was not updated under some
conditions. This is corrected.

6.1.10 Known Issues (R2.7.3)

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.
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WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.

· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

WI: 66529 System Status code 1047 is reported at device restart if Data Logging is
configured to use the USB mass storage device.

Workaround: The status code can be disregarded. Clear the status code
from RemoteConnect after restart.

WI: 66530 System status code 1049 is sometimes reported when reading
configuration from a SCADAPack 47x device with Data Logging configured.

Workaround: The status code can be disregarded. Clear the status code
from RemoteConnect if it occurs.

N/A SCADAPack x70 firmware versions 9.7.2 and older return an invalid
response for a Modbus broadcast message if the Realflo flow computer is
enabled.

Workaround: Upgrade to firmware version 9.7.3 or later or avoid using
Modbus broadcast messages.

6.1.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 
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Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.

6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.1.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
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(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
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6601
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are

6601
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on

6601 AI
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0…20
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d
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y

Always
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 9.0.4 or
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mA 
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 9.0.4 or
later

1.80.0
6 or
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mA 
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d
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y
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22.00mA

Recommended choice for new
installations

X

9.0.4 or
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1.77.
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0…22
mA
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10%
lower
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Always
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20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.



3.10.3

x70 Release Notes SCADAPack x70 Release Notes

33

6.2 SCADAPack x70 R2.7.2 Release Notes 03/2022

SCADAPack x70 R2.7.2 was first available in March 2022.

· SCADAPack 47x Upgrade Requirements

· SCADAPack 57x Upgrade Requirements

SCADAPack 47x Upgrade Requirements

Some SCADAPack 47x RTUs with Cypress (Spansion) NOR flash components did not boot
after a power cycle. SCADAPack 47x bootloader 1.41 helps to protect against overwriting of one-
time-programmable configuration registers in Cypress (Spansion) NOR flash.

Identifying Affected Units

Upgrade the SCADAPack 47x firmware to version 9.6.1 or newer. 

Use the VER command to identify the type of NOR flash. Hardware with Cypress (Spansion)
NOR flash will display

    NOR Flash Chip ID: 0x4d190201

To determine the NOR Flash Chip ID do one of the following

· Using RemoteConnect

1. Open a project.

2. Click Online to connect to the SCADAPack 47x RTU.

3. Right-click SCADAPack x70 Controller Settings – Device DTM.

4. Select Additional Functions > Get Device Information.

5. Click Browse and specify a file name.

6. Click OK.

7. Open the Device Information file read from the RTU and search for NOR Flash Chip ID.

· Using the SCADAPack 47x command line 

1. Type VER and press Enter.

2. Check the NOR Flash Chip ID displayed.

SCADAPack 47x RTUs with other NOR flash components are not affected.

SCADAPack 57x RTUs are not affected.

33
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Action

Upgrade the SCADAPack 47x bootloader to version 1.41 or newer on hardware with Cypress
(Spansion) NOR Flash.

SCADAPack 57x Upgrade Requirements

SCADAPack 570, 574, and 575 RTUs require minimum bootloader and operating system
firmware versions. It is highly recommended that updates be installed on your SCADAPack 57x
RTUs. 

1. Install SCADAPack 57x firmware version 9.5.1 or newer, then 

2. Install SCADAPack 57x bootloader version 1.40 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
older. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack bootloader 1.40 and firmware 9.5.1 added support for new hardware versions. Older
bootloader and firmware versions do not support the newer hardware.

NOTICE

UNEXPECTED OPERATION

Do not use a bootloader version earlier than 1.40 with SCADAPack 57x hardware versions 4.00
or later.
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Do not use an operating system firmware version earlier than 9.5.1 with SCADAPack 57x
hardware versions 4.00 or later. 

Failure to follow these instructions can result in unexpected operation.

If you attempt to install bootloader firmware 1.30 or older on a SCADAPack 57x device with
hardware version 4.00 or newer, the firmware installation may be unsuccessful. System status
code 1060 may be generated. Avoid using bootloader firmware 1.30 or older with SCADAPack
57x hardware versions 4.00 or newer.

If you attempt to install operating system firmware 9.4.3 or older on a SCADAPack 57x device
with hardware version 4.00 or newer, the firmware installation may be unsuccessful. System
status code 1061 may be generated. Avoid using operating system firmware version 9.4.3 or
older with SCADAPack 57x hardware versions 4.00 or newer.

You can check the SCADAPack 57x hardware version, bootloader firmware version and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command. On some SCADAPack RTUs the hardware version may be incorrectly
reported due to a manufacturing issue. 

Follow the recommendations in this document regardless of the reported hardware version.

6.2.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.2.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.10.2

· SCADAPack DNP3 Communication DTM version is 3.10

· SCADAPack x70 Device DTM version is 3.10

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.10.2

· SCADAPack x70 French Documentation version is 1.2.3

· Realflo flow computer version is 7.10.1

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.7.2

SCADAPack 47x bootloader version is 1.41
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SCADAPack 57x firmware version is 9.7.2

SCADAPack 57x bootloader version is 1.40

6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.1.127

6602 I/O module bootloader version is 2.1.127

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.2.3 Software and Firmware Version Compatibility

RemoteConnect version 3.10.2 is intended for use with SCADAPack x70 firmware version 9.7.2.

6.2.4 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.2.5 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit) - version 20H2 and 21H1

Windows 10 Enterprise (32-bit or 64-bit) - version 20H2 and 21H1

Windows Server 2016

6.2.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
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Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

· EcoStruxure Control Expert version 15.0 and 15.0 SP1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.2.7 New and Improved Features (R2.7.2)

Updated Realflo flow computer to version 7.10.1. See Realflo release
notes for details.

WI 65321 Added support for SD card on SCADAPack 47x RTUs.

WI 65427 Added conceptual information about working with objects to the user
documentation.

WI 65433 Updated the address on the Legal Information page of the
documentation.

6.2.8 Fixed Issues (R2.7.2)

WI 59839 The F_DeviceReady function block (FB) indicated that an SD card or USB
mass storage device was installed when it was not. This is corrected.

WI 62654 Certain characters in Project Comments blocked RemoteConnect export
to .RCZ file. This is corrected.

WI 64795 Update and Build project succeeded but after writing the program, system
status code 5000 was reported. This is corrected.

WI 65180 Exhaustion of the dynamic memory pool could have overwritten non-
volatile memory resulting in loss of RTU configuration and unloaded logic
on next reboot. Another defect would have to exist to trigger this to occur.
The firmware now guards against this condition.

38
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6.2.9 Known Issues (R2.7.2)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of
RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1, 15.0 and 15.0 -
SP1.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 



3.10.3

x70 Release Notes SCADAPack x70 Release Notes

39

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.

· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.2.10 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.
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3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.

6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.2.11 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.
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later
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Recommended choice for new
installations

X
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earlier
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AI
report.
10%
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Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
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1.80.6 to an earlier version.

6.3 SCADAPack x70 R2.7.1 Release Notes 12/2021

SCADAPack x70 R2.7.1 was first available in Dec 2021.

SCADAPack 47x Upgrade Requirements

Some SCADAPack 47x RTUs with Cypress (Spansion) NOR flash components did not boot
after a power cycle. SCADAPack 47x bootloader 1.41 helps to protect against overwriting of one-
time-programmable configuration registers in Cypress (Spansion) NOR flash.

Identifying Affected Units

Upgrade the SCADAPack 47x firmware to version 9.6.1 or newer. 

Use the VER command to identify the type of NOR flash. Hardware with Cypress (Spansion)
NOR flash will display

    NOR Flash Chip ID: 0x4d190201

To determine the NOR Flash Chip ID do one of the following

· Using RemoteConnect

1. Open a project.
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2. Click Online to connect to the SCADAPack 47x RTU.

3. Right-click SCADAPack x70 Controller Settings – Device DTM.

4. Select Additional Functions > Get Device Information.

5. Click Browse and specify a file name.

6. Click OK.

7. Open the Device Information file read from the RTU and search for NOR Flash Chip ID.

· Using the SCADAPack 47x command line 

1. Type VER and press Enter.

2. Check the NOR Flash Chip ID displayed.

SCADAPack 47x RTUs with other NOR flash components are not affected.

SCADAPack 57x RTUs are not affected.

Action

Upgrade the SCADAPack 47x bootloader to version 1.41 or newer on hardware with Cypress
(Spansion) NOR Flash.

SCADAPack 57x Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

6.3.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.3.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.10.1

· SCADAPack DNP3 Communication DTM version is 3.10

· SCADAPack x70 Device DTM version is 3.10

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.10.1

· SCADAPack x70 French Documentation version is 1.2.3

· Realflo flow computer version is 7.02.1

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.7.1

SCADAPack 47x bootloader version is 1.41

SCADAPack 57x firmware version is 9.7.1
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SCADAPack 57x bootloader version is 1.40

6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.1.127

6602 I/O module bootloader version is 2.1.127

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.3.3 Software and Firmware Version Compatibility

RemoteConnect version 3.10.1 is intended for use with SCADAPack x70 firmware version 9.7.1.

6.3.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574, and 575 modules with hardware version V4.00 and later require minimum
bootloader and operating system firmware versions, as described in the table below.

If you attempt to install bootloader firmware 1.30 or earlier on a SCADAPack 57x device with
hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or earlier with SCADAPack
57x hardware versions 4.00 or later.

If you attempt to install operating system firmware 9.4.3 or earlier on a SCADAPack 57x device
with hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or earlier with
SCADAPack 57x hardware versions 4.00 or later.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader
Firmware
Version

SP57x
Operating
System
Firmware
Version

Comment

3.02 or
earlier

any any Use bootloader version 1.30 or
later. See SCADAPack 57x
Upgrade Requirements earlier in
this document.

4.00 or later 1.40 or later 9.5.1 or later
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X 4.00 or later 1.30 or earlier
are not
supported

9.4.3 or earlier
are not
supported

Use Bootloader firmware version
1.40 or later.

Use Operating system firmware
version 9.5.1 or later.

You can check the SCADAPack 57x hardware version, bootloader firmware version, and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.3.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.3.6 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit) - version 20H2 and 21H1

Windows 10 Enterprise (32-bit or 64-bit) - version 20H2 and 21H1

Windows Server 2016

6.3.7 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1
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· EcoStruxure Control Expert version 15.0 and 15.0 SP1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.3.8 New and Improved Features (R2.7.1)

WI: 60832 RemoteConnect supports the model 6103 power supply on dialogs
where expansion power supply information is displayed. 6103 power
supply modules do not require configuration in RemoteConnect.

WI: 62540 Documentation for the model 6103 power supply is provided in the user
manual.

WI 64592 DNP3 Data Concentrator and DNP3 Secure Authentication features on
SCADAPack x70 RTUs are automatically licensed. It is no longer
necessary to purchase a license for these features. A software license
is still required for SCADAPack Security Administrator.

WI: 64633 The operating elevation specification for SCADAPack 47x and 6607
modules was updated in documentation to include details on use in
elevations between 3000 m (1.864 mi) and 4000 m (2.485 mi).

WI: 64687 DIN rail specifications in hardware manuals clarified to state 1 mm DIN
rail is the DIN rail size supported.

WI: 64695 A procedure for using USB drives larger than 32 GB with SCADAPack
x70 was added to the documentation.

6.3.9 Fixed Issues (R2.7.1)

WI: 63347 Object floating point values could change by small amounts after a

SCADAPack x70 RTU was power cycled. This is corrected.

WI: 63569 Unexpected values from floating point or long integer calculations

(including from logic functions or RTU object scaling after integer

updates) could be reported on rare occasions in SCADAPack x70 RTU

logic variables, or in analog or counter objects. This is corrected.

WI: 64113 IEC 60870-5-104 ASDU drop-down list was sometimes grayed out when

attempting to update the IOA between Monitor Direction and Control

48
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Direction. This could be worked around by reopening the object

editor dialog. This is corrected.

WI: 64179 In the Logic Editor, changing a Derived Variable name and then

returning to RemoteConnect to resynchronize lost the connection

between database objects and DDT variables. This is corrected.

WI: 64266 IEC 60870-5-104 Control Direction ASDU was read as Single Command

instead of Double Command when opening a project file. This is

corrected.

WI: 64273 RemoteConnect projects created in versions 2.5.3 and older did not

connect to devices over Modbus protocols. RemoteConnect could not

go into online mode using these projects. This is corrected.

WI: 64275 A large SCADAPack 57x project converted to a SCADAPack 47x could

result in the RTU restarting continually with Restart Mask 0x0400 after

writing the application to the SCADAPack 47x RTU. This is corrected.

WI: 64284 RemoteConnect projects created in versions 2.5.3 and older could not

be opened if the RemoteConnect communication used Modbus

protocols. This is corrected.

WI: 64467 IEC 60870-5-104 ASDU default configuration values were different

between RemoteConnect and the firmware This is corrected.

WI: 64524 Digital Objects associated with Modbus Write operations and that had

a DNP3 static group and variation other than the default value of

group variation 2 were reset to the default when opening a project

file. This is corrected.

WI: 64527 The serial port functions for Modbus were available when only

Modbus IP servers and clients were enabled. This is corrected.

WI: 64648

WI: 64723

Status code 5004 - Object Variable Inconsistency – was reported with

some projects after writing to the RTU. The connection between

database objects and DDT variables was lost. This is corrected.

WI: 64677 IEC 60870-5-104 Double Command and Regulating step pulses

returned a negative activation confirmation in response to a GS

control action. This is corrected.
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WI: 64694 RemoteConnect installation troubleshooting did not include list of

folders to delete when removing Unity Pro 13.1. This is corrected.

WI: 64961 The message "Please wait while the Logic Editor is receiving

updates..." could remain in place if the logic editor was not open

while writing the configuration. This is corrected.

WI: 65011 Firmware update procedure did not describe flow computer

configuration is not preserved. This is corrected.

6.3.10 Known Issues (R2.7.1)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of
RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1, 15.0 and 15.0 -
SP1.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.
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WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.

· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.3.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification
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Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.

6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.3.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.
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NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.4 SCADAPack x70 R2.6.1 Release Notes 07/2021

SCADAPack x70 R2.6.1 was first available in July 2021.
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SCADAPack 57x Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

SCADAPack 47x Upgrade Requirements

Some SCADAPack 47x RTUs with Cypress (Spansion) NOR flash components did not boot
after a power cycle. SCADAPack 47x bootloader 1.41 helps to protect against overwriting of one-
time-programmable configuration registers in Cypress (Spansion) NOR flash.

Identifying Affected Units

Upgrade the SCADAPack 47x firmware to version 9.6.1 or newer. 

Use the VER command to identify the type of NOR flash. Hardware with Cypress (Spansion)
NOR flash will display
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    NOR Flash Chip ID: 0x4d190201

To determine the NOR Flash Chip ID do one of the following

· Using RemoteConnect

o Open a project

o Click Online to connect to the SCADAPack 47x RTU

o Right-click SCADAPack x70 Controller Settings – Device DTM

o Select Additional Functions > Get Device Information

o Click Browse and specify a file name

o Click OK

o Open the Device Information file read from the RTU and search for NOR Flash Chip ID.

· Using the SCADAPack 47x command line 

o Type VER and press Enter

o Check the NOR Flash Chip ID displayed

SCADAPack 47x RTUs with other NOR flash components are not affected.

SCADAPack 57x RTUs are not affected.

Action

Upgrade the SCADAPack 47x bootloader to version 1.41 or newer on hardware with Cypress
(Spansion) NOR Flash.

6.4.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.4.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.9.1

· SCADAPack DNP3 Communication DTM version is 3.9

· SCADAPack x70 Device DTM version is 3.9

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11
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· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.9.1

· SCADAPack x70 French Documentation version is 1.2.3

· Realflo flow computer version is 7.02.1

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.6.1

SCADAPack 47x bootloader version is 1.41

SCADAPack 57x firmware version is 9.6.1

SCADAPack 57x bootloader version is 1.40

6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.1.127

6602 I/O module bootloader version is 2.1.127

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.4.3 Software and Firmware Version Compatibility

RemoteConnect version 3.9.1 is intended for use with SCADAPack x70 firmware version 9.6.1.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.
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6.4.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574, and 575 modules with hardware version V4.00 and later require minimum
bootloader and operating system firmware versions, as described in the table below.

If you attempt to install bootloader firmware 1.30 or earlier on a SCADAPack 57x device with
hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or earlier with SCADAPack
57x hardware versions 4.00 or later.

If you attempt to install operating system firmware 9.4.3 or earlier on a SCADAPack 57x device
with hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or earlier with
SCADAPack 57x hardware versions 4.00 or later.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader
Firmware
Version

SP57x
Operating
System
Firmware
Version

Comment

3.02 or
earlier

any any Use bootloader version 1.30 or
later. See SCADAPack 57x
Upgrade Requirements earlier in
this document.

4.00 or later 1.40 or later 9.5.1 or later

X 4.00 or later 1.30 or earlier
are not
supported

9.4.3 or earlier
are not
supported

Use Bootloader firmware version
1.40 or later.

Use Operating system firmware
version 9.5.1 or later.

You can check the SCADAPack 57x hardware version, bootloader firmware version, and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.4.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574
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SCADAPack 575

6.4.6 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit) - version 1909 and 2004

Windows 10 Enterprise (32-bit or 64-bit) - version 1909 and 2004

Windows Server 2016

6.4.7 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

· EcoStruxure Control Expert version 15.0 and 15.0 SP1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.4.8 New and Improved Features (R2.6.1)

WI: 48360 Modbus protocol can be used on USB, serial, and TCP connections for
configuring, monitoring and debugging with RemoteConnect. Previously
these features required using a DNP3 connection.

WI: 48376 Added support for Modbus extended addressing to firmware and
RemoteConnect. Extended addressing can be used with Modbus and
Enron Modbus protocols on client and server interfaces.

WI: 53996 Added support for support Windows 10 Enterprise (32-bit or 64-bit) -
version 1909 and 2004.

61
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WI: 56728 The PERF and REALFLOSTATUS command outputs were added to the
device information file and can be read with "Get Device Information File".

WI: 61104 Improved the documentation of the FILEDIAG command to indicated that
logging stops when the device restarts and once stopped the log file will
be deleted from /ramdir. There was no change made to the firmware.

WI: 61949 Schneider Electric is committed to replacing problematic language in our
code, applications, and documentation. This is a large task and will be
implemented over several releases. In this release we have changed the
following terms.

· Modbus Master/Client is now Modbus Client

· Modbus Slave/Server is now Modbus Server

· Modbus master is now Modbus client

· Modbus slave is now Modbus server

· DNP3 slave or DNP3 slave station is now DNP3 outstation

· DNP3 master or DNP3 master station is now DNP3 controlling station

· HART master is now HART client

· Master key is now Passphrase System Key (presently limited to the
context of securing the config files used for DNP3 Secure
Authentication)

· IP Whitelist is now IP Firewall

· IEC 60870-5-104 Master is now Controlling Station

· IEC 60870-5-104 Slave is now Controlled Station

· Grandfathered is now legacy

· DNP3 Device Profile file names "SCADAPack xxxx Master DNP3
Device Profile" are now "SCADAPack xxxx Client DNP3 Device Profile”

· DNP3 Device Profile file names "SCADAPack xxxx Slave DNP3 Device
Profile" are now “SCADAPack xxxx Outstation DNP3 Device Profile”

· DNP3 Device Profile content referencing Master and Slave was updated
where possible. Some terms were maintained for backward
compatibility with XSLT files from the DNP3 Users Group.

· Folder paths for DNP3 device profiles now use Client and Outstation
terminology.

· Folder path references in documentation for DNP3 device profiles now
use Client and Outstation terminology.

WI: 62396 Updated FDT 2.0 to FDT 2.1 in manuals to match the version numbers of
components in RemoteConnect.

WI: 62671 Changed copyright statements to Schneider Electric Systems USA Inc.
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WI: 62761 Improved usability of the Object table filtering mechanism. Reduced the
screen space required for the controls benefitting users with smaller
displays.

WI: 62766 Added a watchdog on 6602 I/O module firmware to improve robustness
against potential hardware or firmware problems.

WI: 62788 Added support for Modbus multiple-bit digital object mapping in the
Modbus Scanner. Each of the 16 bits in a Modbus input or holding register
can be mapped to a UINT digital object.

WI: 62896 Added EFB Toolkit V14 release note information to x70 documentation.

WI: 62899 Improved documentation of steps to repair Control Expert installations.

WI: 63369 Updated certification information for SCADAPack 470, 474, and 6607.

WI: 63407 Improved the Security Administrator documentation.

WI: 63490 Improved documentation of RTU time usage and time-related system
status bits/words.

WI: 63543 Added a word order parameter for emulation of Telepace long integers.

WI: 63674 Added a document number on the title page of each document.

WI: 64027 The VER command displays the NOR Flash Chip ID for SCADAPack 47x
RTUs. This information is used to identify the manufacturer of the NOR
flash component.

6.4.9 Fixed Issues (R2.6.1)

WI: 51255 5606, 5607, and 5506 I/O modules reported additional out of range events
based on status codes from the module. The modules now report out of
range events only based on the configured Upper Range and Lower Range
limits.

WI: 60659 F1 help in RemoteConnect was missing information for the Copy icon on
the Object Associations tab. This is corrected.

WI: 62245 RemoteConnect Modbus Scanner configuration allowed overlapping
registers of different object types. This is corrected.

WI: 62529 System status code 3019 description was missing from RemoteConnect
and documentation. This is corrected.
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WI: 62736 The complete DNP3 route table was printed on the command line when no
dynamic or static routes were in the list. This is corrected to print nothing
if there are no routes in a section.

WI: 62887 Installer didn’t install logic editor hotfixes and register cdbsps2.dll on
French and Russian Windows versions. This is corrected.

WI: 62890 EFB toolkit documentation did not indicate Control Expert installation is
required to use the toolkit. This is corrected.

WI: 62929 Certain alert time deadband settings could result in a SCADAPack x70
reset due to a processor exception and task watchdog. This is corrected.

WI: 63006 The task watchdog flag and dump file were inconsistent following a restart.
This is corrected.

WI: 63019

WI: 62995
System status code 3000 "A DNP3 Data Concentrator or Modbus
Scanner contains either more remote devices OR more mapped objects
than permitted” was reported when fewer than 3000 Modbus registers
were mapped. The firmware was counting the number of used and unused
registers in Modbus scanners. It now counts objects assigned to
registers.

WI: 63062 RemoteConnect did not validate that the Incoming and Forward Station
address was different from the Station address of the interface. This is
corrected.

WI: 63064 RemoteConnect online ad-hoc object entries were not updated to reflect
changes in the offline Object configuration. This is corrected.

WI: 63202 The SCADAPack 470 command line on serial 4 did not respond after a
power cycle or RESTART RTU command, when high rate RS485 traffic
(for another device) was present on serial 1 or 2. This is corrected.

WI: 63256 Upgrading the SCADAPack 47x firmware required two attempts. Restart
reason 0x0004 was not reported after the first attempt. This is corrected.
To apply the correction, first upgrade the SCADAPack 47x boot loader to
version 1.40 or newer, then upgrade the firmware.

WI: 63331 RemoteConnect validation and documentation of the Channel Receive
Timeout parameter used an incorrect range. The correct range of 0…
65535 was used in firmware. RemoteConnect and documentation are
corrected.

WI: 63385 Modbus serial scanners could generate "Unable to send message -
Corrupt message" logs when 200 analog point scanner were configured.
This is corrected.
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WI: 63432 The Modbus IP scanner could generate "Exception: Unknown" logs when
200 analog point scanners were configured. This is corrected.

WI: 63438 SCADAPack 47x stopped responding to Modbus polls when polled every
10 ms. In some scenarios the RTU restarted with reset reason 800 or
reset reason 10. This is corrected.

Diagnostics output is affected by this change. If a high volume of
diagnostics are enabled on a command line serial port with a low baud
rate configured, some diagnostics may be discarded and you may notice
time gaps in the diagnostics displayed. This can be mitigated by
configuring a higher baud rate for the command line serial port.

WI: 63494 Code signing certificates in the DVD were missing recent certificates. The
certificates are added.

WI: 63513 Installation of Control Expert hotfix
ControlExpert_V150_HF_BMENOR2200H.exe caused integrity check
errors in both Control Expert and x70 Logic Editor. This is corrected. A
second hot fix is provided to correct the effects of the first.

WI: 63517 I/O module hardware manuals indicated a 20 to 16 pin adapter was
provided with I/O modules, when it was a separately ordered part. This is
corrected.

WI: 63534 Serial port Modbus station addresses were invalid (zero) after a cold boot.
The station address is now set to 1.

WI: 63357 System status code 3019 was reported multiple times within a single
project. It is now reported once.

WI: 63558 String parameters were written to the RTU configuration file without using
the proper double quote escape characters. This caused an
interoperability issue with EcoStruxure Geo SCADA Expert. This is
corrected.

WI: 63626 Documentation stated it was possible to build a read only Modbus
scanner and a write only Modbus scanner with overlapping register
addresses. RemoteConnect does not allow this combination. The
documentation is corrected.

WI: 63746 Some SCADAPack 47x RTUs with Cypress (Spansion) NOR flash
components did not boot  after a power cycle. SCADAPack 47x
bootloader 1.41 helps to protect against overwriting of one-time-
programmable configuration registers in Cypress (Spansion) NOR flash.

Identifying Affected Units

Upgrade the SCADAPack 47x firmware to version 9.6.1 or newer. Use the
VER command to identify the type of NOR flash. Hardware with Cypress
(Spansion) NOR flash will display
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    NOR Flash Chip ID: 0x4d190201

SCADAPack 47x RTUs with other NOR flash components are not
affected.

SCADAPack 57x RTUs are not affected.

Action

Upgrade the SCADAPack 47x bootloader to version 1.41 or newer on
hardware with Cypress (Spansion) NOR Flash.

6.4.10 Known Issues (R2.6.1)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of
RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1, 15.0 and 15.0 -
SP1.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.
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WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.

· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.4.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification
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Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.

6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.4.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.
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NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.5 SCADAPack x70 R2.5.3 Release Notes 05/2021

SCADAPack x70 R2.5.3 was first available in May 2021.
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Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

6.5.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.5.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.8.3

· SCADAPack DNP3 Communication DTM version is 3.8

· SCADAPack x70 Device DTM version is 3.8

· SCADAPack x70 Logic Editor version is 14.0 - 200313
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· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.8.3

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.5.3

SCADAPack 47x bootloader version is 1.00

SCADAPack 57x firmware version is 9.5.3

SCADAPack 57x bootloader version is 1.40

6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.0.123

6602 I/O module bootloader version is 2.0.123

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.5.3 Software and Firmware Version Compatibility

RemoteConnect version 3.8.3 is intended for use with SCADAPack x70 firmware version 9.5.3.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.
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6.5.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574, and 575 modules with hardware version V4.00 and later require minimum
bootloader and operating system firmware versions, as described in the table below.

If you attempt to install bootloader firmware 1.30 or earlier on a SCADAPack 57x device with
hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or earlier with SCADAPack
57x hardware versions 4.00 or later.

If you attempt to install operating system firmware 9.4.3 or earlier on a SCADAPack 57x device
with hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or earlier with
SCADAPack 57x hardware versions 4.00 or later.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader
Firmware
Version

SP57x
Operating
System
Firmware
Version

Comment

3.02 or
earlier

any any Use bootloader version 1.30 or
later. See SCADAPack 57x
Upgrade Requirements earlier in
this document.

4.00 or later 1.40 or later 9.5.1 or later

X 4.00 or later 1.30 or earlier
are not
supported

9.4.3 or earlier
are not
supported

Use Bootloader firmware version
1.40 or later.

Use Operating system firmware
version 9.5.1 or later.

You can check the SCADAPack 57x hardware version, bootloader firmware version, and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.5.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574
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SCADAPack 575

6.5.6 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.5.7 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

· EcoStruxure Control Expert version 15.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.5.8 New and Improved Features (R2.5.3)

WI: 63393 Trip/Close complementary pulse operation for DNP3 binary outputs is
supported. Two objects work together as a Trip/Close output pair from a
single DNP3 point index.

6.5.9 Fixed Issues (R2.5.3)

WI: 63324 A gross miscalibration of the SCADAPack 57x power supply voltage could
result in inaccurate readings in the system data reference. This value can
be viewed in RemoteConnect. Now, a gross miscalibration of more than

69
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+/- 3% from the theoretical value is detected and a default calibration is
used. Calibrated devices are not affected by this change.

6.5.10 Known Issues (R2.5.3)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of
RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1 and 15.0.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
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internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.

· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.5.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the



3.10.3

x70 Release Notes SCADAPack x70 Release Notes

71

symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.

6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.5.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.
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Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.6 SCADAPack x70 R2.5.2 Release Notes 04/2021

SCADAPack x70 R2.5.2 was first available in April 2021.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

6.6.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.6.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.8.2

· SCADAPack DNP3 Communication DTM version is 3.8

· SCADAPack x70 Device DTM version is 3.8

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.8.2

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.6.2
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SCADAPack 47x firmware version is 9.5.2

SCADAPack 47x bootloader version is 1.00

SCADAPack 57x firmware version is 9.5.2

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.0.123

6602 I/O module bootloader version is 2.0.123

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.6.3 Software and Firmware Version Compatibility

RemoteConnect version 3.8.2 is intended for use with SCADAPack x70 firmware version 9.5.2.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.6.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574, and 575 modules with hardware version V4.00 and later require minimum
bootloader and operating system firmware versions, as described in the table below.

If you attempt to install bootloader firmware 1.30 or earlier on a SCADAPack 57x device with
hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or earlier with SCADAPack
57x hardware versions 4.00 or later.

If you attempt to install operating system firmware 9.4.3 or earlier on a SCADAPack 57x device
with hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
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code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or earlier with
SCADAPack 57x hardware versions 4.00 or later.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader
Firmware
Version

SP57x
Operating
System
Firmware
Version

Comment

3.02 or
earlier

any any Use bootloader version 1.30 or
later. See SCADAPack 57x
Upgrade Requirements earlier in
this document.

4.00 or later 1.40 or later 9.5.1 or later

X 4.00 or later 1.30 or earlier
are not
supported

9.4.3 or earlier
are not
supported

Use Bootloader firmware version
1.40 or later.

Use Operating system firmware
version 9.5.1 or later.

You can check the SCADAPack 57x hardware version, bootloader firmware version, and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.6.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.6.6 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016
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6.6.7 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

· EcoStruxure Control Expert version 15.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.6.8 New and Improved Features (R2.5.2)

None

6.6.9 Fixed Issues (R2.5.2)

WI: 63234 Alert time deadband settings could cause a SCADAPack x70 Processor
Exception and Task Watchdog. This is corrected.

WI: 63258 RemoteConnect reported invalid object names on DDT type objects after
reading a valid application from the SCADAPack RTU. This is corrected.

6.6.10 Known Issues (R2.5.2)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of

77
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RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1 and 15.0.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.
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· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.6.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.
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6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.6.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment
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 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.7 SCADAPack x70 R2.5.1 Release Notes 01/2021

SCADAPack x70 R2.5.1 was first available in January 2021.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

6.7.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.7.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.8.1

· SCADAPack DNP3 Communication DTM version is 3.8

· SCADAPack x70 Device DTM version is 3.8

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.8.1

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.5.1

SCADAPack 47x bootloader version is 1.00

SCADAPack 57x firmware version is 9.5.1

SCADAPack 57x bootloader version is 1.30
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6601 I/O module firmware version is 2.2.27

6601 I/O module bootloader version is 2.2.27

6602 I/O module firmware version is 2.0.123

6602 I/O module bootloader version is 2.0.123

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.7.3 Software and Firmware Version Compatibility

RemoteConnect version 3.8.1 is intended for use with SCADAPack x70 firmware version 9.5.1.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.7.4 SCADAPack 57x Hardware and Firmware Version Compatibility

SCADAPack 570, 574 and 575 modules with hardware version V4.00 and later require minimum
bootloader and operating system firmware versions, as described in the table below.

If you attempt to install bootloader firmware 1.30 or earlier on a SCADAPack 57x device with
hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1060 will be generated. Avoid using bootloader firmware 1.30 or earlier with SCADAPack
57x hardware versions 4.00 or later.

If you attempt to install operating system firmware 9.4.3 or earlier on a SCADAPack 57x device
with hardware version 4.00 or later, the firmware installation will be unsuccessful. System status
code 1061 will be generated. Avoid using operating system firmware version 9.4.3 or earlier with
SCADAPack 57x hardware versions 4.00 or later.

See table below for hardware and firmware compatibility.

SP57x
Hardware
Version

SP57x
Bootloader

SP57x
Operating
System

Comment
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Firmware
Version

Firmware
Version

3.02 or
earlier

any any Use bootloader version 1.30 or
later. See SCADAPack 57x
Upgrade Requirements earlier in
this document.

4.00 or later 1.40 or later 9.5.1 or later

X 4.00 or later 1.30 or earlier
are not
supported

9.4.3 or earlier
are not
supported

Use Bootloader firmware version
1.40 or later.

Use Operating system firmware
version 9.5.1 or later.

You can check the SCADAPack 57x hardware version, bootloader firmware version, and
operating system firmware version by using RemoteConnect online Additional Functions > Get
Device Information and opening the retrieved text file; or by using the SCADAPack command
line VER command.

6.7.5 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.7.6 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.7.7 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. Use Run as administrator to run the repair process.
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The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

· EcoStruxure Control Expert version 15.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.7.8 New and Improved Features (R2.5.1)

WI: 53895 SCADAPack 47x and 57x support 5505 RTD analog-input modules.

WI: 60800 SCADAPack 47x and 57x support 5410 counter-input modules.

WI: 61414 SCADAPack 47x supports the 6602 HART module with a limited feature
set.

WI: 60799 SCADAPack 57x and 47x support IEC 60870-5-104 protocol.

WI: 62006 The Clear Counters command was removed from RemoteConnect. This
function only worked with objects mapped to DNP3 points. This function is
superseded by the ability to use the object browser, including defining
saved browser presets, allowing the user to define a browser table with
presets of 0 as a short-cut method for defining nominated counters to
clear.

WI: 61162 EFB Toolkit v14 is supported by the logic editor. This feature allows
adding custom C function blocks to the logic library, for use by
SCADAPack x70 applications.

WI: 47679 Added the NETINFO command to provide additional diagnostics of IP
connections.

WI: 61353 Added Geo SCADA Import option for the SCADAPack 47x platform.

WI: 61368 Added XEF and ZEF file formats to the "Import Logic Project" option.

WI: 61308 Added support for SCADAPack 57x version 4 hardware in Boot loader and
firmware.

90
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WI: 59095 Factory boot aborts after 60 seconds to guard against a boot mode switch
stuck in the closed position. A normal boot is performed if the factory boot
aborts.

WI: 54171 Improved the Logic Status indication when logic is not run due to an
empty object database.

WI: 55732 Added GETDNPROUTE command to show DNP3 routes.

WI: 61681 Improved 6602 I/O module HART update time to 10 seconds maximum.

WI: 62075 Clarified that Excel import and export support only the XLS format.

WI: 51392 Improved deletion of objects that are mapped to user DDT variable
instances. Previously, if the removed instance variable was the only
remaining instance of the DDT type, then the DDT type definition was also
deleted.

WI: 48685 Added a software watchdog for logic tasks to improve behavior if a
logic program contains an infinite loop or the execution time is
unexpectedly long.

WI: 62164 Disabled the Under Range Limit, Over Range Limit and Zero Threshold
Limit by default for new objects.

WI: 62167 Improved the usability of the Object Table by removing the source type
column, replacing the data type column with an icon, changing the order
of the last 4 columns to IEC-M, IEC-C, Modbus, DNP3, and moving some
table controls.

WI: 62154 Side by side operation with Control Expert 15 is supported.

WI: 62518 Updated the DNP3 device profile documentation.

WI: 62081 Improved documentation of IP routing.

WI: 61333 Updated the technical support information for Australia, New Zealand, and
Canada.

WI: 61600 Integrated documentation of battery replacement that was formerly
supplied as a separate document.

WI: 60738 Clarified logic documentation for %SW2, %SW3.

WI: 61010 Clarified that file system is not case sensitive in documentation.

WI: 61321 Added Porting Guide for SCADAPack E to SCADAPack RemoteConnect
to the documentation.
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WI: 49663 Improved DNP3 protocol descriptions in SCADA Protocols Technical
Reference.

WI: 55311 Changed name of ClearSCADA to EcoStruxure Geo SCADA Expert to
match the new name for the product.

WI: 60668 Improved the further action documentation of system status code 1038.

WI: 61009 Updated the description of the Discard New Events if Buffer Full
parameter.

WI: 61916 Addressed security vulnerability CVE-2020-12525 and improved solution to
security vulnerability CVE-2020-7528. 

WI: 61917 Added additional layers of defence to the solution for RemoteConnect
security vulnerability CVE-2020-7529. There is no change in functionality.

6.7.9 Fixed Issues (R2.5.1)

WI: 47414 6602 I/O module analog outputs periodically reported field instrument not
yet scanned. This is corrected.

WI: 47417 The 6602 analog output module did not limit the output for out of range
values. This is corrected. Output values greater than the maximum are
limited to 20 mA. Output values less than the minimum are limited to 0
mA.

WI: 47824 The documentation of the Delete command function block didn’t state that
the function block may not remove all files. The documentation now states
“"Deleting hundreds of files may require multiple executions of the del
command, as the del command may time out before all the files are
removed. Check the directory contents following the completion of the
command. Execute the command again if some files were not deleted.”

WI: 48517 F_DeviceReady function block only worked with a forward slash in paths
but F_DirInfo EFB works with both forward and back slash. Both function
blocks now work with forward and back slashes.

WI: 48561 USB mass storage device (drive) size was always detected as 3.2 GB.
This is corrected.

WI: 52795 HART devices were not correctly discovered by 6602 modules when they
were unconnected at power up and connected later. This is corrected.

WI: 55707 SCADAPack 47x folder date was incorrect (01/01/1970) after factory boot.
This is corrected.
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WI: 56401 SCADAPack 47x VER Command did not display 5304 and 5405 module
versions. This is corrected.

WI: 57284 The whoami command displayed incorrect information for Serial 5 on
SCADAPack 47x. This is corrected.

WI: 58504 F_COPY function block returned status code 0 (success) when trying to
overwrite an open file. This is corrected and the function block now returns
code -1008, 'Destination file name in use'.

WI: 58831 The F_DelTree function block incorrectly returned a status code of -1
when attempting to delete a non-existent directory. It now returns status
code -1015 (File or directory does not exist).

WI: 59184 Diagnostics reported “Duplicate requests removed from queue. Request
cancelled for IED 53 (Duplicate Request)” when polling. This is the
intended operation. The unnecessary message was removed.

WI: 59276 RemoteConnect closed unexpectedly when adding an Altivar ATV6xx
drive DTM object. This is corrected.

WI: 59364 10 Mbps Ethernet connection did not work on SCADAPack 47x devices.
This is corrected.

WI: 59379 File diagnostics maximum file size was limited to 12.5 MB on
SCADAPack 47x. This is corrected.

WI: 59598 The route print command did not include "Route Priority: HOST
NETWORK GATEWAY DEFAULT-GW" output. This is corrected.

WI: 60058 The NAME output of the F_FindFile Function block was truncated. This is
corrected. The full name is now returned.

WI: 60281 Counter inputs from a 6601 I/O module could report incorrect counts if the
6601 module was disconnected and reconnected from the I/O bus with
power on. This is corrected.

WI: 60284 The documentation of the F_FindFile function block was unclear. This is
corrected.

WI: 60924 The FREERUN function block output was affected by Real Time Clock
(RTC) changes on SCADAPack 57x. This is corrected.

WI: 61081 The logic task was terminated after setting a break point in the logic
application. This is corrected. 

WI: 61159 Disabling the telnet service could cause a device restart. This is
corrected.
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WI: 61255 RemoteConnect was not able to open an RCZ file on systems where FDT
2.1 libraries were installed by another application. This is corrected.

WI: 61283 The documentation for system status code 1410 did not describe all the
conditions that set the flag. The documentation now states "This condition
is checked when the device is started and when the clock is set".

WI: 61377 Writes to UINT arrays longer than 512 elements mapped to
RemoteConnect objects from a logic program updated the wrong element
in the object. This is corrected.

WI: 61378 Unexpected DNP3 unsolicited messages were sent if the Triggered Event
Notification Delay was larger than the Minimum Unsolicited TX Event
Delay. The configured Class min events buffered event value was
disregarded and the unsolicited events were sent to the configured host as
per the Minimum Unsolicited Event Tx Delay setting. This is corrected.

WI: 61407 Logic Editor R2.4.2 could not open a project created in R2.4.1 (field trial
release). This is corrected.

WI: 61522 SCADAPack 47x could lose communication with 6601 and 5000 series
I/O modules following a 6601 firmware or bootloader update. The
SCADAPack 47x would require a restart to establish communication. This
is corrected.

WI: 61542 Locked objects could not be connected to a Modbus Scanner in
RemoteConnect. This is corrected.

WI: 61574 Update & Build Logic could be executed before a project was saved,
resulting in inconsistent project files. The Update & Build logic button is
now disabled until the project has been saved.

WI: 61669 The F_FindFile function block didn’t use the /user directory when the input
"DIR" was not specified. This is corrected.

WI: 61702 French language selection did not work with a side-by-side installation of
Control Expert 14.1. This is corrected.

WI: 61728 An internet connection was required during installation of RemoteConnect
2.4.2 to obtain an intermediate certificate. The internet connection will still
be used if present with RemoteConnect R2.5.1. If a connection is not
available, the certificate can be installed manually. Instructions are
provided in the Software Installation manual.

WI: 61750 CPU temperature in degrees F was rounded down to the nearest degree.
This is corrected. The CPU temperature is returned as a floating-point
value rounded to the nearest tenth of a degree.
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WI: 61782 The HART_6602Control function block only worked when the MODULE
input was set to 0. This is corrected. Set the MODULE input to the
address of the 6602 module.

WI: 61783 The Device Listen Port setting of the Modbus scanner changed back to
502 (the default) when reading from the SCADAPack device. The setting
now retains the configured value.

WI: 61799 The SCADAPack 47x did not report system status code 1410 when the
battery was low. This is corrected.

WI: 61810 Documentation for OBJ Readfield and OBJ_WriteField function blocks
listed an incorrect DATATYPE for ATTRIB_EventDevUnsol. This is
corrected.

WI: 61837 Documentation incorrectly stated that DNP3 events were preserved
across firmware upgrades. This is corrected. There is no change to
product functionality.

WI: 62052 Switching the Host interface could send DNP3 Request Link Status
messages (used for the DNP/TCP keep-alive) out the wrong port. This is
corrected.

WI: 62320 Documentation incorrectly described online modification of logic and
objects in the Modifying a Logic Application Online topic. This is

corrected.

WI: 62328 DNP3 Objects with Status Flags documentation incorrectly stated bit [4] -
Local Forced Data is "Not Used". The documentation now describes the
operation of this bit.

WI: 62365 When a Structure element was selected, the function Unlock Variable >
Logic variable Name list box was blank after pressing the Unlock button.

This is corrected.

WI: 62710 The wiring example for the 6607 I/O module digital outputs showed diodes
in the wrong orientation. The example now shows the correct diode
orientation and clarifies the wiring connections.

6.7.10 Known Issues (R2.5.1)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation
process and Control Expert / Unity Pro software installation process can
interfere with one another. It is recommended that when installing new
versions of Control Expert / Unity Pro software that the repair installation
option be run for SCADAPack RemoteConnect. Coexisting installations of



3.10.3

x70 Release NotesSCADAPack x70 Release Notes

90

RemoteConnect and Unity Pro are supported for Unity Pro versions 13.0,
13.1, and EcoStruxure Control Expert version 14.0, 14.1 and 15.0.

Workaround: Follow the relevant Post-installation Steps for the Unity Pro
or Control Expert version in the Software installation Manual.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.

Workaround: Use a USB A port on the PC to connect to the USB C port
on the SCADAPack 47x.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load
the application. When writing to the RTU the message “PLC program
internal memory full” is displayed. The Greatest value below the graph is
correct. The value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the
actual values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph
on the left to get the actual value.

WI: 62703 The telnet command prompt will not completely display long output in the
following cases and others.
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· NETINFO output when the table is greater than 46 entries

· TYPE output when displaying a .RTU file or other long files

· Other commands with long output

Workarounds:

Use a serial port command prompt when connected locally.

Long NETINFO output can be obtained by executing the GETINFO
command, transferring the file created to a PC, and opening it on the PC.

Long files can be examined by transferring the file created to a PC and
opening it on the PC.

6.7.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be
blocked from reopening if previous instances of RemoteConnect or the
Logic Editor were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any
RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library
is opened by another application when attempting to modify the logic
library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the
Task Manager and shut down any Unity Pro, Control Expert, and
RemoteConnect/SCADAPack x70 Logic Editor processes. If the
symptoms persist, it is likely that Windows folder permissions are
incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 

  C:\ProgramData\Schneider Electric

2. Select Properties.

3. Select the Security tab.

4. Click Edit.

5. Click on the Users entry in the Group or user names section.
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6. Scroll down the Permissions for Users area until you see a row called
"Write".

7. Check the box in the "Allow" column for the "Write" row.

8. Click OK.

  The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.7.12 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
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 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.8 SCADAPack x70 R2.4.2 Release Notes 08/2020

SCADAPack x70 R2.4.2 was first available in August 2020.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using:

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack 57x bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x firmware version 9.1.2 and earlier versions to firmware version 9.2.1
or newer.

Failure to follow these instructions can result in death or serious injury.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack 57x bootloader firmware version 1.10 to bootloader firmware version 1.30
or newer. Cold boot the SCADAPack 57x device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

SCADAPack 57x bootloader firmware version 1.30 corrects a start-up initialization issue and
digital output initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack 57x device restart.

The firmware in this release includes these corrections.

6.8.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.8.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.7.3

· SCADAPack DNP3 Communication DTM version is 3.7

· SCADAPack x70 Device DTM version is 3.7

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.7.3

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.6.2

SCADAPack 47x firmware version is 9.4.3

SCADAPack 47x bootloader version is 1.00

SCADAPack 57x firmware version is 9.4.3

SCADAPack 57x bootloader version is 1.30
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6601 I/O module firmware version is 2.1.22

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6607 I/O module firmware version is 2.2.4

6607 I/O module bootloader version is 2.2.4

6.8.3 Software and Firmware Version Compatibility

RemoteConnect version 3.7.3 is intended for use with SCADAPack x70 firmware version 9.4.3.

As of R2.0 and newer, RemoteConnect and SCADAPack x70 firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.8.4 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.8.5 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)
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Windows Server 2016

6.8.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. A repair process must always be Run as administrator.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.8.7 New and Improved Features (R2.4.2)

WI: 53267 Added OBJ_NameToID function block and extended the OBJ_ReadField and
OBJ_WriteField function blocks to support system data values.

WI: 55235 SCADAPack 47x firmware now includes a firmware recovery mode. If system
firmware is corrupted or invalid, RemoteConnect can create recovery media
on a USB drive. The drive can be used to replace the corrupted firmware on
the RTU.

WI: 57202 SYS_PROTOCOL system data includes the following Modbus and Enron
references SYS_PROTOCOL_MB_ModbusTCPPort and
SYS_PROTOCOL_MB_EnronTCPUnitId.

WI: 57767 Improved robustness of configuration file parsing when unknown configuration
elements are present in the file. 

WI: 58243 Additional RAM memory is available on the SCADAPack 57x RTU. This
improves operation with large configurations.

WI: 58703 USB drives are dismounted before restarting the RTU following a firmware
patch or a command to restart the RTU.

WI: 58724 USB port DHCP lease information is cached more frequently. This improves
reconnection times on USB following a power cycle or RTU restart command.

101
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WI: 59118 User manual updated to indicate that files are closed when logic is not
running.

WI: 59127 Improved the documentation and the safety message for these logic function
blocks: F_DelTree, F_RMDIR, F_CLOSE, F_COPY, F_DEL, F_EOF,
F_JOIN, F_Read_DINT, F_Read_STRING, F_REN, F_ROPEN, F_WOPEN,
F_Write_DINT, F_Write_STRING

WI: 59175 Added OBJ_ModbusRegToID and OBJ_DNP3PointToID function blocks to
SCADAPack x70 RTU System library.

WI: 59204 User manual now indicates that restarting the logic application will also
disconnect the Logic editor from debug (connect) mode.

WI: 59882 The DNP3/UDP Broadcast server can be disabled in RemoteConnect if it is
not required. This improves cybersecurity for systems not requiring DNP3
broadcast messages.

WI: 60193 Improved documentation for repairing Unity Pro and Control Expert
installations after uninstalling RemoteConnect.

WI: 60275 SCADAPack x70 Security Administrator now requires a user-defined
password for the .SDB configuration file. Opening an older format file requires
defining a password for the file.

WI: 60283 Counter objects are writable from the RemoteConnect object browser. This
can be used to clear a counter or set it to a specific value.

WI: 60344 The F_JOIN function block is deprecated and not available in logic library
LIBSET 14.0 and later. Use the Device_ExecuteCommand function block to
execute an APPEND command to perform this function.

RemoteConnect R2.4.2 can open older programs using F_JOIN. If the logic
library used by the older program is not upgraded, the program will continue
to function as before. If you choose to upgrade the logic library, you must
modify the program to use the Device_ExecuteCommand function block.

WI: 60510 Security Administrator start menu is updated for better compatibility with
Windows 10.

WI: 60636 User manual was updated to describe how to save and restore logic data
using files.

WI: 60778 Added a "Helpful Hints" section to the RemoteConnect installer. Hints are
displayed during the installation to amuse and inform the user.

WI: 60668 Improved the documentation of status code 1038.

WI: 60716 Added troubleshooting instructions for the Logic Editor V14.0 not starting.
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6.8.8 Fixed Issues (R2.4.2)

WI: 60763 Excel import of Modbus Byte Order was incorrect when the Modbus/TCP
Slave had an IP address of 127.0.0.1. This is corrected.

WI: 56293 Addressed VxWorks security vulnerabilities CVE-2019-12256, CVE-2019-
12260, CVE-2019-12261, CVE-2019-12263, CVE-2019-12258, CVE-2019-
12259, CVE-2019-12262, CVE-2019-12265, CVE-2019-12264.

WI: 56650 The RemoteConnect bootloader firmware update did not send the final
command to complete the upgrade, so the bootloader was not replaced. This
is corrected.

WI: 57723 SCADAPack Hardware manuals used the term of "SCADAPack Logic" and
"SCADAPack Logic Power" to refer to the power to the RTU circuits. This is
replaced with “SCADAPack RTU circuitry” and “SCADAPack RTU Input
Power”.

WI: 58073 The OBJ_ReadField function block returned zero for ROR and ROF Quality
flags. This is corrected.

WI: 58360 F_DirInfo did not indicate correct sizes for USB drives over 4 GB. The function
now reports sizes in kBytes instead of bytes.

WI: 58534 RemoteConnect could not read from the RTU when there was no logic present
in the RTU. This is corrected.

WI: 58535,

59392 and

60146

Configurations with many objects with logic variable types defined would fail to
load the logic application. NOCONF was reported on the RemoteConnect
(Online) Logic tab. System status code 5004 was reported. This is corrected.

WI: 58948 The Over Range flag from an analog input I/O module was not visible in the
RemoteConnect Object Browser but was visible from logic. The flag is now
shown in the object browser.

WI: 59236 Modbus Scanner polls were delayed by one cycle when the remote devices
did not respond, and the TCP connection reset before the next poll. This
occurred with long poll intervals. This is corrected.

WI: 59285 Logic non-volatile memory was not cleared on a cold or factory boot. The logic
application was removed, but the underlying non-volatile memory still retained
the last used values. When an identical application was loaded previous
values reappear. This is corrected.

WI: 59416 F1 help for 'Include Time Deadband data in Class 0' showed the wrong topic.
This is corrected.
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WI: 59481 Serial communication function blocks (COM_READ and COM_WRITE) could
crash the RTU firmware when used in cyclic mode. The function blocks are
now disabled in cyclic mode and the user manual is updated to indicate these
function blocks are supported only in periodic mode.

WI: 59691 The RTU did not perform a graceful shutdown of TCP connections if there was
active DNP/TCP communication to the target when a DNP device restart
occurs. This is corrected.

WI: 59694 The IPCONFIG command would accept ETH3 configuration on a SCADAPack
47x RTU. This is corrected.

WI: 59879

and 59998
The F_DelTree function block did not remove folders on USB drives if the
folder was specified using a relative path. This is corrected.

WI: 59902 RemoteConnect crashed when transferring a file to a SCADAPack RTU when
the file name was longer than 253 characters. This is corrected.

WI: 59964 6601 I/O module analog inputs could stop updating. This is corrected.

WI: 60000 A logic project could not be debugged after converting it from SCADAPack
575 to SCADAPack 470. This is corrected.

WI: 60011

and 59982
Addressed RemoteConnect security vulnerabilities with malformed project
files: CVE-2020-7528 and CVE-2020-7529.

WI: 60012 Addressed a logic editor security vulnerability with file permissions: CVE-
2020-7530.

WI: 60013 Addressed a RemoteConnect security vulnerability with file permissions:
CVE-2020-7531.

WI: 60014 Addressed SCADAPack x70 Security Administrator security vulnerability:
CVE-2020-7532.

WI: 60191 The logic SCBUser task was suspended when an invalid filename was applied
to the F_WOPEN FB. This is corrected.

WI: 60233 The loading project dialog would remain open when double clicking an invalid
.prj file. This is corrected.

WI: 60346 A SCADAPack 570 project could not be converted to a SCADAPack 470
project. This is corrected.

WI: 60347 SCADAPack 47x RTUs did not report the DNP3 address correctly on the
USB connection. This is corrected.
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WI: 60448 The SYS_CODE documentation was missing metadata information. This is
corrected.

WI: 60449 There was insufficient information in the SYS_RESTART documentation. This
is corrected. Additional information is provided for
SYS_RESTART_ReasonMask , SYS_RESTART_TaskWdogMask, and
SYS_RESTART_1_Reason through SYS_RESTART_5_Reason.

WI: 60675 Excel import of a large configuration stops at 90% for a long time before
completing. Additional progress messages were added to provide better
feedback. Long intervals between messages are still possible.

WI: 60701 RemoteConnect created inconsistently numbered object names for 5607 I/O
modules on a SCADAPack 57x. This is corrected.

WI: 60743 Excel import and export of Modbus slave device addresses was incorrect
when the Realflo flow computer option was enabled. This is corrected.

WI: 60744 The label "Maximum Record Delay" in the Serial Port settings was corrected
to “Maximum Random Delay”.

WI: 60749 Importing an RTZ file in RemoteConnect would not create object arrays. This
is corrected.

WI: 60695 Removed SCADAPack 47x IECEx Certification from documentation and
labels. This certification is not yet available for SCADAPack 47x.

WI: 57480 Some Modbus/TCP responses were not transmitted on USB if the message
length was a specific size. This occurred only with some custom Modbus
command for reading Realflo batch records. It could be worked around by
changing the number of records read. This is corrected.

WI: 59379 FILEDIAG documentation was unclear on the default behaviour. The
documentation was updated.

WI: 57284 The Modbus slave address was not displayed by the whoami command for
some serial port configurations. This is corrected.

WI: 47815 The restart command help output listed several obsolete services from the
SCADAPack E RTU. The options had no effect. They are removed from the
help output.

WI: 59277 Addressed a third-party component vulnerability affecting Triangle MicroWorks
DNP3 stack: CVE-2020-6996 Triangle MicroWorks DNP3 Outstation
LibrariesDNP3 Outstation .NET Protocol components and DNP3 Outstation
ANSI C source code libraries.
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6.8.9 Known Issues (R2.4.2)

Installation Control Expert and Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process
and Control Expert / Unity Pro software installation process can interfere with
one another. It is recommended that when installing new versions of Control
Expert / Unity Pro software that the repair installation option be run for
SCADAPack RemoteConnect. Coexisting installations of RemoteConnect
and Unity Pro are supported for Unity Pro versions 13.0, 13.1, and
EcoStruxure Control Expert version 14.0 and 14.1.

Workaround: Repair the installations as mentioned above. Remember to
“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer
will automatically attempt a Repair on Unity Pro software.

WI: 47824 del * command leaves some files on a USB drive when there are many files
on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to
another large configuration, the configuration rebuild might not succeed and
would report configuration log messages such as “# 565: Unable to create
object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and
restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts
relate to SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 57666 The 6602 I/O module is not supported on the SCADAPack 47x.

Workaround: None.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x
USB C port.
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Workaround: Use a USB A port on the PC to connect to the USB C port on
the SCADAPack 47x.

WI:60552 The logic editor may fail to start after upgrading from beta test releases R2.4
or R2.4.1 to R2.4.2. Logic editor files should be installed in the C:\Program
Files (x86)\Schneider Electric\UnitySoControl 14.0. On some occasions files
are installed in C:\Program Files (x86)\Schneider Electric\UnitySoControl. 

Workaround: Uninstall UnitySoControl from the control panel. Then install
R2.4.2.

WI: 59220 Logic Editor Memory Consumption dialog shows incorrect values and
calculates the % of memory used using incorrect values. This is displayed
with the Mode > Memory Consumption command. When memory usage is
87% or higher on the dialog, the SCADAPack RTU will be unable to load the
application. When writing to the RTU the message “PLC program internal
memory full” is displayed. The Greatest value below the graph is correct. The
value above the graph should read 3072 Kbytes.

Workaround: 

Multiply the % usage values in the graph on the left by 1.16 to get the actual
values. 

Ignore the % memory available value in the graph on the left. 

Subtract 525000 from the Total (memory available) value below the graph on
the left to get the actual value.

WI: 60765 SCADAPack 47x RTUs may report CAN bus overruns when file operations
are performed. The CAN bus operation is automatically retried. The system
data reference SYS_StatsIO_CANOverrun will show a non-zero number if this
occurs.

Workaround: Do not use the SYS_StatsIO_CANOverrun value. Use other
SYS_StatsIO_CANxxx system data references to detect abnormal CAN bus
operation.

WI: 61159 The RTU may restart if command line diagnostics are running over a Telnet
connection, and a configuration is written to the RTU that disables the Telnet
service.

Workaround: Stop the command line diagnostics before disabling Telnet.

6.8.10 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be

blocked from reopening if previous instances of RemoteConnect or

the Logic Editor were not closed cleanly. 
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Workaround: Launch the Task Manager and shut down any

RemoteConnect processes, then restart RemoteConnect.

Logic Editor Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the

library is opened by another application when attempting to modify

the logic library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the

Task Manager and shut down any Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor processes. If the

symptoms persist, it is likely that Windows folder permissions are

incorrect.

Check the following:

1. With administrator privilege right-click on the following
folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row

called "Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.8.11 SCADAPack x70 and 6601 Firmware Version Compatibility

Customer Guidance for SCADAPack 47x

SCADAPack 47x supports 6601 input output module firmware version 2.0.20 and later.

Customer Guidance for SCADAPack 57x

6601 upgrade recommendations: Upgrade 6601 input output modules (both external and built
into SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
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(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 input output modules shipped from the factory with
1.80.6 or 1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.



3.10.3

x70 Release Notes SCADAPack x70 Release Notes

105

6.9 SCADAPack x70 R2.4.1 Release Notes 05/2020

SCADAPack x70 R2.4.1 was first available in May 2020.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware version 9.1.2 and earlier versions to firmware version 9.2.1 or
newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware version 1.10 to bootloader firmware version 1.30 or
newer. Cold boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader firmware version 1.30 corrects a start-up initialization issue and digital output
initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack x70 device restart.

The firmware in this release includes these corrections.

6.9.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.9.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.7.2

· SCADAPack DNP3 Communication DTM version is 3.7
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· SCADAPack x70 Device DTM version is 3.7

· SCADAPack x70 Logic Editor version is 14.0 - 200313

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.7.2

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.6.1

SCADAPack 47x firmware version is 9.4.2

SCADAPack 47x bootloader version is 0.00

SCADAPack 57x firmware version is 9.4.2

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 2.0.20

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6607 I/O module firmware version is 2.1.11

6607 I/O module bootloader version is 2.1.11

6.9.3 Software and Firmware Version Compatibility

RemoteConnect version 3.7.2 is intended for use with SCADAPack x70 firmware version 9.4.2.

As of R2.0 and newer, RemoteConnect and SCADAPack x70 firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS
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RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.9.4 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.9.5 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.9.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. A repair process must always be Run as administrator.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.114
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6.9.7 SCADAPack x70 Logic Editor V14.0

New and Improved Features

New! Expanded menu items when using LD editor, including customizable Favorites
menu

New! Color customization available for language editor displays. See Tools > Color
Settings.

New! Program Units added for logic task programs (also known as IEC 61131-3
POUs). This feature allows application logic to be shared and more easily
deployed. Each program unit defines local content independent from other
program units and from global variables. Each program unit provides a defined
external interface to the logic project to which specific “effective parameters”
are attached. For example, I/O variables, SCADAPack x70 object variables
can be attached as effective parameters.

New! Integrity checks are performed at logic editor startup for detecting unexpected
modifications to logic editor components

New! Build-time code generation performance improvements

PEP0387277R A search of a DDT type can now find instances of the DDT where nested in
other DDT types

PEP0414041R In the LD and FBD editor, Select View / Page Break allows page breaks to be
inserted for documentation printing

PEP0454763R Color (red/green) is now set on a Connector according to its Boolean value

Fixed Issues

PEP0362017R When printing a logic project, the page numbers were not consistent.  This is
now fixed.

PEP0408801R Adding a block such as AND then double clicking on a pin and selecting the
ellipsis…  opened the variable window, but it could immediately contract the
variable list instead of leaving it expanded. This is now fixed.

PEP0439249R After declaring an out interface variable in an SFC Step action on the process
side and in the global variables, and creating an SFC section in the process
side, you could get an error message “assignment on read variable”. This is
now fixed.

PEP0454722R After adding a new section to a functional module and building the application,
all functional modules were expanded. This is now fixed.
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PEP0418945R

PEP0462542R
The DFB version is now updated after a function block display difference,
following Refine. A REFRESH  button is also added in FBD toolbar to adapt
the display when required.

PEP0475114R JMP instructions in an ST section of a DFB may not have operated correctly.
This is now fixed.

PEP0476462R Opening an FBD section could take a long time. This is now fixed.

PEP0483519R Error message "This variable doesn't exist" could be displayed when refining a
DFB online. This is now fixed.

PEP0487560R If the Implicit Conversion project setting was set, when an output pin was
directly connected to an input block with a different type, the next block could
have a calculation overflow error. This is now fixed.

PEP0489284R When a TON Variable was created in the Private Section of a DFB, an error
message appeared “This type can’t be used here”. This is now fixed.

PEP0489562R The Logic Editor displays shown on a secondary screen were not visible when
the computer switched back to a single screen. This is now fixed.

PEP0490038R Export and Import of variables in .TXT format was not possible. This is now
fixed.

PEP0329921R Boolean variable values were not displayed correctly in the case where
"Tools//Project Settings... //General//Build Settings//Generate with LD
animation" flag was OFF. This is now fixed.

PEP0351626R Depending on the Logic Editor internal windows size and/or after resizing,
some fields in some operator screens were unreadable (mixed fields, partially
hidden…). This is now fixed.

PEP0353275R A compilation error could occur with the message "Fail GCC Compilation 249
and 272" when JUMP instructions were used. This is now fixed.

PEP0386705R When the selection input of a SEL EF was a bit extract of a word of indexed
array (example: InputRegisters[index].3) the result of the SEL EF was not
correct. This is now fixed.

PEP0393132R Depending on the screen resolution and zoom level, in an FBD section the
variable names could be truncated on the right. This is now fixed.

PEP0394251R Searching in a project could cause the Logic Editor to freeze. This is now
fixed.

PEP0398992R If you created a family of a DFBs under a library name (on a computer with the
Logic Editor in English), this name was not correctly displayed on a computer
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with the Logic Editor in German. Default names were displayed instead. This is
now fixed.

PEP0402124R The ENO pin of the DEC function block did not provide any output value. This is
now fixed.

PEP0413522R In Mixed Display Mode some variable names displayed for the OPERATE
block were not consistent. This is now fixed.

PEP0414352R In graphical languages, error “E1199 Left side of in out-pin can only be
connected with in-out-pin or variable” could appear if a new function block was
added and not linked (isolated) to the block containing the error. This is now
fixed.

6.9.8 New and Improved Features (R2.4.1)

New! Realflo flow computer 7.01 is available for SCADAPack 47x RTUs.

New! RemoteConnect checks the integrity of the executable components in itself, the
communication DTM, and the device DTM at start up. The function can be
manually run from the Help > Integrity Check command.

WI: 56300 Added SYS_MODEM_PowerControl system data reference to control the power
to the SCADAPack 47x RTU modem port.

WI: 56322 Added stack dump file creation on SCADAPack 47x RTU. The dump file will be
created if an unexpected exception occurs on the RTU.

WI: 56921 Added documentation topic “Adding a RemoteConnect Object and Logic Variable
Online”.

WI: 58458 Improved robustness of the I/O bus when CAN-H and CAN-L signals are shorted
together.

WI: 58949 Improved backward compatibility with firmware 9.2.3 and earlier. SCADAPack 57x
I/O module channels are only written to the configuration file if they have an Object
association.

WI: 59482 Improved the documentation of x70 Ladder Editor and Control Expert differences.

WI: 59707 Added documentation of system status code 1013 in the troubleshooting guide.

WI: 59726 Clarified the documentation of 6607 sampling rates.
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6.9.9 Fixed Issues (R2.4.1)

WI: 47743 Status IP_Stats command reported IP address 127.0.0.1 when the IP was
disabled. This is corrected.

WI: 48632 Some routing information was missing from the PRINT ROUTE command output.
The Type and Metric values are now displayed.

WI: 50144 In RemoteConnect the SCADAPack 574 Analog Input Channel Configuration
column was too narrow. This is corrected.

WI: 57821 Reading the SYS_Status system data group returned an invalid reference
SYS_Status_NTPState. This is no longer returned.

WI: 58092 I/O Object names and groups were changed when the I/O Board name was
changed. The names are now updated if the name or group is the default name,
but are left unchanged if they have been edited by the user.

WI: 58140 SCADAPack 57x analog input values were retained over a power cycle. The
outputs are now set to zero at power up.

WI: 58181 System status code 5014 and 5017 were sometimes reported when restarting the
RTU from the command line. This is corrected. 

WI: 58344 F_FindFile behaviour with an empty DIR input was not documented. This is
corrected.

WI: 58400 Help text for F_RMDIR was not complete. Now it is.

WI: 58682 An unsupported Remote I/O feature was generated by RemoteConnect in the RTU
configuration file. The unsupported feature is no longer included in the file.

WI: 58834 Addressed a logic editor security vulnerability: CVE-2020-7475

WI: 58933 The values for the SYS_StatsSecLock system data reference were not
documented. The documentation is corrected.

WI: 59043 The last reported internal indication flag was reported incorrectly from polled
outstations. The correct IIN flags are now reported.

WI: 59072 The documentation of the DNP3 master 'No Poll' Polling Type was incorrect. This
is corrected.

WI: 59094 "Help on Type" for the DNP3Peer function blocks did not describe the error codes.
This is corrected.

WI: 59200 DNP3 Master communication with outstations could be lost on SCADAPack 47x
RTUs when diagnostics were running over a Telnet connection. This is corrected.
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WI: 59222 The STATUS IP_STATS command displayed incorrect information, including that
enabled ports were disabled. The correct information is now displayed.

WI: 59263 DNP3 CROB request to a digital input did not generate an event on boot if the
state of the point was active prior to restart. The firmware now waits for I/O driver
tasks to be initialized before sending DNP3 unsolicited messages, accepting
control actions or starting Logic applications.

WI: 59385 DNP3 master addresses 65520 to 65535 were incorrectly allowed. The correct
range 0 to 65519 is now used.

WI: 59389 Corrected a memory leak on SCADAPack 47x RTUs when calling logic function
blocks.

WI: 59393

WI: 59522
SCADAPack 47x non-volatile logic data was not cleared on reconfiguration. This
is corrected.

WI: 59432

WI: 59433

WI: 57177

WI: 58209

F1 (context sensitive) help opened incorrect topics for several pages. This is
corrected.

WI: 59480 SCADAPack 47x Counter Frequency objects had a default display format of
REAL. The format is now DINT.

WI: 59484 The logic state could be set to RUN before I/O boards were ready to accept
analog output controls at start up. The logic now waits for the I/O board to be
ready.

WI: 59496 Addressed a firmware security vulnerability.

WI: 59526 The SCHEDULE and RRTC_DT_MS function blocks did not work and returned an
incorrect status code if the time had not been set. The function now returns the
correct status code (clock unavailable) if the clock is not set.

WI: 59527 The metric value was not set when adding a route to the IP routing table. This is
corrected.

WI: 59556 System data reference for SYS_StatsIOP could not be added to associations in
RemoteConnect. This is corrected.

WI: 59558 An unsupported object type (T_SPx70_EBOOL or T_SPx70_ADV_EBOOL) in an
Excel file imported into RemoteConnect R2.4 could cause the Logic Editor to
become unavailable. The unsupported object is now marked as invalid.

WI: 59601 DNP3 protocol incorrectly reported receiving an unexpected Confirm on start up.
This is corrected.
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WI: 59640 System Data object SYS_MODEM_SIMcardMissing was reported as Object
Does Not Exist. The object now returns 0.

WI: 59645 Importing an incompatible M340 .STA file into RemoteConnect caused the Logic
Editor to become unavailable. This is corrected.

WI: 59735 SCADAPack 47x battery switch documentation was missing. This is corrected.

WI: 59755 RemoteConnect could crash during the Update and Build step while displaying
Saving the Project. This is corrected.

WI: 59768 SYS_PROTOCOL_MB_FC7ExcepStatus was not documented. Now it is.

WI: 59824 Exceeding the Modbus Master scanner point count was described as a license
limitation. The status code 3000 description and documentation is updated to
state “A DNP3 Data Concentrator or Modbus Scanner configuration contains
either more remote devices OR more mapped objects than permitted.”

WI: 59848 Converting a project from a 575 to a 474 retained the Ethernet 3 information and
prevented the use of the IP address. This is corrected.

WI: 59982 Addressed a RemoteConnect security vulnerability.

WI: 60034 RemoteConnect could not import from an Excel file with read only permissions.
This is corrected.

WI: 60040 Addressed a RemoteConnect security vulnerability.

WI: 60015 Renaming a duplicated Modbus Slave device name displayed the progress dialog
forever. The progress dialog now closes after the operation is complete.

6.9.10 Known Issues (R2.4.1)

Installatio

n
Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process and
Unity Pro software installation process can interfere with one another. It is
recommended that when installing new versions of Unity Pro software that the
repair installation option be run for SCADAPack RemoteConnect. Coexisting
installations of RemoteConnect and Unity Pro are supported for Unity Pro versions
13.0, 13.1, and EcoStruxure Control Expert version 14.0 and 14.1.

Workaround: Repair the installations as mentioned above. Remember to “Run as
administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer will
automatically attempt a Repair on Unity Pro software.
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WI: 47824 del * command leaves some files on a USB drive when there are many files on
the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to another
large configuration, the configuration rebuild might not succeed and would report
configuration log messages such as “# 565: Unable to create object due to
insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.
Alternatively, apply a configuration with a very small number of objects and restart
the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by
RemoteConnect installs shortcuts to All programs > Schneider Electric >
SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic
applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts relate to
SCADAPack Logic.

WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 57666 The 6602 I/O module is not supported on the SCADAPack 47x.

Workaround: None.

WI: 59358 A USB C connection from a PC does not work with the SCADAPack 47x USB C
port.

Workaround: Use a USB A port on the PC to connect to the USB C port on the
SCADAPack 47x.

WI: 60166 After installing RemoteConnect and Control Expert, if you uninstall Control

Expert, RemoteConnect will no longer work.

Workaround: Do not uninstall Control Expert after installing the

RemoteConnect update. 

6.9.11 Post Installation Troubleshooting

RemoteC

onnect

and Logic

SCADAPack RemoteConnect Configuration Software start-up may be blocked

from reopening if previous instances of RemoteConnect or the Logic Editor

were not closed cleanly. 
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Editor

Start Up

Workaround: Launch the Task Manager and shut down any RemoteConnect

processes, then restart RemoteConnect.

Logic

Editor

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library is

opened by another application when attempting to modify the logic library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the Task

Manager and shut down any Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor processes. If the symptoms

persist, it is likely that Windows folder permissions are incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row called

"Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.9.12 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE
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LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.10 SCADAPack x70 R2.4 Release Notes 03/2020

SCADAPack x70 R2.4 was first available in March 2020.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using
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· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware version 9.1.2 and earlier versions to firmware version 9.2.1 or
newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware version 1.10 to bootloader firmware version 1.30 or
newer. Cold boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader firmware version 1.30 corrects a start-up initialization issue and digital output
initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack x70 device restart.

The firmware in this release includes these corrections.

6.10.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files, and SCADAPack Software Installation in the documentation set that is installed
with RemoteConnect.

6.10.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.7.1

· SCADAPack DNP3 Communication DTM version is 3.7

· SCADAPack x70 Device DTM version is 3.7

· SCADAPack x70 Logic Editor version is 14.0 - 191125

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.7.1
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· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.5.1

SCADAPack 47x firmware version is 9.4.1

SCADAPack 47x bootloader version is 0.00

SCADAPack 57x firmware version is 9.4.1

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 2.0.20

6601 I/O module bootloader version is 1.80.10

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6607 I/O module firmware version is 2.1.11

6607 I/O module bootloader version is 2.1.11

6.10.3 Software and Firmware Version Compatibility

RemoteConnect version 3.7.1 is intended for use with SCADAPack x70 firmware version 9.4.1.

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.
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6.10.4 Supported Devices

SCADAPack 470

SCADAPack 474

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.10.5 Supported Operating Systems

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.10.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. A repair process must always be Run as administrator.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

· EcoStruxure Control Expert version 14.1

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.10.7 New and Improved Features (R2.4)

New! Added SCADAPack 470 and SCADAPack 474 RTUs.

New! Added 6607 I/O module support to SCADAPack 57x and SCADAPack 47x.

New! Logic editor version 14.0 for SCADAPack 57x and SCADAPack 47x is available.

131
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SCADAPack 57x projects support both V11.1 projects and libraries for existing
installations, and V14.0 projects and libraries. The version is selected in
RemoteConnect.

WI: 47521 MAST task default mode is periodic with a period of 125 ms.

FAST task default mode is periodic with a period of 25 ms.

WI: 47554 Languages Reference topic is added to SCADAPack x70 logic editor
documentation.

WI: 49564

WI: 49390

WI: 49531

Improved documentation of the IP whitelist feature.

WI: 49582 Added conversion guide for Telepace logic users.

WI: 49715 Documentation describes side-by-side use of x70 logic editor and Unity Pro /
Control Expert for users with both tools.

WI: 50142 Improved entry of custom time when setting device time from RemoteConnect.

WI: 50473 RTU configuration created in Geo SCADA Expert can be imported. Use the Import
button on the SCADAPack x70 Logic page, Advanced Configuration section.

WI: 50556 Added confirmation dialog before writing configuration and logic to RTU.

WI: 51085 Object creation and protocol configuration operations often repeated by users now
remember the last selection and use it as the default for subsequent operations.

WI: 51345 Clicking the RemoteConnect icon in the upper left corner displays the Start Page
and makes it visible if it is closed.

WI: 52839 The SYS_LOGIC system data group now includes the periods of the MAST,
FAST, AUX0, and AUX1 tasks. RemoteConnect displays the periods on the online
Logic status page.

WI: 52976 Event configuration on the DNP3 > Slave > Events page now includes File Event
Class. This configures the event class in which a DNP3 file event status is
generated.

WI: 53178

WI: 57928
Improved validation of DNP3 route entries to provide better guidance when
unsolicited response routes or the connect number is missing.

WI: 53294 The DNP Internal Indications (IIN) now include the LOCAL_CONTROL flag (IIN.5)
when forcing is active. RemoteConnect displays this in the online status bar so
users are aware of forced values.
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WI: 53354 Object Browser Applied Value column is renamed to Proposed Value.

WI: 53355 DNP3 slave event configuration workflow was simplified by removing redundant
selections.

WI: 53358 The Add and Remove buttons were removed from the Network View. These
buttons were rarely used. The functions are available by right-clicking a selection

in the view.

WI: 53401 Modbus byte ordering text was made consistent on the Modbus > Slave/Server
page and the Modbus Scanners page.

WI: 53467 Improved guidance in the documentation for the placement of 5103 power
supplies.

WI: 53504 Moved the online status information to the top of the online pages for better
visibility. Improved the layout and color to provide better information.

WI: 53550 Improved the documentation of the STU and STA files in the x70 logic editor.
Documented compatibility with logic editor v11.1.

WI: 53716 Double clicking an entry in the Object Browser opens the Object Editor dialog.

WI: 53721 Popup dialogs can be made transparent by holding down the “eye” icon. This
allows information under the dialog to be viewed.

WI: 54119 Open telnet sessions are closed when the service is disabled by configuration.

WI: 54121 Improved the organization of the Getting Started section of the logic programming
manual.

WI: 54192 Removed the obsolete CLEAR LOGIC command from the command line and
RemoteConnect.

WI: 54319

WI: 56644
Added SYS_StatsIO communication statistics to system data.

WI: 54992 Simplified the workflow for Modbus scanner data type selection by combining
some configuration fields. This did not affect the RTU configuration.

WI: 55057 Documented use of system status function in the x70 logic Multitasking topic.

WI: 55058 Object Browser supports OS_TIME and Hexadecimal display options for System
Data.

WI: 55446 CAD drawings for SCADAPack 570, 574, 575, 470, 474, 6601, 6602, and 6607
are part of the installed files added to your PC.
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WI: 55688 Changing project settings retains a configuration that is compatible with the new
settings making changing a device type simpler.

WI: 55691 When the Object collection is large, the ‘Add Object Association’ list can include
many entries. To help the user filter the list, a new option selects Objects sorted
by group.

WI: 56057 Logic status codes, such as divide by zero in the logic application, no longer set
the system status code or cause the STATUS LED to blink. The information is
reported in system status words %SW125, %S18, %S20, and %S15 for use in
the logic application.

WI: 56316 Addressed security vulnerabilities on SCADAPack 57x.

WI: 56316

WI: 56378
Improved documentation of the limitations of file management function blocks and
added safety messages.

WI: 56338 Provided additional feedback to the user during the Update and Build Logic
operation.

WI: 56339 Increased the number of Modbus scanner devices from 60 to 150.

WI: 58599 Ended support for Windows 7.

WI: 58972 Improved IP Address validation to prevent use of first and last address in the
subnet as the RTU IP address.

6.10.8 Fixed Issues (R2.4)

WI: 47352 The Mode > Start Simulation action in the Logic Editor could take an extended
time to start. This was corrected.

WI: 47624 6602 I/O module analog outputs were reported online when unconnected or
removed. The correct status is now reported.

WI: 47643 DNP3 integrity polls responses that included unsupported objects were rejected.
DNP3 integrity polls that return unsupported objects will now generate diagnostic
messages and parse the remaining objects in the response.

WI: 47705 A low change interval for the DNP3 Secure Authentication session key caused
slow response times. Additional validation of the DNP3 SAv2 Session Key Update
time and Update Count parameters was added to detect if the values are outside
expected limits.

WI: 47725 Modbus master could be configured and would poll devices when the Modbus RTU
master was disabled in RemoteConnect. Additional validation was added in
RemoteConnect to prevent this.
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WI: 47753 Where an online modification leads to the clearing of the project version system
data field (SYS_LOGIC_ProjectVersion), and a configuration is written with the
same modified logic application, the project version was not updated. The project
version is now updated.

WI: 47764 Cancelling a Modbus Master function block request does not cancel the request
until the timeout expires. A new request cannot be made until the timeout is
complete. The documentation was clarified to state “Following a cancelled
request, wait the timeout period before generating a new request”.

WI: 47808 The "whoami" command and the Terminal Server task were reading from the PPP
IP address. They now use the configured IP address for the serial port.

WI: 47890 Modbus function block output message was retained after device restart. Status
code 31 was added to indicate that the function block is idle.

WI: 47939 Removed some Object Browser diagnostics previously shown on a Write
operation. Browser diagnostics are now only shown in the case of an unexpected
condition.

WI: 48021 The 6602 HART Analog Input module was not detected unless at least one AI
point (channel) on the module is associated with an object. This was corrected.

WI: 48092 The saveconfig command was provided incorrectly on from the command line and
user manual. The command was removed.

WI: 48126 DNP3 Master <n> address and Local Address were not displayed by whoami after
RemoteConnect updated the field. This was corrected.

WI: 48129 Modbus store and forward table was cleared after a power cycle or RTU restart.
This was corrected.

WI: 48400 Device_ChangeParam function block with the parameter of
PARAM_DISABLE_DCONS incorrectly reported output parameters. This was
corrected.

WI: 48549 Corrected documentation of the file system capacity for /user and /ramdir drives.

WI: 48687 A directory named 's' could not be deleted using command line or F_Deltree
function block. This was corrected.

WI: 48696 DNP3Peer_AddToRDList and DNP3Peer_AddtoWRList function blocks could add
new content to old lists when an application was stopped and started. The lists
are now cleared when the application is stopped.

WI: 48862 Inconsistent file and folder timestamps were shown in telnet, serial and FTP
sessions. The timestamps are now consistent. FTP treats timestamps from the
RTU as UTC.
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WI: 48863 File system timestamps were shifted by the current offset from UTC after writing
configuration. This was corrected.

WI: 48873 The SetTimeDate function block showed unexpected values when the year was
set beyond 2038. The year is now limited to 2000 to 2037.

WI: 49067 Corrected the DNP3 master device profile documentation.

WI: 49072 Clarified the Modbus RTU master operation documentation.

WI: 49073 Clarified the Modbus RTU slave operation documentation.

WI: 49091 Corrected the documentation of the maximum entries for the Data Concentrator
and Modbus Scanner Devices and Points.

WI: 49422 Corrected documentation by removing the (incorrect) ATTRIB_ObjectType as a
supported attribute for OBJ_WriteField function block.

WI: 50145 Firmware files installed with RemoteConnect were removed when RemoteConnect
was uninstalled. The firmware files are now retained.

WI: 50152 RemoteConnect allowed different numbers of entries in the Data Concentrator and
Modbus Scanner tables than firmware. Corrected the validation of maximum
number of entries in the Data Concentrator and Modbus Scanner tables in
RemoteConnect.

WI: 50389 Configuration conflicts occurred if a group of more than 2000 objects was added to
the object browser. RemoteConnect now limits the number of objects to 2000 and
displays an information icon if there are more than 2000 objects in a group.

WI: 50417 In RemoteConnect, switching a Device to Offline when Auto-Refreshing blocked
the Online tab from closing. This was corrected.

WI: 51928 Clarified documentation of the diagnostic timestamps to state which diagnostics
use the PC clock and which use the RTU clock.

WI: 52983 RemoteConnect crashed when switching from Online to Offline with the Object
Browser configured to automatically refresh. This was corrected.

WI: 53064 Modbus/TCP and Modbus RTU over TCP / UDP terminology was inconsistent in
RemoteConnect. The user interface and documentation have been made more
consistent.

WI: 53086 Previously, the IP Whitelist sets the TCP or UDP port for a given service (e.g.
DNP3 over TCP) from the configuration as it exists when the Whitelist rule is
configured. If the port is changed in the RTU configuration at some later point, it is
possible that the Whitelist may become out of sync with these values. This was
corrected.
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WI: 53237 Object configuration in RemoteConnect and the logic editor could be out of sync if
changes were not saved in RemoteConnect. RemoteConnect now saves the
configuration when the logic is saved and does not automatically save the logic
when the type of a variable is changed.

WI: 53436 Changing the Default DPN3 Port value requires a full RTU restart to take effect.
This was missing from the documentation. The behaviour is now documented.

WI: 53553 A project could be exported before it was built, leading to inconsistencies in the
configuration and logic. Export Project function is now available only after the
project has been built, and a message is shown to the user.

WI: 53618 RemoteConnect reported incorrect object configurations after importing a logic
project. This was corrected.

WI: 53724 The metadata for status code 6602 reported 0. Now, it reports the address of the
I/O module to which the status code applies.

WI: 53896 An unsuccessful firmware update of a 6602 I/O module was not reported. Status
code 3015 is now reported if the update is unsuccessful. 

WI: 53944 DNP3 "Device Attributes" Group 0 Variation 203, 204, and 205 store data related
to the RTU location in a floating-point format. Previously, if these fields were
written from DNP3 specifying a double-precision float value, the firmware would
just store a value of zero. The firmware will now accept either a single or double-
precision floating-point value.

WI: 53948 Updated the description of Status code 1410 to provide better guidance on
recovering from a low battery.

WI: 53969 Configuring an IP Route without a gateway resulted in an incorrect gateway
address reported by route print. Now, when no gateway is specified, the port IP
address is used as the gateway.

WI: 53981 If logic validation was unsuccessful on the RTU and was not loaded, it could still
be put into a RUN state. Now, the device reports the NOCONF state and status
code 5004. The logic cannot be run from this state.

WI: 54092 Status code 6602 was not raised when communication with a 6602 I/O module
was lost. This was corrected.

WI: 54107 Corrected the documentation of serial port 2 and 3 settings after cold boot and
factory boot.

WI: 54144 Forcing current value did not work when an object was already forced. Now, the
current source value is applied, and the object remains forced.

WI: 54338 Patching 9.3.1 firmware build 327 reports restart reason code 0x0001 - Non-
volatile RAM initialized. This was corrected and the expected restart reason is
reported.



3.10.3

x70 Release NotesSCADAPack x70 Release Notes

126

WI: 54343 Reconfiguration of the DNP3 TCP port number prevented RemoteConnect from
automatically connecting to the RTU on the USB port. The DNP3 port number and
the Modbus port number are now constant for the USB interface, so the
connection parameters are always known.

WI: 54504 A second attempt to patch I/O module firmware could be started before the first
attempt was complete. The firmware now checks for an update in progress before
starting a new update.

WI: 54575 The RemoteConnect DTM catalog update was not performed if the user declined
it. RemoteConnect now automatically updates the catalog.

WI: 54608 RemoteConnect could lock up if there is an Object Editor open when Read
Configuration was selected. RemoteConnect will now block the operation when a
dialog is open.

WI: 54658 A single maximum I/O capacity was documented for all SCADAPack RTUs and
the value was too small. Documentation now states the maximum number of
digital and analog I/O for each SCADAPack x70 model. 

WI: 54702 Corrected the temperature range specification in the SCADAPack 5103 Power
Supply Module manual from -40...70 °C (-40...158 °F) to -40...60 °C (-40...140 °F).

WI: 54848 Duplicate objects were created in the logic editor when users rejected changes
made in RemoteConnect, then subsequently made additional changes.
RemoteConnect now handles this case and displays a message instructing the
user how to resolve conflicts caused by rejecting the changes.

WI: 54948 RemoteConnect froze after being left running in online mode for an extended
period. This was corrected.

WI: 54989 DNP3 routing table validation rejected some valid routes. RemoteConnect was
modified as follows:

- Source Port, Start and End, and Destination Port, Start and End cannot be
identical for any two entries

- An overlapping, non-identical range on the same Source port is not allowed 

- An overlapping, non-identical range on the same Destination port is not allowed 

WI: 55017 Importing serial ports with functions set to 'None' caused RemoteConnect to report
an invalid configuration. This was corrected.

WI: 55043 I/O forcing did not operate when an I/O module was offline. The firmware now
processes the forcing request if the control action was unsuccessful, as it would
with an Offline channel.

WI: 55206 Objects with single letter names were not recognized by the RTU firmware. This
was corrected.
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WI: 55259 The POINT_IS_BAD quality flag was set unnecessarily for some I/O module
conditions. It was replaced with POINT_FAILED for Modbus and DNP3 objects,
and STATS_REFERENCE_CHECK when the input is uncalibrated.

WI: 55268 Invalid addresses were allowed when configuring SCADAPack 574 I/O modules.
RemoteConnect now limits the address range on the SP574 I/O module to 0-7.

WI: 55461 Status code 6602 was reported after updating SCADAPack 57x firmware followed
by updating 6602 firmware followed by restarting the RTU. This was corrected.

WI: 55557 Some dialogs in RemoteConnect were too large to acknowledge and correct
invalid configuration. The dialogs are now sized to fit in the available space.

WI: 55583 Documentation of the configurable Modbus/TCP port number was missing from
R2.3.2 release. The information was added.

WI: 55662 The SYS_LOGIC_AUX0period and SYS_LOGIC_AUX1period values were incorrect
by a factor of 10. This was corrected.

WI: 55781 Changing the Device Type (From DTM > Project Settings) more than once caused
the logic editor to stop working. This was corrected.

WI: 55822 The 6601 firmware did not apply the inversion property when the first 4 counters
were set to High speed counter, thus still counting on a rising edge, instead of a
falling edge. This was corrected.

WI: 55923 Changing the SCADAPack Type (e.g. 575 to 574) created an invalid configuration
which could not be written to the RTU. This was corrected.

WI: 55937 The Object browser treated REAL SYSTEM DATA as INT when the value returned
was 0.0. The data type of the object is now explicitly checked.

WI: 55956 Analog object event deviation settings for physical inputs were different from
default analog object settings. The default event deviation type is now set to None
for both.

WI: 56076 SCADAPack 57x RTU could reset when the ping function block is triggered with
PPP port configured, but there is no connected modem. This was corrected.

WI: 56083 The RTU can not be configured if the file system is full. Two system status codes
were added to inform the user of low resources. Status code 1037 is raised when
the available memory drops under 20MB. Status code 1039 is raised when the
available memory drops below 10MB.

WI: 56108 Changing the protocol in the Project creation wizard deselected Modbus IP
Clients and Modbus IP Servers options. The selected options are now retained.

WI: 56155 When a project was copied or saved under a different project name, opening the
original and the copied/saved version in two instances of RemoteConnect did not
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work. This was corrected.

WI: 56188 Documented that F_WOPEN function block can be used to open a maximum of
10 files. Previously this information was missing from the documentation.

WI: 56258 Restart command line help and documentation were missing some services.
Missing services were added, and deprecated services removed in both the
documentation and the command line help.

WI: 56416 Scale parameters were not written to the RTU when changed from the default
values. RemoteConnect now writes these parameters to the configuration file, if at
least one differs from the default values.

WI: 56490

WI: 56511

WI: 58377

The RemoteConnect shutdown process is more robust, reducing the need for
users to manually kill processes in the event of an unexpected shutdown.

Removed the Process Scrubber application from the Windows Start Menu.

WI: 56683 Updated the 570, 574, and 575 hardware manuals Specifications topics. Rewrote
the Data Capacity section to provide more detailed information and updated the
Communications section.

WI: 56686 Improved validation rules for IP addresses in RemoteConnect to exclude invalid IP
addresses.

WI: 56687 When a Modbus Scanner is added for a device with a Modbus RTU serial Device
Type the Modbus Registers assigned to the scanner objects had a blank Modbus
Data Type. RemoteConnect now creates objects with the expected Modbus
Register and Modbus Data Types values.

WI: 56700 Revised documentation of Modbus message counters to match the operation of
the RTU.

WI: 56710 Changing Number of DNP3 Masters from 2 to 1 did not remove all information from
the RTU configuration file. This was corrected.

WI: 56924 Documentation did not indicate that changes to DNP3 event buffers required
restarting the device. This was corrected.

WI: 56932 SCADAPack 57x RTUs could reset when the generated output of the MULTIME
function block exceeded 49 days. This was corrected.

WI: 57117 SCADAPack 57x RTUs could reset when configuration and logic was written from
RemoteConnect. RemoteConnect would report a NOCONF logic status. This was
corrected.

WI: 57120 Changed documentation of the default mode for the MAST task from cyclic to
periodic.
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WI: 57148 The Hart scanner did not stop when the RTU was reconfigured without a Hart IO
Module. This was corrected.

WI: 57159 Corrected documentation of maximum Modbus Slave devices from 128 to 150.

WI: 57201 RemoteConnect allowed entry of any value for 6601 I/O module debounce time.
The values are now validated to be a multiple of 10 ms.

WI: 57215 Added missing documentation of digital inputs Debounce and Invert parameters.

WI: 57570 Added missing documentation for Data Concentrator behaviour when the Integrity
Poll Ratio is set to 0 or 1.

WI: 57612 DNP3 class polls were not sent when the data concentrator detected a Restart IIN
or Buffer Overflow IIN. The data concentrator now forces an integrity poll under
these conditions.

WI: 57622 Communication with the 6601 I/O module could stop and require an RTU restart to
restore operation. This was corrected in the 6601 I/O module firmware. See Loss
of communication to I/O module(s) in Troubleshooting.

WI: 57650 System status code 6601 was not reported when the SCADAPack 575 internal
I/O board (which is a 6601 module) was not connected. This was corrected.

WI: 57796 The 20th IP route and 100th DNP3 Route were not imported from an Excel file.
This was corrected.

WI: 57889 The SYS_STATUS_Modeswitch didn’t return the HEX switch value on
SCADAPack 57x. This was corrected.

WI: 57926 Corrected the description of status code 3009 to "Unable to create a DNP3
master session due to missing or invalid IP address or destination port"

WI: 57994 Added an Addendum to the x70 logic documentation describing that MAX_REAL
and LIMIT_REAL function blocks don't trigger %S18 and %SW17 when input is
out of range.

WI: 57998 RemoteConnect incorrectly reported applying a security file when a loss of
communication prevented transfer of the file. It also correctly displayed a message
indicating the communication loss. Now, it no longer displays the incorrect
message.

WI: 58115 The PTC function blocks reported 0 for the stop time when a running logic
application was rewritten to the RTU. This was corrected.

WI: 58267 A device using DNP3 Secure Authentication (SAv2) could lose communication
with RemoteConnect with some key change parameters. RemoteConnect now
allows editing of the Key Change Interval and Key Change Count parameters in
the Comms DTM for the default key option.
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WI: 58428 The Device Lock feature did not re-establish communication with the RTU
following a communication loss. RemoteConnect will now attempt to re-establish
communication.

WI: 58466 Digital input LEDs on the SCADAPack 575 were not active after a factory boot.
This was corrected. It could be worked around by writing a configuration to the
SCADAPack 575.

WI: 58492 The MKDIR function block reported -1 when a directory could not be created rather
than the expected -1016. This was corrected and additional checking of the file
path is done.

WI: 58523 The PID_INT function block would halt the logic and reported an illegal function
block call if the in/out parameter array was smaller than 44 elements. This was
corrected. This can be worked around using the correct declaration ARRAY
[0..43] OF INT.

WI: 58605 The RTU GETCONFIG command did not report the value of the
SYS_ID_INFO_SERIALPORTPOWERON system data reference. This was
corrected.

WI: 58725 RemoteConnect could write a configuration containing Simulator logic.
RemoteConnect now checks if the logic editor is in simulation mode before
writing.

WI: 58880 The PID_INT function block logic scan time parameter in pid_para[5] always
reported 0 in periodic mode. This was corrected. This parameter will continue to
report 0 in cyclic mode as the function block is not compatible with cyclic mode
(as documented).

WI: 58901 Executing an invalid command via "Execute Command" set the connection state
to "Disturbed". The connection now remains in the Connected state.

WI: 58935 Object Browser Object names were not automatically updated when an I/O
module was renamed. RemoteConnect now updates the names.

WI: 58944 The target DNP3 address on the USB connections in RemoteConnect was
changed to 0 after a device restart. RemoteConnect now verifies the DNP3
address is successfully read before it is updated in the connection info.

WI: 58951 Attempting to read a configuration when first launching RemoteConnect could be
unsuccessful. RemoteConnect now waits for the device type check to complete
before reading.

WI: 59108 DNP3 Peer Write List was unsuccessful if there were unprintable characters in the
file list strings. Unprintable characters are now removed from the start and end of
the file list strings.

WI: 59122 PPP modem connection could be lost and not reacquire its PPP IP address after
writing configuration from RemoteConnect. This was corrected.
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WI: 59323 The SCADAPack 574 analog input channels were labeled from AI1-AI8 instead of
AI0-AI7. This was corrected. 

6.10.9 Known Issues (R2.4)

Installatio

n

Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another. It

is recommended that when installing new versions of Unity Pro software that

the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 13.0, 13.1, and EcoStruxure Control Expert version 14.0 and

14.1.

Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed and

would report configuration log messages such as “# 565: Unable to create

object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.
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WI: 54918 The SD card on the SCADPack 47x is not supported.

Workaround: Use a USB mass storage device (USB drive) instead.

WI: 57666 The 6602 I/O module is not supported on the SCADAPack 47x.

Workaround: None.

WI: 58181 System status code 5014 and 5017 are sometimes reported when restarting

the RTU from the command line.

Workaround: The status codes are incorrect and may be ignored.

6.10.10 Post Installation Troubleshooting

RemoteC

onnect

and Logic

Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be blocked

from reopening if previous instances of RemoteConnect or the Logic Editor

were not closed cleanly. 

Workaround: Launch the Task Manager and shut down any RemoteConnect

processes, then restart RemoteConnect.

Logic

Editor

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library is

opened by another application when attempting to modify the logic library

Steps to resolve

Check that no instances of Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor are running. Launch the Task

Manager and shut down any Unity Pro, Control Expert, and

RemoteConnect/SCADAPack x70 Logic Editor processes. If the symptoms

persist, it is likely that Windows folder permissions are incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row called

"Write".
7. Check the box in the "Allow" column for the "Write" row.
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8. Click OK.
The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.10.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 2.0.20 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA
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 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.11 SCADAPack x70 R2.3.2 Release Notes 01/06/2020

SCADAPack x70 R2.3.2 was first available in January 2020.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware version 9.1.2 and earlier versions to firmware version 9.2.1 or
newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware version 1.10 to bootloader firmware version 1.30 or
newer. Cold boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader firmware version 1.30 corrects a start-up initialization issue and digital output
initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack x70 device restart.
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The firmware in this release includes these corrections.

6.11.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

6.11.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.6.3

· SCADAPack DNP3 Communication DTM version is 3.6

· SCADAPack x70 Device DTM version is 3.6

· SCADAPack x70 Logic Editor version is 11.1 - 181010

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.6.3

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x firmware version is 9.3.3

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 1.80.10

6601 I/O module bootloader version is 1.80.10

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6.11.3 Software and Firmware Version Compatibility

RemoteConnect version 3.6.3 is intended for use with SCADAPack x70 firmware version 9.3.3.

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE



3.10.3

x70 Release NotesSCADAPack x70 Release Notes

136

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.11.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.11.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.11.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. A repair process must always be Run as administrator.

The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12.0

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.139
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6.11.7 New and Improved Features (R2.3.2)

WI: 48369 Added 2 counter inputs on SCADAPack 570 and SCADAPack 575.

WI: 48371 Added support for Realflo licensing. 

WI: 54742

WI: 54747

WI: 55730

WI: 48364

Added Realflo flow computer option in Project settings, the new file wizard,

and in the SCADAPack status page. 

When the flow computer option is enabled:

· Modbus registers for Realflo flow computer use are reserved in object
configuration.

· Enron Modbus serial port parameters are available.

WI: 57456 The Export Project function is blocked if the project has not been built. This

synchronizes logic and configuration before exporting.

WI: 57485 Modified the Update and Build Logic function to automatically save the

RemoteConnect project (logic and configuration) after the user confirms the

logic should be built. Previously the logic was saved, but the configuration

was not.

WI: 57623 Added Device Lock feature. The RTU is locked by default and requires the

user to provide a password (or disable the feature) at the first use of the

device and following a cold or factory boot.

WI: 58270 Added troubleshooting procedure for RemoteConnect start up when

SCADAPack x70 logic library is missing.

WI: 58336 Changed the SERVICE boot settings to provide one DNP3 port (com1) and one

Modbus port (com2) and set both ports to RS232.

6.11.8 Fixed Issues (R2.3.2)

WI: 56810 When writing configuration with a large number of objects to the RTU the

firmware restarted and RemoteConnect reported a timeout. This is fixed.

WI: 57131 The Read Project command was available when the communication DTM was

offline. It is now disabled.

WI: 57182 Update and Build Logic button text was in English when the language was set

to French. It is now in French.
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WI: 57252 Pinned RemoteConnect shortcuts on the Windows 10 taskbar would not work

after upgrading RemoteConnect. This is fixed.

WI: 57455 Improved import function to accept files exported from ClearSCADA (Geo

SCADA) that don’t contain any logic.

WI: 57464 Closing RemoteConnect without saving changes incorrectly saved changes

made in the logic editor, resulting in RemoteConnect settings being out of

sync with the logic editor. Now, the logic changes are not saved when the

user chooses to close without saving.

WI: 57531 Fixed a problem preventing renaming object arrays in RemoteConnect. Arrays

can now be renamed. 

WI: 57538 Changed the message displayed following export of a project after renaming

an object. The message now instructs the user to Update and Build logic from

RemoteConnect.

WI: 57634 RemoteConnect could become non-responsive if objects in RemoteConnect

and logic editor were out of sync. This is fixed.

WI: 57758 Making multiple DNP3 Slave Address changes for elements of a struct

variable caused the Logic Editor variable to remain unlocked. The variable is

now locked correctly.

WI: 57903 The RTU was missing some DNP3 points in integrity polls. Fixed a problem

that caused the object’s pending deadband state to not clear when the

deadband time cleared.

Changed the RemoteConnect setting Class 0 Data Filter to Include Time

Deadband data in Class 0 to better describe the operation and updated the

description to “When this option is selected, an active time deadband on a

DNP3 point will delay creation of DNP3 events and will include the current

state or value in Class 0 poll responses.  When this option is not selected, an

active time deadband will delay creation of DNP3 events and withhold the

relevant data from Class 0 poll responses.”

WI: 58109 The RemoteConnect connection state would toggle between Connected and

Disturbed when the TCP address of the RTU was different from

RemoteConnect. The state now stays in Disturbed.

WI: 58156 RemoteConnect did not display the Device Type correctly when first launched

and connected to an RTU. The Device Type is now displayed correctly.
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WI: 58250 RemoteConnect could block the user from clicking the OK button if the Set

Device Time button was clicked when the information dialog was open,

requiring the user to force close the RemoteConnect application. The button

no longer prevents closing the information dialog.

6.11.9 Known Issues (R2.3.2)

Installatio

n

Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another. It

is recommended that when installing new versions of Unity Pro software that

the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 13.0, 13.1, and EcoStruxure Control Expert version 14.0.

Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47523 Logic Editor PLC Simulator 

The Mode > Start Simulation action in the Logic Editor can take an extended

period of time to start. The PLC Simulator is started and the project is

prepared for download, but it can take up to 2 minutes for the download to

start. After the first download, subsequent uses of the PLC Simulator don't

experience this issue while the SCADAPack x70 Logic Editor and PLC simulator

remain open.

Workaround: Start the simulator manually from the Windows Programs

menu. This may take multiple attempts. After starting via the Windows

menu, it should be possible to use Mode > Start Simulation.

WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.
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WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed and

would report configuration log messages such as “# 565: Unable to create

object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.

WI: 53086 The IP Whitelist sets the TCP or UDP port for a given service (e.g. DNP3 over

TCP) from the configuration as it exists when the Whitelist rule is configured.

If the port is changed in the RTU configuration at some later point, it is

possible that the Whitelist may become out of sync with these values.

Workaround: Make a change to the IP whitelist configuration. This will trigger

an update from the associated TCP or UDP port configuration. 

OR

Restart the device after writing the configuration change to the device.

WI: 53436 If you change the Default DPN3 Port value, the changes to the configuration

do not take effect.

Workaround: Restart the RTU

6.11.10 Post Installation Troubleshooting

RemoteC

onnect

and Logic

Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be blocked

from reopening if previous instances of RemoteConnect or the Logic Editor

were not closed cleanly. 

Workaround: Run the Process Scrubber application, which will shut down any

remaining processes, then restart RemoteConnect.

Logic

Editor

Logic Editor is unable to communicate with SCADAPack RemoteConnect

Symptoms
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The SCADAPack x70 Logic Editor is starting, but is unable to communicate with

SCADAPack RemoteConnect. When this occurs, the Logic Editor may not

display variables that were created in the Object Editor and you may not be

able to build the application from RemoteConnect.

Steps to resolve

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they are

running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it and

select Run as administrator to open it.

3. In the command line window, change to the default installation

directory by typing one of the following commands:

64-bit systems:

cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack 11.1” 

32-bit systems:

cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message

DllRegisterServer in pserver.dll succeeded is displayed.

Logic

Editor

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library is

opened by another application when attempting to modify the logic library

Steps to resolve

Check that no instances of Unity Pro and RemoteConnect/SCADAPack x70

Logic Editor are running. Use the Process Scrubber, if necessary. If the

symptoms persist, it is likely that Windows folder permissions are incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
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5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row called

"Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.11.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is supported only on 6601
firmware 1.80.6 and later. “restart iofirm bl6601.bin <module address>” will apply bootloader
file bl6601.bin. The filename bl6601.bin is the only filename that is accepted for the bootloader.
Other file names will result in an attempt to patch the 6601 firmware and not the 6601
bootloader. The 6601 bootloader version is not reported on the command line.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.
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SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.12 SCADAPack x70 R2.3.1 Release Notes 06/9/2019

SCADAPack x70 R2.3.1 was first available in September 2019.

Upgrade Requirements

It is highly recommended that updates be installed on your SCADAPack 57x devices if using

· SCADAPack 57x firmware version 9.1.2 and earlier, or

· SCADAPack bootloader firmware version 1.10.

First, install SCADAPack 57x firmware version 9.2.1 or newer, then install SCADAPack 57x
bootloader firmware version 1.30 or newer.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware version 9.1.2 and earlier versions to firmware version 9.2.1 or
newer.

Failure to follow these instructions can result in death or serious injury.
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware version 1.10 to bootloader firmware version 1.30 or
newer. Cold boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader firmware version 1.30 corrects a start-up initialization issue and digital output
initialization issue. 

SCADAPack 57x firmware version 9.2.1 corrects an issue for users of firmware version 9.1.2 and
earlier. Logic variables T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following
an online logic modification and a SCADAPack x70 device restart.

The firmware in this release includes these corrections.

6.12.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

6.12.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.6.2

· SCADAPack DNP3 Communication DTM version is 3.6

· SCADAPack x70 Device DTM version is 3.6

· SCADAPack x70 Logic Editor version is 11.1 - 181010

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.6.2

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x firmware version is 9.3.2

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 1.80.10

6601 I/O module bootloader version is 1.80.10
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6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6.12.3 Software and Firmware Version Compatibility

RemoteConnect version 3.6.2 is intended for use with SCADAPack x70 firmware version 9.3.2.

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.12.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.12.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.12.6 SCADAPack RemoteConnect, Unity Pro, and Control Expert Compatibility

RemoteConnect installations can coexist with specific Unity Pro or Control Expert installations.
If RemoteConnect is installed on a computer that had Unity Pro or Control Expert installed
previously, the RemoteConnect installation automatically confirms that components in the
SCADAPack x70 Logic Editor and Unity Pro or Control Expert are correctly referenced. If Unity
Pro or Control Expert is installed or upgraded on a computer that already had RemoteConnect
installed, then a repair process is likely required on RemoteConnect to confirm that components
are correctly referenced. A repair process must always be Run as administrator.
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The Unity Pro or Control Expert versions that are verified as suitable for coexisting installation
with RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12.0

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure Control Expert version 14.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows French
edition. See WI: 50233  in the Known Issues section below.

6.12.7 New and Improved Features (R2.3.1)

WI: 47734

WI: 47742

Modbus master and slave diagnostics are integrated into a single

MODBUSDIAG command on the command line. The information provided by

the diagnostics is improved.

WI: 47833 Improved the RTU start up time with large DNP3 configurations.

WI: 48275 Modbus register byte order for 32-bit values (REAL, DINT, UDINT) can be

selected for Modbus/TCP Server and Modbus RTU Slave.

WI: 48377 Modbus master and slave are supported on the same serial port. Select the

Modbus port function in RemoteConnect. 

WI: 54749 Added a Licensing tab to the online mode. This tab shows all license

information for the RTU and improves the presentation of application

licenses.

WI: 55583 The Modbus/TCP port number is configurable. Previously it was fixed at 502.

WI: 56222 Added Import from Geo SCADA button on the offline logic page, advanced

section.

The following features will be used with a future Realflo release. They are visible in
RemoteConnect.

WI: 54742

WI: 54747

WI: 55730

WI: 48364

Added Realflo flow computer option in Project settings, the new file wizard,

and in the SCADAPack status page. 

When the flow computer option is enabled:

181
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· Modbus registers for Realflo flow computer use are reserved in object
configuration.

· Enron Modbus serial port parameters are available.

WI: 48371 Added support for Realflo licensing. 

6.12.8 Fixed Issues (R2.3.1)

WI: 56868 Fixed occasional loss of configuration after firmware update. Firmware prior

to version 9.3.2 generated invalid Modbus Scanner and DNP3 Data

Concentrator configurations under some circumstances. The firmware would

reject the invalid configuration after a firmware update and return to default

settings. Firmware version 9.3.2 does not produce the invalid configuration

and can identify and correct the problem when reading configurations

produced by earlier versions of firmware.

WI: 56794 RemoteConnect created duplicate variables in the Object Editor and the Logic

Editor under some circumstances. Additional checks have been added and

the user is presented with options for fixing inconsistencies when they are

detected. The “Replace Variables” command has been extended to address

the situation.

WI: 56405 Update and Build logic operations display a dialog and complete before other

functions can be selected. 

WI: 55774 Improved documentation for launching the PLC Simulator for SCADAPack

logic.

WI: 56444 Fixed an issue where the DNP3 device address was not changed after writing

a large configuration.

WI: 55683 Corrected conditions that led to invalid reports of status code 1040.

Previously this was incorrectly reported when scaling some raw integer

values into floating point engineering values. Removed the status code as it

can no longer occur.

WI: 55705 Fixed an issue where F_MKDIR Function Block did not return 0 when a

directory is successfully created.
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WI: 55829 Fixed an issue with Modbus RTU serial slave that rejected some valid

commands.

WI: 55719 Fixed an issue where importing an Excel file twice would result in duplicate

objects.

WI: 55826 Removed invalid setting for inverting digital inputs on 5000 series modules.

Inverting inputs is not supported in these modules. Previously, the invalid

setting in RemoteConnect was ignored by the firmware.

WI: 56461 Fixed RTU continuous restart with task watchdog of 0x2000 when loading

large configurations into the RTU.

WI: 56574 Fixed RTU restart with task watchdog of 0x4000 when serial data was received

on the console port during start up.

WI: 56647 Fixed RTU restart when IP_PING is called with some invalid IP addresses such

as non-nodal addresses ending in 0 (e.g. 10.2.3.0).

WI: 55599 Fixed occasional read errors with 5000 series and 6601 I/O modules during file

write operations. Previously, this could delay reading of data from the

modules. The data would be read on the next attempt. 

WI: 55598 Fixed lock up of Ethernet and USB communication during execution of some

logic applications.

WI: 56609 Added check of RemoteConnect archive file (RCZ) version. RemoteConnect

will display a message and abort opening the file if the file is from a newer

version of RemoteConnect.

6.12.9 Known Issues (R2.3.1)

Installatio

n

Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another. It

is recommended that when installing new versions of Unity Pro software that

the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 13.0, 13.1, and EcoStruxure Control Expert version 14.0.
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Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47523 Logic Editor PLC Simulator 

The Mode > Start Simulation action in the Logic Editor can take an extended

period of time to start. The PLC Simulator is started and the project is

prepared for download, but it can take up to 2 minutes for the download to

start. After the first download, subsequent uses of the PLC Simulator don't

experience this issue while the SCADAPack x70 Logic Editor and PLC simulator

remain open.

Workaround: Start the simulator manually from the Windows Programs

menu. This may take multiple attempts. After starting via the Windows

menu, it should be possible to use Mode > Start Simulation.

WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed and

would report configuration log messages such as “# 565: Unable to create

object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.

WI: 53086 The IP Whitelist sets the TCP or UDP port for a given service (e.g. DNP3 over

TCP) from the configuration as it exists when the Whitelist rule is configured.
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If the port is changed in the RTU configuration at some later point, it is

possible that the Whitelist may become out of sync with these values.

Workaround: Make a change to the IP whitelist configuration. This will trigger

an update from the associated TCP or UDP port configuration. 

OR

Restart the device after writing the configuration change to the device.

WI: 53436 If you change the Default DPN3 Port value, the changes to the configuration

do not take effect.

Workaround: Restart the RTU

48546 String input parameters for file function blocks are limited to 126 characters

in function block diagram program sections, and 254 characters in structured

text program sections due to logic editor restrictions. Animation tables

display only the first 100 characters of the strings. This is not clear in the

documentation.

Workaround: Be aware of these limitations when creating and debugging

applications.

6.12.10 Post Installation Troubleshooting

RemoteC

onnect

and Logic

Editor

Start Up

SCADAPack RemoteConnect Configuration Software start-up may be blocked

from reopening if previous instances of RemoteConnect or the Logic Editor

were not closed cleanly. 

Workaround: Run the Process Scrubber application, which will shut down any

remaining processes, then restart RemoteConnect.

Logic

Editor

Logic Editor is unable to communicate with SCADAPack RemoteConnect

Symptoms

The SCADAPack x70 Logic Editor is starting, but is unable to communicate with

SCADAPack RemoteConnect. When this occurs, the Logic Editor may not

display variables that were created in the Object Editor and you may not be

able to build the application from RemoteConnect.
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Steps to resolve

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they are

running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it and

select Run as administrator to open it.

3. In the command line window, change to the default installation

directory by typing one of the following commands:

64-bit systems:

cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack 11.1” 

32-bit systems:

cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message

DllRegisterServer in pserver.dll succeeded is displayed.

Logic

Editor

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library is

opened by another application when attempting to modify the logic library

Steps to resolve

Check that no instances of Unity Pro and RemoteConnect/SCADAPack x70

Logic Editor are running. Use the Process Scrubber, if necessary. If the

symptoms persist, it is likely that Windows folder permissions are incorrect.

Check the following:

1. With administrator privilege right-click on the following folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row called

"Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.
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The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.12.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is supported only on 6601
firmware 1.80.6 and later. “restart iofirm bl6601.bin <module address>” will apply bootloader
file bl6601.bin. The filename bl6601.bin is the only filename that is accepted for the bootloader.
Other file names will result in an attempt to patch the 6601 firmware and not the 6601
bootloader. The 6601 bootloader version is not reported on the command line.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment
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 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.13 SCADAPack x70 R2.2.2 Release Notes 10/7/2019

SCADAPack x70 R2.2.2 was first available in July 2019.

Upgrade Requirements

This release includes SCADAPack 57x bootloader and firmware updates. It is highly
recommended that these updates be installed on your SCADAPack 57x devices. 

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware 9.1.2 and earlier versions to firmware 9.2.1 or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware 1.10 to bootloader firmware 1.30 or newer. Cold
boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader 1.30 corrects a start-up initialization issue and digital output initialization issue. For
more information see WI: 53096  in the Fixed Issues section below.175
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Firmware 9.2.1 corrects an issue for users of firmware 9.1.2 and earlier. Logic variables
T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following an online logic
modification and a SCADAPack x70 device restart. For more information, see WI: 53148  in
the Fixed Issues section below.

First, install SCADAPack 57x firmware version 9.2.1, then install SCADAPack 57x bootloader
version 1.30 or newer.

6.13.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

6.13.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.5.3

· SCADAPack DNP3 Communication DTM version is 3.5

· SCADAPack x70 Device DTM version is 3.5

· SCADAPack x70 Logic Editor version is 11.1 - 181010

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.5.3

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x firmware version is 9.2.3

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 1.80.10

6601 I/O module bootloader version is 1.80.10

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

176
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6.13.3 Software and Firmware Version Compatibility

RemoteConnect version 3.5.3 is intended for use with SCADAPack x70 firmware version
9.2.1, 9.2.2, 9.2.3.

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.13.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.13.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.13.6 Unity Pro Compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, the RemoteConnect
installation automatically confirms that components in the SCADAPack x70 Logic Editor and
Unity Pro are correctly referenced. If Unity Pro is installed or upgraded on a computer that
already had RemoteConnect installed, then a repair process is likely required on
RemoteConnect to confirm that components are correctly referenced. A repair process must
always be Run as administrator.

The Unity Pro versions that are verified as suitable for coexisting installation with
RemoteConnect are:

· Unity Pro version 11.1
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· Unity Pro version 12

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure™ Control Expert (formerly known as Unity Pro) version 14.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows
(French edition). See WI: 50233 .

6.13.7 New and Improved Features (R2.2.2)

There are no updates in this release

6.13.8 Fixed Issues (R2.2.2)

WI: 55888 MODBUS Read/Write scanners associated with logic variables, performed a

write on startup before commencing periodic read operations and write-

on-change operations.

This functionality has been updated to perform read operations at startup

to update the RTU database from slave device register values. Only Forced

RTU objects are written to the MODBUS device at startup. Thereafter,

periodic read & write-on-change operations occur.

WI: 55711 RTU watchdog restarts repeatedly occurred on some Modbus Scanner

configurations due to a resource conflict between the Modbus Scanner and

a Serial Port.

The resource conflict no longer occurs.

WI: 55556 The Logic Editor could not be opened after migrating some projects from

earlier versions.

The project is now migrated successfully, after which the Logic Editor can

be opened.

6.13.9 Known Issues (R2.2.2)

Installation Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another.

181
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It is recommended that when installing new versions of Unity Pro software

that the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 11.1, 12, 13.0, 13.1, and EcoStruxure Control Expert 14.

Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47523 Logic Editor PLC Simulator 

The Mode > Start Simulation action in the Logic Editor can take an extended

period of time to start. The PLC Simulator is started and the project is

prepared for download, but it can take up to 2 minutes for the download to

start. After the first download, subsequent uses of the PLC Simulator don't

experience this issue while the SCADAPack x70 Logic Editor and PLC

simulator remain open.

Workaround: Start the simulator manually from the Windows Programs

menu. This may take multiple attempts. After starting via the Windows

menu, it should be possible to use Mode > Start Simulation.

WI:47780 Modbus master and Modbus slave diagnostics on serial connections don't

show both transmit and received messages. 

Workaround: To see the messages, enable both master and slave

diagnostics. See the MODMASTERDIAG and MODSLAVEDIAG commands.

WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed

and would report configuration log messages such as “# 565: Unable to

create object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.
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WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.

WI: 53086 The IP Whitelist sets the TCP or UDP port for a given service (e.g. DNP3 over

TCP) from the configuration as it exists when the Whitelist rule is

configured. If the port is changed in the RTU configuration at some later

point, it is possible that the Whitelist may become out of sync with these

values.

Workaround: Make a change to the IP whitelist configuration. This will

trigger an update from the associated TCP or UDP port configuration. 

OR

Restart the device after writing the configuration change to the device.

WI: 53435 If you change the Default DNP3 Port value, the changes to the configuration

do not take effect.

Workaround: Restart the RTU

6.13.10 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

Issue

SCADAPack RemoteConnect Configuration Software start-up may be

blocked from reopening if previous instances of RemoteConnect or the

Logic Editor were not closed cleanly. 

Workaround: Run the Process Scrubber application, which will shut

down any remaining processes, then restart RemoteConnect.

Logic Editor Logic Editor is unable to communicate with SCADAPack

RemoteConnect

Symptoms
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The SCADAPack x70 Logic Editor is starting, but is unable to

communicate with SCADAPack RemoteConnect. When this occurs, the

Logic Editor may not display variables that were created in the Object

Editor and you may not be able to build the application from

RemoteConnect.

Steps to resolve

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they

are running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it

and select Run as administrator to open it.

3. In the command line window, change to the default

installation directory by typing one of the following

commands:

64-bit systems:

cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack

11.1” 

32-bit systems:

cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message

DllRegisterServer in pserver.dll succeeded is displayed.

Logic Editor Issue

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library

is opened by another application when attempting to modify the logic

library

Steps to resolve

Check that no instances of Unity Pro and RemoteConnect/SCADAPack

x70 Logic Editor are running. Use the Process Scrubber, if necessary. If
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the symptoms persists, it is likely that Windows folder permissions are

incorrect.

Check the following:

1. With administrator privilege right-click on the following
folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row

called "Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.13.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is supported only on 6601
firmware 1.80.6 and later. “restart iofirm bl6601.bin <module address>” will apply bootloader
file bl6601.bin. The filename bl6601.bin is the only filename that is accepted for the bootloader.
Other file names will result in an attempt to patch the 6601 firmware and not the 6601
bootloader. The 6601 bootloader version is not reported on the command line.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.
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Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.14 SCADAPack x70 R2.2.1 Release Notes 01/05/2019

SCADAPack x70 R2.2.1 was first available in May 2019.

Upgrade Requirements

This release includes SCADAPack 57x bootloader and firmware updates. It is highly
recommended that these updates be installed on your SCADAPack 57x devices. 
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 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware 9.1.2 and earlier versions to firmware 9.2.1 or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware 1.10 to bootloader firmware 1.30 or newer. Cold
boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader 1.30 corrects a start-up initialization issue and digital output initialization issue. For
more information see WI: 53096  in the Fixed Issues section below.

Firmware 9.2.1 corrects an issue for users of firmware 9.1.2 and earlier. Logic variables
T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following an online logic
modification and a SCADAPack x70 device restart. For more information, see WI: 53148  in
the Fixed Issues section below.

First, install SCADAPack 57x firmware version 9.2.1, then install SCADAPack 57x bootloader
version 1.30 or newer.

6.14.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

6.14.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.5.2

· SCADAPack DNP3 Communication DTM version is 3.5

· SCADAPack x70 Device DTM version is 3.5

· SCADAPack x70 Logic Editor version is 11.1 - 181010

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.5.2

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

175

176
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SCADAPack 57x firmware version is 9.2.2

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 1.80.10

6601 I/O module bootloader version is 1.80.10

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6.14.3 Software and Firmware Version Compatibility

RemoteConnect version 3.5.2 is intended for use with SCADAPack x70 firmware version
9.2.1 or 9.2.2

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.14.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.14.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)
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Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.14.6 Unity Pro Compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, the RemoteConnect
installation automatically confirms that components in the SCADAPack x70 Logic Editor and
Unity Pro are correctly referenced. If Unity Pro is installed or upgraded on a computer that
already had RemoteConnect installed, then a repair process is likely required on
RemoteConnect to confirm that components are correctly referenced. A repair process must
always be Run as administrator.

The Unity Pro versions that are verified as suitable for coexisting installation with
RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure™ Control Expert (formerly known as Unity Pro) version 14.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows
(French edition). See WI: 50233 .

6.14.7 New and Improved Features (R2.2.1)

WI: 55071

A hotfix is provided on the RemoteConnect R2.2.1 DVD to add the function IS_PAR_CON to the
SCADAPack x70 logic library. This function is compatible with the Unity Pro / Control Expert
function of the same name. It is used in DFBs to determine, for a DFB instance in a program
section, whether the user has connected a variable to the specified parameter (pin) of the DFB
instance. The IS_PAR_CON function is not installed automatically. 

If this function is required in logic, you can install the hotfix from the RemoteConnect DVD menu.

6.14.8 Fixed Issues (R2.2.1)

WI: 54733 Logic source written from the logic editor could not be read from the RTU.

This is corrected. Additional diagnostics were added to the firmware.

WI: 55025 A missing I/O module (5000 series or 6601) resulted in loss of

communication with other I/O modules.

181
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WI: 55026 I/O communication did not recover after loss of communication to a 5000

series or 6601 I/O module.

WI: 55061 6601 firmware could not be updated, and the I/O module remained in the

bootloader state after attempting to update the module.

6.14.9 Known Issues (R2.2.1)

Installation Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another.

It is recommended that when installing new versions of Unity Pro software

that the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 11.1, 12, 13.0, 13.1, and EcoStruxure Control Expert 14.

Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47523 Logic Editor PLC Simulator 

The Mode > Start Simulation action in the Logic Editor can take an extended

period of time to start. The PLC Simulator is started and the project is

prepared for download, but it can take up to 2 minutes for the download to

start. After the first download, subsequent uses of the PLC Simulator don't

experience this issue while the SCADAPack x70 Logic Editor and PLC

simulator remain open.

Workaround: Start the simulator manually from the Windows Programs

menu. This may take multiple attempts. After starting via the Windows

menu, it should be possible to use Mode > Start Simulation.

WI:47780 Modbus master and Modbus slave diagnostics on serial connections don't

show both transmit and received messages. 

Workaround: To see the messages, enable both master and slave

diagnostics. See the MODMASTERDIAG and MODSLAVEDIAG commands.
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WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed

and would report configuration log messages such as “# 565: Unable to

create object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.

WI: 53086 The IP Whitelist sets the TCP or UDP port for a given service (e.g. DNP3 over

TCP) from the configuration as it exists when the Whitelist rule is

configured. If the port is changed in the RTU configuration at some later

point, it is possible that the Whitelist may become out of sync with these

values.

Workaround: Make a change to the IP whitelist configuration. This will

trigger an update from the associated TCP or UDP port configuration. 

OR

Restart the device after writing the configuration change to the device.

WI: 53435 If you change the Default DPN3 Port value, the changes to the configuration

do not take effect.

Workaround: Restart the RTU
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6.14.10 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

Issue

SCADAPack RemoteConnect Configuration Software start-up may be

blocked from reopening if previous instances of RemoteConnect or the

Logic Editor were not closed cleanly. 

Workaround: Run the Process Scrubber application, which will shut

down any remaining processes, then restart RemoteConnect.

Logic Editor Logic Editor is unable to communicate with SCADAPack

RemoteConnect

Symptoms

The SCADAPack x70 Logic Editor is starting, but is unable to

communicate with SCADAPack RemoteConnect. When this occurs, the

Logic Editor may not display variables that were created in the Object

Editor and you may not be able to build the application from

RemoteConnect.

Steps to resolve

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they

are running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it

and select Run as administrator to open it.

3. In the command line window, change to the default

installation directory by typing one of the following

commands:

64-bit systems:

cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack

11.1” 

32-bit systems:

cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll
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When the registration is complete, a dialog box with the message

DllRegisterServer in pserver.dll succeeded is displayed.

Logic Editor Issue

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library

is opened by another application when attempting to modify the logic

library

Steps to resolve

Check that no instances of Unity Pro and RemoteConnect/SCADAPack

x70 Logic Editor are running. Use the Process Scrubber, if necessary. If

the symptoms persists, it is likely that Windows folder permissions are

incorrect.

Check the following:

1. With administrator privilege right-click on the following
folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row

called "Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.14.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.
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6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is supported only on 6601
firmware 1.80.6 and later. “restart iofirm bl6601.bin <module address>” will apply bootloader
file bl6601.bin. The filename bl6601.bin is the only filename that is accepted for the bootloader.
Other file names will result in an attempt to patch the 6601 firmware and not the 6601
bootloader. The 6601 bootloader version is not reported on the command line.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations
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X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.15 SCADAPack x70 R2.2 Release Notes 01/03/2019

SCADAPack x70 R2.2 was first available in March 2019.

Upgrade Requirements

This release includes SCADAPack 57x bootloader and firmware updates. It is highly
recommended that these updates be installed on your SCADAPack 57x devices. 

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack firmware 9.1.2 and earlier versions to firmware 9.2.1 or newer.

Failure to follow these instructions can result in death or serious injury.

 WARNING

UNINTENDED EQUIPMENT OPERATION

Upgrade SCADAPack bootloader firmware 1.10 to bootloader firmware 1.30 or newer. Cold
boot the SCADAPack device following the upgrade.

Failure to follow these instructions can result in death or serious injury.

Bootloader 1.30 corrects a start-up initialization issue and digital output initialization issue. For
more information see WI: 53096  in the Fixed Issues section below.

Firmware 9.2.1 corrects an issue for users of firmware 9.1.2 and earlier. Logic variables
T_SPx70_INT and T_SPx70_UINT may indicate incorrect values following an online logic
modification and a SCADAPack x70 device restart. For more information, see WI: 53148  in
the Fixed Issues section below.

First, install SCADAPack 57x firmware version 9.2.1, then install SCADAPack 57x bootloader
version 1.30 or newer.

6.15.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

175

176
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6.15.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.5.1

· SCADAPack DNP3 Communication DTM version is 3.5

· SCADAPack x70 Device DTM version is 3.5

· SCADAPack x70 Logic Editor version is 11.1 - 181010

· Schneider Electric Generic HART DTM version is 5.1.1189.11

· HART STB Multiplexer Communication DTM version is 1.0.8.0

· SCADAPack x70 English Documentation version is 3.5.1

· SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x firmware version is 9.2.1

SCADAPack 57x bootloader version is 1.30

6601 I/O module firmware version is 1.80.10

6601 I/O module bootloader version is 1.80.10

6602 I/O module firmware version is 1.81.2

6602 I/O module bootloader version is 1.81.2

6.15.3 Software and Firmware Version Compatibility

RemoteConnect version 3.5.1 is intended for use with SCADAPack x70 firmware version
9.2.1

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS
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RemoteConnect versions R2.0 and later are not compatible with projects created with
RemoteConnect versions R1.6 and earlier.

See the release notes for RemoteConnect version 2.0 in the documentation for more
instructions. 

Failure to follow these instructions can result in equipment damage.

6.15.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.15.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2016

6.15.6 Unity Pro Compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, the RemoteConnect
installation automatically confirms that components in the SCADAPack x70 Logic Editor and
Unity Pro are correctly referenced. If Unity Pro is installed or upgraded on a computer that
already had RemoteConnect installed, then a repair process is likely required on
RemoteConnect to confirm that components are correctly referenced. A repair process must
always be Run as administrator.

The Unity Pro versions that are verified as suitable for coexisting installation with
RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12

· Unity Pro version 13.0*

· Unity Pro version 13.1*

· EcoStruxure™ Control Expert (formerly known as Unity Pro) version 14.0

* RemoteConnect has a known issue with Unity Pro version 13.0 and 13.1 on Windows
(French edition). See WI: 50233 .181
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6.15.7 New and Improved Features (R2.2)

Excel Import and Export

Improved the Excel Import from File and Export to File feature: provided a new format, added
more configuration parameters to the exported file, and provided confirmation information in
RemoteConnect after importing the Excel file. 

Forcing Object Values

Added a forcing mechanism to let you override data in the SCADAPack x70 device database so
that you can set data to a required state or value (for example, during commissioning or
maintenance activities).

Object Browser Presets

Added a preset mechanism to let you configure an online browser list with optional preset values
for each object. This allows you to build browser lists for rapid deployment of value sets to
database objects (for example, during commissioning or maintenance activities). The preset
values are stored along with the browser lists in the RemoteConnect project, and as well in the
RTU configuration which can be read back from a SCADAPack device.

Hold Outputs on Logic Stop

Added parameters that allow you to influence the state of outputs when a logic application
transitions from RUN to a STOP or HALT state.  

Logic and Logic Editor

Added Help on Type for SCADAPack x70 function blocks. Added System Status Words %
SW54 to %SW58.

Modbus Protocols

Added new protocols to the Modbus master scanner for Modbus RTU over TCP and Modbus
RTU over UDP. Modbus/TCP inactivity timeout to terminate a connection is now configurable. 

6.15.8 Miscellaneous Improvements (R2.2)

WI: 47620 Exposed RTU's unsolicited state to System Data

WI: 47702 Revised the default Serial Port functions

WI: 47810 STATUS LED indicates an I/O module alert
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WI: 47925 Modbus scanner configuration parser rejects invalid variable size /

function code combinations.

WI: 48175 Added system data fields SYS_SET_DNP3M_StopPollingIfFull and

SYS_SET_DNP3S_DiscardEvntsIfFull.

WI: 49124 Added release notes history to documentation. The release notes shown

during installation now describe the current release, and do not include

history.

WI: 49142 Improved documentation for IP Whitelist to state “When changes are

made to the IP Whitelist settings, the device may temporarily lose

connectivity as the firewall is reconfigured. Some TCP/IP connections may

need to be re-established.”

WI: 50131 Provided support for Windows 10 Professional builds 1803 and 1809

WI: 50160 Updated technical support contact information and website in About

dialog and Installer.

WI: 50172 Added a pop-up dialog in the x70 DTM for 'Corrupt Configuration' and

'Device Trouble' indications

WI: 50196 Added a tooltip to the project settings Slave address custom field option to

let the user know that selecting the option can cause loss of data in

Custom fields of logic variables.

WI: 50197 Online modification notifications are not shown for the Logic Editor

Simulator.

WI: 50214 Added a 'Do not show this message again' option to the Write confirmation

popup in the Object Browser.

WI: 50229 Updated the Start menu organization for compatibility with Windows 10

WI: 50251 RemoteConnect DNP3 > Slave > Events Advanced section has a new

checkbox control for "Discard New Events if Buffer Full"

WI: 50264

WI: 50366

DNP3 Point Data Class Object Table organization includes a None grouping

and can be organized by DNP3 Point Data Class.

WI: 50310 Removed SCADAPack 57x modules from the list of configurable I/O

modules. A permanent SCADAPack 57x module is added to the project

based on the controller type and cannot be deleted.
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WI: 50461 Read File from Device provides more control over the source file and

destination file

WI: 50658 RemoteConnect provides more automatic DNP3 and Modbus point number

assignment options when creating copies of objects.

WI: 51037 Added “Slave Address(es) in Logic Editor Custom Field” to the Project

Settings dialog to allow you to view DNP3 point numbers and/or Modbus

register addresses in the Logic Editor.  

WI: 53249 A message reporting a hardware condition or invalid configuration in the

SCADAPack device is now displayed as a banner at the top of the

RemoteConnect online pages and not as a pop-up message.  

WI: 54058 Removed CLEAR CONFIG command option.

WI: 54069 The cold boot and factory boot default configurations now include the

SYS_CODE_StatusCode.

6.15.9 Fixed Issues (R2.2)

WI: 53096 Bootloader version 1.30 for SCADAPack 57x corrects a start up initialization

issue and digital output issue. 

Bootloader 1.10 can result in the SCADAPack devices not booting, resetting

after booting, or in loaded configurations and programs not executing as

expected. It is highly recommended that the bootloader be upgraded on

SCADAPack 57x devices. Bootloader 1.20 corrects this issue.

Bootloader 1.20 and earlier versions turn on the SCADAPack 57x device

DOUT digital output for 2 to 3 seconds at power up or reset. It is highly

recommended that the bootloader be upgraded if the DOUT digital output

is used or will be used on the device. Bootloader 1.30 corrects this issue.

To upgrade bootloader 1.10 or earlier to version 1.30

1. Back up the configuration.

2. Place the system in a safe state. The SCADAPack device will reset as
part of this procedure.

3. Install SCADAPack 57x firmware version 9.2.1 or newer.

4. Install SCADAPack 57x bootloader version 1.30. 
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5. Cold boot the SCADAPack device.

6. Reload the configuration from the backup.

7. Restore the system to operation.

To upgrade bootloader 1.20 to version 1.30

1. Place the system in a safe state. The SCADAPack device will reset as
part of this procedure.

2. Install SCADAPack 57x firmware version 9.2.1 or newer.

3. Install SCADAPack 57x bootloader version 1.30.

4. Restore the system to operation.

WI: 53148 Firmware 9.1.2 and earlier may experience logic running with an

incomplete logic configuration. This occurs if an online modification is

made, the user ignores the RemoteConnect message indicating the logic

application must be written to the SCADAPack device, and the SCADAPack

device is reset or power is cycled. In this situation logic inputs may have

incorrect values and outputs can be written to incorrect values. This issue

was corrected in firmware 9.1.3.

Users that upgraded from firmware 9.1.2 to firmware 9.1.3 may experience

the behaviour above if condition was present at the time of the upgrade. It

is necessary to write the logic application prior to or following the upgrade.

Additional checks of logic variable DDT versions were added in version

9.2.1. SCADAPack 57x firmware version 9.2.1 reports a new system status

code (5013) and doesn’t start the logic application if the DDT versions are

not valid. To resolve status code 5013, rewrite the configuration to the

SCADAPack 57x device after the firmware upgrade.

WI: 47514 System > System Status specific task library function blocks are now

supported in the logic editor: SYST_READ_FLOAT_STATUS,

SYST_READ_TASK_BIT, SYST_RESET_TASK_BIT and SYST_TIME

WI: 47515 Types Library Update didn't operate when you changed the Installation

Path

WI: 47524 “Error allocating PAT memory space” reported when launching PLC

Simulator in x70 Logic Editor

WI: 47539 The Function Input Assistant in Logic Editor could not be closed on a single

screen if previously opened on a multiple screen system.
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WI: 47542 Fixed logic editor exception caused by opening a Derived Function Block

(selecting Refine on the FB Instance), then selecting a private variable, and

trying to Initialize an Animation Table.

WI: 47623 SYS_CLOCK System Objects were not updated after a time change to PC

Local Time

WI: 47631 Irregular events generated instead of Periodic Events on System Data

WI: 47644 Device restarted with restart reason 0x4206 and watchdog 0x10000080

(DNP3 task and Modbus Scanner task) when writing configuration to the

device.

WI: 47645 The logic application is not run if the device configuration is corrupted due

to a discharged battery on the device.

WI: 47666 Modbus Serial Master function block stopped polling when serial port baud

rate changed.

WI: 47701 Configuration of Maximum Event Storage was read incorrectly while new

configuration was being applied.

WI: 47703 Physical 6601 Counters were not initialized on the SCADAPack 575 RTU.

WI: 47707 DNP3 g10v2 objects for DNP3 point 0 were not reported in an integrity poll. 

WI: 47709 There was no report if a license could not be applied because the file

system had no remaining space to store the license.

WI: 47711 System status code 1036 (backup license file missing) was reported after

loading new firmware.

WI: 47715 Group50Var1 (Time and Date - absolute time) object write requests did not

reject some invalid requests. 

WI: 47744 Device could restart with restart reason 0x4200 and Watchdog mask 0x0010

after write configuration with Serial 3 or 4 changed to Modbus, RS485,

115200.

WI: 47747 For some date changes, logic system status words %SW49 (day of week)

and %SW70 (week of year) were incorrect after device restart.

WI: 47779 Some diagnostic messages were still reported after turning off diagnostics

with the modslavediag disable * command.
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WI: 47788 Modbus RTU transmissions could have gaps longer than 3.5 character-

times, which could cause some Modbus devices to reject the messages.

WI: 47804 CAPITALISED commands on command line were rejected.

WI: 47809 Updating 6601 I/O firmware on a system with 4 or more I/O modules was

unreliable.

WI: 47818 Rounding in USB drive free size measurement reported on command line

was incorrect.

WI: 47823 USB drive statistics were incorrect for drives larger than 16 GB.

WI: 47831 USB drive information did not update after the drive was removed. The

correct state is now reported. The update is performed every 60 seconds.

Old information may be reported for up to 60 seconds after the drive is

removed, inserted, or updated.

WI: 47838 The whoami command displayed incorrect information about the licensed

services after applying the license but before restart of the RTU.

WI: 47852 The I/O bus occasionally reported incorrect checksums when multiple 6601

I/O modules were connected. Invalid messages are correctly rejected, and

the operation retries on the next I/O scan. The response time to an input or

output change increases slightly when an incorrect checksum is detected.

WI: 47964 ATTRIB_ValueString constant was incorrectly set to 105. The correct value

of 138 is now used.

WI: 48074 The SCADAPack device USB port could take over 70 seconds to be detected

by Windows following a SCADAPack x70 device restart. This time has been

reduced to less than 20 seconds, unless the SCADAPack x70 device was cold

booted. 

WI: 48409 Logic application halted when clock management function blocks from the

System > SysClock library were used in the logic. These function blocks

were not implemented in earlier firmware versions.

WI: 48419 The Modbus scanner did not revert the database value in response to an

unsuccessful write (an exception response from the remote device). The

database value now reverts to the previous value if the write is

unsuccessful.
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WI: 48533 PPP dynamic reconfiguration required a device restart to apply the

configuration. Configuration no longer requires a device restart.

WI: 49059 Device reconfiguration caused a memory leak and processor exception

when memory was low. This was observed on a system using about 98% of

available memory.

WI: 49107 Function block Help on Type feature in the logic editor did not work with

SCADAPack x70 > RTU System library function blocks. These now display

help in a web page. 

WI: 49155 System Status Double Words %SD18 and %SD20 are now supported.

WI: 50184 An incorrect logic variable type for SYS_INFO_CPUmoduleTempC could

hang RemoteConnect. 

WI: 50213 DNP3 and Modbus parameters were incorrectly configured when using

custom templates in logic editor.

WI: 50255 Launching help using F1 could block use of RemoteConnect.

WI: 50261 Enabled Modbus IP Services information in whoami command was

inconsistent

WI: 50262 Elementary Variables and Derived Variables may be cleared in x70 Logic

when creating a new object in RemoteConnect.

WI: 50269 Online/Offline button was out of sync after canceling a write operation

with a large number of logic objects

WI: 50287 Deleting Scanner and keeping objects deleted object groups. Now when an

Object Association is cleared, and the Object is not deleted, only the

association-related attributes are cleared. The group name is left as is.

WI: 50785 Default Scan Rates for Modbus were too short for some common

applications. 

WI: 51167 Control validation tooltips were displayed in English regardless of the

language setting.

WI: 51742 Logic debugger's indication of online connection was inconsistent if

communication path changed when connected.
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WI: 52826 RemoteConnect R2.1.1 froze when using Copy Objects from Object

Configuration pane.

WI: 53501 Corrected DNP3 Data Concentrator sessions handling under high

communications load.

WI: 53773 Logic status was not updated when the backup file was not present, which

was not correct. The logic status is now updated by default, then updated

again if the backup is present.

WI: 53829 Writing a default project twice could cause RemoteConnect to lock up.

WI: 53986 Documentation about adding 16 I/O modules should have stated 15 I/O

modules. There are 16 I/O module entries available including the I/O on

the SCADAPack device.

WI: 54014 6602 I/O module resets every 1 minute when 24 Vdc applied at power up.

6.15.10 Known Issues (R2.2)

Installation Unity Pro installation compatibility

The SCADAPack RemoteConnect Configuration Software installation process

and Unity Pro software installation process can interfere with one another.

It is recommended that when installing new versions of Unity Pro software

that the repair installation option be run for SCADAPack RemoteConnect.

Coexisting installations of RemoteConnect and Unity Pro are supported for

Unity Pro versions 11.1, 12, 13.0, 13.1, and EcoStruxure Control Expert 14.

Workaround: Repair the installations as mentioned above. Remember to

“Run as administrator” when doing a Repair.

When installing new versions of SCADAPack RemoteConnect, the installer

will automatically attempt a Repair on Unity Pro software.

WI: 47523 Logic Editor PLC Simulator 

The Mode > Start Simulation action in the Logic Editor can take an extended

period of time to start. The PLC Simulator is started and the project is

prepared for download, but it can take up to 2 minutes for the download to

start. After the first download, subsequent uses of the PLC Simulator don't

experience this issue while the SCADAPack x70 Logic Editor and PLC

simulator remain open.
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Workaround: Start the simulator manually from the Windows Programs

menu. This may take multiple attempts. After starting via the Windows

menu, it should be possible to use Mode > Start Simulation.

WI:47780 Modbus master and Modbus slave diagnostics on serial connections don't

show both transmit and received messages. 

Workaround: To see the messages, enable both master and slave

diagnostics. See the MODMASTERDIAG and MODSLAVEDIAG commands.

WI: 47824 del * command leaves some files on a USB drive when there are many files

on the drive. 

Workaround: Repeat the command until the files are removed.

OR

Connect the USB drive to a PC (or other computer) and delete the files.

WI: 47841 When reconfiguring a SCADAPack RTU from one large configuration to

another large configuration, the configuration rebuild might not succeed

and would report configuration log messages such as “# 565: Unable to

create object due to insufficient configuration memory space”.

Workaround: Cold boot the RTU before applying the new configuration.

Alternatively, apply a configuration with a very small number of objects and

restart the RTU. The new large configuration should then be accepted.

WI: 50233 Installing Unity Pro v13.0 or v13.1 on Windows (French edition) followed by

RemoteConnect installs shortcuts to All programs > Schneider Electric >

SoCollaborative > Unity Pro for both Unity Pro and SCADAPack Logic

applications. 

Workaround: Identify, from the shortcut path properties, which shortcuts

relate to SCADAPack Logic.

WI: 53063 A change in master connection addressing information (DNP3 slave address

or DNP3 master address) can result in unsolicited messages not being

reported if a DNP3 routing table entry for the new address pair is not

present.

Workaround: Update or add a DNP3 route for the new DNP3 address pair

and use the RemoteConnect ‘Restart DNP3’ function to activate the

modified configuration
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WI: 53086 The IP Whitelist sets the TCP or UDP port for a given service (e.g. DNP3 over

TCP) from the configuration as it exists when the Whitelist rule is

configured. If the port is changed in the RTU configuration at some later

point, it is possible that the Whitelist may become out of sync with these

values.

Workaround: Make a change to the IP whitelist configuration. This will

trigger an update from the associated TCP or UDP port configuration. 

OR

Restart the device after writing the configuration change to the device.

WI: 53435 If you change the Default DPN3 Port value, the changes to the configuration

do not take effect.

Workaround: Restart the RTU

6.15.11 Post Installation Troubleshooting

RemoteConnect

and Logic Editor

Start Up

Issue

SCADAPack RemoteConnect Configuration Software start-up may be

blocked from reopening if previous instances of RemoteConnect or the

Logic Editor were not closed cleanly. 

Workaround: Run the Process Scrubber application, which will shut

down any remaining processes, then restart RemoteConnect.

Logic Editor Logic Editor is unable to communicate with SCADAPack

RemoteConnect

Symptoms

The SCADAPack x70 Logic Editor is starting, but is unable to

communicate with SCADAPack RemoteConnect. When this occurs, the

Logic Editor may not display variables that were created in the Object

Editor and you may not be able to build the application from

RemoteConnect.

Steps to resolve

Register pserver.dll as described below
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1. Close the Logic Editor and RemoteConnect applications if they

are running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it

and select Run as administrator to open it.

3. In the command line window, change to the default

installation directory by typing one of the following

commands:

64-bit systems:

cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack

11.1” 

32-bit systems:

cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message

DllRegisterServer in pserver.dll succeeded is displayed.

Logic Editor Issue

Logic editor or Types Library update tool library modification

Symptoms

SCADAPack Logic Editor or Types Library Update tool reports the library

is opened by another application when attempting to modify the logic

library

Steps to resolve

Check that no instances of Unity Pro and RemoteConnect/SCADAPack

x70 Logic Editor are running. Use the Process Scrubber, if necessary. If

the symptoms persists, it is likely that Windows folder permissions are

incorrect.

Check the following:

1. With administrator privilege right-click on the following
folder: 
C:\ProgramData\Schneider Electric

2. Select Properties.
3. Select the Security tab.
4. Click Edit.
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5. Click on the Users entry in the Group or user names section.
6. Scroll down the Permissions for Users area until you see a row

called "Write".
7. Check the box in the "Allow" column for the "Write" row.
8. Click OK.

The security settings will update on the sub-folders.

9. Click OK to exit the Properties dialog.

6.15.12 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is supported only on 6601
firmware 1.80.6 and later. “restart iofirm bl6601.bin <module address>” will apply bootloader
file bl6601.bin. The filename bl6601.bin is the only filename that is accepted for the bootloader.
Other file names will result in an attempt to patch the 6601 firmware and not the 6601
bootloader. The 6601 bootloader version is not reported on the command line.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

For information on SCADAPack 57x firmware versions 9.03 or earlier, refer to the
RemoteConnect R2.0 release notes in the documentation. 

Failure to follow these instructions can result in equipment damage.

A new calibration format for 6601 analog inputs has been added to support extended over-range
capabilities. Interoperability of various versions of firmware and calibration is described below.
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SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

6.16 SCADAPack x70 R2.1.1 Release Notes 25/10/2018

SCADAPack x70 R2.1.1 was first available in October 2018.

6.16.1 Installation Requirements, Instructions, and Troubleshooting

Refer to “Software Installation.pdf” located both at the root of the folder that contains the
installation files and in the documentation set that is installed with RemoteConnect.

6.16.2 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.4.3

SCADAPack x70 English Documentation version is 3.4.3

SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x Firmware version is 9.1.3

6601 I/O module firmware version 1.80.10

6601 I/O module bootloader version 1.80.10

6602 I/O module firmware version 1.77.64
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6602 I/O module bootloader version 1.77.64

6.16.3 Software and Firmware Version Compatibility

RemoteConnect version 3.4.3 is intended for use with SCADAPack x70 firmware version
9.1.3

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

6.16.4 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.16.5 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2012 R2

Windows Server 2016

6.16.6 Unity Pro Compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, the RemoteConnect
installation automatically confirms that all components in the SCADAPack x70 Logic Editor and
Unity Pro are correctly referenced. If Unity Pro is installed or upgraded on a computer that
already had RemoteConnect installed, then a “repair” process is likely required on
RemoteConnect to confirm that all components are correctly referenced. A “repair” process must
always be “Run as administrator”.

The Unity Pro versions that are verified as suitable for coexisting installation with
RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12

· Unity Pro version 13
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6.16.7 Removing Unused Function Blocks

After you click Update & Build Logic on the SCADAPack x70 Logic page, the SCADAPack
x70 Logic Editor may display an error that a function block is not in the library. This situation
can occur if you have an existing project that contains EFBs that are no longer in the latest
custom library. You will need to rework your logic application to resolve the issues and remove
the function blocks that are no longer in the custom library. 

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

When you remove elementary function blocks and derived function blocks, the project will no
longer perform as it did in the past. 

You will need to add new function blocks to update the logic application.

Failure to follow these instructions can result in equipment damage.

To remove function blocks that are no longer in the custom library

1. In the SCADAPack x70 Logic Editor, remove the EFBs from your project that are causing the
errors. 

2. Navigate to Project > Variables & FB Instances > Elementary FB Instances and double-
click to open. 

3. In the Data Editor, delete the function block(s). 

4. Navigate to Tools > Types Library Manager > Application and right-click on any item.

5. Select Purge Unused Types. 

The project is updated and linking to EFBs that were in the project, but no longer in the custom
library, is cleaned up.

6.16.8 Fixed Issues (R2.1.1)

· Feature Affected: Modbus Scanner

Issue: The Modbus scanner did not write values when configured to write On change. Values
were written at the scan rate when configured to write At scan rate or On change and at scan
rate.
Resolution: Values are written when a change is detected when configured to write On
change.

Engineering reference: FUN-1471

· Feature Affected: DNP3 File Transfer
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Issue: A cancelled DNP3 file transfer would block subsequent transfers until the original file
transfer timed out.
Resolution: The subsequent transfer is no longer blocked.

Engineering reference: FUN-1367

· Feature Affected: Modbus Scanner

Issue: Modbus Scanner didn’t start after firmware patch and writing configuration.
Resolution: The Modbus Scanner restarts after firmware patch and writing configuration.

Engineering reference: FUN-1455

· Feature Affected: Modbus Serial Master and Slave

Issue: Modbus serial task can deadlock when a new configuration is applied and a Modbus
slave request is received.
Resolution: The Modbus serial task restarts after a configuration is applied.

Engineering reference: FUN-1495

· Feature Affected: Force LED

Issue: The Force LED turns on incorrectly after a firmware upgrade when no variables are
forced due to T_SPx70_INT and T_SPx70_UINT analog forcing, which was removed in R2.1.
Resolution: The Force LED turns on when variables are forced.

Engineering reference: FUN-1503

· Feature Affected: RemoteConnect project export

Issue: After opening an archived project upgraded from R1.6 to R2.1, the project cannot be
exported without making a change to the project.
Resolution: The project can now be exported without making a change

Engineering reference: RSC-2721

· Feature Affected: RemoteConnect project management

Issue: Opening and closing an unmodified program from an older version of RemoteConnect
results in "There are unapplied changes in the project" message.
Resolution: The project is no longer marked as modified until a modification is made by the
user.

Engineering reference: RSC-2743
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· Feature Affected: RemoteConnect Read from Device

Issue: The Source Details column in the Object Configuration view is empty after reading
from a SCADAPack device. The information is available from the pop-up dialog but not in the
table.
Resolution: The information read from the device is now displayed.

Engineering reference: RSC-2765

· Feature Affected: RemoteConnect Communication Settings

Issue:  When a configuration is written to a SCADAPack device with a changed DNP3
address, RemoteConnect does not reconnect to the device with the new DNP3 address.
Resolution: The new DNP3 address is now used.

Engineering reference: RSC-2769

· Feature Affected: HART Documentation

Issue: A user must wait 30 seconds before reconnecting a HART device when moving it from
one channel to another. This allows the host enough time to recognize that the device is
disconnected. 
Resolution: Added a procedure for disconnecting and reconnecting a HART device to the
documentation.

Engineering reference: DSUM-1049

6.16.9 Known Issues/ Known Customer Difficulties (R2.1.1)

See the section Known Issues / Known Customer Difficulties (R2.1) later in this document.

6.16.10 Post Installation Troubleshooting

Logic Editor is unable to communicate with SCADAPack RemoteConnect

Symptoms: 

The SCADAPack x70 Logic Editor is starting, but is unable to communicate with SCADAPack
RemoteConnect. When this occurs, the Logic Editor may not display variables that were created
in the Object Editor and you may not be able to build the application from RemoteConnect.

Steps to resolve:

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they are running on the PC.
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2. In the Windows menu, search for cmd.exe then right-click on it and select Run as
administrator to open it.

3. In the command line window, change to the default installation directory by typing one of the
following commands:

64-bit systems: cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack 11.1” 

32-bit systems: cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message DllRegisterServer in
pserver.dll succeeded is displayed.

Logic editor or Types Library update tool library modification

Symptoms:

SCADAPack Logic Editor or Types Library Update tool reports the library is opened by another
application when attempting to modify the logic library

Steps to resolve:

Check that no instances of Unity Pro and RemoteConnect/SCADAPack x70 Logic Editor are
running. Use the "Process Scrubber" if necessary. If the problem persists it is likely a Windows
folder permissions problem.

Check the following:

· With administrator privilege right click on the following folder: C:\ProgramData\Schneider
Electric

· Select Properties

· Select the Security tab

· Click Edit

· Click on the Users entry in the Group or user names section

· Scroll down the Permissions for Users area until you see a row called "Write"

· Check the box in the "Allow" column for the "Write" row

· Click OK

· The security settings will update on all the sub-folders

· Click OK to exit the Properties dialog

Engineering reference: DSUM-919
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6.16.11 SCADAPack 57x and 6601 Firmware Version Compatibility

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is only supported on
device firmware 9.0.4 and later and 6601 firmware 1.80.6 and later. “restart iofirm bl6601.bin
<module address>” will apply bootloader file bl6601.bin. The filename bl6601.bin is the only
filename that is accepted for the bootloader. Other file names will result in an attempt to patch
the 6601 firmware and not the 6601 bootloader. The 6601 bootloader version is not reported on
the command line.

SP57x minimum firmware version: If there is an attached 6601 or a built-in 6601 (SP575) the
device firmware version should be 9.0.4 or later.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use SP570 or SP575 9.0.3 or earlier firmware in conjunction with a 6601 1.80.6 or later
with extended over-range calibration. They are not compatible. 

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

Failure to follow these instructions can result in equipment damage.

A new version of 6601 I/O module firmware and bootloader has been released since the release
of SP57x firmware 9.0.3. A new calibration format for 6601 analog inputs has been added to
support extended over-range capabilities. Interoperability of various versions of firmware and
calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment
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 9.0.3 or
earlier

1.77.1
31 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.3 or
earlier

1.80.0
6 or
later

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

6601 I/O modules upgraded to
1.80.6 from earlier versions will
leave calibration unchanged.
Recommended for upgrading
systems that do not require
extended over-range capabilities.

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.3 or
earlier

1.77.
131 or
earlier

0…22
mA

AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.3 or
earlier

1.80.0
6 or
later

0…22mA AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. When
adding new 6601 I/O modules to
existing systems, SP57x
firmware should be upgraded to
9.0.4 or later. If this is not
practical, contact Schneider
Electric technical support.
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6.17 SCADAPack x70 R2.1 Release Notes 5/09/2018

SCADAPack x70 R2.1 is a version, first available in September 2018.

6.17.1 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.4.2

SCADAPack x70 English Documentation version is 3.4.2

SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x Firmware version is 9.1.2

6601 I/O module firmware version 1.80.10

6601 I/O module bootloader version 1.80.10

6602 I/O module firmware version 1.77.64

6602 I/O module bootloader version 1.77.64

6.17.2 Software and Firmware Version Compatibility

RemoteConnect version 3.4.2 is intended for use with SCADAPack x70 firmware version
9.1.2

As of R2.0 and newer, RemoteConnect and SCADAPack 57x firmware is cross compatible with
future software and firmware releases. This compatibility is limited to features common to the
version of software and firmware available. Unknown feature configurations are parsed and do not
block reconfiguration, though the features themselves may be unavailable.

6.17.3 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.17.4 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)
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Windows Server 2012 R2

Windows Server 2016

6.17.5 Unity Pro compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, the RemoteConnect
installation automatically confirms that all components in the SCADAPack x70 Logic Editor and
Unity Pro are correctly referenced. If Unity Pro is installed or upgraded on a computer that
already had RemoteConnect installed, then a “repair” process is likely required on
RemoteConnect to confirm that all components are correctly referenced. A “repair” process must
always be “Run as administrator”.

The Unity Pro versions that are verified as suitable for coexisting installation with
RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12

· Unity Pro version 13

6.17.6 Removing Unused Function Blocks

After you click Update & Build Logic on the SCADAPack x70 Logic page, the SCADAPack
x70 Logic Editor may display an error that a function block is not in the library. This situation
can occur if you have an existing project that contains EFBs that are no longer in the latest
custom library. You will need to rework your logic application to resolve the issues and remove
the function blocks that are no longer in the custom library. 

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

When you remove elementary function blocks and derived function blocks, the project will no
longer perform as it did in the past. 

You will need to add new function blocks to update the logic application.

Failure to follow these instructions can result in equipment damage.

To remove function blocks that are no longer in the custom library

1. In the SCADAPack x70 Logic Editor, remove the EFBs from your project that are causing the
errors. 

2. Navigate to Project > Variables & FB Instances > Elementary FB Instances and double-
click to open. 

3. In the Data Editor, delete the function block(s). 

4. Navigate to Tools > Types Library Manager > Application and right-click on any item.



3.10.3

x70 Release Notes SCADAPack x70 Release Notes

195

5. Select Purge Unused Types. 

The project is updated and linking to EFBs that were in the project, but no longer in the custom
library, is cleaned up.

6.17.7 New Features (R2.1)

· Feature: SCADAPack RAM battery status reporting.

Summary: The RAM battery voltage is now exposed via SYSTEM DATA in addition to the
RAM battery state and is displayed on the RemoteConnect Online Status page. The RAM
battery state has had a value deadband of 100 mVdc added to it. It will report low battery at 3
Vdc and return to reporting good battery at 3.1 Vdc.

Engineering reference: FUN-1341, FUN-1405, RSC-2605

· Feature: System Status Codes

Summary: The following system status codes have been added:

1013: Object creation error

1014: Object deletion error

1037: File system has insufficient space to carry out operation

1038: Unable to create object due to insufficient configuration memory space

3300: One or more default IP Whitelist rules was not successfully applied

3301: A user-created IP Whitelist rule was not successfully applied

Engineering reference: DSUM-939, RSC-2678, RSC-2676, RSC-2646, FUN-1374

· Feature: RemoteConnect “Get Device Information” command

Summary: RemoteConnect now supports generating and collecting a diagnostic file from the
RTU with a single command. The “Get Device Information” command has the SCADAPack
generate a file that includes the output of many common commands and then transfers the
file to the PC. This file is typically used by technical support to help diagnose operational
issues. 

Engineering reference: RSC-2599 

· Feature: Logic editor system bits

Summary: System bit %S51 is supported and displays the same information as System
Data SYS_CLOCK_QualityAlert. It represents the quality of the real-time clock.

Engineering reference: FUN-1390, DSUM-956 
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· Feature: Modbus TCP server

Summary: The inactivity timeout for Modbus TCP server connections is configurable. It was
fixed at 60 seconds in previous versions of SCADAPack x70 firmware.

Engineering reference: FUN-1397

· Feature: RemoteConnect serial port 5 Vdc line 

Summary: RemoteConnect can configure the state of the 5 Vdc power line on the serial
ports. This was previously possible only via logic.

Engineering reference: RSC-2079

· Feature: 6602 Hart Analog module

Summary: Support has been added for one 6602 HART Analog module to connect to the
SCADAPack 570, 574, and 575.

Engineering reference: RSC-2497

· Feature: DNP3 Device Trouble Internal Indication(IIN)

Summary: The SCADAPack now raises DNP3 Device Trouble IIN 1.6 when the NVRAM
battery has a low voltage or a real-time clock issue is detected.

Engineering reference: DSUM-999

6.17.8 Updates (R2.1)

· Feature Affected: IP Whitelist

Update: The maximum number of entries for the IP whitelist has been increased from 20 to
100.

Engineering reference: DSUM-950, FUN-1385

· Feature Affected: GETINFO command

Update: The GETINFO command now has a fixed filename rather than the filename being
based on the SCADAPack serial number. This is to facilitate easier file transfers.

Engineering reference: FUN-1036

· Feature Affected: Physical I/O controlled via logic

Update: The documentation has been updated to clarify the behaviour of physical digital
outputs and physical analog outputs when the logic application enters the HALT state or the
running of the logic is affected for other reasons.
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Engineering reference: DSUM-905

· Feature Affected: SCADAPack diagnostics

Update: The documentation and RemoteConnect have been updated to describe and
translate additional software task watchdog codes.

Engineering reference: DSUM-938, RSC-2648

· Feature Affected: Ethernet configuration

Update: The default value for a subnet mask is 255.255.255.0. Previously the default was
0.0.0.0, which was not a valid subnet.

Engineering reference: FUN-1325

· Feature Affected: Logic application System Words

Update: The RemoteConnect “Reset Diagnostic Status” and command line RESTART
MASK command now also clears %SW17 and %SW125.

Engineering reference: FUN-1329 

· Feature Affected: IP whitelist

Update: The direction restrictions for some services in the IP whitelist have been updated.
Direction restrictions for a particular service do not limit the creation of a single bidirectional
rule for all services.

Engineering reference: FUN-1358, RSC-2568

· Feature Affected: Logic editor function blocks

Update: The comments for MB_WORD_TO_BOOL and MB_BOOL_TO_WORD inputs and
outputs have been updated.

Engineering reference: FUN-1388 

· Feature Affected: Modbus Store and Forward

Update: Modbus Store and Forward (MS&F) support has been extended to support
TELEBUS commands issued from Telepace Studio. MS&F has been updated to queue only
the last message from each source. The default timeout for MS&F has been increased to
1200ms.

Engineering reference: FUN-1396, FUN-1411, RSC-2637

· Feature Affected: Database Objects
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Update: The Source Type object attribute is no longer locked for objects associated with
logic variables that are part of an array or DDT element. The Logic Task attribute is
configurable for objects associated with logic variables that are part of an array or structure.

Engineering reference: RSC-2640, RSC-2565.

· Feature Affected: Modbus TCP Client

Update: The configuration of the Device Listen Port for a Modbus TCP device in the Modbus
Master/Client configuration has been limited to between 1 and 49151. 0 is not a valid port
number and ports above 49151 are reserved for ephemeral ports.

Engineering reference: RSC-2630

· Feature Affected: RemoteConnect

Update: The number of instances of the SCADAPack Communication DTM and
SCADAPack Device DTM have been restricted to one. Previously it was possible to add
additional DTM instances although the additional DTM instances did not serve a useful
purpose.

Engineering reference: RSC-2106, RSC-2275, RSC-2522, RSC-2552

· Feature Affected: RemoteConnect Low Voltage Alert Level

Update: The default of the Low Voltage Alert Level in RemoteConnect has been updated from
23 Vdc to 11.5 Vdc.

Engineering reference: RSC-2324

· Feature Affected: DNP3 Data Concentrator Master

Update: The DNP3 Master page has been renamed to the DNP3 Data Concentrator Master
page.

Engineering reference: RSC-2562

· Feature Affected: DNP3 object attributes

Update: The DNP3 Static group and variation attribute defaults to None when no DNP3 point
number is configured.

Engineering reference: RSC-2578

· Feature Affected: RemoteConnect Get Device Time command

Update: The Get Device Time command has been removed as the SCADAPack time is
presented on the online Status page along with details about local time zone offset and
daylight-saving time.
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Engineering reference: RSC-2666

6.17.9 Improvements (R2.1)

· Feature Affected: RemoteConnect online Status page

Improvement: The online mode Status page has been reworked to include a variety of new
fields, an Advanced Status section and more detailed information relating to existing fields.

Engineering reference: RSC-2603, RSC-2648, RSC-2513 

· Feature Affected: RemoteConnect Project Export

Improvement: A RemoteConnect project can be exported prior to saving the project.

Engineering reference: RSC-2195

· Feature Affected: RemoteConnect Logic editor

Improvement: Performance for projects with hundreds, or thousands, of objects associated
with logic variables has been improved.

Engineering reference: RSC-2629 

· Feature Affected: RemoteConnect object Quality indicators

Improvement: The obsolete Logic Controlled quality indicator has been removed from
RemoteConnect.

Engineering reference: RSC-2634

· Feature Affected: RemoteConnect Terminology

Improvement: Modified some terminology in RemoteConnect to provide better clarity about
objects and the association of objects with logic variables or other data sources.

Engineering reference: RSC-2575, DSUM-930

· Feature Affected: RemoteConnect dialogs

Improvement: The Clear Counters dialog has been reworked. A number of other dialogs
have been modified, give cancellation options, progress bars or other updates.

Engineering reference: RSC-2534, RSC-2528, RSC-2491, RSC-2402, RSC-2548, RSC-
2491, RSC-2086, RSC-2219, RSC-2280, RSC-2354

· Feature Affected: System Data
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Improvement: RemoteConnect Object Editor system data reference configuration has been
improved.

Engineering reference: RSC-2199 

· Feature Affected: RemoteConnect Import from Excel File

Improvement: The Import from Excel File command can be attempted while the logic editor
is in connected mode.

Engineering reference: RSC-2298

· Feature Affected: RemoteConnect objects

Improvement: RemoteConnect now indicates when Object attributes are locked due to an
object’s association with logic variables that are elements of a logic variable array a logic
variable structure.

Engineering reference: RSC-2448

· Feature Affected: RemoteConnect CommDTM

Improvement: The communication settings fields of the CommDTM fields are now disabled
while RemoteConnect is online. These settings can now be modified only in offline mode.

Engineering reference: RSC-2456

· Feature Affected: SCADAPack 57x hardware type

Improvement: RemoteConnect will now indicate to the user when a configuration for a
variation of SCADAPack 57x is deployed to a different variation of SCADAPack 57x (e.g. a
SP570 configuration deployed to a SP575). The deployment of the configuration is still
permitted as this may be necessary when replacing a unit with a spare.

Engineering reference: RSC-2492

· Feature Affected: Logic editor custom user libraries

Improvement: Custom user library content is now preserved when upgrading from an earlier
version of RemoteConnect. SCADAPack library functions are now updated using the Types
Library Update tool. The tool can be used to update or install new custom library content in
the SCADAPack Logic Editor libset. To do this run the Types Library Update tool from
Programs > Schneider Electric > SoCollaborative > SCADAPack Logic > Types Library
Update. The tool can also be used to replace the SCADAPack x70 library functions if they
are accidentally removed or modified. To do this run the Types Library Update and open the
following file: C:\Program Files (x86)\Common Files\FDT\DTMs\Schneider
Electric\SCADAPack x70\SCADAPack Logic Library Definitions\V11.1\RTU
System\family.DSC.

Engineering reference: RSC-2502
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· Feature Affected: RemoteConnect and unapplied changes

Improvement: RemoteConnect notifies the user about the loss of unapplied data when
closing a project that has changes that have not been applied.

Engineering reference: RSC-2536 

· Feature Affected: IP Whitelist

Improvement: A description column was added to the IP whitelist table. This can be used to
provide additional context for users trying to understand the network topology the
SCADAPack resides in.

Engineering reference: RSC-2540

· Feature Affected: Logic Task object attribute

Improvement: The Logic Task attribute now defaults to None so that organizing the object
list by logic task does not display objects that are not linked to logic variables.

Engineering reference: RSC-2625 

6.17.10 Fixed Issues (R2.1)

· Feature Affected: Modbus Scanner

Issue: The SCADAPack would report system status code 1350 (Modbus Master/Client
invalid Slave Device configuration) after the application of some legitimate configurations.
Resolution: The SCADAPack does not report system status code 1350 for legitimate
configurations.

Engineering reference: FUN-1372

· Feature Affected: Modbus TCP Server

Issue: The Modbus TCP Server unit identifier configuration would not always be applied after
reconfiguration and would require a restart to be applied.
Resolution: The Modbus TCP Server unit identifier configuration is applied after
reconfiguration.

Engineering reference: FUN-1373, RSC-2619

· Feature Affected: CHM help files

Issue: The manuals opened via RemoteConnect context sensitive help (F1 key) could lock up
when a link in the manual was clicked on. Process Scrubber would be required to close the
help file. This was a Microsoft CHM issue.
Resolution: The Microsoft CHM issue persists but manuals opened via context sensitive
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help now have cross-manual links disabled to prevent this issue from occurring. The full
documentation set opened via the start menu or RemoteConnect Help menu option still has
working cross-manual links.

Engineering reference: DSUM-926

· Feature Affected: Modbus Master and Slave

Issue: The SCADAPack permitted the use of the same Modbus address as both slave and
master on the same port. This produced unreliable communications.
Resolution: RemoteConnect and the SCADAPack now restrict the configuration of the same
Modbus address as both Master and Slave on any given serial port.

Engineering reference: FUN-1057, FUN-1406, RSC-2651

· Feature Affected: Modbus

Issue: The description of Modbus exception code 04 in SCADAPack diagnostics was
incorrect. 
Resolution: The description of Modbus exception code 04 has been updated from "Illegal
Response Length" to “Slave Device Failure” to be in line with current standards.

Engineering reference: FUN-1342 

· Feature Affected: RemoteConnect Recent Projects 

Issue: RemoteConnect would display Excel export files and other file types in the list of
Recent Projects. When selected these would not work.
Resolution: The RemoteConnect Recent Projects list is now restricted to project files.

Engineering reference: RSC-2570

· Feature Affected: DNP3 Counter Initialization 

Issue: The DNP3 counter write command would only be processed if the initialization value
was zero.
Resolution: The DNP3 counter write command is processed regardless of the initialization
value.

Engineering reference: FUN-1240

· Feature Affected: IP forwarding

Issue: The IP forwarding feature was enabled after a factory boot of the SCADAPack. The
RemoteConnect default configuration is to have IP forwarding disabled.
Resolution: The IP forwarding feature is now disabled after a factory boot of the
SCADAPack.

Engineering reference: FUN-1323
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· Feature Affected: File deletion

Issue: The number of files reported as deleted by the delete command would count
directories traversed as well as files deleted.
Resolution: The delete command reports the number of files deleted.

Engineering reference: FUN-1335

· Feature Affected: FILEDIAG command

Issue: The FILEDIAG command argument requirements were not clearly specified in the
command line help and it was easy to enter an invalid command without it being clear why
the command was rejected.
Resolution: The FILEDIAG command arguments have been made more robust and flexible
to allow a greater range of inputs to be processed.

Engineering reference: FUN-1383

· Feature Affected: RS485 serial port communications

Issue: Some configurations using RS485 serial communications would experience software
task watchdogs, which would then prompt the SCADAPack to restart. This typically occurred
only under heavier serial communication loads.
Resolution: The software task watchdog no longer occurs.

Engineering reference: FUN-1403, FUN-1415

· Feature Affected: Logic System Words

Issue: The Logic System Words representing time (%SW49, %SW50, %SW51, %SW52, %
SW53 and %SW70) were not updated when the SCADAPack time was updated by an
external source like a DNP3 time write. The SCADAPack clock time itself was correctly
updated.
Resolution: The Logic System Words representing time are now updated when an external
time update is received by the SCADAPack.

Engineering reference: FUN-1417

· Feature Affected: RemoteConnect and Logic Editor synchronization

Issue: User actions in the Logic Editor were blocked when RemoteConnect had a “write
configuration was successful” dialog opened.
Resolution: The Logic Editor is not blocked by the “write configuration was successful”
dialog.

Engineering reference: RSC-1973

· Feature Affected: IP address validation
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Issue: IP address, Subnet Mask and Gateway fields with an invalid value would revert to the
previous valid value after the field no longer had focus.
Resolution: Invalid values will persist in these fields until the value is corrected by the user.

Engineering reference: RSC-1974

· Feature Affected: Logic Editor Online modification

Issue: The online modification of some function blocks could result in those function blocks
not working as intended when internal logic STOPRUN or RUNSTOP events occurred at
some later point in time. A restart of the SCADAPack would eliminate the chance of this
occurring.
Resolution: Function blocks that are modified online perform some additional steps to
register to receive STOPRUN and RUNSTOP events.

Engineering reference: USOC-49

· Feature Affected: Object browser

Issue: String values with a Display Format of “Hex” were validated in groups of 4 bytes and
not validated as a series of individual bytes.
Resolution: String values with a Display Format of “Hex” are validated byte by byte with
each byte containing two Hex characters.

Engineering reference: RSC-2677

· Feature Affected: SCADAPack Identification Strings

Issue: The identification strings Location Name, ID Code/Number and Device Name were not
read from the SCADAPack to RemoteConnect though they were written to and stored in the
SCADAPack correctly.
Resolution: RemoteConnect successfully reads the identification strings from the
SCADAPack.

Engineering reference: RSC-2656

· Feature Affected: Modbus Slave and Modbus Server

Issue: The Modbus register address attribute of objects would not persist through an export
to Excel file and subsequent import from Excel file.
Resolution: The Modbus register address attribute is correctly supported by Excel import
and export options.

Engineering reference: RSC-2650

· Feature Affected: Modbus Scanner

Issue: The Modbus Scanner would mark a valid serial port configuration as invalid in some
configurations after an import from Excel file was performed.
Resolution: The issue no longer occurs.
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Engineering reference: RSC-2635

· Feature Affected: RemoteConnect USB communications

Issue: The USB target DNP3 address was not updated in the DNP3 CommDTM
automatically after a new configuration was written to the SCADAPack. This could result in
communication issues when DNP3 addresses became mismatched.
Resolution: The settings of the DNP3 CommDTM are updated after a configuration is written.

Engineering reference: RSC-2414

· Feature Affected: RemoteConnect and Logic Editor synchronization

Issue: The synchronization between RemoteConnect and the Logic Editor would be broken if
a project that contained T_SPx70_EBOOL data types was imported from an Excel file.
Support for this data type was removed in R2.0. RemoteConnect would report "The Logic
Editor is currently unavailable. Please close the RemoteConnect application, run Process
Scrubber and then reopen the project in RemoteConnect".
Resolution: T_SPx70_EBOOL objects are now excluded from the import from Excel file
process.

Engineering reference: RSC-2511

· Feature Affected: Object editor navigation

Issue: The Prev and Next buttons of the object editor would not respect the order of an object
list that had been sorted using criteria other than the default.
Resolution: The Prev and Next buttons move between objects based on the current object
sorting being used.

Engineering reference: RSC-2512

· Feature Affected: Object and logic variable association

Issue: When Logic variables that were part of a DDT variable were associated with an object,
it was possible to produce object names that were too long.
Resolution: The maximum name length for DDT logic variables and their sub elements are
now matched to the maximum name length for objects.

Engineering reference: RSC-2515

· Feature Affected: RemoteConnect validation

Issue: RemoteConnect would not immediately display some errors when reading a
configuration from the SCADAPack. The error would not be reported until the section of the
navigation tree containing the relevant page was expanded.
Resolution: RemoteConnect displays errors with a newly read project regardless of the state
of the navigation tree.

Engineering reference: RSC-2527
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· Feature Affected: Object attribute validation

Issue: RemoteConnect did not enforce some validation rules for raw minimum and raw
maximum or for engineering minimum and engineering maximum. The firmware would then
detect these issues after the configuration had been applied.
Resolution: RemoteConnect performs additional validation on raw minimum, raw maximum,
engineering minimum and engineering maximum.

Engineering reference: RSC-2538

· Feature Affected: Object Browser

Issue: Object browser names that contained spaces were not read from the SCADAPack to
RemoteConnect correctly.
Resolution: Space characters are now supported in object browser names.

Engineering reference: RSC-2545

· Feature Affected: 5506 Analog Input Module

Issue: The Input Type of analogs on the 5506 was always set to 4…20 mA after importing a
configuration from an Excel file.
Resolution: The Input Type of 1…5 Vdc is now properly supported in exports to and imports
from Excel files.

Engineering reference: RSC-2583

· Feature Affected: Object browser

Issue: Some objects would remain in the object browser after being deleted from the list of
objects in the configuration.
Resolution: The objects are cleared from the object browser when deleted from the list of
objects in the configuration.

Engineering reference: RSC-2588

· Feature Affected: Modbus RTU

Issue: The Modbus serial port configuration was absent when importing some project
configurations.
Resolution: The issue has been resolved.

Engineering reference: RSC-2607

· Feature Affected: Modbus Scanner, DNP3 Data Concentrator

Issue: RemoteConnect performance was significantly degraded once the number of devices
configured exceeded 10 for either the Modbus Scanner or DNP3 Data Concentrator. The
slowdown was most significant when opening a project or adding a device. The firmware’s
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performance was unaffected.
Resolution: The issue has been resolved.

Engineering reference: RSC-2616

· Feature Affected: Object validation

Issue: RemoteConnect would sometimes raise a validation error “Invalid Engineering Scaling
value” for Digital Objects after upgrading projects created under older versions of
RemoteConnect. This was not a valid attribute for digital objects.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2627

· Feature Affected: SCADAPack RemoteConnect Configuration Software

Issue: When attempting to open the DTM pane by double-clicking, a spurious error message
would sometimes appear:

“An unexpected error occurred: 

DTM Topology Editor

Cannot open DTM UI: Object reference not set to an instance of an object.”

Resolution: This message no longer appears.

Engineering reference: RSC-514

6.17.11 Known Issues/ Known Customer Difficulties (R2.1)

· Feature Affected: Logic Editor Defined Function Block debugging 

Issue: When a Refine operation is used in the SCADAPack x70 Logic Editor to debug an
instance of a user defined function block (DFB), attempting to add a private DFB instance
variable to an animation table can cause a Logic Editor exception.

Work around: Hover over a private variable to view the value, but do not add the private
variable to an animation table.

Engineering reference: USOC-70

· Feature Affected: Multiple screen display. 

Issue: When a laptop is switched from a multiple screen display to a single screen display,
application windows may become orphaned on the no longer visible screen. If the logic editor
is not accepting input after attempting to open a secondary window such as the Types
Library Manager or FFB Input Assistance, it's possible that the window is open on a
previously opened display. If you've moved from using a multi-screen display to a laptop, for
example, the opened window may not be visible.

Work around: 
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Press Alt-F4 to close the hidden window and resume using the logic editor main screen.

OR

Press Alt-Space then M and hold down the left-arrow key to move the window onto the
current display.

· Feature Affected: RemoteConnect on Windows 10. 

Issue: RemoteConnect dialog content is blank.

Work around: Some Windows 10 versions may show blank display content as a result of
interaction between Windows WPF and Windows 10 Video Drivers. Microsoft have suggested
a temporary solution as follows:

1. With administrator privileges, run regedit from Windows.

2. Navigate to the following registry key:
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Avalon.Graphics

3. Add a New DWORD value (or modify the value if it exists): 

DisableHWAcceleration

4. Set the value to 1.

5. Log out of Windows.

6. Log in again, and start RemoteConnect.

Engineering reference: DSUM-914

· Feature Affected: SCADAPack RTU Object database configuration. 

Issue: When reconfiguring a SCADAPack RTU from one large configuration to another large
configuration, the configuration rebuild may fail with configuration log messages similar to “#
565: Unable to create object due to insufficient configuration memory space”.

Work around: Cold boot the RTU before applying the new configuration. Alternatively apply a
configuration with a very small number of objects and restart the RTU. The new large
configuration should then be accepted.

Engineering reference: FUN-1314

· Feature Affected: Logic Editor PLC Simulator 

Issue: The Mode > Start Simulation action in the Logic Editor can take an extended period of
time to start. The PLC Simulator is started and the project is prepared for download, but it
can take up to 2 minutes for the download to start. After the first download, subsequent uses
of the PLC Simulator don't experience this issue while the SCADAPack x70 Logic Editor and
PLC simulator remain open. In some cases, a message from the simulator, stating "Error
allocating PAT memory space" can occur.

Workaround: Press OK and ignore this message. 

Engineering reference: USOC-94, USOC-95
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· Feature Affected: Logic Editor PLC Simulator 

Issue: The Mode > Start Simulation action in the Logic Editor may not start.

Workaround: Start the simulator manually. From the Windows menu type in “PLC
Simulator”. This may take multiple attempts. After starting via the Windows menu it should
be possible to use “Mode > Start Simulation.

Engineering reference: USOC-94, USOC-95

· Feature Affected: SCADAPack RemoteConnect Configuration Software start-up 

Issue: The SCADAPack RemoteConnect Configuration Software may be blocked from
reopening if previous instances of RemoteConnect or the Logic Editor were not closed
cleanly. 
Workaround: Run the “Process Scrubber” application, which will shut down any remaining
processes, then restart RemoteConnect.

· Feature Affected: Unity Pro installation compatibility

Issue: The SCADAPack RemoteConnect Configuration Software installation process and
Unity Pro software installation process can interfere with one another. It is recommended that
when installing new versions of Unity Pro software that the repair installation option be run for
SCADAPack RemoteConnect. Coexisting installations of RemoteConnect and Unity pro are
only supported for Unity Pro versions 11.1, 12 and 13.
Work around: Use a virtual machine for RemoteConnect installations or for Unity Pro
installations or Repair the installations as mentioned above. Remember for a Repair to
always be “Run as administrator”.

When installing new versions of SCADAPack RemoteConnect, the installer will automatically
attempt a Repair on Unity Pro software.

6.17.12 Post Installation Troubleshooting

Logic Editor is unable to communicate with SCADAPack RemoteConnect

Symptoms: 

The SCADAPack x70 Logic Editor is starting, but is unable to communicate with SCADAPack
RemoteConnect. When this occurs, the Logic Editor may not display variables that were created
in the Object Editor and you may not be able to build the application from RemoteConnect.

Steps to resolve:

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they are running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it and select Run as
administrator to open it.
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3. In the command line window, change to the default installation directory by typing one of the
following commands:

64-bit systems: cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack 11.1” 

32-bit systems: cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message DllRegisterServer in
pserver.dll succeeded is displayed.

Logic editor or Types Library update tool library modification

Symptoms:

SCADAPack Logic Editor or Types Library Update tool reports the library is opened by another
application when attempting to modify the logic library

Steps to resolve:

Check that no instances of Unity Pro and RemoteConnect/SCADAPack x70 Logic Editor are
running. Use the "Process Scrubber" if necessary. If the problem persists it is likely a Windows
folder permissions problem.

Check the following:

· With administrator privilege right click on the following folder: C:\ProgramData\Schneider
Electric

· Select Properties

· Select the Security tab

· Click Edit

· Click on the Users entry in the Group or user names section

· Scroll down the Permissions for Users area until you see a row called "Write"

· Check the box in the "Allow" column for the "Write" row

· Click OK

· The security settings will update on all the sub-folders

· Click OK to exit the Properties dialog

Engineering reference: DSUM-919
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6.17.13 SCADAPack 57x and 6601 Firmware Version compatibility table

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is only supported on
device firmware 9.0.4 and later and 6601 firmware 1.80.6 and later. “restart iofirm bl6601.bin
<module address>” will apply bootloader file bl6601.bin. The filename bl6601.bin is the only
filename that is accepted for the bootloader. Other file names will result in an attempt to patch
the 6601 firmware and not the 6601 bootloader. The 6601 bootloader version is not reported on
the command line.

SP57x minimum firmware version: If there is an attached 6601 or a built-in 6601 (SP575) the
device firmware version should be 9.0.4 or later.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use SP570 or SP575 9.0.3 or earlier firmware in conjunction with a 6601 1.80.6 or later
with extended over-range calibration. They are not compatible. 

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

Failure to follow these instructions can result in equipment damage.

A new version of 6601 I/O module firmware and bootloader has been released since the release
of SP57x firmware 9.0.3. A new calibration format for 6601 analog inputs has been added to
support extended over-range capabilities. Interoperability of various versions of firmware and
calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment
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 9.0.3 or
earlier

1.77.1
31 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.3 or
earlier

1.80.0
6 or
later

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

6601 I/O modules upgraded to
1.80.6 from earlier versions will
leave calibration unchanged.
Recommended for upgrading
systems that do not require
extended over-range capabilities.

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.3 or
earlier

1.77.
131 or
earlier

0…22
mA

AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.3 or
earlier

1.80.0
6 or
later

0…22mA AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. When
adding new 6601 I/O modules to
existing systems, SP57x
firmware should be upgraded to
9.0.4 or later. If this is not
practical, contact Schneider
Electric technical support.
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6.18 SCADAPack x70 R2.0 Release Notes 20/07/2018

SCADAPack x70 R2.0 is a version, first available in July 2018.

6.18.1 Application and Firmware Versions

SCADAPack x70 RemoteConnect application version is 3.4.1

SCADAPack x70 English Documentation version is 3.4.1

SCADAPack x70 French Documentation version is 1.2.3

SCADAPack x70 Security Administrator version is 1.2.0

SCADAPack 57x Firmware version is 9.1.1

6601 I/O module firmware version 1.80.10

6601 I/O module bootloader version 1.80.10

6.18.2 Software and Firmware Version Compatibility

RemoteConnect version 3.4.1 is intended for use with SCADAPack x70 firmware version
9.1.1

As of R2.0, RemoteConnect and SCADAPack 57x firmware is cross compatible with future
software and firmware releases. This compatibility is limited to features common to the version of
software and firmware available. Unknown feature configurations are parsed and do not block
reconfiguration.

6.18.3 Supported Devices

SCADAPack 570

SCADAPack 574

SCADAPack 575

6.18.4 Supported Operating Systems

Windows 7 Professional (32-bit or 64-bit)

Windows 8.1 Professional (32-bit or 64-bit)

Windows 10 Professional (32-bit or 64-bit)

Windows Server 2012 R2

Windows Server 2016
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6.18.5 Unity Pro Compatibility

RemoteConnect installations can coexist with specific Unity Pro installations. If RemoteConnect
is installed on a computer that had Unity Pro installed previously, a “repair” process is likely
required for Unity Pro to confirm that all components are correctly referenced. If Unity Pro is
installed on a computer that already had RemoteConnect installed, then a “repair” process is
likely required on RemoteConnect to confirm that all components are correctly referenced.

The Unity Pro versions that are suitable for coexisting installation with RemoteConnect are:

· Unity Pro version 11.1

· Unity Pro version 12

· Unity Pro version 13

6.18.6 Removing Unused Function Blocks

After you click Update & Build Logic on the SCADAPack x70 Logic page, the SCADAPack
x70 Logic Editor may display an error that a function block is not in the library. This situation
can occur if you have an existing project that contains EFBs that are no longer in the latest
custom library. You will need to rework your logic application to resolve the issues and remove
the function blocks that are no longer in the custom library. 

NOTICE

INCONSISTENT DATA, UNPREDICTABLE RESULTS

When you remove elementary function blocks and derived function blocks, the project will no
longer perform as it did in the past. 

You will need to add new function blocks to update the logic application.

Failure to follow these instructions can result in equipment damage.

To remove function blocks that are no longer in the custom library

1. In the SCADAPack x70 Logic Editor, remove the EFBs from your project that are causing the
errors. 

2. Navigate to Project > Variables & FB Instances > Elementary FB Instances and double-
click to open. 

3. In the Data Editor, delete the function block(s). 

4. Navigate to Tools > Types Library Manager > Application and right-click on any item.

5. Select Purge Unused Types. 

The project is updated and linking to EFBs that were in the project, but no longer in the custom
library, is cleaned up.
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6.18.7 New Features (R2.0)

· Feature: IP whitelist.

Summary: The IP whitelist can be used to limit traffic by IP address and port number. This
can be used to enhance security or to prevent misconfigured devices elsewhere on the
network from sending SCADA protocol commands.

Engineering reference: FUN-119

· Feature: System data.

Summary: The System data feature replaces the old system point interface. System data
can be connected to objects individually or a group of related system data can be associated
with a group of objects. These system data objects can be added to the new object browser.
A number of system data references are now included by default in a new project.

Engineering reference: FUN-260, RSC-527, RSC-2082, RSC-2136, RSC-2202

· Feature: Revised Online Object Browser.

Summary: The online object browser has been overhauled. New features include periodic
refresh, the ability to read unconfigured system data at runtime and the display of data in a
variety of formats (e.g HEX, REAL, UINT).

Engineering reference: RSC-2249, RSC-2164, RSC-875

· Feature: Configuration filtering options.

Summary: Added filtering, sorting and organizing options to the Object editor page of
RemoteConnect.

Engineering reference: RSC-265

· Feature: Modbus Master addressing.

Summary: The Modbus master can now poll address range 1 - 255 rather than 1 – 247.

Engineering reference: RSC-1791

· Feature: Modbus serial port.

Summary: Modbus RTU slave and Modbus RTU master ports have been amalgamated into a
single Modbus port option. Both Slave and Master functionality has access to any port
configured as Modbus. Master request can also be sent via EFB on the same port.

Engineering reference: RSC-2213

· Feature: Modbus Store & Forward.
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Summary: Modbus requests and responses can be exchanged via the SCADAPack x70
RTU, with the SCADAPack x70 handling message routing and address translation for both
Modbus RTU and Modbus TCP messages.

Engineering reference: 

6.18.8 Updates (R2.0)

· Feature Affected: Modbus Scanner

Update: Removed UINT as a data type for digital objects. Storing the bits of input registers
and holding registers will be done with a new multi-bit digital object type that will be available
in a subsequent release.

Engineering reference: RSC-2426

· Feature Affected: Logic editor EFB

Update: Removed legacy EFBs DNP3Peer_AddToRDList, DNP3Peer_AddToWRList,
OBJ_GetAttrib_REAL, OBJ_GetAttrib_DINT, OBJ_SetAttrib_REAL, OBJ_SetAttrib_DINT and
OBJ_GetAttrib_STRING.

Engineering reference: RSC-2128

· Feature Affected: Logic editor variable forcing

Update: Removed inadequate forcing data types (EBOOL & Forced Analog) from logic editor.
A new forcing mechanism will be available in a subsequent release. RemoteConnect has
been modified to help with the update of projects that include forcing variable types.

Engineering reference: FUN-1131, FUN-1134, RSC-1818, RSC-2065

· Feature Affected: DNP3 file transfer

Update: DNP3 Legacy file transfer mode was removed from RemoteConnect. DNP3
revised file transfer is now the only option.

Engineering reference: RSC-2154

· Feature Affected: DNP3 Data Concentrator

Update: DNP3 Data concentrator is now a licenced feature by default.

Engineering reference: FUN-1191

· Feature Affected: Physical I/O

Update: RemoteConnect restricts the number of configurable 6601 I/O modules to 4.

Engineering reference: RSC-2415
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6.18.9 Improvements (R2.0)

· Feature Affected: Serial Cell modems

Improvement: Exposed PAP/CHAP username and password strings.

Engineering reference: FUN-305

· Feature Affected: SCADAPack Clock and uptime functionality

Improvement: Improved Real Time Clock performance to minimize drift over time and reduce
gradual differences in accumulated timers like TON EFBs and SCADAPack uptime.

Engineering reference: FUN-341

· Feature Affected: DNP3 Protocol

Improvement: Valid DNP3 point numbers have been extended to 0-65534. Previously they
were limited to 0-49999.

Engineering reference: RSC-2137

· Feature Affected: Logic application memory consumption

Improvement: The NVRAM usage of the logic application can now be reported.

Engineering reference: FUN-635, USOC-55

· Feature Affected: Logic editor System bits and system words

Improvement: %SW10 First cycle after cold start was added to the list of supported %S
and %SW

Engineering reference: FUN-636

· Feature Affected: Physical I/O

Improvement: Hardware over-range and under-range on the SP574 generate an event
instead of relying on over-range and under-range settings in the configuration.

Engineering reference: FUN-685

· Feature Affected: Modbus RTU over serial ports

Improvement: Modbus frame timing on serial ports improved to distinguish between
messages that appear in rapid succession on a multidrop link.

Engineering reference: FUN-875

· Feature Affected: Logic application
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Improvement: Minor configuration changes do not result in disruption to the running logic
application if the logic application signature is unchanged

Engineering reference: FUN-935

· Feature Affected: Logic application scan time

Improvement: Improved logic performance when the SCADAPack is under heavy load from
IP communications traffic.

Engineering reference: FUN-1025

· Feature Affected: Logic editor EFBs

Improvement: Request(REQ) and confirm (CNF) pins added to the F_FindFile, F_DelTree &
F_DirInfo EFBs

Engineering reference: FUN-1124

· Feature Affected: Logic application status

Improvement: Added new logic status elements to report HALT and other status conditions.

Engineering reference: FUN-1125

· Feature Affected: Logic application

Improvement: Added system status code 5012 for when the logic application HALTs with a
non-recoverable error

Engineering reference: FUN-1172

· Feature Affected: RemoteConnect general operation

Improvement: Performance enhancements to RemoteConnect to allow it to handle larger
collections of objects and save and restore projects faster. Object creation, editing and
deletion performance was improved.

Engineering reference: RSC-838, RSC-264, RSC-1802, RSC-1814, RSC-2084, RSC-1690,
RSC-1658, RSC-1795, RSC-1799, RSC-1864

· Feature Affected: Modbus Scanner

Improvement: The Modbus Data Type is now editable after creation of a Modbus Scanner
device. Previously this field was not editable after the device had been created.

Engineering reference: RSC-1257

· Feature Affected: Logic debugger service
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Improvement: The Option for enabling the Logic debugger IP service has been moved to the
SCADAPack x70 Logic page.

Engineering reference: RSC-1272

· Feature Affected: RemoteConnect Online operation

Improvement: A periodic connection check was added to help RemoteConnect detect when
the ONLINE connection to a RTU has been interrupted. Various improvements to the
reporting of connectivity status.

Engineering reference: RSC-1381, RSC-2524

· Feature Affected: Import from Excel file

Improvement: Importing from Excel now accepts blank ID values for newly created objects.

Engineering reference: RSC-1385

· Feature Affected: Software and firmware interoperability

Improvement: Compatibility between SCADAPack x70 firmware and RemoteConnect has
been improved. Future versions will be compatible with multiple other versions as long as the
features being used are present in both firmware and software.

Engineering reference: RSC-1551

· Feature Affected: RemoteConnect tree navigation

Improvement: The SCADAPack page has been converted to a summary page that provides
a variety of information. Additional summary pages have also been added to provide quick
access to configuration information.

Engineering reference: RSC-1564, RSC-1712, RSC-1713, RSC-1728

· Feature Affected: Logic application

Improvement: Logic tasks like FAST, AUX0 & AUX1 will now automatically be added when
an object is added that uses one of these tasks.

Engineering reference: RSC-1618

· Feature Affected: RemoteConnect general operation

Improvement: Improved the detail and differentiation of many status messages, confirmation
dialogs and popup windows in RemoteConnect. Improved progress dialogs. Addressed minor
issues relating to notification and progress dialogs.

Engineering reference: RSC-1621, RSC-1664, RSC-2478, RSC-1710, RSC-1905, RSC-
1922, RSC-1963, RSC-2354, RSC-2282, USOC-58, RSC-2532, RSC-2530
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· Feature Affected: RemoteConnect general operation

Improvement: Information icons have been added to provide useful details when using
RemoteConnect. These are represented by a white ‘i' in a blue circle.

Engineering reference: RSC-1681

· Feature Affected: RemoteConnect installation

Improvement: The installer for RemoteConnect has been improved and streamlined.

Engineering reference: RSC-1688

· Feature Affected: RemoteConnect and Logic Editor synchronization

Improvement: Added an indicator that the logic editor is starting so that it is obvious when
RemoteConnect has started but the logic editor has not yet started. Added a message to
indicate if the logic editor does not start.

Engineering reference: RSC-1691, RSC-2069, RSC-1990

· Feature Affected: DNP3 master & Modbus Master

Improvement: The point and register tables on the general DNP3 master and Modbus
master pages have been limited to just the device pages so that the main page for each of
these features is not overly cluttered.

Engineering reference: RSC-1726

· Feature Affected: Import from Excel file and Export to Excel file

Improvement: Exporting to and importing from Excel now supports additional configuration
parameters.

Engineering reference: RSC-2006, RSC-2167, RSC-2083

· Feature Affected: RemoteConnect compatibility with Unity Pro

Improvement: Added detection for when the SCADAPack x70 logic editor’s libraries have
been replaced by Unity Pro libraries (e.g. as a result of upgrading Unity Pro).

Engineering reference: RSC-2060

· Feature Affected: SCADAPack Diagnostics

Improvement: Added system status codes:

· 5011: New Logic execution status code generated. See RemoteConnect Online Logic page,
SCADAPack Logic Diagnostic Viewer or Logic variable %SW125
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· 5012: Logic execution Unavailable. Restart the Controller

· 1350: Modbus Master/Client invalid Slave Device configuration

· 1351: Modbus Master/Client invalid Point Scanner configuration

· 1036: Backup firmware license not found (This may appear when upgrading an RTU from
older versions of firmware that do not perform additional backup actions on the firmware
licence)

· 3202: Configuration conflict in the System Data object table

Engineering reference: RSC-2093, RSC-2208, RSC-1766, RSC-2276

· Feature Affected: RemoteConnect configuration read from SCADAPack

Improvement: Added a Read configuration option to the RemoteConnect start page to read
configuration directly from the RTU rather than first opening a project or creating a new
project.

Engineering reference: RSC-2099

· Feature Affected: RemoteConnect unapplied changes

Improvement: RemoteConnect will now prompt the user if a project is about to be closed
and there are changes that have not been added to the project with the “Apply” button.

Engineering reference: RSC-2107

· Feature Affected: RemoteConnect Online operation

Improvement: Improved the icons and status information for reporting of communication and
connectivity issues between RemoteConnect and the RTU.

Engineering reference: RSC-2146

· Feature Affected: RemoteConnect Firmware update wizard

Improvement: Improved the firmware update wizard. Improved the cancellation process of
the firmware update wizard.

Engineering reference: RSC-2150, RSC-1956, RSC-2280

· Feature Affected: RemoteConnect on low resolution screens

Improvement: Adjusted screen layout to better accommodate small laptop screens. Added
emphasis in the documentation to the full screen mode option.

Engineering reference: RSC-2153

· Feature Affected: RemoteConnect and Unity Pro compatibility
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Improvement: Various improvements to reduce the impact RemoteConnect can have on a
Unity Pro installation. Automated running the Unity Pro repair option after a RemoteConnect
installation. Users are encouraged to retain the installer for Unity Pro and SCADAPack x70
Logic Editor to facilitate running a Repair step in the future. Users are also reminded to
always Run as administrator for a Repair step.

Engineering reference: RSC-2156, RSC-2325

· Feature Affected: RemoteConnect setting SCADAPack time

Improvement: Improved RTU time setting options in RemoteConnect. It is now possible to
nominate a time rather than just relying on the current PC time.

Engineering reference: RSC-2175

· Feature Affected: RemoteConnect project opening

Improvement: RemoteConnect now opens the configuration UI automatically when an
existing project is opened.

Engineering reference: RSC-2182

· Feature Affected: RemoteConnect Online UI

Improvement: Online UI Status, logic and objects pages have been revised and improved.

Engineering reference: RSC-2186

· Feature Affected: RemoteConnect Online operation

Improvement: The RemoteConnect online UI is now opened automatically when entering
online mode

Engineering reference: RSC-2201

· Feature Affected: DNP3 Master and Modbus Master

Improvement: Moved status and control configuration from the advanced section to the
basic section for the Modbus Scanner and DNP3 data concentrator.

Engineering reference: RSC-2217

· Feature Affected: RemoteConnect Import from Excel file

Improvement: Added “Enable Import” option in Excel configuration export to provide more
control when importing. Renamed the export and import options “Export to Excel File” and
“Import from Excel File”. Improved Configuration error reporting during an import.

Engineering reference: RSC-2407, RSC-2405, RSC-1804
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· Feature Affected: Object Database

Improvement: Increased the maximum number of objects supported by RemoteConnect
and the RTU. Configurations with 15000 objects can be loaded into the RTU. Approximately
6000 objects can be connected to logic variables.

Engineering reference: FUN-1209, RSC-2211

· Feature Affected: Physical I/O

Improvement: Automatically associate a status object to a physical I/O module when the
module is first added to the configuration.

Engineering reference: RSC-2474

6.18.10 Fixed Issues (R2.0)

· Feature Affected: Device_CROB function block 

Issue: The Device_CROB function block generates DNP3 Control Relay Output Block
(CROB) requests. Only the Pulse ON option of the DNP3 CROB latch and pulse commands
can be sent from the function block.
Resolution: The Device_CROB EFB supports the full range of CROB options.

Engineering reference: FUN-340

· Feature Affected: RemoteConnect logic status reporting

Issue: The logic application’s name and version would sometimes disappear from
RemoteConnect and the command line.
Resolution: The issue no longer occurs.

Engineering reference: FUN-387

· Feature Affected: Modbus Slave

Issue: Modbus exception code response was not correctly generated for all exception codes.
Resolution: The issue no longer occurs.

Engineering reference: FUN-472

· Feature Affected: Modbus TCP server

Issue: On Modbus TCP, Modbus function code 0x02 would only work with a register count of
1984 or less.
Resolution: Function code 0x02 works with the maximum register count of 2000.

Engineering reference: FUN-475
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· Feature Affected: File system function blocks

Issue: F_DirInfo EFB wouldn’t function correctly with multiple instances of the function block
in an application.
Resolution: The issue no longer occurs.

Engineering reference: FUN-571

· Feature Affected: COM function blocks

Issue: COM_OPEN, COM_WRITE and COM_CLOSE being called repeatedly in rapid
succession would cause the RTU to restart.
Resolution: This no longer occurs.

Engineering reference: FUN-587

· Feature Affected: Analog outputs at reconfiguration

Issue: Analog outputs are not properly initialized after redeploying a RemoteConnect project.
Resolution: Analog outputs are reinitialized after deploying a RemoteConnect project

Engineering reference: FUN-789

· Feature Affected: Service boot mode

Issue: Service Boot wouldn’t stop the logic application from running.
Resolution: A service boot now stops the logic application from running.

Engineering reference: FUN-851

· Feature Affected: USB communication

Issue: Disabling the USB port function wouldn’t disable the USB port communications.
Resolution: The USB port can be disabled.

Engineering reference: FUN-929

· Feature Affected: SCADAPack Factory Boot

Issue: SP570 reports as a SP575 after factory boot.
Resolution: SP570 reports as SP570 after factory boot.

Engineering reference: FUN-991

· Feature Affected: Ethernet port configuration

Issue: Ethernet IP configured as 0.0.0.0 reports as 127.0.0.1 on the command line of the
RTU.
Resolution: Ethernet IP configured as 0.0.0.0 reports as 0.0.0.0 on the command line of the
RTU.
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Engineering reference: FUN-995

· Feature Affected: Modbus Scanner

Issue: Modbus scanner did not set the point quality when communications with a remote
device are unsuccessful.
Resolution: The Modbus Scanner sets the point quality to bad when communications with a
remote device are unsuccessful.

Engineering reference: FUN-1026

· Feature Affected: 5103 I/O power module

Issue: The SCADAPack would be unable to communicate with 5000 series modules if it was
connected to a 5103 power module with a blown 5v fuse.
Resolution: SCADAPack communications are unaffected as long as there remains sufficient
power for I/O modules

Engineering reference: FUN-1049 (Customer)

· Feature Affected: SCADAPack Run LED

Issue: The RUN LED would stay on solid when the logic application entered the HALT state.
Resolution: The RUN LED now flashes when the logic application enters the HALT state.

Engineering reference: FUN-1092

· Feature Affected: SCADAPack Command line

Issue: The command line CLEAR EVENTS command would cause the free event pool to be
set to zero.
Resolution: The CLEAR EVENTS command now clears events as intended.

Engineering reference: FUN-1097

· Feature Affected: USB memory stick

Issue: When deleting hundreds of files on a connected USB memory stick, the RTU would
restart due to a Task watchdog being triggered.
Resolution: A task watchdog is not triggered.

Engineering reference: FUN-1107

· Feature Affected: Serial Cell Modem communications

Issue: Default routes could not be correctly added to a cell modem PPP link unless the link
had already been established.
Resolution: The RTU now adds a default route for the PPP serial port after a cell modem
data connection is established.
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Engineering reference: FUN-1111

· Feature Affected: Analog event generation

Issue: Spurious analog events were generated during reconfiguration of the RTU. These could
have invalid values due to changes to analog scaling or the restarting of I/O drivers.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1119

· Feature Affected: %S logic bits

Issue: System status bits %S0 (warm start), %S1 (cold start) and %S13 (First scan in RUN)
were not set correctly in some situations.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1136

· Feature Affected: RemoteConnect online operation

Issue: The RTU could restart with a task watchdog after being issued controls via the
RemoteConnect R1.6 object browser.
Resolution: The online object browser has been overhauled as part of a feature update and
this issue no longer occurs.

Engineering reference: FUN-1163, FUN-1210, FUN-1045

· Feature Affected: MB_IPMaster and MB_Serial_Master function blocks

Issue: MB_IP_Master and MB_Serial_Master EFBs would report “INVALID_FN_CODE” when
using function code 5 or 6. The request message would still be sent out.
Resolution: “INVALID_FN_CODE” is no longer reported.

Engineering reference: FUN-1165

· Feature Affected: RemoteConnect Logic application reporting

Issue: RemoteConnect would report the logic application as being in a STOP state when the
logic was in a RUN state. The value in RemoteConnect would be updated to the correct RUN
value after less than a minute.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1176

· Feature Affected: Logic Debug service

Issue: The logic engine in the firmware would generate an exception if the Logic Debug
service was disabled and then a reconfiguration enabled the Logic debug service.
Resolution: The issue no longer occurs.
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Engineering reference: FUN-1183

· Feature Affected: 

Issue: The Modbus Slave and DNP3 slave did not deal with UINT values from Counter objects
consistently. DNP3 would roll over the value while Modbus would cap the value at 65535.
Resolution: Both protocol drivers now roll over the value.

Engineering reference: FUN-1192

· Feature Affected: SCADAPack DNP3 pulse operations

Issue: DNP3 pulse output commands with an OFF TIME of zero were accepted only once for
any given point. Subsequent pulse commands received a busy response. Pulse commands
with a non-zero OFF TIME were unaffected.
Resolution: Subsequent commands work as intended.

Engineering reference: FUN-1194

· Feature Affected: 6601 chatter filter

Issue: The 6601 digital input Chatter Filter feature would set the POINT_IS_BAD quality
instead of the CHATTER_FILTER quality.
Resolution: The CHATER_FILTER quality is set.

Engineering reference: FUN-1198

· Feature Affected: RemoteConnect Counter Reset command

Issue: The RemoteConnect counter reset command was not being processed correctly.
Resolution: The counter reset command now clears the specified range of counters or all
counters as requested.

Engineering reference: FUN-1227, RSC-2416

· Feature Affected: SCADAPack Reconfiguration

Issue: Reconfiguring the Serial port function from None to Command line or from
Command line to None would cause the RTU to restart.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1247

· Feature Affected: DNP3Peer_AddObjToWRList function block

Issue: The DNP3 peer function block DNP3Peer_AddObjToWRList would not accept
PEER_BinaryOutput_Write as an OBJTY input. The documentation incorrectly listed this
functionality as being supported.
Resolution: Documentation has been updated to exclude PEER_BinaryOutput_Write
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Engineering reference: FUN-1253

· Feature Affected: USB memory stick

Issue: The capacity and free size of a connected USB memory stick was not reported
correctly via the MEMSHOW command-line command or via the
SYS_CAPACITY_USB_Files_SizeUsed and SYS_CAPACITY_USB_Files_SizeFree
system data fields.
Resolution: Capacity and free size information is correctly reported

Engineering reference: FUN-1258

· Feature Affected: IFCONFIG on command-line

Issue: Using the IFCONFIG command to set the IP address for Ethernet port 3 would instead
set the IP address for Ethernet port 2. The subnet mask was set correctly.
Resolution: The command now correctly sets the IP address for Ethernet port 3.

Engineering reference: FUN-1261

· Feature Affected: SCADAPack Reconfiguration

Issue: Reconfiguration that added or removed I/O modules could lead to a task watchdog
restart for certain configurations.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1263

· Feature Affected: SCADAPack Modbus Reconfiguration

Issue: Reconfiguration of Modbus/TCP Server Unit ID would not be applied until after a power
cycle of the RTU
Resolution: The new configuration is applied at configuration time.

Engineering reference: FUN-1288

· Feature Affected: Modbus Scanner

Issue: The Modbus Scanner did not correctly issue read requests for UINT values mapped to
Counter objects in the database. The Modbus Scanner did not correctly issue write requests
for UINT or UDINT values mapped to Counter objects in the database. RemoteConnect did
not present UINT and UDINT as the only data types for a Counter object. Modbus Scanner
entries with an object type of Counter were not saved by RemoteConnect.
Resolution: Counter objects are supported.

Engineering reference: FUN-1293, FUN-1294, FUN-1297, RSC-1740, RSC-1828, RSC-
2443, RSC-2426

· Feature Affected: RemoteConnect invalid parameters indication
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Issue: Pages in the navigation pane were not always marked as containing invalid
parameters after reading a configuration from the SCADAPack.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1050

· Feature Affected: RemoteConnect Read File from Device

Issue: Attempting the “Read File from Device” option for a file that didn’t exist in the RTU
would cause the RemoteConnect UI to freeze after the second consecutive attempt.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1497

· Feature Affected: RemoteConnect French language support

Issue: RemoteConnect Install and Uninstall options would still be in English when the
Windows OS language settings were set to French.
Resolution: The RemoteConnect Install and uninstall windows are presented in French when
the Windows OS language settings are set to French.

Engineering reference: RSC-1592

· Feature Affected: RemoteConnect Import from Excel File

Issue: Modbus 6 digit register addresses would not be successfully imported from an Excel
file.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1601

· Feature Affected: RemoteConnect configuration.

Issue: The Apply button could remain disabled after changes had been made to the
configuration.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1606

· Feature Affected: RemoteConnect Input voltage status reporting

Issue: RemoteConnect didn’t correctly report the Input Voltage Status. It would report as
Normal and not switch to Low when the voltage dropped below the configured threshold.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1608

· Feature Affected: IP forwarding
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Issue: IP forwarding settings were applied at reconfiguration time and saved in the
configuration but IP forwarding was always enabled at RTU startup. This led to a mismatch
between information displayed in RemoteConnect and information displayed on the command
line.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1656

· Feature Affected: Serial Cell Modem support

Issue: PAP/CHAP passwords were visible in the RemoteConnect UI.
Resolution: PAP/CHAP passwords are now obscured in the RemoteConnect UI.

Engineering reference: RSC-1683

· Feature Affected: RemoteConnect serial communications

Issue: RemoteConnect could not communicate via serial ports to a RTU with a DNP3
address of 256 or above.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1695

· Feature Affected: DNP3 master

Issue: Renaming a DNP3 master remote device in RemoteConnect would incorrectly rename
the associated Status and control objects.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1708

· Feature Affected: Variable unlock and resynchronize

Issue: Unlocking an object associated with a logic variable and renaming it would cause
another unrelated object to be unlocked.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1709

· Feature Affected: SCADAPack 574 I/O configuration

Issue: RemoteConnect allowed the configuration of Debounce Time and Invert point state
for SCADAPack 574 digital inputs DI0 – 15 even though these are not valid options for the
Digital input hardware.
Resolution: Debounce Time and Invert point state are disabled.

Engineering reference: RSC-1720 

· Feature Affected: RemoteConnect navigation tree
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Issue: In some scenarios, RemoteConnect would display the incorrect page for the selected
item in the navigation tree.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1783

· Feature Affected: RemoteConnect Import from Excel file

Issue: RemoteConnect UI would lock up if the configuration was marked as invalid when an
Import from Excel file action was performed.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1797

· Feature Affected: 

Issue: Due to a Windows 10 default folder permissions issue, the RemoteConnect project
export feature would cause RemoteConnect to lock up on Windows 10.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1806

· Feature Affected: DNP3 master and Modbus Master

Issue: Manually created objects were not properly added to DNP3 master data concentrators
or to Modbus Scanners and the association information was incorrect. Automatically created
objects were unaffected.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1868

· Feature Affected: Logic Editor

Issue: Attempting to save a project while the logic editor was still starting would cause
RemoteConnect to display a saving progress dialog indefinitely. This did not occur once the
logic editor had been started.
Resolution: To ensure integrity of logic and configuration, the save operation cannot be run
until the logic editor has finished starting.

Engineering reference: RSC-1874

· Feature Affected: RemoteConnect validation

Issue: RemoteConnect did not prohibit carriage return and line feed characters from being
entered into the comments field. The RTU would reject these configurations as being
incorrect.
Resolution: RemoteConnect does not permit carriage return and line feed characters to be
entered in the comments field.

Engineering reference: RSC-1909



3.10.3

x70 Release NotesSCADAPack x70 Release Notes

232

· Feature Affected: RemoteConnect reporting of SCADAPack status

Issue: RemoteConnect reports the RAM battery state as NORMAL even if it was not.
Reading the RAM battery status via the Logic application was unaffected.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1969

· Feature Affected: RemoteConnect validation

Issue: RemoteConnect did not correctly validate 6 digit Modbus register addresses when
opening a configuration that used 6 digit addressing.
Resolution: The issue no longer occurs.

Engineering reference: RSC-1975

· Feature Affected: DNP3 master and Modbus Master

Issue: The DNP3 Master and Modbus Scanner pages would not refresh correctly when a
device entry was deleted and the Apply button was not enabled. The Object page and Object
Group page were unaffected.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2005

· Feature Affected: Modbus Master

Issue: When loading or importing a configuration, the Write Outputs field of the Modbus
Scanner would change a setting of On Change to At Scan Rate.
Resolution: The On Change setting is correctly retained.

Engineering reference: RSC-2023

· Feature Affected: RemoteConnect and Logic Editor synchronization

Issue: Using the copy object option in the object editor page and then changing the logic
variable type of the new object before applying the changes would result in the logic editor not
creating a new variable for the new object-to-variable relationship.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2028

· Feature Affected: Logic Editor custom libraries

Issue: Logic editor custom libraries could not be created without first marking the installed
custom.db file with read-write instead of read-only file permissions.
Resolution: The custom.db file is now installed with read-write file permissions by default.

Engineering reference: RSC-2124
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· Feature Affected: RemoteConnect general operation

Issue: RemoteConnect would sometimes display an empty white tab in addition to the
normal configuration and online tabs. The white tab could not be closed but did not otherwise
interfere with user operations.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2132

· Feature Affected: RemoteConnect Object Editor

Issue: In certain circumstances the OK button on the Object Editor popup was not enabled
after a modification was made.
Resolution: This issue has been corrected.

Engineering reference: RSC-2221

· Feature Affected: RemoteConnect project settings

Issue: RemoteConnect would not clean up all objects that were made irrelevant by a project
settings change. For example, when removing Modbus master from the project settings. 
Resolution: Objects impacted by project settings changes are now cleaned up.

Engineering reference: RSC-2244

· Feature Affected: RemoteConnect validation

Issue: In RemoteConnect the PPP/CHAP username field did not prevent the entry of carriage
return and line feed characters. The addition of these characters would cause configuration
parsing problems for the firmware.
Resolution: Carriage return and line feed characters are not permitted.

Engineering reference: RSC-2251

· Feature Affected: RemoteConnect UI

Issue: RemoteConnect tables would sometimes be displayed with columns that were only
one character-width wide.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2269

· Feature Affected: Modbus Master

Issue: In RemoteConnect, the Modbus Scanner allowed the user to select FC 6 for REAL
and DINT values. FC 6 writes only a single register at a time and is not a valid choice for
multi register data formats.
Resolution: FC 6 is not permitted for 32 bit data types.

Engineering reference: RSC-2273
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· Feature Affected: RemoteConnect object editor

Issue: The edit icon could appear next to an object when an object edit was started but
cancelled.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2339

· Feature Affected: RemoteConnect general operation

Issue: Rapid and repeated opening and closing of projects in RemoteConnect could cause
the configuration window to no longer display. The window would continue to not display until
RemoteConnect was restarted.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2403

· Feature Affected: RemoteConnect recent projects

Issue: Excel files would incorrectly be listed under recent projects when an export to Excel
file or import from Excel file action was performed.
Resolution: Excel files are no longer listed under recent projects.

Engineering reference: RSC-2483

· Feature Affected: RemoteConnect USB communication

Issue: USB communications would not work when the DNP3 or Modbus address of the RTU
were over 3 digits long.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2444, FUN-1211

· Feature Affected: DNP3 point numbers for database objects. 

Issue: Database objects required a DNP3 address as a mandatory field.
Resolution: RemoteConnect no longer considers DNP3 point numbers mandatory for objects

Engineering reference: RSC-1887

· Feature Affected: DNP3 routing

Issue: Certain DNP3 routes were not permitted by validation rules.
Resolution: Loosened DNP3 route validation rules to permit more routing combinations.

Engineering reference: RSC-2071

· Feature Affected: DNP3 secure authentication
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Issue: Applying a Master key via the USB interface did not work. It was rejected in the same
manner as when the action is attempted via Ethernet.
Resolution: The issue has been corrected and applying a master key via the USB interface
works as intended.

Engineering reference: FUN-661, RSC-1997

· Feature Affected: Variable unlocking and resynchronization

Issue: DNP3 point number and Modbus register object attributes were lost after logic
variables were unlocked and resynchronized.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2587

· Feature Affected: Variable unlocking and resynchronization

Issue: Any modifications to the comments attribute of an object made after unlocking a logic
variable but before resynchronizing would not be passed to the logic editor during the
resynchronization operation.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2395

· Feature Affected: DTM Create PDF report

Issue: The Create PDF report options for the DTMs did not work in offline or online mode.
Resolution: The issue no longer occurs.

Engineering reference: RSC-2313

· Feature Affected: DNP3 Secure Authentication

Issue: The SCADAPack did not correctly report the state of the DNP3 secure authentication
licence to RemoteConnect. The state of the licence was correctly displayed on the
SCADAPack command line.
Resolution: The issue no longer occurs.

Engineering reference: FUN-1225

· Feature Affected: RemoteConnect TCP communications

Issue: RemoteConnect could not connect to a SCADAPack that was using a DNP3 port
number other than the default of 20000.
Resolution: RemoteConnect can communicate over DNP3 port numbers other than the
default.

Engineering reference: RSC-2586

· Feature Affected: SCADAPack DTM
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Issue: It was possible to import a DTM XML file and create multiple instances of the
Communication and Device DTMs. Once there are multiple DTM instances, communications
and configuration would not work as intended.
Resolution: Duplicate DTMs are now prevented by blocking imports for SCADAPack DTMs.

Engineering reference: RSC-2275

6.18.11 Known Issues/ Known Customer Difficulties (R2.0)

· Feature Affected: Modbus Master

Issue: The Modbus Master configuration can cause slow RemoteConnect performance.
When RemoteConnect Modbus Master has more than 10 Modbus Slave devices configured,
performance of RemoteConnect can be impacted.

This results in high CPU usage by RemoteConnect when the project is opening, closing, the
logic editor is opening, and when other object configuration changes are being made. In rare
cases it may cause the Configuration interface to display an incorrect menu and not select
pages. If this occurs close the Configuration – SPx70 Controller tab and double-click on
SCADAPack x70 Controller Settings to open the configuration again.

This issue does not affect the run-time communication with the Modbus Devices when the
configuration is loaded on to the SCADAPack controller.

Workaround: when configuring for 11 or more external devices, allow extra time for projects
to open and apply changes. Consider removing “placeholder” Modbus devices that are not in
use. Alternatively, consider using logic MB_IP_Master or MB_Serial_Master function blocks.

Engineering Reference: RSC-2601

Resolution: expected in RemoteConnect release R2.1

· Feature Affected: Logic variable to object mapping. 

Issue: Logic applications in the SCADAPack will not work correctly with over 64 Kilobytes of
variable data mapped to the object database.

Work around: Both RemoteConnect and the SCADAPack track the variable-to-object data
required and prevent the configuration of or execution of applications that exceed this
amount.

Engineering Reference: FUN-1352, RSC-2593

· Feature Affected: Multiple screen display. 

Issue: When a laptop is switched from a multiple screen display to a single screen display,
application windows may become orphaned on the no longer visible screen. If the logic editor
is not accepting input after attempting to open a secondary window such as the Types
Library Manager or FFB Input Assistance, it's possible that the window is open on a
previously opened display. If you've moved from using a multi-screen display to a laptop, for
example, the opened window may not be visible.

Work around: 
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Press Alt-F4 to close the hidden window and resume using the logic editor main screen.

OR

Press Alt-Space then M and hold down the left-arrow key to move the window onto the
current display.

· Feature Affected: RemoteConnect on Windows 10. 

Issue: RemoteConnect dialog content is blank.

Work around: Some Windows 10 versions may show blank display content as a result of
interaction between Windows WPF and Windows 10 Video Drivers. Microsoft have suggested
a temporary solution as follows:

· With administrator privilege run regedit from Windows

· Navigate to the following registry key:
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Avalon.Graphics.

· Add a New DWORD value (or modify the value if it exists):

· DisableHWAcceleration. Set the value to 1

· Log out of Windows

· Log in again, and start RemoteConnect.

Engineering reference: DSUM-914

· Feature Affected: Object database configuration. 

Issue: When reconfiguring from one large configuration to another large configuration, the
configuration rebuild may fail with configuration log messages similar to “# 565: Unable to
create object due to insufficient configuration memory space”.

Work around: Cold boot the RTU before applying the new configuration. Alternatively apply a
configuration with a very small number of objects and restart the RTU. The new large
configuration should then be accepted.

Engineering reference: FUN-1314

· Feature Affected: Custom function block and DDT components. 

Issue: During a RemoteConnect software upgrade, the custom function block and DDT
component libraries may be removed. 
Work around: Backup custom function blocks and DDT components prior to upgrading the
RemoteConnect software.

· Feature Affected: SCADAPack RemoteConnect configuration software

Issue: When attempting to open the DTM pane by double-clicking, a spurious error message
may appear:

“An unexpected error occurred: 
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DTM Topology Editor

Cannot open DTM UI: Object reference not set to an instance of an object.”

Workaround: Restart the RemoteConnect application

Engineering reference: RSC-514

· Feature Affected: Logic Editor PLC Simulator 

Issue: The Mode > Start Simulation action in the Logic Editor can take an extended period of
time to start. The PLC Simulator is started and the project is prepared for download, but it
can take up to 2 minutes for the download to start. After the first download, subsequent uses
of the PLC Simulator don't experience this issue while the SCADAPack x70 Logic Editor and
PLC simulator remain open. In some cases, a message from the simulator, stating "Error
allocating PAT memory space" can occur.

Workaround: Press OK and ignore this message. 

Engineering reference: USOC-94, USOC-95

· Feature Affected: Logic Editor PLC Simulator 

Issue: The Mode > Start Simulation action in the Logic Editor may not start.

Workaround: Start the simulator manually. From the Windows menu type in “PLC
Simulator”. This may take multiple attempts. After starting via the Windows menu it should
be possible to use “Mode > Start Simulation.

Engineering reference: USOC-94, USOC-95

· Feature Affected: SCADAPack x70 factory boot 

Issue: The SCADAPack RemoteConnect configuration software does not read the
configuration from a SCADAPack x70 device that has been factory booted. 
Workaround:  Write the configuration to the device or restart the device.

Engineering reference: RSC-893

· Feature Affected: SCADAPack RemoteConnect configuration software start-up 

Issue: The SCADAPack RemoteConnect configuration software may be blocked from
reopening if previous instances of RemoteConnect or the Logic Editor were not closed
cleanly. 
Workaround: Run the “Process Scrubber” application, which will shut down any remaining
processes, then restart RemoteConnect.

· Feature Affected: Unity Pro installation compatibility

Issue: The SCADAPack RemoteConnect configuration software installation process and
Unity Pro software installation process can interfere with one another. It is recommended that
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when installing new versions of Unity Pro software that the repair installation option be run for
SCADAPack RemoteConnect. Coexisting installations of RemoteConnect and Unity pro are
only supported for Unity Pro versions 11.1, 12 and 13.
Work around: Use a virtual machine for RemoteConnect installations or for Unity Pro
installations or Repair the installations as mentioned above.

When installing new versions of SCADAPack RemoteConnect, the installer will automatically
attempt a Repair on Unity Pro software.

· Feature Affected: IEC 60870-5-101 and IEC 60870-5-104 slave protocol support. 

Issue: The IEC 60870-5-101 and IEC 60870-5-104 slave protocol drivers have been
temporarily disabled in the SCADAPack RemoteConnect configuration software. 

Work around: SCADAPack E devices use the same protocol drivers as the SCADAPack
x70 devices. Use SCADAPack E Configurator to evaluate the IEC 60870-5-101 and IEC
60870-5-104 slave protocol drivers for their suitability in applications.

6.18.12 Post Installation Troubleshooting

Logic Editor is unable to communicate with SCADAPack RemoteConnect

Symptoms: 

The SCADAPack x70 Logic Editor is starting, but is unable to communicate with SCADAPack
RemoteConnect. When this occurs, the Logic Editor may not display variables that were created
in the Object Editor and you may not be able to build the application from RemoteConnect.

Steps to resolve:

Register pserver.dll as described below

1. Close the Logic Editor and RemoteConnect applications if they are running on the PC.

2. In the Windows menu, search for cmd.exe then right-click on it and select Run as
administrator to open it.

3. In the command line window, change to the default installation directory by typing one of the
following commands:

64-bit systems: cd “C:\Program Files (x86)\Schneider Electric\UnityScadaPack 11.1” 

32-bit systems: cd “C:\Program Files\Schneider Electric\UnitySCADAPack 11.1”

4. Type the following command to complete the registration:

regsvr32.exe pserver.dll

When the registration is complete, a dialog box with the message DllRegisterServer in
pserver.dll succeeded is displayed.
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Logic editor or Types Library update tool library modification

Symptoms:

SCADAPack Logic Editor or Types Library Update tool reports the library is opened by another
application when attempting to modify the logic library

Steps to resolve:

Check that no instances of Unity Pro and RemoteConnect/SCADAPack x70 Logic Editor are
running. Use the "Process Scrubber" if necessary. If the problem persists it is likely a Windows
folder permissions problem.

Check the following:

· With administrator privilege right click on the following folder: C:\ProgramData\Schneider
Electric

· Select Properties

· Select the Security tab

· Click Edit

· Click on the Users entry in the Group or user names section

· Scroll down the Permissions for Users area until you see a row called "Write"

· Check the box in the "Allow" column for the "Write" row

· Click OK

· The security settings will update on all the sub-folders

· Click OK to exit the Properties dialog

Engineering reference: DSUM-919

6.18.13 SCADAPack 57x and 6601 Firmware Version compatibility table

Customer Guidance

6601 upgrade recommendations: Upgrade 6601 I/O modules (both external and built into
SP575) to firmware version 1.80.10 and bootloader version 1.80.10. For 6601 input output
modules shipped with firmware 1.77.131 or earlier, and where extended over-range capabilities
(up to 22 mA) are required, the module may be returned to a Schneider Electric facility for
recalibration.

6601 minimum firmware version: 6601 I/O modules shipped from the factory with 1.80.6 or
1.80.10 firmware should not be downgraded to versions earlier than 1.80.6.

6601 bootloader upgrade mechanism: The command line command “restart iofirm
<filename> <module address>” is provided for 6601 firmware upgrades. The 6601 firmware
upgrade command can be used to upgrade the 6601 bootloader. This is only supported on
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device firmware 9.0.4 and later and 6601 firmware 1.80.6 and later. “restart iofirm bl6601.bin
<module address>” will apply bootloader file bl6601.bin. The filename bl6601.bin is the only
filename that is accepted for the bootloader. Other file names will result in an attempt to patch
the 6601 firmware and not the 6601 bootloader. The 6601 bootloader version is not reported on
the command line.

SP57x minimum firmware version: If there is an attached 6601 or a built-in 6601 (SP575) the
device firmware version should be 9.0.4 or later.

NOTICE

LOSS OF SENSOR ACCURACY

If you use firmware versions that are incompatible with extended over-range calibration on 6601
analog inputs, the analog inputs may report values 10% lower than the actual value.

Use only firmware versions that are compatible with extended over-range calibration.

Do not use SP570 or SP575 9.0.3 or earlier firmware in conjunction with a 6601 1.80.6 or later
with extended over-range calibration. They are not compatible. 

Do not use 6601 firmware earlier than 1.80.6 with extended over-range calibration. They are not
compatible.

Failure to follow these instructions can result in equipment damage.

A new version of 6601 I/O module firmware and bootloader has been released since the release
of SP57x firmware 9.0.3. A new calibration format for 6601 analog inputs has been added to
support extended over-range capabilities. Interoperability of various versions of firmware and
calibration is described below.

SP57x
Firmw
are

6601
Firmw
are

6601
Calibrati
on

6601 AI
Value

Over-
range

Comment

 9.0.3 or
earlier

1.77.1
31 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.77.
131 or
earlier

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.3 or
earlier

1.80.0
6 or
later

0…20
mA

Reporte
d
normall
y

Always
active at
20.05mA

6601 I/O modules upgraded to
1.80.6 from earlier versions will
leave calibration unchanged.
Recommended for upgrading
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systems that do not require
extended over-range capabilities.

 9.0.4 or
later

1.80.0
6 or
later

0…20
mA 

Reporte
d
normall
y

Always
active at
20.05mA

 9.0.4 or
later

1.80.0
6 or
later

0…22
mA 

Reporte
d
normall
y

Always
active at
22.00mA

Recommended choice for new
installations

X

9.0.3 or
earlier

1.77.
131 or
earlier

0…22
mA

AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.4 or
later

1.77.
131 or
earlier

0…22
mA

AI
report.
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. Should
only occur when a 6601 is
mistakenly downgraded from
1.80.6 to an earlier version.

X

9.0.3 or
earlier

1.80.0
6 or
later

0…22mA AI
report
10%
lower
values

Always
active at
20.05mA

NOT RECOMMENDED. When
adding new 6601 I/O modules to
existing systems, SP57x
firmware should be upgraded to
9.0.4 or later. If this is not
practical, contact Schneider
Electric technical support.
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7 SCADAPack RemoteConnect, Unity Pro, and Control Expert
Compatibility

The following matrix describes compatible versions of SCADAPack RemoteConnect, Unity Pro,
and Control Expert.

· X indicates versions that are NOT compatible

· ü indicates compatibility between the SCADAPack RemoteConnect version and the Unity
Pro or Control Expert version

· Where an X or ü is not present, concurrent installation and operation of the two versions may
be possible, but is not supported.

SCADAPack
RemoteConn
ect Installer /
About
Version

Unity Pro
<%CONTROLEXPERTECOSTRUX%

>

11.0
and
Earli

er

V11.
1

V12.
0

V13.
0

V13.
1

V14.
0

V14.
1

V15.
0

V15.
0 -

SP1

V15.
1

and
later

R2.0 / 3.4.1

R2.1 / 3.4.2
X ü ü ü n/a n/a n/a n/a n/a X

R2.1.1 / 3.4.3 X ü ü ü ü n/a n/a n/a n/a X

R2.2 / 3.5.1

R2.2.1 / 3.5.2

R2.2.2 / 3.5.3

R2.3 / 3.6.1

R2.3.1 / 3.6.2

R2.3.2 / 3.6.3

X ü ü ü ü ü X X n/a X

R2.4 / 3.7.1

R2.4.1 / 3.7.2

R2.4.2 / 3.7.3

X X X ü ü ü ü X n/a X

R2.5.1 / 3.8.1

R2.5.2 / 3.8.2

R2.5.3 / 3.8.3

X X X ü ü ü ü ü n/a X
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R2.6.1 / 3.9.1

R2.7.1 /
3.10.1

R2.7.2 /
3.10.2

X X X ü ü ü ü ü ü X

R2.7.3 /
3.10.3

X X X X X X X X X ü
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